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O blogu Kompjuteri

- Opste kompjuterske teme. Pitanja i odgovori, pomoc korisnicima, igre, emulatori, operativni sistemi, grafika, programiranje, internet...
- Prvobitno je postojao klub Kompjuteri na nekadasnjem sajtu Urbae, ali je zbog reorganizacije sajta i promene dizajna i 
funkcionalnosti, klub Kompjuteri morao biti zatvoren, jer, novonastale promene umesto da poboljsaju funkcionalnost klubova, samo su 
upropastile do tada solidnu platformu za funkcionisanje klubova.
- Zatim je osnovana grupa Kompjuteri na Fejsbuku, koja je takodje zatvorena zbog prelaska na novi format grupa, za koji tvrde da 
donosi poboljsanja, ali umesto poboljsanja, funkcionalnost grupa je upropastena.
- Zbog toga sam otvorio ovaj blog na WordPressu. Nadam se da WordPress nece, kao i Urbae i Fejsbuk, nekim nazovi poboljsanjima 
upropastiti funkcionalnost bloga.

----------------------------------------------------

- Saveti, programi i internet adrese koje sam pomenuo u blogu su provereni i bezbedni. Ne odgovaram za bilo kakvu eventualnu stetu 
nastalu koriscenjem saveta, programa i ostalih stvari pomenutih u blogu. Jer, kao sto napisah, sve je probano i provereno, tako da ako 
nesto nije u redu, znaci da nesto niste dobro odradili.
- Internet adrese i linkovi prema drugim sajtovima koji se pominju u tekstovima, su provereni u vreme pisanja samih tekstova. S 
obzirom da su mnogi tekstovi stari i vise od godinu dana, moze se desiti da su neke adrese u medjuvremenu promenjene, pa samim 
tim i ti linkovi nece raditi. Ako primetite da neka adresa prema drugom sajtu vise nije aktuelna, slobodno ostavite komentar. Ja cu u 
najkracem mogucem roku to ispraviti.

                                            ~ Darth Ewok

O ovoj knjizi 

Ebook je nastao sa idejom da se citaocima da lep i koristan poklon povodom Nove godine. Sadrzi sve textove od pocetka rada, koji 
datira godinama unazad i pre prelaska na wordpress platformu. U njemu cete naci analize, uputstva i tutorijale vezane za 
Kompjuterske nauke u najsirem smislu. Od raznih operativnih sistema i networkinga, preko programiranja, dizajna i multimedije, pa do 
prikaza open source programa i besplatnih igara. 

U gotovo svim postovima, akcenat smo stavljali na prakticnost u radu. Pored brojnih resenja za neke od standardnih problema, 
znacajan deo cine pojedinacni i serije tutorijala. Npr. naci cete izuzetnu seriju vezanu za rad sa Gimpom, ili kratak ali vrlo efektan uvod 
u Python. Mislim da ovakav pristup bez puno teoretisanja predstavlja i najvecu vrednost ove knjige. 

Imajte takodje u vidu, da textovi predstavljaju odraz iskustva i pristupa autora. On se ne poklapa uvek sa opste prihvacenim pogledima 
u IT svetu. Takodje, pojedina uputstva obradjuju podesavanja na dubinskom sistemskom nivou. Iako smo se trudili da sto jasnije 
objasnimo svaki detalj, to nije uvek moguce. Autori nece snositi odgovornost za eventualne probleme koji mogu nastati, te vas molim 
da imate u vidu, da uputstva u knjizi primenjujete na sopstvenu odgovornost. 

Opredelili smo se za CC-BY-SA licencu. Ukratko, ebook mozete koristiti u celosti ili po textovima u bilo koje svrhe, ukljucujuci i 
komercijalne. Neophodno je samo da navedete izvor, te da eventualni remix bude pod istom licencom (Share Alike). Takodje, licenca 
je kompatibilna sa Radovima Slobodne Kulture. 

Na kraju bih rekao da ce ovaj ebook biti od najvece koristi nasim redovnim citaocima. Zato sto nece biti samo IT zbornik, vec i offline 
podsetnik onoga sto vec znaju. U tom smislu vas pozivam da, kao i do sada, pratite nas rad na dobro poznatoj adresi > 

https://kompjuteri2011.wordpress.com 

Srecna Nova i sve najbolje.

                                            ~ Windu Jet

https://kompjuteri2011.wordpress.com
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Celes a (2011-05-25 19:55) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

Geoshell (2011-05-25 19:56) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

Programi sa www.paehl.de/english.php (2011-05-25 19:59) - darthewok . . . . . . . . . . . . . . . . 90

Advanced SystemCare Free (2011-05-25 20:01) - darthewok . . . . . . . . . . . . . . . . . . . . . . 90

Smart Defrag (2011-05-25 20:02) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Artweaver (2011-05-25 20:04) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Startup Delayer (2011-05-25 20:05) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Programi sa pabloso waresolu ons.com (2011-05-25 20:06) - darthewok . . . . . . . . . . . . . . . 92

Gnome Sub tles (2011-05-25 20:07) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

Programiranje (2011-05-25 20:09) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

JDownloader (2011-05-25 20:10) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

XBMC (2011-05-25 20:11) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

gMapMaker i Mobile GMaps (2011-05-25 20:13) - darthewok . . . . . . . . . . . . . . . . . . . . . 93

MyViewPad (2011-05-25 20:14) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

Kicad (2011-05-25 20:15) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

HashCalc (2011-05-25 20:16) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Tor (2011-05-25 20:17) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Polipo (2011-05-25 20:18) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

LibreOffice (2011-05-25 20:19) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

TrueCrypt (RealCrypt) (2011-05-25 20:20) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . 96

OOoTranslit (2011-05-25 20:21) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Microemulator (2011-05-25 20:25) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Liferea (2011-05-25 20:26) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Streamtuner2 (2011-05-25 20:27) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Link-O-Rama pt1 (2011-05-26 05:01) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

Link-O-Rama pt2 (2011-05-26 05:18) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Link-O-Rama pt3 (2011-05-26 05:46) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

Link-O-Rama pt4 (2011-05-26 06:24) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

Blender i limited user nalog (2011-05-30 02:23) - darthewok . . . . . . . . . . . . . . . . . . . . . . 108

1.2 June . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Free Morphing (2011-06-01 23:33) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

FotoMorph (2011-06-01 23:49) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

FotoMix (2011-06-01 23:59) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
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WinMorph (2011-06-04 16:08) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110

OpenShot (2011-06-05 14:01) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110

AV Linux (2011-06-05 14:09) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Fedora 15 i Gnome 3 (2011-06-09 15:23) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Kako modifikova sat da prikazuje i datum u Fedori 15 (2011-06-11 00:04) - darthewok . . . . . . . . 112

Podesavanje dugmica na naslovnoj liniji prozora ( tlebar) u Fedori 15 (2011-06-11 00:11) - darthewok 113

Ak viranje ikona na desktopu u Fedori 15 (2011-06-11 00:15) - darthewok . . . . . . . . . . . . . . . 113

Op mizacija Fedore 15 i zatvaranje nepotrebnih otvorenih portova (2011-06-11 17:20) - darthewok . 113

Kako pronaci podesavanja za adsl modem ili ruter? (2011-06-14 14:49) - darthewok . . . . . . . . . . 116

Uputstvo za povezivanje i podesavanje EchoLife HG520s. (2011-06-17 21:53) - darthewok . . . . . . 116

Facebook i bezbedna konekcija (secure connec on - h ps) (2011-06-23 02:22) - darthewok . . . . . . 120

Kdenlive (2011-06-24 03:45) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

Lista default sifri za neke mrezne uredjaje (2011-06-29 23:41) - darthewok . . . . . . . . . . . . . . . 120

1.3 July . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Save Images (2011-07-03 19:40) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

TP-Link TL-WN722NC Wireless USB Adapter (2011-07-08 16:35) - darthewok . . . . . . . . . . . . . 121

Prebacivanje .mdx u .iso (2011-07-15 00:13) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . . 122

Gimp tutorijal 01 (2011-07-17 19:40) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Gimp tutorijal 02 (2011-07-18 12:11) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Gimp tutorijal 03 (2011-07-19 12:49) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Gimp tutorijal 04 (2011-07-20 12:44) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

Gimp tutorijal 05 (2011-07-21 01:45) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

Gimp tutorijal 06 (2011-07-21 13:19) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

Gimp tutorijal 07 (2011-07-21 15:51) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125

Gimp tutorijal 08 (2011-07-22 11:52) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125

Gimp tutorijal 09 (2011-07-23 17:21) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125

Gimp tutorijal 10 (2011-07-24 09:37) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125

Gimp tutorijal 11 (2011-07-25 10:42) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

Gimp tutorijal 12 (2011-07-26 09:59) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

Screengrab (2011-07-26 13:08) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

Video DownloadHelper (2011-07-26 13:16) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . 126

Gimp tutorijal 13 (2011-07-26 17:57) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Gimp tutorijal 14 (2011-07-26 21:17) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Gimp tutorijal 15 (2011-07-27 07:51) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Gimp tutorijal 16 (2011-07-27 22:49) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
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Gimp tutorijal 17 (2011-07-28 15:50) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Gimp tutorijal 18 (2011-07-28 23:08) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

UFO Alien Invasion (2011-07-30 21:22) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

1.4 August . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

20 godina Linuxa (2011-08-01 15:26) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

Slobodni so ver (2011-08-02 09:36) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

Brisanje Flash Cache-a (2011-08-07 14:29) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

zsnes (2011-08-14 22:04) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

MAME (2011-08-15 00:17) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131

Be erPrivacy (2011-08-19 15:48) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131

Cookie Monster (2011-08-19 16:44) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131

PrivacySuite (2011-08-19 16:59) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

shouldichangemypassword.com (2011-08-21 07:13) - darthewok . . . . . . . . . . . . . . . . . . . . 132

User Agent Switcher (2011-08-24 03:29) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Advanced Cookie Manager / Editor (2011-08-24 03:32) - darthewok . . . . . . . . . . . . . . . . . . 133

RefControl (2011-08-24 03:40) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

KBasic (2011-08-25 11:37) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

Highpass sharpening (2011-08-26 19:57) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . 134

1.5 September . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Kako poveca WIFI domet? (2011-09-09 22:07) - darthewok . . . . . . . . . . . . . . . . . . . . . . 135

Sta je to Easter Egg? (2011-09-09 22:19) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . 136

Sta je NetBIOS over TCP/IP (NetBT ili NBT)? (2011-09-16 12:28) - darthewok . . . . . . . . . . . . . . 136

Recuva (2011-09-16 12:52) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

Double Driver (2011-09-18 21:46) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

Firefox i Facebook (2011-09-19 00:48) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

Wolfenstein: Enemy Territory (2011-09-25 23:14) - darthewok . . . . . . . . . . . . . . . . . . . . . 138

1.6 October . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

Zas ta fajla grub.conf od nedozvoljenih izmena prilikom podizanja sistema (2011-10-01 22:33)
- darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

Otvaranje Google pretrazivaca na engleskom (2011-10-10 14:05) - w1ndu . . . . . . . . . . . . . . . 140

Ripovanje mp3 is avi fajla (2011-10-10 14:14) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . 140

˜ nrg2iso ˜ (2011-10-10 14:39) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

Kako instalira dll fajl? (2011-10-29 15:56) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . 141

1.7 November . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

˜ MiPony ˜ (2011-11-09 18:15) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

Otvaranje Google pretrazivaca na engleskom u Operi. (2011-11-10 21:55) - darthewok . . . . . . . . 142
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Gimp tutorijal 19 (2011-11-11 16:51) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

Gimp tutorijal 20 (2011-11-13 12:37) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

Gimp tutorijal 21 (2011-11-14 13:26) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

Dodaci za Firefox da Facebook radi normalno... (2011-11-19 15:07) - darthewok . . . . . . . . . . . . 144

Eraser [FF] (2011-11-20 07:26) - w1ndu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144

Gimp tutorijal 22 (2011-11-20 12:51) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145

Linux Free So ware Catalog and Packages Search (2011-11-21 12:16) - darthewok . . . . . . . . . . 145

GIMP Matrix Plugin (2011-11-22 03:28) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . 145

Pixlr Grabber (2011-11-25 15:57) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

Fedora 16 i Grub2 (2011-11-25 16:46) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

Grub2 - Izmena podrazumevane boot opcije i izmena vremena (2011-11-25 17:06) - darthewok . . . 147

Op mizacija Fedore 16, zatvaranje nepotrebnih otvorenih portova i instaliranje nekih programa.
(2011-11-26 09:20) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu
Internet za pone (Fedora 15 i 16). (2011-11-26 13:58) - darthewok . . . . . . . . . . . . . 152

Photo editor online (2011-11-26 17:38) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . 154

MyPaint (2011-11-28 02:40) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

1.8 December . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155

Global Conflict Blue 2 (2011-12-01 00:38) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . 155

Sta je TCP/IP? (2011-12-02 06:28) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155

Gimp tutorijal 23 - Layer Mask (2011-12-04 15:56) - darthewok . . . . . . . . . . . . . . . . . . . . . 156

Fedora 16 boot problem posle poslednjeg apdejta (2011-12-14 20:28) - darthewok . . . . . . . . . . 156

Second Life u Linuxu (2011-12-19 11:33) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . 157

Fedora 16 & Virtual Box (2011-12-25 16:23) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . 158

Fedora 16 & vlasnicki NVidia i ATI drajveri (2011-12-26 19:03) - darthewok . . . . . . . . . . . . . . . 158

Srecna Nova Godina!!! (2011-12-30 01:48) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . 158

Jhead (2011-12-31 15:15) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159

2 2012 161

2.1 January . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

2011 in review (2012-01-01 12:25) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

Instaliranje custom firmware-a na PSP 3000 (2012-01-02 21:41) - darthewok . . . . . . . . . . . . . 161

Srecan Bozic! (2012-01-07 12:33) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162

Gimp tutorijal 24 – Ray Studio (2012-01-11 03:22) - darthewok . . . . . . . . . . . . . . . . . . . . . 162

Fedora 16 i VLC problem posle poslednjeg update-a (2012-01-15 22:49) - darthewok . . . . . . . . . 162

Gimp tutorijal 25 - 3D TV foto montaza (2012-01-17 21:09) - darthewok . . . . . . . . . . . . . . . . 163
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Protest na internetu... (2012-01-18 04:49) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . 163

”PROTECT IP / SOPA” akt rusi Internet (2012-01-18 05:24) - darthewok . . . . . . . . . . . . . . . . . 164

Linux Mint 12 - kako sam podesio i koje sam programe dodatno instalirao (2012-01-22 11:04)
- darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164

Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu
Internet za pone (Mint 12). (2012-01-22 11:13) - darthewok . . . . . . . . . . . . . . . . 168

Gimp tutorijal 26 - ubacivanje Photoshop braseva u Gimp (2012-01-23 00:13) - darthewok . . . . . . 168

Gimp tutorijal 27 - munje, varnice i neonske reklame (2012-01-24 19:14) - darthewok . . . . . . . . . 169

Mint 12 i Kdenlive (2012-01-27 15:55) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . 169

Mint 12, Skype i izvrnuta slika na integrisanoj web kameri na Asus laptopu (2012-01-27 19:46)
- darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169

Besplatni web hos ng - 000webhost.com (2012-01-30 11:45) - darthewok . . . . . . . . . . . . . . . 170

YoWindow - vremenska prognoza (2012-01-30 12:17) - darthewok . . . . . . . . . . . . . . . . . . . 171

2.2 February . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172

Gimp tutorijal 28 - sneg (2012-02-05 16:08) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . 172

Gimp tutorijal 29 - dopuna prethodne epizode (2012-02-05 17:48) - darthewok . . . . . . . . . . . . 172

Gimp tutorijal 30 - Animirani GIF-ovi (2012-02-07 20:17) - darthewok . . . . . . . . . . . . . . . . . 172

Gimp tutorijal 31 - Hockney fotografija (2012-02-09 00:43) - darthewok . . . . . . . . . . . . . . . . 172

Dogfight Ba le In The Skies (2012-02-10 02:31) - darthewok . . . . . . . . . . . . . . . . . . . . . . 173

Gimp tutorijal 32 - Valen ne’s Vampir (2012-02-12 15:06) - darthewok . . . . . . . . . . . . . . . . . 177

Aviary Tools (2012-02-15 02:31) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

Start Page - pretrazivac (2012-02-15 03:00) - darthewok . . . . . . . . . . . . . . . . . . . . . . . . 178

Gimp tutorijal 33 - Svemir (2012-02-17 19:42) - darthewok . . . . . . . . . . . . . . . . . . . . . . . 179

2.3 March . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179
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1. 2011

1.1 May

fstab i noa me (2011-05-24 12:28) - darthewok

Da bi poboljsali performanse u Linuxu i (kazu ljudi) produzili vek hard diska, korisno je u fajlu etc/fstab postavi za
svaku stavku opciju noa me ili barem tamo gde to nije potrebno. Opcija noa me je posebna opcija za mountovanje
fajl sistema koja sprecava upisivanje vremena pristupa odredjenom fajlu. Prilikom citanja fajla se vrsi upisivanje vre-
mena pristupa fajlu, pa samim m, ukljucivanjem opcije noa me, se dobija na performansama sistema. To u ovom
primeru izgleda ovako:
/dev/VolGroup00/LogVol00 / ext3 defaults,noa me 1 1
LABEL=/boot /boot ext3 defaults,noa me 1 2

Dodato 27.1.2012:
Ako radite neke bekape podataka gde je potreban podatak o vremenu pristupa fajlu ili imate neke servere
kojima je potreban podatak o vremenu pristupa fajlu, ili Vam je iz nekog razloga potreban podatak o
vremenu pristupa fajlu, onda ne treba postavlje noa me u fstab.

Dodavanje novih TTF fontova u Linuxu (Gnome v2.18.0 okruzenje) (2011-05-24 12:34) - darthewok

Otvori : System - Preferences - Look and Feel - Font u prozoru Font Preferences kliknu na Detail, za m u prozoru
Font Rendering Details kliknu na Go to font folder. Kada se otvori Font folder, tada u taj prozor prevuci zeljeni TTF
font. Ovo ne morate radi kao Root, ovaj postupak moze da primeni i obican user. S m sto ce jedino on moci da
koris taj font.

Popravka RPM baze (2011-05-24 12:37) - darthewok

Ukoliko Vam iz bilo kog razloga pobrljavi rpm baza.
To mozete porpavi na sledeci nacin:
U terminalu ukucajte: rpmdb –rebuilddb
Ukoliko i dalje ima problema sa rpm bazom, onda kucajte sledece: rm -f /var/lib/rpm/ _ _db.00*
pa za m opet: rpmdb –rebuilddb
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Meni se pojavila greska: rpmdb: unable to lock mutex: Invalid argument posle jedne ’nasilne’ instalacije. Pa sam
na ovaj nacin to uspeo da popravim.
rm -f /var/lib/rpm/ _ _db.00*
rpmdb –rebuilddb

Grub Windows + Linux dual boot (2011-05-24 12:41) - darthewok

Ako koris te Windows i Linux, koji su instalirani na 2 zasebna hard diska i pri tome je Linuxov hard disk prvi, a Win-
dowsov drugi, doci ce do problema prilikom ucitavanja Windowsa, da budem precizniji Windows nece moci da se
ucita kada se izabere u Grub meniju. To se lako moze resi izmenom fajla /boot/grub.conf.
Treba doda dve linije u grub.conf tako da se ’so verski zamene’ prvi i drugi disk:

map (hd0) (hd1)
map (hd1) (hd0)

Dakle, grub.conf bi u ovom primeru ovako izgledao:
# grub.conf generated by anaconda
#
# Note that you do not have to rerun grub a er making changes to this file
# NOTICE: You have a /boot par on. This means that
# all kernel and initrd paths are rela ve to /boot/, eg.
# root (hd0,0)
# kernel /vmlinuz-version ro root=/dev/VolGroup00/LogVol00
# initrd /initrd-version.img
#boot=/dev/sda
default=0

meout=5
splashimage=(hd0,0)/grub/splash.xpm.gz
hiddenmenu

tle Fedora (2.6.23.1-42.fc8 )
root (hd0,0)
kernel /vmlinuz-2.6.23.1-42.fc8 ro root=/dev/VolGroup00/LogVol00 rhgb quiet
initrd /initrd-2.6.23.1-42.fc8.img

tle Windows
rootnoverify (hd1,0)
map (hd0) (hd1)
map (hd1) (hd0)
chainloader +1
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Autostart (2011-05-24 13:00) - darthewok

Ako zelite da se neki program automatski pokrene kada se podigne sistem, na primer zelite da se Compiz-Fusion
odmah pokrene, treba uradi sledece (vazi za Gnome graficko okruzenje). Kliknu na System - Preferences - Startup
Applica ons u prozoru Startup Applica ons Preferences

[1]
Startup Applica ons Preferences

kliknu na Add, a za m u polje command ukuca komandu kojom se program pokrece, u ovom primeru treba ukuca
fusion-icon. U polje name ukuca naziv programa, mada to polje nije mnogo bitno, ali da bi znali sta se pokrece,
dobro je da upisete ime koje asocira na program. U ovom primeru upisite Compiz-Fusion. U polje comment stavite
komentar na primer Compiz-Fusion Autostart. Kliknite na Ok. Ovaj primer se odnosi na Compiz-Fusion. I naravno,
ovo ce da radi ako imate instaliran Compiz-Fusion. Mozete da eksperimen sete i sa drugim programima koje zelite da
pokrenete automatski kada se podigne sistem.

1. http://kompjuteri2011.files.wordpress.com/2011/05/startup.png

Lista ak vnih mreznih i internet konekcija (2011-05-24 13:05) - darthewok

Ako imate potrebu ili zelju da vidite listu ak vnih mreznih i internet konekcija ili sta s ku veze, to mozete vide tako
sto u terminalu ukucate komandu netstat. Netstat ima dosta opcija. Listu opcija mozete vide ako ukucate u termi-
nalu: man netstat. Evo nekih primera:
netstat -s (prikaz sta s ka veze)
netstat -vat (prikaz liste ak vnih konekcija)
netstat -vatp (prikaz liste ak vnih konekcija sa nazivima programa koji su uspostavili konekciju)
netstat -vatpn (isto kao i u prethodnom slucaju, samo sto ne pretvara IP adrese u nazive hostova, vec daje prikaz samo
IP adresa sa kojima je uspostavljena konekcija)

ifconfig (2011-05-24 13:06) - darthewok

Ukoliko Vam treba podatak o MAC adresi mrezne kar ce, to mozete vide , komandom ifconfig
Takodje, ta komanda ce prikaza i jos neke parametre mreze.

21

http://kompjuteri2011.files.wordpress.com/2011/05/startup.png


Compiz Fusion (2011-05-24 13:12) - darthewok

Citao sam po forumima da ljudi imaju dosta problema sa pokretanjem Compiz-Fusion u Fedori 8, takodje sam i ja
naisao na neke probleme, ali sam ih uspesno resio. Pa sam zato resio da postavim ovaj post.
Ukoliko rucno downloadujete i instalirate Compiz-Fusion paket u Fedori 8, treba preuze sledece fajlove:

sip-4.7.1-2.fc8.i386.rpm (potrebno za qt4)
sip-devel-4.7.1-2.fc8.i386.rpm (potrebno za qt4)
U fedori vec postoje sip i sip-devel, samo su starije verzije, pa morate update-ova komandom rpm -Uvh sip*.rpm

Ostale pakete mozete instalira klasicno rpm -ivh *.rpm. Barem sam kod sebe tako radio i uspelo je.
qt4-4.3.3-1.fc8.i386.rpm (potrebno za fusion-icon)
qt4-x11-4.3.3-1.fc8.i386.rpm (potrebno za fusion-icon)
PyQt4-4.3.1-3.fc8.i386.rpm (potrebno za fusion-icon)

compiz-fusion-0.6.0-12.fc8.i386.rpm
compiz-fusion-gnome-0.6.0-12.fc8.i386.rpm
ccsm-0.6.0-4.fc8.noarch.rpm
emerald-themes-0.5.2-2.fc8.noarch.rpm
compizconfig-python-0.6.0.1-2.fc8.i386.rpm
gnome-compiz-manager-0.10.4-3.fc8.i386.rpm
compiz-fusion-extras-0.6.0-1.fc8.i386.rpm
libsexy-0.1.11-3.fc8.i386.rpm
compiz-fusion-extras-gnome-0.6.0-1.fc8.i386.rpm
python-sexy-0.1.9-3.fc7.i386.rpm
emerald-0.5.2-2.fc8.i386.rpm
fusion-icon-0-0.3.20071206git.fc8.noarch.rpm
fusion-icon-gtk-0-0.3.20071206git.fc8.noarch.rpm
fusion-icon-qt-0-0.3.20071206git.fc8.noarch.rpm

Na kraju jos komentar za fusion-icon. Na nekim sajtovima sa tutorijalima o pokretanju i instalaciji Compiz-Fusion-
a se uopste ne pominje fusion-icon, koji je neophodan za pokretanje C-F-a, jer se tom komandom pokrece C-F.

Ukljucivanje Pulse Audio Sound Servera u Fedori 8 (2011-05-24 13:13) - darthewok

Pulse Audio Sound Server omogucava da se pusta vise audio strimova istovremeno. I takodje eliminise neke moguce
nega vne posledice ako dva ili vise programa krenu da pustaju audio.

22



Kliknu na System - Preferences - Personal - Sessions
U prozoru Startup Programs kliknu na Add
U prozoru koji se pojavi popuni polja Name, Command i Comment:
Name: PulseAudio Sound Server
Command: /usr/bin/pulseaudio -D
Comment: The Pulse Audio sound server daemon
Kliknu na Ok i zatvori GNOME session prozor.
Restartova kompjuter.

Sada je potrebno podesi Gnome da pocne da koris Pulse Audio:
Kliknu na System - Preferences - Hardware - Sound
U okviru stavki Sound Events, Music and Movies, i Audio Conferencing, Sound Playback postavi na PulseAudio
Zatvori prozor.

Ovim je sistem je podesen za Pulse Audio.

Podesavanje Openal da radi sa Pulse Audio (2011-05-24 13:14) - darthewok

Posle podesavanja Pulse Audia, neke igre koje korsite Openal nisu imale zvuk.
To se resava na sledeci nacin. Proverite da li u /home/ folderu postoji fajl .openalrc. Ako ne, otvorite omiljeni vam
text editor i ukucajte sledeci red:
(define devices ’(esd))
Sacuvajte fajl pod imenom .openalrc
Ako ste sve dobro uradili, trebalo bi da dobijete zvuk.

SDL i Pulse Audio (2011-05-24 13:17) - darthewok

Da bi programi i igre koje koriste SDL mogle da rade kada je ukljucen Pulse Audio, potrebno je instalira novu verziju
SDL-a 1.2.13 (ili noviju), koja ima podrsku za Pulse Audio.
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Kalibrisanje Dzojs ka u Linuxu (pod uslovom da je prepoznat :) ) (2011-05-24 13:19) - darthewok

Otvori terminal i ukuca komandu jscal -c /dev/js0
Za m pra sta pise na ekranu i tako radi .

Google Earth (2011-05-24 13:20) - darthewok

Ukoliko Google Earth nece da se startuje iz Applica ons menija ili dvoklikom na ikonu na desktopu, proba pokretan-
jem iz terminala.
Ako se pojavi sledeca poruka o gresci prilikom pokusaja starovanja iz terminala:
./googleearth-bin: error while loading shared libraries: ./libminizip.so: cannot restore segment prot a er reloc: Per-
mission denied
Treba uradi sledece:

cd /home/ime _ak vnog _korisnika/google-earth
chcon -t texrel _shlib _t *.so

Ovo je tes rano u Fedori 8 sa verzijom Google Earth 4.3.7204.0836 (beta)!

Provera da li postoje greske i bad blokovi na hard disku i popravka is h (2011-05-24 13:22) - darthewok

Uci u root nalog ili u terminalu ukuca su - i sifru root naloga.
U terminalu ukuca :
badblocks /dev/oznaka _uredjaja -s > test
- oznaka _uredjaja moze bi sda, sdb, hda, hdb itd... U zavisnos od toga koji uredjaj zelite da proveravate i kako Vasa
Linux distribucija vidi hard diskove.
- -s prikazuje dokle je badblocks s gao sa proverom.
- test je naziv fajla u koji se upisuju eventualni bad blokovi.

Ukoliko postoje greske onda ih mozete popravi komandom fsck.
fsck -t ext3 -l test /dev/oznaka _uredjaja
- -t p file sistema u ovom slucaju ext3.
- -l test ucitava bad block file u ovom slucaju test.
- oznaka _uredjaja moze bi sda, sdb, hda, hdb itd... U zavisnos od toga koji uredjaj zelite da proveravate i kako Vasa
Linux distribucija vidi hard diskove.
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Nekoliko saveta za YUM (2011-05-24 13:24) - darthewok

YUM je open source paket menadzer za rpm kompa bilne Linux distribucije. Radi u komandnoj liniji.
Fajlovi za apdejt i instalaciju se preuzimaju preko repozitorijuma i automatski instaliraju/apdejtuju u zavisnos koju
komandu zadate.
To lepo radi i po defaultu se preuze pake posle instalacije/apdejta automatski brisu iz kesa. Ja licno vise volim da
preuzete pakete imam u svojoj arhivi da bih mogao ponovo da ih upotrebim ako se za to ukaze potreba. Da bi ste
sprecili automatsko brisanje paketa, treba uradi sledece:
Logujte se kao root i pokrenite text editor, na primer gedit. Takodje mozete i kao user u terminalu ukuca komandu
su - za m root sifru i ukuca gedit. Bitno je da imate root privilegije. U text editor ucitajte fajl /etc/yum.conf i nad-
jite liniju u kojoj pise keepcache=0. Umesto 0 stavite 1 i ukljucili ste cuvanje yum kesa. Linija treba da izgleda ovako:
keepcache=1.
Po defaultu yum kes se nalazi u direktorijumu: /var/cache/yum
Tako da ako zelite preuzete pakete snimi na cd/dvd/usbflash, mozete ih tu naci.
Kada zelite da ispraznite kes, u terminalu kucajte:
yum clean all
Na nekim sajtovima sam video da pise:
yum clean headers
yum clean packages
Meni vise odgovara prva varijanta sa jednim redom.
Mozete izabra po zelji. Naravno, ovo morate radi u terminalu sa root privilegijama.

Za kraj jos nekoliko komandi za yum:
yum -v check-update - proverava da li postoje nove verzije instaliranih paketa.
yum -v update ime _paketa - preuzimanje novije verzije paketa (apdejt). Mozete koris i * ukoliko postoji vise srod-
nih paketa.
Na primer yum -v update gnome* preuzece sve pakete koji pocinju sa gnome.
yum -v install ime _paketa - instalacija novog paketa. Takodje, kao i u prethodnom slucaju mozete koris *.
Toliko za ovaj put. YUM ima jos dosta komandi, kucajte yum -h da bi ih izlistali.

Isntalacija USB Wireless Adaptera (2011-05-24 13:28) - darthewok

U ovom primeru cu objasni postupak za instalaciju MSI US60SE USB Wireless adaptera u Fedori 10.

Ako nemate instaliran ndiswrapper instalirajte ga sa zvanicnog repozitorijuma. Mozda cete mora , da kao i ja, tom
prilikom apdejtujete i kernel na noviju verziju.

Posto se zavrsila instalacija ndiswrappera, ubacite cd sa drajverima za USB Wireless koji ste dobili, za m pokrenite
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terminal i ukucajte su - a za m root sifru.
Ukljucite USB Wireless Adapter u usb port.
U terminalu ukucajte ndiswrapper -i i putanju do inf fajla koji se nalazi u direktorijumu sa drajverom na cd-u. U mom
primeru to izgleda ovako: ndiswrapper -i /media/MSI _CDV5/MSI/US60SE/Win2000 _XP/Drivers/net5523.inf
Kada se drajver instalira ukucajte ndiswrapper -l da bi ste videli da li ste uspesno odradili instalaciju. Trebalo bi da se
pojavi nesto poput ovoga:
net5523 : driver installed
device (0CF3:0002) present
To znaci da je drajver uspesno instaliran.
Za m ukucajte ndiswrapper -m
Trebalo bi da se pojavi ovo:
adding ”alias wlan0 ndiswrapper” to /etc/modprobe.d/ndiswrapper ...
Ukucajte:
iwconfig wlan0
Time ste podesili USB Wireless adapter.
Ukoliko ste u dometu nekog wireless rutera ili ap-a njihova lista sa jacinom signala ce bi prikazana kada se klikne na
ikonu Network Manager Applet-a koji se nalazi u gornjem desnom uglu, levo od sata.
Konektujete se klikom na neki od uredjaja koji su u dometu.

Za korisnike Fedore 10 (2011-05-24 13:29) - darthewok

Posle automatskog update-a od 03.04.2009. desava se da neke igre i programi ne reaguju na tastaturu. Problem sam
resio deinstalacijom paketa libgxim i scim i restartom kompjutera posle deinstalacije. Njih i onako ne koris m, pa sam
ih deinstalirao. Ukoliko ih koris te, instalirajte stariju verziju koja nije pravila probleme.
Problema cna verzija je libgxim-0.3.2-3.fc10.i386.

Kako pokrenu Java programe u Linuxu? (2011-05-24 13:41) - darthewok

To je moguce uradi na vise nacina:

1. Komandom iz terminala: java -jar /direktorijum/fajl.jar

2. Dvoklikom na ikonu java programa koji ima ekstenziju .jar.
Ukoliko se ne pokrene program vec Ark ili Arcive Manager, onda treba podesi da fajlove sa ekstenzijom jar pokrece
java. To se radi na sledeci nacin:
desni klik na ikonu java programa -> Proper es -> Open With -> Add -> Use a custom command -> u polje ukuca : java
-jar i kliknu na add i cekira java u lis programa Open With i na kraju Close.
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3. Napravi sh skriptu i sacuva je u folderu gde se nalazi java program. Sh skripta treba da ima sledecu liniju:
java -jar fajl.jar
Skriptu sacuva pod imenom koji Vam odgovara, na primer program.sh, za m desni klik na ikonu sh skripte, pa na
Permissions i tu s klira opciju Allow execu ng file as program. Prilikom pokretanja, dvoklikom na ikonu, izabratu
opciju Run.

Napomena:
Da bi Java programi radili, morate ima instaliran Java Run me Environment (JRE).

Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Inter-
net za pone (2011-05-24 13:44) - darthewok

Ovde cu opisa korake koje treba odradi u Linux distrou Fedora 13 i 14. Ovo je postupak podesavanja Mobile Broad-
band veze, tako da pretpostavljam da je is ili slican postupak i za ostale Linux distroe koji koriste Gnome graficko
okruzenje.
Na internetu sam nalazio gomilu nenormalno komplikovanih uputstava za povezivanje CDMA modema. Postoje razni
problemi, od toga da neki Linux distroi ne podrzavaju do cni modem, preko instalacije drajvera, pa sve do prak cnog
primera unosenja parametara.
U Fedori 13 i 14 je sve glatko proslo. Modem je odmah prepoznat, bez dodatnih drajvera, potrebno je samo une
odgovarajuce parametre.

1. Prikljucite modem u USB port.
2. Kliknite levim tasterom misa na ikonu za mrezu (dva monitora) koja se nalazi gore desno, pored sata i datuma.
3. Po potrebi, ako Vam je ak van Wired Connec on, kliknite na Disconnect.
4. Desnim tasterom misa kliknite na ikonu mrezne konekcije, za m levim tasterom misa na Edit Connec ons.
5. Kada se otvori prozor Network Connec ons, kliknite na kar cu Mobile Broadband, za m na Add.
6. U prozoru New Mobile Broadband Connec on u padajucem meniju treba odmah da pise AnyDATA CDMA Products,
kliknite Forward.
7. U Country list kliknite na Serbia. U Fedori 13, u lis provajdera za Srbiju jos nema Orion telekoma, pa zato parame-
tre treba une rucno.
8. Kliknite na I can’t find my provider I wish to enter manualy. U polje upis te ime provajdera, na primer Orion.
9. Kliknite na Forward, pa na Apply.
10. U prozoru za podesavanje konekcije u polje Number treba da stoji #777 u polje Username ukucajte Vase korisnicko
ime, a u polje Password ukucajte lozinku i kliknite na Apply. Ostali parametri neka budu na Default podesavanjima.

Tes rajte da li Vam radi internet.
Levim tasterom misa kliknite na ikonu mrezne konekcije u gornjem desnom uglu. Tu levim tasterom misa kliknite na
Vasu novu konekciju.
Pokrenite Operu ili Firefox i uzivajte u mobilnom internetu. Kada zelite prekinu vezu, kliknite na ikonu mrezne konek-
cije i za m na Disconnect. Tada mozete otkaci modem sa USB porta.

Za slucaj da Vam ne radi internet, prvo proverite da li ste u dometu i da li imate signal, jer se sa bezicnim interne-
tom nikad ne zna. Za m treba da proverite i ostale parametre koji treba da izgledaju ovako:
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U kar ci ppp se ngs u delu Authen ca on, kliknite na Configure Methods i proverite da li su sve stavke s klirane. U
delu Compression polja Allow BSD data compression, Allow Deflate data compression i Use TCP header compression
treba da su s klirana.
U kar ci IPv4 Se ngs, u padajucem meniju treba da je izabrana opcija Automa c (ppp).

Postupak povezivanje CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Internet za pone (Fedora
15 i 16). « Kompjuteri (2011-11-26 13:58:58)
[...] sam opisivao postupak povezivanja za Fedoru 13 i 14. U Fedori 15 i 16, postupak je malo drugaciji. Pretpostavljam da je
postupak slican i za druge [...]

Real Crypt (True Crypt) - Fedora (2011-05-24 13:46) - darthewok

Ukljucivanje read/write za usere u Real Crypt (True Crypt).

U Linuxu moze doci do problema prilikom mount-ovanja kriptovanih diskova u Real/True Crypt-u, jer to morate uradi
kao ROOT, pa iz tog razloga dolazi do problema prilikom pristupa fajlovima na kriptovanom disku ili prilikom upisivanja
fajlova na kriptovani disk, ako to radite iz korisnickog naloga, a ne root naloga.

Evo, kako sam taj problem resio kod mene.
Pokrenite RealCrypt, kada trazi ROOT sifru, upisite je i kliknite OK.
Idite u: Se ngs -> Preferences -> Mount Op ons
U okviru Filesystems u polje Mount op ons ukuca :
Kod sam podelio u dva reda, jer je dugacak i ne vidi se ceo, vi kucajte u jednom redu.

rw,nosuid,nodev,uhelper=devkit,uid=500,
gid=500,shortname=lower,dmask=0077,u 8=1,flush

Iz RealCrypt-a mount-ujte Vas kriptovani disk i moci cete mu pristupa normalno iz korisnickog naloga.

Jos da dodam, ako zelite iskljuci Access me azuriranje fajlova, to mozete uradi ako dodate noa me u Mount op-
ons. Evo i primera:

Kod sam podelio u dva reda, jer je dugacak i ne vidi se ceo, vi kucajte u jednom redu.

rw,nosuid,nodev,noa me,uhelper=devkit,uid=500,
gid=500,shortname=lower,dmask=0077,u 8=1,flush

U Fedori 16 UID i GID pocinju od 1000. Tako da parametri umesto 500 treba da imaju vrednost 1000.
Kod sam podelio u dva reda, jer je dugacak i ne vidi se ceo, vi kucajte u jednom redu.

rw,nosuid,nodev,noa me,uhelper=devkit,uid=1000,
gid=1000,shortname=lower,dmask=0077,u 8=1,flush
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CTRL D (2011-05-24 13:50) - darthewok

Precica u Linuxu koja se ne koris cesto, jer dosta ljudi ne zna za nju, a moze bi korisne.

- CTRL D - radi isto sto i komanda exit, znaci zatvara terminal prozor ili, ako ste logovani kao root komandom su -,
onda ctrl d izloguje root-a.

Problem prilikom reprodukcije videa koji se javlja na kompjuterima sa ATI video kar cama
(2011-05-24 13:51) - darthewok

Problem se javlja prilikom brzih scena ili kada je veci deo scene u pokretu. U m slucajevima mogu se prime jedna
ili vise linija po ekranu, pa izgleda, kao da je video iseckan. Evo i resenja problema:
Otvorite podesavanja za ATI video kar cu (ATI Catalyst Control Center), za m u grupi opcija za 3D kliknite na More
Se ngs tu ce te naci Wait for ver cal refresh koji treba postavi na On, unless applica on specifies. Za m u podesa-
vanjima programa za reprodukciju videa, postavite video izlaz na OpenGL. Na primer u programu VLC, idite na Tools ->
Preferences -> Video za m u padajucem meniju Output izaberite GLX Video Output i kliknite na save. Izadjite iz VLC-a
i ponovo ga pokrenite.

Firefox 4 save (2011-05-24 13:53) - darthewok

U Fedori 13 i Fedori 14 se jos nije u zvanicnom repozitorijumu pojavio Firefox 4, a mislim da i nece, barem, sigurno
nece u Fedori 13. Ali to nije problem, jer mozete doda novi Firefox repozitorijum komandom:

su -c ’wget -P /etc/yum.repos.d/ h p://repos.fedorapeople.org/repos/spot /firefox4/fedora-firefox4.repo’

Za m, preuzmite i instalirajte Firefox komandom:

su -c ’yum install firefox4’
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Firefox ce bi instaliran i uporedo ce te ima postojecu verziju Firefoxa 3.6.x i 4.
Da bi ste izbegli konflikte izmedju dva firefoxa, napravite za svaku verziju po jedan profil. Za postojecu verziju profil
vec postoji, samo napravite novi profil za verziju 4. Za m na ikoni Firefoxa u polju Command dodajte iza firefox4 %u
jos i -P ”ime _profila”. Za Firefox 4 bi na primer komanda izgledala ovako firefox4 %u -P ”Firefox4”, a za staru verziju:
firefox %u -P ”default”.

U ovoj verziji, WebGL je moguce pokrenu sa NVidia grafickim kar cama bez problema, ostale kar ce nisu ukljucene
u startu. U narednom primeru cu opisa kako da omogucite WebGL i na ostalim grafickim kar cama, na primer ATI.
Ne znam da li ce ovo radi na svim modelima Intelovig grafickih kar ca. U svakom slucaju, sam ovo tes rao na ATI
kar ci i radi.
Kao root treba da izmenite fajl /usr/bin/xulrunner2
Treba da dodate sledece dve linije:

MOZ _GLX _IGNORE _BLACKLIST=1
export MOZ _GLX _IGNORE _BLACKLIST

Ove dve linije treba da stoje ispred linije:

exec $XUL _PROGRAM ” $@”

Za m sacuvajte fajl i pokrenite Firefox 4.
I idite na sajt: [1]h p://www.khronos.org/webgl/wiki/Demo _Repository
da bi ste isprobali WebGL sa demoima na toj adresi.

1. http://www.khronos.org/webgl/wiki/Demo_Repository

Firefox 4 save 2 (2011-05-24 13:54) - darthewok

Firefox 4 ima neki problem sa nspluginwrapper-om, tako da na nekim sajtovima moze doci do problema sa flash sadrza-
jem. Na primer na [1]www.smallworlds.com sam naisao na problem.
Resenje je deinstalacija nspluginwrapper-a, koji vam i onako, najverovatnije nece ni treba ako korsi te 32-bitni linux.

1. http://www.smallworlds.com/

Olympus Digital Voice Recorder (2011-05-24 13:55) - darthewok

- Olympus Digital Voice Recorder -
Modeli: VN-960PC, VN-120PC, VN-240PC, VN-480PC, VN-2100PC, VN-3100PC, VN-4100PC
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Gore navedeni diktafoni dolaze sa drajverom i so verom samo za Windows i mozda za Mac OSX. Ali nemaju podrsku
za Linux. Takodje, modeli diktafona nisu radjeni po, da ih tako nazovem USB Flash standardima, pa nije moguce
iscita sadrzaj ni u varijan ”Flash diska”.
Posle dugo traganja i nekoliko neuspesnih pokusaja, nasao sam resenje.
U zavisnos od Linux distribucije koju koris te, mozete preuze deb, rpm pakete ili source kod.
Na zvanicnom sajtu mozete preuze source kod i deb pakete za distribucije koje ga podrzavaju.
[1]h p://code.google.com/p/odvr/

RPM pakete mozete pronaci na adresi: [2]h p://rpm.pbone.net/
To je pretrazivac za RPM pakete. U polje za pretragu ukucajte odvr i kliknite na search.
Meni je u pretrazi prikazao rpm pakete za Mandrivu i PC Linux OS. Ako koris te Fedoru mozete preuze rpm paket za
Mandrivu. Probao sam i kod mene radi.

Inace, program pokrecete iz terminala, morate bi u terminalu logovani kao root ili komandom sudo. Jer program
ne radi kada se pokrene iz user naloga.

U verziji 0.1.5 postoji i gui, ali se takodje pokrece iz terminala.
odvr - verzija koja radi u komandnoj liniji
odvr-gui - verzija sa grafickim interfejsom

1. http://code.google.com/p/odvr/
2. http://rpm.pbone.net/

O blogu Kompjuteri... (2011-05-24 14:09) - darthewok

• Opste kompjuterske teme. Pitanja i odgovori, pomoc korisnicima, igre, emulatori, opera vni sistemi, grafika,
programiranje, internet…

• Prvobitno je postojao klub Kompjuteri na nekadasnjem sajtu Urbae, ali je zbog reorganizacije sajta i promene
dizajna i funkcionalnos , klub Kompjuteri morao bi zatvoren, jer, novonastale promene umesto da poboljsaju
funkcionalnost klubova, samo su upropas le do tada solidnu pla ormu za funkcionisanje klubova.

• Za m je osnovana grupa Kompjuteri na Fejsbuku, koja je takodje zatvorena zbog prelaska na novi format grupa,
za koji tvrde da donosi poboljsanja, ali umesto poboljsanja, funkcionalnost grupa je upropastena.

• Zbog toga sam otvorio ovaj blog na WordPressu. Nadam se da WordPress nece, kao i Urbae i Fejsbuk, nekim
nazovi poboljsanjima upropas funkcionalnost bloga.

—————————————-————————————- —-—————————————–—————————— —

• Save , programi i internet adrese koje sam pomenuo u blogu su provereni i bezbedni. Ne odgovaram za bilo
kakvu eventualnu stetu nastalu koriscenjem saveta, programa i ostalih stvari pomenu h u blogu. Jer, kao sto
napisah, sve je probano i provereno, tako da ako nesto nije u redu, znaci da nesto niste dobro odradili.
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• Internet adrese i linkovi prema drugim sajtovima koji se pominju u tekstovima, su provereni u vreme pisanja
samih tekstova. S obzirom da su mnogi tekstovi stari i vise od godinu dana, moze se desi da su neke adrese u
medjuvremenu promenjene, pa samim m i linkovi nece radi . Ako prime te da neka adresa prema drugom
sajtu vise nije aktuelna, slobodno ostavite komentar. Ja cu u najkracem mogucem roku to ispravi .

Pretrazivac RPM paketa (2011-05-24 19:36) - darthewok

Evo jedan odlican sajt za pretrazivanje rpm paketa: [1]h p://rpm.pbone.net/

1. http://rpm.pbone.net/

Vise zanimljivih web adresa (2011-05-24 19:38) - darthewok

Koga interesuje istorija kompjutera, na ovoj adresi ce naci dosta podataka:
[1]h p://www.computerhope.com/history/

Googleov prevodilac, izmedju ostalog, moze da prevede tekst. Lepo radi, prevodio sam neke tekstove sa span-
skog i nemackog jezika na engleski. Jednostavnim copy/paste, mozete preves tekstove u jezik koji razumete.
[2]h p://www.google.com/language _tools

Srpsko-engleski recnik mozete naci na adresi [3]h p://www.metak.com/

Za igranje na Linuxu.
[4]h p://www.linux-gamers.net/

Jako dobar sajt sa dosta fajlova za download.
[5]h p://fliiby.com/

Ovo nije korisna web adresa, vec jedna jako zanimljiva telnet adresa. U komandnom promptu ukucajte telnet
towel.blinkenlights.nl i prikazace se ascii star wars animacija.

Na sajtu [6]h p://www.liu li es.com/products/wintaskspro/processlibrary/ mozete naci informacije o Windowso-
vim procesima i drugim exe fajlovima.
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Pretrazivac torrenta.
[7]h p://www.mininova.org/

Sajt za korisnike torrenta.
[8]h p://torren reak.com/

1. http://www.computerhope.com/history/
2. http://www.google.com/language_tools
3. http://www.metak.com/
4. http://www.linux-gamers.net/
5. http://fliiby.com/
6. http://www.liutilities.com/products/wintaskspro/processlibrary/
7. http://www.mininova.org/
8. http://torrentfreak.com/

Smajliji za Facebook chat (2011-05-24 19:39) - darthewok

Na ovoj adresi mozete vide smajlije za Fejsbuk:
[1]h p://www.djod.co.uk/2008/04/23/facebook-chat-emo cons-emotes-and-sm ilies/

1. http://www.djod.co.uk/2008/04/23/facebook-chat-emoticons-emotes-and-smilies/

Freeware programi. (2011-05-24 19:40) - darthewok

Mnogo freeware programa na jednom mestu. Lepo osmisljen i pregledan sajt sa opisom programa i linkovima za
download. Neki linkovi su direktni, neki vode prema ma cnom sajtu programa.

[1]h p://www.aplusfreeware.com/

1. http://www.aplusfreeware.com/
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Prikaz i linkovi prema open source alterna vama komercijalnih programa (2011-05-24 19:42) - darthewok

Prikaz i linkovi prema open source alterna vama komercijalnih programa:
[1]h p://www.osalt.com/

1. http://www.osalt.com/

Pretrazivac za korisnicka imena i sifre (2011-05-24 19:44) - darthewok

Pretrazivac za korisnicka imena i sifre za sajtove gde je potrebna registracija.
Ukoliko naidjete na sajt gde je potrebna registracija da bi se koris le usluge sajta, a pri tome, ne zelite da se registru-
jete, mozete upotrebi pretrazivac BugMeNot na adresi:
[1]h p://www.bugmenot.com/

1. http://www.bugmenot.com/

Programi za grafiku, obradu, prikaz fotografija, korisni graficki ala i filteri (2011-05-24 19:45) - darthewok

Prikaze besplatnih programa za grafiku, obradu, prikaz, konverziju fotografija i grafickih formata, kao i druge korisne
programe za grafiku mozete naci na adresi:[1]
h p://www.photo-freeware.net/

1. http://www.photo-freeware.net/

IXQUICK pretrazivac (2011-05-24 19:47) - darthewok

IXQUICK pretrazivac jedan od retkih koji korisnicima garantuje privatnost, jer ne balezi IP adrese sa kojih se vrsi pre-
traga. Jos jedna dobra stvar je sto nude i opciju bezbedne konekcije putem SSL enkripcije (HTTPS). Na njihovom
sajtu mozete preuze i dodatak za Firefox, da bi se ixquick nasao na lis pretrazivaca, takodje i tu postoji mogucnost
bezbedne pretrage putem ssl enkripcije (h ps).

Adresa pretrazivaca je: [1]h p://www.ixquick.com/
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Adresa ssl/h ps verzije je: [2]h ps://ixquick.com/

1. http://www.ixquick.com/
2. https://ixquick.com/

Start Page – pretrazivac « Kompjuteri (2012-02-15 03:00:12)
[...] Start Page je internet pretrazivac koga razvija Ixquick. Ixquick vec ima pretrazivac o kome sam ranije pisao. Taj clanak
mozete vide ovde. [...]

Suse Studio (2011-05-24 19:52) - darthewok

Zelite napravi sopstvenu Linux Live distribuciju? Nista lakse.
To mozete uradi online na adresi: [1]h p://susestudio.com/
Zaista mocna stvar i laka za koriscenje. Mozete napravi sistem koji moze da se podigne sa USB flesa, da ga napravite
kao Live CD/DVD ili da radi u virtuelnom okruzenju ili da se instalira na hard disk.

1. http://susestudio.com/

Google pretraga sa SSL enkripcijom (2011-05-24 19:54) - darthewok

Jos uvek je u Beta fazi, ali je jako korisno sto se ce privatnos i bezbednos . Umesto standardne adrese Google pre-
trazivaca [1]h p://www.google.com/ treba upisa [2]h ps://www.google.com/. Dakle, obra te paznju da umesto
h p pise h ps.
[3]h ps://www.google.com/

1. http://www.google.com/
2. https://www.google.com/
3. https://www.google.com/

Dosta korisnih malih besplatnih programa za Windows (2011-05-24 19:56) - darthewok

[1]h p://www.qso online.com/free _stuff.php
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1. http://www.qsoftonline.com/free_stuff.php

URL adrese (2011-05-24 19:57) - darthewok

U posledenje vreme se dosta cesto koriste servisi za skracivanje URL adrese. S jedne strane, to je korisna stvar, da bi
se skra le dugacke URL adrese, s druge strane, zlonamerni korisnici mogu da iskoriste neki od h servisa da navedu
nekog na potencijalno opasnu URL adresu.
Ako zelite zna realnu URL adresu koja se krije iza skracene URL adrese mozete iskoris neki od sledecih sajtova.

[1]h p://www.unshorten.com/
[2]h p://unshort.me/

1. http://www.unshorten.com/
2. http://unshort.me/

Google Chrome (2011-05-24 19:58) - darthewok

Ako imate problema sa Google Chrome instalerom (za Windows) sa adrese [1]h p://www.google.com/chrome ili ne
zelite da ga korsi te, mozete koris alterna vni standalone instaler za koji Vam nije potrebna ak vna internet konek-
cija, jer je to kompletna instalacija, a ne downloader, kao u prvom slucaju.
Mozete ga naci na adresi:
[2]h p://www.google.com/chrome/eula.html?standalone=1

1. http://www.google.com/chrome
2. http://www.google.com/chrome/eula.html?standalone=1

Grafika i Graficki dizajn (2011-05-24 19:59) - darthewok

Lista sa kratkim opisom i linkovima najboljih open source programa za grafiku, animaciju i graficki dizajn.
[1]h p://blog.worldlabel.com/2010/periodic-table-of-the-open-source-grap hics-and-design-apps.html

1. http://blog.worldlabel.com/2010/periodic-table-of-the-open-source-graphics-and-design-apps.html
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Second Life (2011-05-24 21:39) - darthewok

Ako imate problem sa registracijom na Second Life. Pokusajte da se registrujete preko nekog stranog Proxy-a ili preko
Tor mreze. Ne znam zasto, ali nikako nisam mogao da se registrujem, stalno sam dobijao gresku u vezi sifre i ako je
sifra bila dobra. Inace, sifra treba da bude izmedju 6 i 16 karaktera. Preko Tor mreze sam uspeo iz prvog puta da se
registrujem.

Dropbox (2011-05-24 21:42) - darthewok

Dropbox je internet servis za skladistenje i deljenje fajlova na internetu. Prednost Dropbox-a je u tome sto omogu-
cava lako sinhronizovanje fajlova na svim uredjajima koji su povezani preko interneta. Podrzane pla orme su: Linux,
Windows, Mac, iPhone, iPod, BlackBerry i Android. Besplatan Dropbox nalog pruza do 2 GB prostora.
h p://www.dropbox.com/

VICE emulator Commodore kompjutera (2011-05-24 21:48) - darthewok

Davno sam poceo da se bavim kompjuterima. Prvi kompjuter mi je bio Commodore 64, sa nostalgijom se secam h
lepih vremena. Svim nostalgicarima mogu da preporucim Vice emulator. Postoji u verzijama za Windows, Linux i
dosta drugih opera vnih sistema. Mozete ga naci na adresi: [1]h p://www.viceteam.org/
Vice emulira rad 8-bitnih Commodore-ovih kompjutera, izmedju ostalih C-64, C-128, Plus 4 itd... Na internetu moze
da se nadje veliki broj igara i programa za Commodore 64, pa ponovo mozete da se podse te onih lepih i srecnih
vremena.

1. http://www.viceteam.org/
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Java script Commodore 64 Emulator (2011-05-24 21:50) - darthewok

[1]h p://www.kingsquare.nl/jsc64
Na gore navedenoj adresi mozete naci Commodore 64 emulator napisan kompletno u JavaScriptu. Da bi ste ga uopste
pokrenuli, potreban je neki od savremenih web browsera koji podrzava HTML5 jer se za prikaz ekrana koriste HTML5
Canvas elemen .
Ovo je samo proba da se tes ra koncept, tako da emulator nije dovoljno op mizovan i razlicito se ponasa na razlilci m
web browserima.
Probao sam 4 browsera: Chrome 4.0.249.43, Opera 10.10, Firefox 3.5.6 i Sea Monkey 1.1.18.
Konfiguracija na kojoj sam ovo probao je:
CPU: Intel Core 2 Duo E4300 1.8 GHz
RAM: 2 GB
GPU: MSI NVIDIA GeForce 7600 GS 256 MB

Osim u Operi, emulator radi, ali je primetno usporenje. U Firefoxu i Sea Monkey-u, emulator je jako spor i jedva
da moze da se koris . Ovaj put se Chrome najbolje pokazao, jer je jedino u Chrome-u brzina, tj usporenje bilo pod-
nosljivo.
Kao sto rekoh ranije u tekstu, ovo je samo proba koncepta, to su naglasili i autori ovog projekta. Ovo je tek pocetak
HTML-a 5 i u buducnos treba ocekiva dosta zanimljivih sadrzaja napravljenih ovom tehnologijom. A nadam se da
ce i autori ovog emulatora nastavi da ga razvijaju i bolje op mizuju.

1. http://www.kingsquare.nl/jsc64

Flash Commodore 64 Emulator (2011-05-24 21:51) - darthewok

Nasao sam jos jedan Commodore 64 emulator koji radi u web browseru, ali ovog puta je pisan u Flash-u. Mozete ga
naci na ovoj adresi:
[1]h p://codeazur.com.br/stuff/fc64 _final/

I ovaj emulator sam probao u 4 web browsera: Chrome 4.0.249.43, Opera 10.10, Firefox 3.5.6 i Sea Monkey 1.1.18.
I jedino Opera pravi problem, jer ne rade znaci interpunkcije koji se dobijaju kombinacijom shi i brojeva, na primer
shi 2 za ” (navodnik).
U ostalim browserima se lepo ponasa i brzo radi. Takodje sam probao i dve igre od 8 ponudjenih. Prime o da nema
zvuka. Nadam se da ce u nekoj od sledecih verzija i emulacija SID (zvucnog) cipa na Commodore 64 bi resena. Sto se

ce samih igara koje sam probao Rally Speedway II radi bez problema (osim sto nema zvuk), a Elite ima manji problem
sa upravljanjem, jer nije kao na originalu i u drugim klasicnim emulatorima.

1. http://codeazur.com.br/stuff/fc64_final/
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Retrospec (2011-05-24 21:53) - darthewok

[1]h p://retrospec.sgn.net/users/tomcat/yu/index.php
Odlican sajt posvecen 8-bitnim i 16-bitnim kompjuterima. Takodje mozete pronaci i skenirane casopise sa prostora
bivse Jugoslavije i knjige za ZX Spectrum, Commodore 64 i Orao. Svet kompjutera je od prvog broja iz 10. meseca
1984. do 12. meseca 1997. Takodje, prisutni su i svi brojevi Sveta igara (1-10). Amiga Style svih 7 izaslih brojeva.
Ostali casopisi, kao sto su Moj mikro, Racunari i drugi, jos nisu komple rani.

1. http://retrospec.sgn.net/users/tomcat/yu/index.php

Vice za PSP (2011-05-24 21:55) - darthewok

Vice, dobro pozna Commodore 64 emulator, na adresi [1]h p://psp.akop.org/vice mozete naci verziju za PSP.
Takodje, na adresi [2]h p://psp.akop.org/ mozete naci dosta emulatora za PSP koji emuliraju ZX Spectrum, Atari, MSX,
Sega, NeoGeo, Amstrad i Coleco Vision.
Da bi ste pokrenuli emulatore na PSP, potreban je Custom Firmware ili ako nemate Custom Frimware, emula-
tore mozete pokrenu sa Oficijelnim Firmwerom ako koris te Half-Byte Loader, eksploit koji mozete naci na adresi
[3]h p://wololo.net/wagic/hbl/ tu, takodje mozete naci i uputstvo za Half-Byte Loader.
Tes rao sam Vice pokrenut uz pomoc Half-Byte Loadera i radi odlicno. Probao sam nekoliko igara i rade bez problema.

1. http://psp.akop.org/vice
2. http://psp.akop.org/
3. http://wololo.net/wagic/hbl/

Lista default IP adresa rutera nekih proizvodjaca (2011-05-24 21:58) - darthewok

3Com: 192.168.1.1
Apple: 10.0.1.1
Asus: 192.168.1.1, 192.168.1.220
Belkin: 192.168.2.1, 10.1.1.1
Buffalo: 192.168.11.1
Dell: 192.168.1.1
D-Link: 192.168.0.1, 0.30, 0.50, 1.1, 10.1.1.1
Linksys: 192.168.0.1, 1.1
Microso : 192.168.2.1
Motorola: 192.168.10.1, 20.1, 30.1, 62.1, 100.1, 102.1, 1.254
MSI: 192.168.1.254
Netgear: 192.168.0.1, 0.227

39

http://retrospec.sgn.net/users/tomcat/yu/index.php
http://psp.akop.org/vice
http://psp.akop.org/
http://wololo.net/wagic/hbl/


Senao: 192.168.0.1
SpeedTouch: 10.0.0.138, 192.168.1.254
Trendnet: 192.168.0.1, 1.1, 2.1, 10.1,
U.S. Robo cs: 192.168.1.1, 2.1, 123.254
Zyxel: 192.168.1.1, 2.1, 4.1, 10.1, 1.254, 10.0.0.2, 0.138

Za ljubitelje farmi :) (2011-05-24 22:01) - darthewok

Free Farm Game je izuzetno detaljna i realna igra koja simulira farmu. Igra je besplatna i za registraciju je potrebno
une nekoliko najosnovnijih podataka, kao sto je email adresa, korisnicko ime, sifra i ime farmera. Igru sam probao u
Firefoxu i Operi i lepo radi. Samo da napomenem da je potreban Flash plejer.
Mozete je igra na adresi:
[1]h p://www.freefarmgame.fr/

1. http://www.freefarmgame.fr/

Smallworlds (2011-05-24 22:02) - darthewok

Smallworlds je zanimljiva i prilicno zarazna online browser igra. To je u stvari virtuelni svet u kome vodite svoj avatar
koji kreirate na pocetku igre. Malo podseca na YoVille, ali je znatno kompleksniji od njega. Moze se uporedi sa
Second Life-om, s tom razlikom, sto za Smallworlds ne treba dodatni so ver, vec se igra iz browera, a i nije radjen u
punom 3D okruzenju, kao Second Life, vec je grafika izometrijska 3D iz polup cije perspek ve.
[1]h p://www.smallworlds.com/

1. http://www.smallworlds.com/

David (2012-08-19 00:14:54)
Pozdrav, video sam neke od vaših tutorijala na youtube, pa sam došao ovde. Igram jednu igru goodgamemafia.com. Nemam no-
vac da kupujem gold koji je potreban za igru, da li postoji neki trick, cheat tools ili nešto slično :) a da si spreman podijeli ? Živjeli!

darthewok (2012-08-19 09:44:52)
Pozdrav! Nisam igrao tu igru, pa ne znam eventualne trikove za dobijanje zlata. Uglavnom sa m online igrama je tesko vara .
Ako neko od citalaca igra tu igru i ako zna neke trikove, moze slobodno pisa ovde.
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BSOD (2011-05-24 22:09) - darthewok

Na sajtu grupe BSOD ima dosta video tutoriala. Epizode traju oko 40-45 minuta. Pokrivene su mnoge oblas i za
so ver i za hardver. Sadrzaj epizoda mozete vide takodje na njihovom sajtu.

[1]h p://www.bsodtv.org/

1. http://www.bsodtv.org/

Gimp (2011-05-24 22:11) - darthewok

Video tutorijali za Gimp.
[1]h p://mee hegimp.org/

1. http://meetthegimp.org/

Inkscape (2011-05-24 22:12) - darthewok

Video tutorijali za Inkscape.
[1]h p://screencasters.heathenx.org/

1. http://screencasters.heathenx.org/

Instaliranje Inkscape 0.48 u Fedori 13 (2011-05-24 22:15) - darthewok

Dakle, propisno sam se namucio sa novim Inkscape-om. Zato sto se na zvanicnom repozitorijumu za Fedoru 13 jos
uvek nije pojavila nova verzija Inkscape-a. A zamislite, postoji za beta verziju Fedore 14. :) Naravno, verziju sa Fedora
14 nisam mogao da instaliram zbog ”dependencies” problema. Jer i ”dependencies” su nove verzije rpm paketa, koji
su, u trenutku dok ovo pisem dostupni samo za Fedoru 14 beta. A, na zalost ni na zvanicnom Inkscape sajtu ne postoji
prekompajlirana verzija za Linux, vec samo za Windows i Mac. Na internetu sam nasao samo jedan link za rpm Fedora
13 paket, ali nisam hteo da rizikujem, jer nije ni na jednom zvanicnom sajtu, vec ga je neko kompajlirao i postavio na
net.

41

http://www.bsodtv.org/
http://meetthegimp.org/
http://screencasters.heathenx.org/


Prvo sam probao x puta da napravim rpm paket kompajlirajuci source koji sam skinuo sa Inkscapeovog sajta. Ali bez
uspeha, linker je konstantno izbacivao dve greske na kraju procesa, samo sam izgubio dosta vremena. Onda sam na
adresi [1]h p://www.fedoraforum.de/viewtopic.php?f=21 &p=115444naisao na jednostavno resenje.
Za pocetak bice Vam potrebni:
rpm-build i c++ kompajler. Ako ih nemate, oba mozete naci na Fedorinom zvanicnom repozitorijumu.

Postupak:
1. Pokrenite terminal i ulogujte se kao root (su -)
2. Instalirajte potrebne rpm pakete (yum -y install ImageMagick-c++-devel ImageMagick-c++ ImageMagick-devel Im-
ageMagick glibmm24-devel libsigc++-devel gtkmm24-devel glibmm24 libsigc++ gtkmm24 intltool gc gc-devel lcms
lcms-devel gsl gsl-devel libxml2-devel libxslt-devel boost-devel popt-sta c poppler-devel gtkspell-devel libwpg-devel
perl-ExtU ls-Embed python-lxml)
3. Preuzmite source rpm (wget [2]h p://kojipkgs.fedoraproject.org/packag es/inkscape/0.48.0/1.fc15/src/inkscape-
0.48.0-1.fc15.src.rpm)
4. Napravite rpm paket komandom (rpmbuild –rebuild inkscape-0.48.0-1.fc15.src.rpm) ako posle ove komande bude
problema sa ”dependencies”, vidite u terminalu sta Vam od rpm paketa fali i to instalirajte komandom yum -y install i
upisite pakete koji Vam fale. Sacekajte da se pake preuzmu i instaliraju i ponovo upisite rpmbuild –rebuild inkscape-
0.48.0-1.fc15.src.rpm. Kompajliranje i pravljenje rpm paketa ce malo duze da potraje.

Napravice se tri rpm paketa u direktorijumu /root/rpmbuild/RPMS/i686
inkscape-0.48.0-1.fc13.i686.rpm
inkscape-docs-0.48.0-1.fc13.i686.rpm
inkscape-view-0.48.0-1.fc13.i686.rpm
Mozete instalira sva tri, ali je dovoljan samo inkscape-0.48.0-1.fc13.i686.rpm (rpm -Uvh inkscape-0.48.0-
1.fc13.i686.rpm).
Ako slucajno bude problema sa ”dependencies” prilikom instaliranja, instalirajte potrebne rpm pakete, pa onda
inkscape-0.48.0-1.fc13.i686.rpm.

1. http://www.fedoraforum.de/viewtopic.php?f=21&p=115444
2. http://kojipkgs.fedoraproject.org/packages/inkscape/0.48.0/1.fc15/src/inkscape-0.48.0-1.fc15.src.rpm

Blender (2011-05-24 22:17) - darthewok

Dobre tutorijale za Blender mozete vide na:
[1]h p://blendernerd.com/

Tutorijale za pocetnike mozete vide na:
[2]h p://www.youtube.com/profile?user=super3boy &view=videos

1. http://blendernerd.com/
2. http://www.youtube.com/profile?user=super3boy&view=videos
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Sta sve mozete da radite sa programom VLC, a da to mozda niste znali da moze? (2011-05-24 22:18)
- darthewok

- Mozete konvertova video ili audio fajl u drugi format. Kliknite na Media -> Convert/Save. U kar ci File, ucitajte fajl
koji zelite da kovertujete klikom na dugme Add, za m kliknite na Convert / Save. U prozoru Convert u polje Des na-

on kliknite na Browse da bi ste odredili gde ce konvertovani fajl bi sacuvan i pod kojim imenom. U polju Se ngs
izaberite format u koji zelite da konvertujete fajl klikom na padajuci meni Profile. Takodje, mozete promeni default
parametre zeljenog profila. Za m kliknite na Start i sacekajte da se proces zavrsi.

- Pored konverzije fajlova, takodje mozete ripova DVD, Audio CD ili Video CD i Super Video CD. Kliknite na Media
-> Convert/Save. Kliknite na kar cu Disc i tu izaberite sta zelite da ripujete, za m kliknite na Convert / Save. U pro-
zoru Convert u polje Des na on kliknite na Browse da bi ste odredili gde ce konvertovani fajl bi sacuvan i pod kojim
imenom. U polju Se ngs izaberite format u koji zelite da konvertujete fajl klikom na padajuci meni Profile. Takodje,
mozete promeni default parametre zeljenog profila. Za m kliknite na Start i sacekajte da se proces zavrsi.

- Na is nacin mozete snimi audio/video sadrzaj sa interneta i web kamere/tv kar ce. Ako nesto skidate sa inter-
neta, Kliknite na Media -> Convert/Save. Za m kliknite na kar cu Network i tu ukucajte URL adresu zeljenog sadrzaja.
Odnosno, ako snimate sadrzaj sa web kamere ili tv kar ce, kliknite na Media -> Convert/Save. Za m kliknite na kar cu
Capture Device i tu podesite opcije. Dalje, postupak je is , kao i u prethodna dva primera za konvertovanje. Kliknite
na Convert / Save. U prozoru Convert u polje Des na on kliknite na Browse da bi ste odredili gde ce konvertovani fajl
bi sacuvan i pod kojim imenom. U polju Se ngs izaberite format u koji zelite da konvertujete fajl klikom na padajuci
meni Profile. Takodje, mozete promeni default parametre zeljenog profila. Za m kliknite na Start i sacekajte da se
proces zavrsi.

- Mozete gleda i slusa video i audio strimove sa interneta ili lokalne mreze. Kliknite na Media -> Open Network
Stream, za m ukucajte URL adresu i kliknite na Play.

- Mozete strimova (emitova ) video i audio sadrzaj na internet ili lokalnu mrezu. Kliknite na Media -> Streaming.
Izaberite sta zelite da strimujete i podesite opcije.

- Mozete slusa /gleda podcastove i predefinisane radio i tv stanice. Ukljucite play listu, ako nije ukljucena (View
-> Playlist). Sa leve strane, u Media Browseru kliknite na malu strelicu pored reci Internet ili dvoklik na Internet, da se
otvori sadrzaj pod tom stavkom. Tu se nalazi lista predefinisanih sadrzaja koji su dostupni na internetu.

- Ako zelite da brzo snimite neki sadrzaj, to mozete ucini klikom na record dugme (dugme sa crvenim krugom). Record
dugme se po defaultu ne vidi, pa morate ukljuci Advanced controls (View -> Advanced Controls). Klikom na to dugme
zapocinjete snimanje, ponovnim klikom na to dugme zaustavljate snimanje. Audio fajlovi se po defaultu snimaju u
direktorijum Music, a video fajlovi u direktorijumu Videos (ovo vazi za Linux) u Windowsu se verovatno snima u My
Documents ili My Videos, odnosno My Music.
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Video tutorijali za Gimp namenjeni pocetnicima i naprednijim korisnicima. (2011-05-24 22:21) - darthewok

[1]h p://www.youtube.com/playlist?list=PL6A20CF1351BE8B87 &feature=plcp

[2]h p://www.youtube.com/user/GIMPtricks

1. http://www.youtube.com/playlist?list=PL6A20CF1351BE8B87&feature=plcp
2. http://www.youtube.com/user/GIMPtricks

Falcon Patrol - Patrol Falcon (2011-05-24 22:32) - darthewok

- Falcon Patrol - [1]h p://www.onlinegamesector.com/onlinefull/6129/patrol-falcon.htm

Odlicna obrada hita sa Commodore 64. Sada se zove Patrol Falcon. :)
Evo i Youtube link da vidite kako izgleda rimejk i original. :)
Rimejk: [youtube=h p://www.youtube.com/watch?v=mfgufXOBxUE]
Original (C-64): [youtube=h p://www.youtube.com/watch?v=WpYptNw4BhI]

1. http://www.onlinegamesector.com/onlinefull/6129/patrol-falcon.htm

3D Starstrike (2011-05-24 22:40) - darthewok

- 3D Starstrike - [1]h p://download.cnet.com/3D-Star-Strike/3000-2095 _4-10920433.html
Svemirska pucacina sa ZX Spectruma.

Rimejk: [youtube=h p://www.youtube.com/watch?v=tuCaOwhzjdo]
Original (ZX48k): [youtube=h p://www.youtube.com/watch?v=rR1kTlxOrgI]

1. http://download.cnet.com/3D-Star-Strike/3000-2095_4-10920433.html
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Barbarian (2011-05-24 22:45) - darthewok

- Barbarian - [1]h p://www.classic-retro-games.com/Barbarian _39.html
Borilacka igra sa macevima. Igra je jako verno obradjena, skoro, kao da igram original na Commodore 64 ili Amigi. :)
S obzirom da su sprajtovi i kompletna grafika u obliku bmp fajlova, moguce je i modifikova igru. :)
Original (Amiga verzija): [youtube=h p://www.youtube.com/watch?v= C4Ii _YfJNvw]

1. http://www.classic-retro-games.com/Barbarian_39.html

Wizard of Wor (2011-05-24 22:46) - darthewok

- Wizard of Wor - [1]h p://www.classic-retro-games.com/Wizard-of-Wor-(2) _363.html

Svojevremeno dosta popularna igra, prvobitno se pojavila na Midway arkadnim apara ma (1980), a kasnije, su urad-
jene i verzije za Commodore 64, Atari 2600 i Bally Astrocade. Graficki vrlo skromna igra, ali zato vrlo zarazna.

C-64 verzija: [youtube=h p://www.youtube.com/watch?v=bGTGLu1ziEg]

1. http://www.classic-retro-games.com/Wizard-of-Wor-%282%29_363.html

Ghostbusters (2011-05-24 22:48) - darthewok

- Ghostbusters - [1]h p://www.classic-retro-games.com/GhostBusters _193.html

Jos jedna odlicna obrada igre sa C-64. Igra je radjena prema istoimenom filmu.

Rimejk: [youtube=h p://www.youtube.com/watch?v=EKSnP-naroA]
Original (C-64): [youtube=h p://www.youtube.com/watch?v=yUOZh8ZeLSU]

1. http://www.classic-retro-games.com/GhostBusters_193.html
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Skool Daze (prekrsten u Klass of 99) (2011-05-24 22:50) - darthewok

- Skool Daze (prekrsten u Klass of 99) - [1]h p://retrospec.sgn.net/users/rjordan/klass/index.htm

Odlicna obrada hita sa ZX Spectruma s pocetka osamdese h. :)

Rimejk: [youtube=h p://www.youtube.com/watch?v=aCeLEAVQ58Y]
Original (ZX48k): [youtube=h p://www.youtube.com/watch?v=Y6BxB 0LY4]

1. http://retrospec.sgn.net/users/rjordan/klass/index.htm

IK+ / Interna onal Karate (2011-05-24 22:52) - darthewok

- IK+ / Interna onal Karate -
[1]h p://www.allegro.cc/depot/IKPC-IKRemake/
[2]h p://www.poke53280.de/ar kel/ar kel.php?id=39 (Ovo je bolji rimejk i ima samo 64 Kb) :)

Borilacka igra za Commodore 64, Amigu i jos neke kompjutere tog vremena.

IK+ (Amiga): [youtube=h p://www.youtube.com/watch?v=u-1XstYycxA]

1. http://www.allegro.cc/depot/IKPC-IKRemake/
2. http://www.poke53280.de/artikel/artikel.php?id=39

Yoda Soccer (2011-05-24 22:54) - darthewok

- Yoda Soccer -
Yoda Soccer je obrada hita sa Amige ”Sensible World of Soccer”. Igra je jos u beta fazi, tako da jos uvek nema imena
igraca i mova, ali zato postoji editor, pa ko voli, moze da napravi move i reprezentacije. Takodje, postoji i konverter
za konverziju baze mova iz originalnog SWOS-a.
Razvija se za Linux, Windows i Mac.
[1]h p://yodasoccer.sourceforge.net/
Jedva sam uspeo da nadjem roster fajl sa movima, igracima i logoima mova za Yoda Soccer. Nisu obuhvacene sve
zemlje, ali je dobro i to za pocetak.
[2]h p://mio.discoremoto.alice.it/yodasoccer

Ovde mozete naci roster fajl sa movima iz Juzne Amerike.
[3]h p://ockhamyoda.altervista.org/ockhamupdate.yoda.en.htm
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Nisam uspeo da nadjem audio efekte za Yoda Soccer, jer beta verzija nema ni zvuka. Jedino sto sam nasao su neki
linkovi koji vise nisu ak vni za sound modove za SWOS. Ako neko ima SWOS verziju za PC na CD-u, moze audio fajlove
da iskoris za Yoda Soccer. Video sam u jednom tutorialu, da je potrebno prvo konvertova audio fajlove u wav i
potom prebaci u odgovarajuci direktorijum.

1. http://yodasoccer.sourceforge.net/
2. http://mio.discoremoto.alice.it/yodasoccer
3. http://ockhamyoda.altervista.org/ockhamupdate.yoda.en.htm

Boulder Rocks!, Trismania, Retrofire, Blue Max 3D (2011-05-24 22:56) - darthewok

Ovaj put cu da predstavim 4 igre, koje mozete preuze sa adrese [1]h p://gad.art.pl/
inace, na toj adresi ima jos dosta interesantnih stvari.
To je poljski sajt, pa su i igre vecinom na poljskom jeziku, ali ima i engleskih verzija.

Prva igra je Boulder Rocks! 3D verzija 1.1.1
To je rimejk popularnog Boulder Dasha. Postoji i editor nivoa, kao i jedan dodatni set nivoa. Igru mozete igra sa
klasicnom grafikom i zvukom kao u originalu ili sa poboljsanom grafikom i zvukom.

Druga igra je Trismania
To je osavremenjena verzija tetrisa u 3D.

Treca igra je Retrofire
To je rimejk igre Lander sa 8-bitnih kompjutera. Sada je u potpunos u 3D okruzenju.

Cetvrta igra je Blue Max 3D
To je rimejk igre Blue Max, velikog hita sa Commodore 64 i ZX Specrum, u 3D okruzenju.

Toliko za ovaj put.

1. http://gad.art.pl/

Avidemux: konverzija DVD videa u AVI ili MP4 (2011-05-24 23:08) - darthewok

Priprema:
—————————————-—-
- Iskopira fajlove sa DVD-a na hard disk
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- U Avidemux ucita VTS _01 _1.VOB

- Kada se pojavi prozor sa tekstom: This looks like mpeg Do you want to index it? kliknite na Yes

- Kada se pojavi prozor sa tekstom: There is several mpeg file, append them? kliknite na Yes

Secenje videa:
—————————————-—-
- Frame I (infra frame ili key frame) uvek mora bi na pocetku snimka. Tip frejma se vidi u donjem delu. Na primer za
infra frejm pise Frame Type: I (neki broj).

- Obra paznju kod secenja videa da I frame bude na pocetku isecka.

- Strelilce levo i desno sluze za premotavanje frejm po frejm, strelice gore i dole sluze za premotavanje infra
frejm, po infra frejm, sto je korisno kod secenja videa.

- Da bi ste isekli parce videa, postavite se na infra frejm od kojeg zelite da secete video, za m kliknite na ikonu
A u donjem delu ekrana, pa premotajte do kraja dela koji zelite da izbacite i kliknite na B (opet treba da bude infra
frejm). Na kraju pri snite delete na tastaturi i markirani deo ce bi uklonjen.

Filteri:
—————————————-—-
- Po potrebi upotrebi neki filter za deinterlace (na primer: yadif sa podrazumevanim parametrima ili Decomb
Telecide sa opcijom No strategy). Ako se koris neki deinterlace filter, on mora bi prvi u lis filtera. Obavezno
upotrebi deinterlace, ako je DVD video snimljen DVD rekorderom sa TV-a. Jer je PAL TV slika ”interlejsovana”.

- Kada se konvertuje video sa Panasonic DVD recordera DMR-ES-10 ili nekog drugog modela koji ima rezoluciju
videa 704x576, da bi se dobio aspekt slike 4:3, treba upotrebi filter Resize, MPlayer resize ili u nekim slucajevima
Crop (ako video ima crne trake gore i dole). Resize je precizniji, ali je MPlayer resize brzi. Vizuelno nisam prime o
nikakvu razliku prilikom reprodukcije videa, pa preporucujem MPlayer resize, zbog brzine.
Rezoluciju postavi na 704x528 da bi se dobio aspekt slike 4:3. Aspekt slike 4:3 se moze pos ci i bez filtera, prilikom
reprodukcije izborom opcije Aspect ra o 4:3 u VLC-u ili nekom drugom media plejeru. Ali, zbog kompa bilnos sa
media plejerima koji nemaju tu opciju, zgodno je odmah kada se pravi video korigova i aspekt. Naravno, to vazi,
ako je aspekt slike 4:3. Desavaju se i situacije, kada se pojavljuju crne trake gore i dole, to znaci da na ekranu 4:3 ide
snimak koji je 16:9 (ili neki drugi wide screen aspekt). U tom slucaju mozete upotrebi filter Crop i iseci te crne trake.
Samo, pazite, jer tl na TV emisijama i filmovima cesto prelazi u to crno polje sa donje strane. U tom slucaju mozete
i delimicno filterom Crop iseci te crne trake sa gornje i donje strane, tako da ceo tl bude vidljiv. Eksperimen site i
vidite sta Vam najvise odgovara. Samo je vazno da se drzite standarda, da aspekt slike bude 4:3, 16:9 ili neki drugi
koji se redje koris .

- Samo da razjasnim neke stvari oko konverzije. Problemi prilikom konverzije PAL videa u neki ”kompjuterski”
format su u tome sto se PAL slika sastoji iz dve poluslike koje su ”interlejsovane” i prilagodjene za prikaz na obicnom
PAL televizoru, a na monitoru kompjutera je ”progresivno” skeniranje slike za razliku od PAL televizora. Drugi problem
je sto su pikseli na monitoru kompjutera kvadra , a pikseli na televizoru su pravougaonog oblika. Pa je iz ta dva
razloga potrebno prvo ”deinterlejsova ” video, a za m promeni rezoluciju da odgovara prikazu na kompjuteru. Da
slika na kompjuteru ne bi bila deformisana.

- Posle filtera resize korisno je upotrebi filter MSharpen ili neki drugi sharpen filter. Ovde treba bi pazljiv i

48



proba izlazni video. Jer ako ima dosta snega na slici, moze stvori kontra efekat.

- Ostale filtere koris u zavisnos od specificnih potreba.

Kodeci i parametri (koje najcesce koris m):
—————————————-—-
Video:
MPEG-4 AVC
General: Encoding mode: Two Pass - Average Bitrate
Average bitrate: 1000 ili 1500 kbit/s
Mo on: Subpixel Refinement: 7 (default) ili 10 (best) u zavisnos od potrebe.
Ostali parametri su default

Filteri po redosledu (yadif ili neki drugi deinterlacer mora bi prvi):
- Deinterlace:
yadif - default parametri (Mode: Temporal & spa al check Order: Top field first)
- Crop i Resize za aspekt slike 4:3 sa Panasonic DVD rekordera:
Crop (704x576 -> 704x528) ako je le erbox (ima crne trake gore i dole) i posle toga po potrebi MPlayer resize
(704x528 -> 640x480)
ili ako nije le erbox (nema crnih traka gore i dole) MPlayer resize (704x576 -> 704x528 ili 704x576 -> 640x480)
- Ostali filteri (po potrebi):
MSharpen - default parametri (High Q, Treshold: 15, Strenght: 100)

Audio:
MP3 (lame)
Channel mode: Stereo ili Mono u zavisnos od potrebe
Bitrate mode: CBR
Quality: 9
Bitrate: 128

Format:
MP4

Zakljucak:
—————————————-—-
Sto se brzine ce, ovo nije najbrzi nacin za konverziju videa sa DVD-a u MP4/AVI, ali je kvalitetan. Postupak cete
znatno ubrza ako u konfiguraciji postavite single pass i bez upotrebe filtera, ali ce tada i kvalitet videa bi losiji.

Open Arena (2011-05-24 23:16) - darthewok

- Open Arena - [1]h p://www.openarena.ws/

Open Source pucacina iz prvog lica, koris Quake 3 engine. Jedna od najboljih open source igara. Na internetu postoji
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dosta mapa i botova za Quake 3, koji mogu da rade i u Open Areni. Igra se moze igra u single player rezimu ili u
mul player rezimu u lokalnoj mrezi ili preko interneta. Listu servera mozete naci na sajtu.

Postoji u verzijama za: Linux, Windows i Mac OSX.
Minimalna konfiguracija (podatak sa sajta): Pen um 90MHz sa 32MB RAM-a.
Preporucena konfiguracija (podatak sa sajta): PII 233MHz sa najmanje 96MB RAM-a.
I naravno 3d kar ca koja podrzava Open GL.
Ali iz iskustva mogu reci, da je za komotno igranje potrebna dosta jaca konfiguracija, bar P4 na 1.6 Ghz i 512 Mb ram-a
i graficka kar ca NVidia ili A sa 128 Mb. Ali sve zavisi od nivoa detaljnos grafike i rezolucije koju podesite i od mape
koju igrate.

Aktuelna verzija je 0.8.5.
Ovo je link za promo vni trejler za verziju 0.7.1
[youtube=h p://www.youtube.com/watch?v=fIf0kKR-IFg]

1. http://www.openarena.ws/

Warsow (2011-05-24 23:18) - darthewok

- Warsow - [1]h p://www.warsow.net/

Open source pucacina iz prvog lica, uz Open Arenu, jedna od najboljih open source igara tog pa. Graficki jako lepo
izgleda. Koris QFusion engine. To je unapredjeni Quake 2 engine.

Postoji u verzijama za: Windows, Linux i Mac OS X.

Na zvanicnom sajtu nisam nasao podatak o minimalnoj hardverskoj konfiguraciji potrebnoj za igranje, ali je igra za-
htevnija od Open Arene. Taj podatak verovatno pise u readme fajlu, ali trenutno nemam instaliranu igru.

Promo vni trejler za verziju 0.5
[youtube=h p://www.youtube.com/watch?v=vtJKrIngTIs]

1. http://www.warsow.net/

Star Wars: The Ba le of Yavin i The Ba le of Endor (2011-05-24 23:20) - darthewok

- Star Wars: The Ba le of Yavin -
- Star Wars: The Ba le of Endor -
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[1]h p://www.bruneras.com/

Zanimljive svemirske pucacine, bazirane na Star Wars filmovima. 3D objek su solidni, ali su teksture rudimentarne.
Ipak, najvaznije je da su igre prilicno igrive i jednostavne. Na srecu, igre je moguce lako modova . Pa se na internetu
mogu naci modovi koji poboljsavaju grafiku. Linkove mozete naci na zvanicnom sajtu.

Jos neki zanimljivi modovi su:

Tron Recgnizer mod za Star Wars: The Ba le of Yavin
[2]h p://webhome.idirect.com/ tomyee/tron.htm
Mod radjen po uzoru na film Tron.

Star Trek DS9: The Invasion of Cardassia mod za Star Wars: The Ba le of Endor
Mod radjen po uzoru na Star Trek DS9.
[3]h p://webhome.idirect.com/ tomyee/ioc2.htm

Modovi se instaliraju preko originalne igre, tako da preporucujem, da originalnu igru iskopirate u drugi folder da bi ste
je kasnije mogli igra .

Potrebna konfiguracija:
DirectX 8.1
1.4 Ghz ili jaci procesor, ali mislim da bi bez ikakvih modifikacija igra radila i na znatno slabijim masinama.
3D graficka kar ca
Windows 98, ME, 2000 ili XP

Evo i kako izgledaju igre:
Star Wars: The Ba le of Yavin
[youtube=h p://www.youtube.com/watch?v=vmhh8pSlB-U]

Star Wars: The Ba le of Endor:
[youtube=h p://www.youtube.com/watch?v=2DTcM _rTH90]

1. http://www.bruneras.com/
2. http://webhome.idirect.com/%7Etomyee/tron.htm
3. http://webhome.idirect.com/%7Etomyee/ioc2.htm

Orbiter (2011-05-24 23:27) - darthewok

- Orbiter - [1]h p://orbit.medphys.ucl.ac.uk/

Besplatan svemirski simulator letenja za Windows.

Evo i kako izgleda:
[youtube=h p://www.youtube.com/watch?v=h9t-SruikPk]
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1. http://orbit.medphys.ucl.ac.uk/

Flight Gear (2011-05-24 23:28) - darthewok

- Flight Gear - [1]h p://www.flightgear.org/

Open Source simulator letenja.
Razvija se za: Windows, Linux, Mac OS X, Solaris (sparc/x86) i FreeBSD

Evo i kako izgleda
[youtube=h p://www.youtube.com/watch?v=V1yers9v2-g]

1. http://www.flightgear.org/

Free Orion (2011-05-24 23:30) - darthewok

- Free Orion - [1]h p://www.freeorion.org/

Free Orion je open source svemirska potezna strategija. Kao inspiracija za Free Orion, posluzile su igre pa Master Of
Orion, Space Empires i Galac c Civiliza ons. Razvija se za Windows XP/Vista (verovatno radi i na Windows 7), Linux i
Mac OS X. Igra zahteva podrsku za OpenGL 2.0. Ako je igrate na Windowsu XP, trazi SP2 ili noviji i NET Framework 2.0
ili noviji.

1. http://www.freeorion.org/

Command & Conquer (2011-05-24 23:31) - darthewok

Nekoliko cuvenih klasika iz devedese h i pocetka dvehiljadi h je postalo freeware.
Rec je o real me strategijama:
- Command & Conquer: Red Alert
- Command & Conquer: Tiberian Sun
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- Command & Conquer: Tiberian Sun – Firestorm
- Command & Conquer: Tiberian Dawn

Mozete ih preuze sa adrese:
[1]h p://www.commandandconquer.com/classic
Tu se takodje nalaze i linkovi sa uputstvom za instalaciju.

— Dodatak: 08.01.2012. —

Izgleda da je Bioware otkupio prava na Command & Conquer i Red Aler igre. Tako da vise nije moguce preuze be-
splatne igre sa gore pomenutog linka.
Nasao sam linkove za besplatne verzije.
Command and Conquer Gold - [2]h p://www.freewarefiles.com/Command-And -Conquer-Gold _program
_44723.html
Command and Conquer: Red Alert 1 (Allied Disk): [3]h p://www.freewarefiles.com/Command-And-Conquer-Red-
Alert _program _44782.html
Command and Conquer: Red Alert 1 (Soviet Disk): [4]h p://www.freewarefiles.com/Command-and-Conquer-Red-
Alert-1-Soviet-Di sk _program _58247.html
Command and Conquer: Tiberian Sun and Firestorm 2.0.3: [5]h p://www.freewarefiles.com/Command-and-
Conquer-Tiberian-Sun-and-Fire storm _program _55228.html

1. http://www.commandandconquer.com/classic
2. http://www.freewarefiles.com/Command-And-Conquer-Gold_program_44723.html
3. http://www.freewarefiles.com/Command-And-Conquer-Red-Alert_program_44782.html
4. http://www.freewarefiles.com/Command-and-Conquer-Red-Alert-1-Soviet-Disk_program_58247.html
5. http://www.freewarefiles.com/Command-and-Conquer-Tiberian-Sun-and-Firestorm_program_55228.html

Future Pinball (2011-05-24 23:32) - darthewok

Future Pinball je sistem za pravljenje i igranje flipera. Omogucava Vam da dizajnirate i igrate flipere. Koris naprednu
fiziku da bi, sto je moguce vernije docarao igranje pravog flipera.
Potrebna konfiguracija za igranje (po podacima sa sajta):
Pen um / Athlon procesor 1800 mhz ili vise
Najmanje 512 MB ram memorije
Geforce FX / Radeon video kar cu (provereno radi na intel integrisanoj grafickoj kar ci, ali u so verskom modu)
Razvija se za Windows Vista/XP (sedmicu nisu pomenuli na sajtu)
Sa sajta mozete skinu i dodatne table za igranje flipera, sto obavezno preporucujem.

[1]h p://www.futurepinball.com/
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Samo da se nadovezem, neke zahtevnije table nece radi na Intel integrisanim grafickim kar cama ili ce radi us-
poreno. Ali one table koje nisu preterano zahtevne ce radi sasvim lepo.

1. http://www.futurepinball.com/

Oolite (2011-05-24 23:36) - darthewok

- Oolite -
[1]h p://www.oolite.org/
Na adresi: [2]h p://wiki.alioth.net/index.php/Oolite _Main _Page mozete naci dosta korisnih informacija o igri
Oolite. Takodje, na istoj adresi mozete naci i dodatke za igru (OXP).
Oolite 1.74 trejler:
[youtube=h p://www.youtube.com/watch?v=Zn1ldl03E3s]
Oolite je open source rimejk legendarne igre Elite sa osmobitnih kompjutera. Razvija se za Windows, Linux i Mac
OS/X.
Igra i izvorni kod (source code) su pod GNU GPL licencom.
Oolite je svemirska simulacija u kojoj mozete trgova , napada druge brodove, vadi minerale iz asteroida...
Po startovanju igre, imate svoj brod Cobra Mk III sa minimalnom opremom koja se sastoji od prednjeg Pulse lasera,
tri projek la, i 100 kredita. Nalazite se na pocetnoj lokaciji u svemirskoj stanici koja se nalazi u orbi oko planete u
sistemu Lave.
U pocetku igre, je najbolje da budete miroljubivi trgovac dok ne skupite dovoljno kredita da bolje opremite svoj brod.
Takodje, u pocetku izbegavajte sisteme gde je anarhija. Moja licna preporuka je da nadjete dobre trgovacke puteve.
Dakle, najbrzu zaradu cete ostvari tako sto nadjete dve planete, koje imaju dosta razlicit tehnoloski nivo. Jer se
tada i cene razlici h proizvoda dosta razlikuju. Pa na primer, mozete na jednoj plane kupi robu po znatno nizoj
ceni, a na drugoj plane to isto proda po znatno visoj ceni. Ubrzo cete skupi dovoljno kredita da mozete pristojno
opremi brod za izazove koji Vas ocekuju.

Da Vas u nekoliko recenica upoznam i sa instrument tablom (HUD). U centralnom delu dominira radar. Ispod
radara je krug koji moze bi zelen, zut i crven. Krug oznacava trenutno opste stanje. Zeleno, sve je ok, nema drugih
brodova u blizini i mozete koris Hyperspeed, Zuto, neki objekat je u blizini. Crveno znaci da Vas neko napada.
Za m, tu je podatak o datumu i vremeni i desno od njega je prikaz trenutne razmere radara i kompas. Kada ste
u blizini svemirske stanice, levo od radara se pojavljuje slovo S i tada mozete ak vira kompjuter za sletanje ako
ga imate. Levo od radara su podaci o prednjem (FWD) i zadnjem s tu (AFT). Ispod su podaci o hipersvemirskom
gorivu (Fuel), temperaturi kabine (CT), temperaturi lasera (LT) i visini - udaljenos od planete ili sunca (ALT). Ispod
su indikatori za projek le. Desno od radara je brzinomer (SPD), indikator rotacije (ROLL), indikator nagiba (PITCH)
ispod h indikatora se nalaze indikatori za energiju (E1, E2, E3 i E4). U toki borbe, kada Vas pogode laseri ili projek li
prednji i zadnji s tovi ce poce da se trose. Kada se potrose s tovi, prilikom svakog sledeceg pogotka u Vas brod
praznice se energija. Kada se energija skroz isprazni brod ce da eksplodira.

Upotreba radara. Vrlo je intui vno resen. To je 3D radar koji ima prikaz u svim pravcima 360 stepeni po x, y i
z osi. U sredini ste Vi. Dve kose linije predstavljaju trenutni pogled, ako ste u prodnjem pogledu, onda ce dve kose
linije bi sa gornje strane. Objek su predstavljeni malim pravougaonicima. Koji cesto imaju tanke linije. Ta linija
predstavlja visinu objekta u odnosu na vas. Visina moze bi nega vna ili pozi vna. Ako je neki objekat iznad Vas,
linija ce bi ispod pravougaonika. Ako je objekat ispod, linija ce bi iznad pravougaonika.
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Objek na radaru su prikazani razlici m bojama, a svaka boja ima svoje znacenje.
bela - asteroid ili kontejner
zelena - svemirska stanica
zuto/zelena - navigaciona bova svemirske stanice ili bova koja se nalazi na dolaznoj poziciji kada dodjete iz
hipersvemira u sistem.
plavo/svetlo plava - hipersvemirski oblak koji ostaje kada brod skoci u hipersvemir
zuta - neutralni svemirski brod
plava - policijski svemirski brod
svetlo plava - projek l
plavo/crvena - policijski svemirski brod koji Vas napada
crvena - brod koji Vas napada
crveno/zelena - Thargoid (vanzemaljska rasa)

Pocetnicima ce mozda bi problema cno sletanje na svemirske stanice. Evo jedan savet. Ispred svake stanice
se nalazi, da je tako nazovem, navigaciona bova. Ona se uvek nalazi ispred ulaza u stanicu na jedno desetak precnika
stanice udaljena od same stanice. Le te prema bovi, ali malo desno od nje, da Vam bova bude sa leve strane, a
stanica sa desne. Kada se nadjete izmedju stanice i bove (pogledajte na radaru) zaustavite se. Prebacite se na desni
pogled i trebalo bi da vidite stanicu i ulaz u nju. Za m se prebacite na pogled napred i ro rajte brod prema stanici.
Names te se tako da se nisan nalazi u centru otvora stanice. Polako ppovecajte brzinu do pola i ro rajte brod da se
usaglasi sa rotacijom stanice. Uz malo vezbe, uvezbacete se da ulazite u stanicu u punoj brzini.

Necu se detaljnije upusta u objasnjavanje svih dodataka za Vas brod, ali cu samo objasni Fuel Scoop i lasere.
Fuel Scoop je korisna stvar, jer s njim mozete da pokupute kontejner koji je ostao iz unistenog broda, da pokupite
minerale iz unistenog asteroida (potreban je Mining laser), da dopunite hipersvemirsko gorivo kada se priblizite
suncu (opasan postupak i ne radite to bez External heat sheild). Kada skupljate kontejnere i minerale, priblizavajte
mu se, tako sto ga drzite na nisanu. Kada mu se skroz briblizite, malo podignite brod, da bi kontejner prosao malo
ispod broda. Fuel Scoop ce automatski da ga pokupi ako ima mesta.
Na pocetku ste opremljeni najslabijim Pulse laserom. Dosta bolji od Pulse lasera je Beam laser. Military laser je
najbolji za borbu. Mining laser se koris za vadjenje ruda iz asteroida. Pucajte nekoliko puta na asteroid i kada se on
raspadne na sitnije delove, te delove pokupite Fuel Scoop-om i dobicete minerale koje mozete proda . Brod mozete
opremi sa maksimalno 4 lasera, za svaki pogled po jedan. Napred obavezno postavite Military laser. Ako planirate
da vadite rude iz asteroida, Mining laser stavite pozadi ili sa strane, kako Vam je zgodnije.

Oolite se uglavnom igra preko tastature, ali je mozete igra dzojs kom ili misem. Mis ne preporucujem, probao sam
misem i jako je nezgodno igra misem.

Komande sa tastature (americka/US tastatura):

Komande dok ste u svemirskoj stanici:
F1 ili 1 - lansiranje (izlazak iz svemirske stanice)
F2 ili 2 - meni (ucitavanje i snimanje pozicije, izlazak iz igre i podesavanja)
F3 ili 3 - dodatna oprema za brod
F3 F3 ili 3 3 - brodovi za prodaju
F5 ili 5 - sta s ka igraca
F5 F5 ili 5 5 - sta s ka broda
strelica gore / dole - pomeranje kursora gore / dole
enter - izbor obelezene stavke

Navigacija:
F6 ili 6 - mapa blize okoline
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i - informacije o sistemu (na mapi blize okoline)
F6 F6 ili 6 6 - mapa galaksije
strelice - pomeranje kursora po mapi
home - vracanje kursora na trenutnu lokaciju
F7 ili 7 - podaci o izabranoj plane
^ - napredna navigacija na mapi galaksije (potreban je Advanced Naviga onal Array)
? - prelazak na ekran trzista prevoznika (Carrier Market)

Kupovina i prodaja robe:
F8 ili 8 - ekran za kupovinu i prodaju robe
strelice gore / dole - izbor stavke u lis
strelice levo /desno - prodaja / kupovina jedne jedinice iz izabrane stavke u lis
enter - kupovina / prodaja maksimalne kolicine

Trziste prevoznika (Carrier Market):
F8 F8 ili 8 8 - ekran trzista prevoznika (Carrier Market)
strelice gore / dole - izbor stavke u lis
enter - prihvatanje ugovora izabrane stavke
f5 - prikaz ak vnih ugovora
? - prikaz odredista na mapi galaksije

Kontrole dok le te kroz svemir:
F1 ili 1 - pogled napred
F2 ili 2 - pogled nazad
F3 ili 3 - pogled levo (port)
F4 ili 4 - pogled desno (starboard)
strelica gore - poniranje
strelica dole - podizanje
strelica levo - rotacija na levo
strelica desno - rotacija desno
, - kormilo pravca na levo
. - kormilo pravca na desno
w - ubrzanje
s - usporavanje
i - ubrizgavanje ”Witchspace” goriva sluzi kao a erburn ako ima goriva za hiperpogon (potreban je Witchspace Fuel
Injectors)
j - hiperbrzina (ne radi ako ste blizu neke planete, sunca, svemirske stanice ili drugih brodova)
h - skok kroz Witchspace (hipersvemir) (prethodno morate izabra sistem na koji idete i ne radi u blizini svemirske
stanice)
g - skok kroz hipersvemir u drugu galaksiju (potrebna je dodatna oprema)
v - spoljni pogledi na brod
z - promena dometa radara
shi z - reset dometa radara
\ - promena cilja za svemirski kompas (potreban je Space Compas)
shi l - trazenje dozvole za sletanje na svemirsku stanicu (nije obavezno prilikom sletanja, ali je preporucljivo)
c - kompjuter za sletanje (potreban je Docking Computers)
shi d - kompjuter za sletanje - trenutno sletanje (potreban je Docking Computers)
shi c - pristajanje uz ak vnu metu (potrebna je dodatna oprema)
s - iskljucivanje muzike prilikom sletanja (kada je ak van kompjuter za sletanje)
d - izbacivanje jednog kontejnera sa robom (moze se bira sa shi r)
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shi r - sledeca stavka u tovarnoj lis (Cargo Manifestu)
‘ - lista primljenih poruka
o - ak vira specijalnu opremu (potrebna je dodatna oprema, na primer ak vira Wormhole Scanner)
esc - lansiranje kapsule za spasavanje (potreban je Escape Capsule)
p - pauza

Borbene kontrole:
a - pucanje laserom
t - ak viranje projek la
m - ispaljivanje projek la kada je meta zakljucana (prethodno treba ak vira projek l)
u - deak viranje projek la
y - izbor projek la (ako ih ima)
tab - energetska bomba (potreban je Energy Bomb)
+ - sledeca meta (potrebna je dodatna oprema)
- - prethodna meta (potrebna je dodatna oprema)
r - iden fikacija mete
e - ECM / unistava rakete (potreban je ECM System)

Ostale kontrole:
o - iskljucivanje HUD u pauzi
n - ukljucivanje HUD u pauzi
- snimanje slike ekrana na disk
shi f - ukljucivanje / iskljucivanje prikaza ”frame rate”
shi m - ukljucivanje / iskljucivanje kontrole broda misem
shi q - izlazak iz igre
f11 - promena rezolucije ekrana
f12 - ukljucivanje / iskljucivanje igranja u prozoru ili preko celog ekrana

1. http://www.oolite.org/
2. http://wiki.alioth.net/index.php/Oolite_Main_Page

TripleA (2011-05-24 23:38) - darthewok

TripleA je potezna strateska igra. Razvija se za Windows, Linux i Mac. Moze se igra pro v kompjutera ili pro v vise
igraca.

[1]h p://triplea.sourceforge.net/mywiki

1. http://triplea.sourceforge.net/mywiki
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Danger from the deep (2011-05-24 23:42) - darthewok

- Danger from the deep -
[1]h p://dangerdeep.sourceforge.net/
Danger from the deep je open source simulacija nemacke podmornice iz drugog svetskog rata. Jos uvek je u fazi
razvoja i neke opcije jos nisu dostupne, ali moze da se igra.
Razvija se za Linux i Windows.
[youtube=h p://www.youtube.com/watch?v=LU1aM _SmoSM]

1. http://dangerdeep.sourceforge.net/

KB SSL Enforcer addon za Chrome (2011-05-24 23:53) - darthewok

KB SSL Enforcer

Radi isto sto i HTTPS-Everywhere dodatak za Firefox.

Karakteris ke:
- Automatski detektuje da li sajt podrzava SSL (TLS) i preusmerava vas na h ps
- Fleksibilne opcije za premoscavanje autodetekcije
- Kesira sajtove koji podrzavaju SSL (postuje ”incognito” mod)
- Open Source (GPLv2 ili noviji)

Mozete ga preuze sa adrese:
[1]h ps://chrome.google.com/extensions/detail/flcpelgcag foegekianiofph ddckof

1. https://chrome.google.com/extensions/detail/flcpelgcagfhfoegekianiofphddckof

iMacros addon za Firefox (2011-05-25 00:03) - darthewok

iMacros firme iOpus je dodatak za Firefox, koji automa zuje rad u Firefoxu. Ako vise puta treba da ponovite jednu te
istu stvar, ovo je idealan dodatak za Vas. Prvo snimite ono sto radite, bice snimljen svaki link na koji kliknete, tekst koji
ukucate i sta god da radite sa Firefoxom iMacros ce to zapam i po potrebi ponovi kada kliknete na dugme play.

Adresa na kojoj ga mozete naci je:
[1]h ps://addons.mozilla.org/en-US/firefox/addon/imacros-for-firefox/
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1. https://addons.mozilla.org/en-US/firefox/addon/imacros-for-firefox/

ProCon La e addon za Firefox (2011-05-25 00:06) - darthewok

ProCon je filter sadrzaja za Firefox browser. Moze filtrira sve vrste materijala (pornografiju, kockanje, itd. ..), takodje
moze blokira kompletan protok, pazeci da samo zeljene web stranice (postavljene u Whitelist) mogu bi prikazane.
Takodje poseduje i filter reci, pa mozete blokira psovke i slicno.
ProCon takodje ima zas tu lozinkom kako bi se sprecilo ne ovlasceno menjanje parametara.

[1]h ps://addons.mozilla.org/en-US/firefox/addon/procon-la e/

1. https://addons.mozilla.org/en-US/firefox/addon/procon-latte/

WOT - Web Of Trust addon za Firefox (2011-05-25 00:08) - darthewok

Wot, Web of Trust, te upozorava o rizicnim web - sajtovima koji su potencijalno opasni. Ikone u boji (crvena, zuta i
zelena) vam pokazuju ocene za 21 milion sajtova. Crvena ikona znaci da je sajt opasan, zuta da treba bi oprezan,
zelena pokazuje da je sajt bezbedan i ikona sa znakom pitanja znaci da sajt jos nije ocenjen.
[1]h ps://addons.mozilla.org/en-US/firefox/addon/wot-safe-browsing-tool/

1. https://addons.mozilla.org/en-US/firefox/addon/wot-safe-browsing-tool/

Torbu on addon za Firefox (2011-05-25 00:11) - darthewok

Torbu on je dodatak za Firefox kojim lako i bezbedno mozete omoguci ili onemoguci koriscenje Tor mreze u Fire-
foxu. Kako bi se sacuvala anonimnost korisnika. Prethodno je potrebno instalira Tor ([1]h p://www.torproject.org/)
i Polipo ([2]h p://www.pps.jussieu.fr/ jch/so ware/polipo/)

Torbu on mozete preuze sa adrese:
h ps://addons.mozilla.org/en-US/firefox/addon/torbu on/
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1. http://www.torproject.org/
2. http://www.pps.jussieu.fr/%7Ejch/software/polipo/

HTTPS Everywhere addon za Firefox (2011-05-25 00:12) - darthewok

HTTPS Everywhere je dodatak za Firefox. Napravljen je u saradnji The Tor Project i The Electronic Fron er Founda on.
Kriptuje komunikaciju sa nekim sajtovima, gde h ps nije po defaultu ukljucen. Neki od podrzanih sajtova su: Google
Search, Wikipedia, Twi er, Facebook, most of Amazon, GMX, Wordpress.com blogs, The New York Times, The Wash-
ington Post, Paypal, EFF, Tor, Ixquick, Mail.com, Live (Hotmail).
Tes rao sam dodatak na Facebooku i radi odlicno. Ne samo da je enkriptovana strana za logovanje, vec i dosta drugih
strana na Facebooku, koje inace nisu enkriptovane. Jedino 3rd party aplikacije nisu pod h ps enkripcijom.
Chat na Facebooku ne radi sa ovim dodatkom. Mozda ce jednog dana radi , kada FB bude postavio h ps verziju
chata. Chat ne radi samo na h ps enkriptovanim stranama, dok na stranama koje nisu enkriptovane (h p) chat radi
normalno. Dakle, ako bas hocete da chatujete otvorite neku 3rd party aplikaciju i chatujte. Ili iskljucite opciju za Face-
book u HTTPS-Everywhere dodatku. (Tools->Add Ons->HTTPS Everywhere->Preferences i tu iskljuci Facebook)
Ovaj odlican dodatak za Firefox mozete preuze na adresi:
[1]h ps://www.eff.org/h ps-everywhere

1. https://www.eff.org/https-everywhere

Telekom Srbije i bezicni ADSL ruteri (2011-05-25 00:21) - darthewok

Prime o sam da bezicna mreza (wlan), nema nikakvu zas tu i moze joj se pristupi bez sifre!!! Dakle, putem bezicne
mreze (wlan) moze da se na internet ili lokalnu mrezu nakaci ko hoce, dovoljno je samo da je u dometu.
Ukoliko posedujete bezicni ruter Huawei Echo life HG520s ili noviji model HG520c i svetli Vam WLAN lampica, obavezno
proverite podesavanje rutera (ako to vec niste uradili). Lako moze da se desi da Vam je WLAN lose podesen i da moze
da se nakaci ko hoce bez sifre.
Ukoliko ne koris te WLAN, najbolje je da ga iskljucite, a ako ga koris te, onda zas te svoju mrezu. Kod modela
HG520c bezicna mreza se moze lako ukljuci i iskljuci , jer ovaj uredjaj poseduje taster za ukljucivanje i iskljucivanje
bezicne mreze.

Aleksandar (2013-04-25 22:05:20)
Posle svega navedenog o wifi ruterima, imam jedno pitanje. Da li je moguce promeni Telekomovu sifru? Ako moze, onda na
koji nacin? Hvala unapred :)
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darthewok (2013-04-26 14:07:54)
Sifra za bezicnu mrezu (WLAN) se moze promeni . Podesavanje WLAN: - Pokrenite neki web browser, na primer Firefox ili
Operu. U adress bar upisite h p://192.168.1.1 - Izaberite opciju Basic -> Wireless Lan. - U podesavanjima za WLAN mozete
ukljuci ili iskljuci WLAN. Access Point – moze bi Enable (ukljucen) ili Disable (iskljucen) Channel ID – podesavanje kanala
(frekvencije) Authen ca on Type – Ovde birate vrstu zas te, ogranicenja pristupa Opensystem – otvoreni sistem, moze se
pristupi bez sifre (OVO NIKAKO NE SMETE KORISTITI) WEP – slab sistem zas te, ni njega ne preporucujem WPA-PSK/WPA2-
PSK – preporuceni sistem za zas tu Encryp on – Sifrovanje, postoje dve vrste u okviru WPA-PSK/WPA2-PSK, a to su TKIP i
AES. Preporucujem da se koris AES. Telekom Srbije isporucuje ove uredjaje sa ak viranim WLAN i bez zas te sifrom, pa
preporucujem da, ako ne koris te WLAN, da ga obavezno iskljucite. Ako ga koris te postavite WPA-PSK/WPA2-PSK zas tu i
ukucajte sifru, koja je dovoljno dugacka i dovoljno komplikovana da ne moze svako da je provali, a koju cete lako zapam .
Preporucujem i podesavanje Wireless MAC Address Filtera, kao dodatni nivo zas te. Na kraju kliknite na Submit. Takodje, ako
imas HG520s onda pogledaj i kratko uputstvo koje sam napisao na ovoj adresi: h ps://kompjuteri2011.wordpress.com/201
1/06/17/uputstvo-za-povezivanje-i-podesavanje-echolife-hg520s/

edoo (2014-01-06 13:13:43)
Treba mi pomoc oko povezivanja 2 wireless rutera bezicno, da li je moguce, na koji nacin ? Radi prosirenja wirelles mreze treba
mi da jos jedan wirelles ruter prikacim bezicno za stari wireless ruter Molim za pomoc ako neko zna Hvala

darthewok (2014-01-07 12:57:15)
Moguce je uz pomoc nekog Wireless range extendera ili rutera koji poseduje opciju da radi u klijent rezimu i da moze da se
nakaci na neku bezicnu mrezu. Ali ni jedno ni drugo nisam probao. Ako se odlucis za Wireless range extender, onda proveri da
li je kompa bilan sa ruterom koji posedujes. Jer sam na jednom sajtu nasao tekst gde se pominje da nisu svi Wireless range
extenderi kompa bilni sa bezicnom opremom. Evo i citat: ”A wireless range extender connects via Wi-Fi to a router or access
point. However, due to the nature of this technology, most wireless range extenders work only with a limited set of other
equipment. Check the manufacturer’s specifica ons carefully for compa bility informa on.”

Podesavanje bezicnih rutera (2011-05-25 00:27) - darthewok

Cesto po gradu vidjam lose podesene parametre wireless rutera. Korisnici se cesto uopste ne potrude da zas te svoju
mrezu. Ili mozda i ne znaju sta treba da urade i kakvim se potencijalnim opasnos ma izlazu na taj nacin. To nije mnogo
komplikovano. Dovoljno je uradi nekoliko koraka koja sam opisao da bi zas li mrezu.

1. Ukljuci enkripciju. Najbolje WPA2-PSK ili WPA-PSK. Za m ukuca sifru da bi se sprecio pristup bez sifre.
2. Sakri SSID ukljucivanjem opcije Hide SSID.
3. Ak vira MAC filter i definisa MAC adrese vasih bezicnih uredjaja kojima ce bi dozvoljen pristup mrezi. Ukoliko
se MAC adresa nekog uredjaja ne slaze sa listom u MAC filteru, taj uredjaj nece moci da se nakaci na mrezu, cak i ako
korisnik zna sifru za pristup bezicnoj mrezi.
4. Promeni ”fabricke” parametre lokalne mreze, sifru pristupa ruteru i IP adresu rutera.
5. Iskljuci DHCP server. Ovo ce vam malo zakomplikova zivot, jer onda na svakom kompjuteru u mrezi morate rucno
da unesete parametre veze, ali ce i potencijalnom uljezu stvori probleme. :)

UPOZORENJE: Ako ne znate sta radite, najbolje ne dirajte nista!!!
U nekoliko koraka je objasnjeno osnovno podesavanje i zas ta bezicne pristupne tacke na ruteru.
Potrebno je da imate neko osnovno znanje iz oblas kompjuterskih mreza da bi ste primenili ove korake u praksi.
Takodje, je potrebno da znate kako se podesavaju mreze u opera vnom sistemu koji koris te.
Ako sakrijete (iskljucite) SSID, potrebno je da znate kako da se povezete na WLAN koji ne emituje SSID.
Ako ukljucite MAC filter, potrebno je da znate MAC adresu Vaseg bezicnog uredjaja i da tu MAC adresu upisete u MAC
filter na ruteru.
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Ako menjate fabricke parametre lokalne IP i subnet mask, treba da znate osnove IP i subnet mask adresiranja.
Ako iskljucujete DHCP server na ruteru, onda na kompjuteru morate rucno podesi IP adresu, subnet mask, gateway
i DNS.
Obra te paznju na WLAN sifru koju kucate na Vasem ruteru. Zapam te sifru, jer istu morate ukuca i na Vasem kom-
pjuteru kojim se kacite na WLAN!!!

darthewok (2012-01-05 12:17:49)
Nisam bas strucnjak za mobilne telefone, ali svi smart telefoni, proizvedeni u poslednjih nekoliko godina imaju mogucnost
povezivanja na wireless lan (wlan). Ako tvoj modem za KDS internet ima ugradjen wireless onda telefon mozes poveza na
modem i surfova internetom preko telefona. Ako modem nema wireless, onda pitaj u KDS-u da ga zamene za neki wireless
model ili kupi wireless ruter. Sto se ce direktnog povezivanja na ostale wlan uredjaje, mislim da to nece ici, barem ne bez
nekog specijalizovanog so vera koji bi instalirao na telefon. Mozda eventualno, ako uredjaji imaju ugradjeni h p server,
pa da se preko rutera ili mozda direktno, preko ugradjenog web browsera ili Opera mobile da se povezes na h p server tog
uredjaja. Ali, posto nemam ni jedan od uredjaja koje si pomenuo, onda ne mogu to da probam u praksi. Povezivanje na ruter
je jednostavno, barem na mojoj Nokiji 5800. Pokrenem neki program koji trazi konekciju na internet, na primer Opera Mobile.
Za m, ukucam web adresu ili pokrenem pretragu na Google-u i telefon mi ponudi nekoliko opcija za povezivanje na internet.
Opcija Search for WLAN sluzi za pretragu wlan pristupnih tacaka. To koris s kada se prvi put kacis na tvoju mrezu ili kada si u
gradu i trazis slobodne pristupne tacke. Opcija internet je kacenje na neku poznatu pristupnu tacku, ako si u dometu, na primer
tvoj wlan ruter u kuci. Ako nema poznate pristupne tacke, onda se nudi opcija kacenja na MTS, VIP ili Telenor, u zavisnos od
toga cije usluge koris s.

Srdjan Milanovic (2012-01-04 22:23:00)
Ne znam da li je pravo mesto ali ukoliko jeste da li neko moze da mi odgovori da li je moguce i kako da se smart tel. npr. Nokia
N9 ili mozda Samsung G. Note bezicno poveze sa kDS kablovskim int., sa tv-om, bezicnom tastaturom, web kam., printerom
eventualno eksternim HD-om i predlog oko opreme _

Test an virusa koji sam radio davne 2008. godine :) (2011-05-25 00:37) - darthewok

Svi testovi su radjeni sa default podesavanjima an virusnih programa.
—————————————-—————————–
NOD 32 v 3.0.636.0
Virus signature database: 2853 (20080206)
Skeniranje kompletnog hard diska: 3m 29s (ukupno 30995 skeniranih fajlova)
Skeniranje Hackers Matrix CD-a: 6m 15s, nadjeno 519 inficiranih fajlova
Skeniranje Crackers Matrix CD-a: 1m 22s, nadjeno 8 inficiranih fajlova

Subjek vne ocene:
+
Poseduje Scan Progress, ne opterecuje mnogo sistem
-
Nije besplatan, nema mogucnost update-a iz lokalnog foldera
—————————————-—————————–
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AVG Free v 7.5.516
Virus base: 269.17.2/1280 Release date:15-Feb-08 09:00

Skeniranje kompletnog hard diska: 6m 22s (ukupno 16063 skeniranih fajlova)
Skeniranje Hackers Matrix CD-a: 10m 47s, nadjeno 525 inficiranih fajlova
Skeniranje Crackers Matrix CD-a: 3m 34s, nadjeno 7 inficiranih fajlova

Subjek vne ocene:
+
Besplatan, moze da se update-uje iz lokalnog foldera, ne opterecuje mnogo sistem
-
Nema Scan Progress
—————————————-—————————–
Kaspersky An -Virus 7.0.0.125 (verzija na srpskom)
Baza podataka: 17-Dec-07 11:28:48

Skeniranje kompletnog hard diska: 7m 28s (ukupno 32068 skeniranih fajlova)
Skeniranje Hackers Matrix CD-a: 24m 04s, nadjeno 650 inficiranih fajlova
Skeniranje Crackers Matrix CD-a: 5m 29s, nadjen 31 inficirani fajl

Subjek vne ocene:
+
Poseduje Scan Progress, prikazuje ocekivano vreme zavrsetka skeniranja
-
Trazi restart Windowsa prilikom zavrsene instalacije, nije besplatan
—————————————-—————————–
Panda Pla num Internet Security 2005
Virus def: 08.03.2005.

Skeniranje kompletnog hard diska: 2m 35s (ukupno 16871 skeniranih fajlova)
Skeniranje Hackers Matrix CD-a: 4m 19s, nadjeno 633 inficiranih fajlova
Skeniranje Crackers Matrix CD-a: 1m 23s, nadjeno 22 inficirana fajla

Subjek vne ocene:
+
Moze da se update-uje iz lokalnog foldera
-
Trazi restart Windowsa prilikom zavrsene instalacije, nije besplatan, na kraju skeniranja ne prikazuje ukupno vreme
skeniranja pa sam morao da merim stopericom za potrebe testa.
—————————————-—————————–
Bit Defender 8.0.202 Free
nepoznat datum baze definicije virusa

Skeniranje kompletnog hard diska: 4m 55s (ukupno 32746 skeniranih fajlova)
Skeniranje Hackers Matrix CD-a: 7m 14s, nadjeno 681 inficiranih fajlova
Skeniranje Crackers Matrix CD-a: 2m 39s, nadjeno 29 inficiranih fajlova

Subjek vne ocene:
+
Besplatan, poseduje scan progress, prikazuje ocekivano vreme zavrsetka skeniranja, lep i detaljan prikaz rezultata
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skeniranja
-
Trazi restart Windowsa prilikom zavrsene instalacije, u besplatnoj verziji nije dostupan virus shield, ne prikazuje
datum baze definicije virusa, ne moze da se update-uje iz lokalnog foldera
—————————————-—————————–
ClamWin Free 0.90.2.1 (RC2)
Virus DB version: (main: 43; daily: 3304) (06:35 27. May. 2007.)

Skeniranje kompletnog hard diska: 12m 23s (ukupno 9745 skeniranih fajlova)
Skeniranje Hackers Matrix CD-a: 15m 45s, nadjeno 303 inficiranih fajlova
Skeniranje Crackers Matrix CD-a: 4m 40s, nadjeno 5 inficiranih fajlova

Subjek vne ocene:
+
Besplatan, GNU licenca,
-
Nema Scan Progress
—————————————-—————————–
Avira An vir Personal Edi on Classic
Virus defini on file 6.38.00.225 16-Apr-07

Skeniranje kompletnog hard diska: 2m 41s (ukupno 28914 skeniranih fajlova)
Skeniranje Hackers Matrix CD-a: 10m 35s, nadjeno 720 inficiranih fajlova
Skeniranje Crackers Matrix CD-a: 2m 8s, nadjeno 16 inficiranih fajlova

Subjek vne ocene:
+
Besplatan, poseduje Scan progress, moze da se update-uje iz lokalnog foldera
-

—————————————-—————————–
PC-cillin internet security 2006
nepoznat datum baze definicije virusa

Skeniranje kompletnog hard diska: 2m 55s (ukupno 10743 skeniranih fajlova)
Skeniranje Hackers Matrix CD-a: 4m 26s, nadjeno 465 inficiranih fajlova
Skeniranje Crackers Matrix CD-a: 1m 8s, nadjeno 1 inficiranih fajlova

Subjek vne ocene:
+
Poseduje An spajver, poseduje spam filter, fraud filter, web site filter, poseduje Scan progress,
-
Trazi restart Windowsa prilikom zavrsene instalacije, nije besplatan, ne moze da se update-uje iz lokalnog foldera, ne
prikazuje datum baze definicije virusa
—————————————-—————————–
Avast 4.7.942
Virus database: 18.01.2007.

Skeniranje kompletnog hard diska: 3m 50s
Skeniranje Hackers Matrix CD-a: 5m 19s, nadjeno 662 inficiranih fajlova

64



Skeniranje Crackers Matrix CD-a: 1m 23s, nadjeno 24 inficiranih fajlova

Subjek vne ocene:
+
moze da se update-uje iz lokalnog foldera, besplatan
-
Trazi restart Windowsa prilikom zavrsene instalacije, nema Scan Progress, na kraju skeniranja ne prikazuje ukupno
vreme skeniranja pa sam morao da merim stopericom za potrebe testa, jako los izvestaj o skeniranju koji se vidi samo
ako se pokrene skeniranje iz glavnog menija ako se pokrene desnim klikom onda ne postoji izvestaj o skeniranju pa
mora da se gleda log.
—————————————-—————————–

Samo da ne bude zabune. Zato sto sam u delu testa koji skenira ceo hard disk naveo i ukupan broj skeniranih
fajlova, koji se dosta razlikuju. Rec je o istom sistemu, ali razlika postoji jer razlici an virusi ne skeniraju sve fajlove.
Neki skeniraju samo potencijalno opasne fajlove, neki skeniraju sve. Sve zavisi kako je podeseno po defaultu. Opet,
neki an virusi ne mogu da otvore neke spakovane fajlove. U svakom slucaju, naveo sam broj skeniranih fajlova da
bih donekle predstavio brzinu skeniranja.

Kao sto se vidi, nisam koris o bas najsvezije verzije an virusnih programa, kao i njihovih an virusnih baza.
Posto na internet idem preko spore dial-up veze, skidanje novih an virusnih programa i update njihovih an virusnih
baza bi trajao citavu vecnost. To je jedan od razloga zasto sam bas koris o cd-ove Hacker Matrix i Crackers Matrix.
To su stari diskovi, sa starim virusima i trojancima. Pa je i test ravnopravniji, posto, kao sto rekoh an virusi i njihove
baze nisu bas najsveziji. Na primer Panda je iz 2005. godine, a PC cillin iz 2006. To su najstariji, pa da bi i njih stavio u
ravnopravan polozaj, zbog toga sam koris o ta dva diska. Drugi razlog zasto sam koris o ta dva cd-a je sto jedino na
njima postoji velika kolicina virusa i trojanaca. Novih virusa imam jako malo, svega nekoliko.

Avira me je prijatno iznenadila u svakom pogledu. Iskreno, nisam ocekivao da ce ovako dobro da se pokaze.
Pogotovu sto je rec o besplatnoj verziji. Kaspersky je uznapredovao i ova verzija se bolje pokazala od Pande. Da
podse m na slicnom testu pre 3 godine, Panda se bolje pokazala od Kasperskog. Na zalost nemam noviju verziju
Pande, pa bi to onda bilo pravo poredjenje. I Bit Defender se takodje prilikom skeniranja pokazao dosta dobro. Mana
besplatne verzije je sto nema virus shield zas tu.
Ovaj test ipak treba uze sa odredjenom dozom rezerve, jer sam koris o diskove sa jako starim virusima i trojancima.

Evo nekoliko sajtova gde se porede an virusni programi (2011-05-25 00:57) - darthewok

[1]h p://www.av-compara ves.org/
[2]h p://an -virus-so ware-review.toptenreviews.com/
[3]h p://www.sunbelt-so ware.com/ihs/alex/Results _2D2008m3b _US.xls _detec on1.htm

1. http://www.av-comparatives.org/
2. http://anti-virus-software-review.toptenreviews.com/
3. http://www.sunbelt-software.com/ihs/alex/Results_2D2008m3b_US.xls_detection1.htm
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Evo jedan trik u Virtual Box-u. :) (2011-05-25 01:04) - darthewok

Ukoliko imate Linux, u Virtual Boxu mozete pokrenu Windows igre. Direct X jos uvek nije u potpunos podrzan, ali bi
Open GL igre trebalo da rade bez problema. Instalirajte Windows u okviru Virtual Box-a. U meniju kliknite na Devices,
pa na Install Guest Addi ons. Mountovace se iso virtuelni CD. Pokrenite VBoxWindowsAddi ons-x86.exe i instalirace
se drajveri za Open GL i jos neke korisne stvari, koje za ovu pricu nisu bitne.
Sada jos samo ostaje da instalirate neku Windows igru sa podrskom za Open GL i isprobate je. Ja sam tes rao Counter
Strike 1.6 i Half Life. Kada pokrenete CS ili HL, u podesavanjima za grafiku podesite Open GL. Ukoliko u toku igre bude
problema sa kontrolom misa, pri snite na tastaturi desni ctrl+i ili iz menija Machine kliknite na Disable Mouse Inte-
gra on. I resicete problem kontrole misem u m igrama. U CS-u se tada javlja drugi problem, a to je da ce se izgubi
pointer misa prilikom izbora opcija prilikom kupovine oruzija, ali za to postoje precice sa tastature i nije neki problem.
Da, jos jedan savet u vezi grafike, kako da igrate u Full skrinu (za malo da zaboravim.. :)
Pre pokretanja CS-a na tastaturi pri snite desni ctrl+f za full screen (ceo ekran) i ako se windowsova slika nije rasirila
preko celog ekrana (postoji crni border) ponovo se vra te u mod prozora pri snite desni ctrl+f da biste izasli iz moda
celog ekrana i za m pri snite desni ctrl+g ili auto resize guest display iz machine menija, pa onda opet desni ctrl+f.
Uzivajte u igranju. :)
Takodje, igru mozete pokrenu i bez Virtual Boxa, ako imate u Linuxu instaliran Wine, ali posto, nisam bas pristalica
Wine-a iz bezbednosnih razloga, onda dajem prednost Virtual Box-u.
Sto se ce Direct3D-a, odnosno DirectX-a, postoji dodatak koji se zove WineD3D.exe. Koji navodno treba da Direct3D
API prevede u OpenGL, ali mi posle toga nije radio Counter Strike, a nije mi proradio ni Direct3D, pa sam vra o bekape
DLL-ova, koje je napravio WineD3D prilikom instalacije. Moguce da to radi u Wine-u, ali kod mene nije radilo u Virtual
Boxu. Jednog dana cu to proba i u Wine-u, kada me ne bude mrzelo da ga instaliram za probu.

Blokiranje sajtova uz pomoc HOSTS fajla (2011-05-25 01:45) - darthewok

Ukoliko zelite da blokirate neki sajt, to mozete uradi , ako pomocu Notepada ili nekog drugog text editora izmenite
hosts fajl koji se nalazi u c:/windows/system32/drivers/etc ako koris te windows, odnosno u /etc ako koris te Linux.
Dovoljno je samo doda linije (pozeljno je da adrese budu sa www i bez www kao u primeru):

127.0.0.1 nekisajt.com
127.0.0.1 www.nekisajt.com
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Open Source i Freeware lista za Linux i Windows (2011-05-25 01:54) - darthewok

Internet:
- Opera - Internet browser, email klijent, chat klijent, sve to je objedinjeno u jednom programu. Podrzani su skoro svi
opera vni sistemi.
- Firefox - Internet browser. Podrzani su skoro svi opera vni sistemi.
- Thunderbird - E-mail klijent. Podrzani su skoro svi opera vni sistemi.
- Evolu on - E-mail klijent, kalendar, podsetnik, organajzer za Linux.
- XChat - IRC klijent. Linux verzija je free.
- Pidgin - Internet Messenger. Podrzava dosta IM standarda. Izmedju ostalog i najpopularnije MSN, Yahoo Messenger,
ICQ... Postoji i u Linux i u Windows verziji.
- Kopete - Ima istu funkciju kao i Pidgin. Za Linux.
- Downloader for X - File downloader za Linux.
- Zone Alarm - Firewall za Windows. Besplatan za licnu/kucnu upotrebu.
- Firestarter - Firewall za Linux.
- gFTP - FTP klijent za Linux.
- Google Earth - Satelitski snimci Zemlje. Podrzani su Windows i Linux.
- Kompozer - Izrada web sajtova za Linux i Windows.

Mul medija:
- WinAMP - Mul medijalni plejer za Windows.
- XMMS - Audio plejer za Linux (podseca na WinAMP).
- Amarok - Audio plejer za Linux, od pre izvesnog vremena, mislim da postoji i verzija za Windows.
- VLC - Mul medijalni plejer. Pusta sve i svasta. Ima interne vlasnicke kodeke, tako da ne morate da brinete da li
Vam je u sistemu instaliran odgovarajuci kodek ili ne. Takodje pusta, u zadnje vreme jako popularne, FLV fajlove sa
YouTube-a. Takodje, moze da konvertuje jedan format u drugi i da strimuje. Jedina mana mu je ruznjikav korisnicki
interfejs, koji deluje nedovrseno. Odlikuje ga mala hardverska zahtevnost. Na primer, na jednom starom kompjuteru
sa samo 128 MB memorije i sa jako zastarelom video kar com, BS Player cesto secka pri pustanju filmova, a VLC sve
pusta bez problema. Postoji u verzijama za Linux, Windows, Mac OS X, BeOS, BSD, QNX i Solaris.
- Audacity - Editor audio semplova. Postoji u verziji za Windows i Linux.
- Virtual DUB - Video editor za Windows.
- Xine - Video plejer za Linux
- MPlayer - Video plejer za Linux.
- Kaffeine - Mul medijalni plejer za Linux. Podrzava i Digitalne satelitske TV kar ce.
- Prog DVB - Program za Digitalnu satelitsku TV za Windows. Uz pomoc pluginova, moze da pusta nonFTA kanale i da
skida internet strimove satelitskih internet provajdera.
- Audio Grabber - Audio CD grabber za Windows. Besplatan je tek od verzije 1.83.
- Sound Juicer - Audio CD grabber za Linux.
- KM Player - Mul medijalni plejer za Windows. Kao i VLC, ima interne vlasnicke kodeke i moze da pusta dosta for-
mata, ukljucujuci 3gp i flv. S tom razlikom sto ima daleko lepsi korisnicki interfejs, koji podseca na WinAMP. Takodje
podrzava i skinove. Za razliku od VLC-a, ne moze da konvertuje mul medijalne fajlove.
- Avidemux - Video editor za Linux i Windows.

Usluzni programi:
- K3B - Program za spaljivanje CD/DVD-ova za Linux.
- Open Office - Paket kancelarijskih programa. Podrzano je dosta opera vnih sistema.
- Krusader - File menadzer za Linux (podseca na Total Commander).
- Midnight Commander - File menadzer koji radi u terminalu (tekstualnom rezimu) za Linux (podseca na Norton Com-
mander).
- Gedit - Text editor za Linux.
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- PSPad - Text editor za Windows.
- CDBurnerXP ver. 4.0.022 - Program za snimanje cd/dvd-ova za Windows. Odlican program. Jedina mana je sto nema
opciju copy cd/dvd. Ili je barem jos nisam nasao.
- InfraRecorder 0.44.1 - Program za snimanje cd/dvd-ova za Windows. Poseduje sve sto treba. Dostojna zamena za
Nero.

Grafika:
- The Gimp - Program za rastersku grafiku, crtanje, obradu slika i fotografija. Postoji za Linux i Windows.
- Inkscape - Program za vektorsku grafiku. Postoji za Linux i Windows.
- Blender - Program za 3D grafiku i animaciju. Postoji za Linux i Windows.
- Fast Stone Image Viewer - Program za pregled slika za Windows, poseduje i neke funkcije za ogranicenu obradu fo-
tografija, uklanjanje crvenih ociju, podesavanje kontrasta, odsecanje i slicno.
- XnView - Program za pregled slika. Postoji u verziji za Windows i Linux

An virus/An spajver:
- AVG - An virus za Windows i Linux. Besplatan je za licnu/kucnu upotrebu.
- Spybot Search & Destroy - An spajver program za Windows.
- Ad Aware - An spajver program za Windows.

Igre
- Open Arena - FPS za Linux, Windows, Mac.
- Oolite - Rimejk legendarne Elite za Linux i Windows.
- Freecol - Rimejk Coloniza on za Linux i Windows.
- Freeciv - Rimejk Civiliza on za Linux i Windows.
- Torcs - Auto trke za Linux i Windows.
- Flightgear - Simulator letenja za Linux i Windows.
- Armagetron Advanced - Trka motora iz filma Tron za Linux i Windows.
- Lincity - Pravljenje grada za Linux i Windows.
- Open city - Pravljenje grada za Linux i Windows.
- Global Conflict Blue - Rec je o real me strategiji koja podseca na Fleet Command. Dakle rec je o pomorsko - vazdus-
nim borbama. Ovo je prava igra za ljubitelje igara pa Harpoon i Fleet Command. Jedina je mana sto ima jako malo
misija, a ne postoji nikakav editor misija koji bi olaksao pravljenje novih misija. Jedino da se nove misije skidaju sa
interneta ili da udjete u avanturu da sami pravite misije. Ono malo misija moze da posluzi kao tutorijal za pravljenje
novih misija, za to je dovoljan obican text editor (na primer Notepad iz Windowsa ili PSpad).
- Bygfoot - Za ljubitelje fudbala i menadzerskih igara, preporucujem Bygfoot, open source fudbalski menadzer. Razvija
se za Linux i Windows. Izuzetno je mali, download fajl je manji od 1 Mb, a kada se raspakuje, odnosno intalira, zauz-
ima nesto preko 3 Mb. Za razliku od nekih komercijalnih fudbal menadzera, ovaj nije pretrpan nepotrebnom sumom
opcija.

Ostalo:
- Stellarium - Astronomski program, virtuelni planetarijum. Postoji u verziji za Linux i Windows.
- Free Basic - Programski jezik Basic. Postoji za Windows i Linux.
- Just Basic - Programski jezik Basic za Windows.
- Vice - Emulator 8-bitnih Commodore kompjutrera za vise opera vnih sistema izmedju ostalog Linux i Windows. Po-
drzani su Commodore-64, 128, CBM-II, PET, Plus 4 i Vic.
- UAE - Amiga emulator za vise opera vnih sistema, izmedju ostalog Linux i Windows.
- Beryl - Dodatak za 3D vizuelne efekte u Linux grafickim okruzenjima Gnome i KDE.
- Compiz-Fusion - Dodatak za 3D vizuelne efekte u Linux grafickim okruzenjima Gnome i KDE (slicno kao i Beryl).
- Wine - Omogucava da se pokrenu Windows programi u Linuxu.
- VirtualBox 1.6.2 firme Sun, je open source alterna va programu VMware. Postoji u verzijama za Windows, Linux,
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Macintosh i Open Solaris.
- Ako volite da programirate u programskom jeziku Basic, to mozete radi uz pomoc Crea ve Basic-a i Emer-
gence Basic-a, koje razvija firma Ionic Wind So ware i mozete ih download-ova sa njihovog sajta na adresi:
[1]h p://www.ionicwind.com/
- Netstumbler, besplatan program za analizu bezicnih mreza, moze da posluzi i kao pomoc pri usmeravanju i konstru-
isanju antena za bezicne mreze.

1. http://www.ionicwind.com/

Batch resize animiranih GIFova (2011-05-25 04:09) - w1ndu

Tutorial se bavi konverzijom animiranih GIFova u batch procesu (vise odjednom). U koliko koris te GIMP, DBP (David’s
Batch Processor) addon ce vam bi od koris na nix pla ormama. U Win-u postoji problem sa pomenu m zato sto
animacije ne rade na outputu, tako da cemo za potrebe ovog tutoriala koris ImageReady iz Photoshop paketa.

1. Napravite backup slika koje zelite da resizujete. Otvorite ImageReady i jednu sliku. Treba nam jedna za sada,
jer samo pravimo akciju koju cemo automa zova (batchova ) kasnije.
2. Selektujte Ac ons, u koliko ne vidite ovaj deo izaberite Window > Ac on.
3. Izaberite Create new ac on i nazovite je PicResize, ona ce automatski poce da se snima (ako ne pocne kliknite
Record).
4. Idite na Image > Image Size > promenite velicinu > Ok
5. Za m File > Save Op mized As (ostavite default vrednos ) > Save
6. Kliknite Stop record u Ac ons tabu.
7. Selektujte PicResize ac on i na okruglom dugmetu sa strelicom (gore-desno), izaberite Create droplet i snimite ga
na desktop. Nakon toga zatvorite sve.

Nakon kreiranja dropleta, sledi njegova upotreba. Najpre napravite folder output u kome cete snimi resizovane
gifove.

1. 2x klik na PicResize.exe i on ce se automatski otvori u ImageReady.
2. 2x klik na Batch Op ons i u Save dijalogu izaberite Op mized > In: Specific Folder > Choose > izaberite vas output
folder > Ok
3. Minimizujte ImageReady > drag-dropujte folder sa slikama na PicResize.exe > sve slike ce bi procesovane i sniml-
jene u output folder.

Napomena: Ovaj tutorijal je prilagodjen PS/IR v7, ako koris te drugu verziju moguce je da ce pojedini koraci bi
malo drugaciji.

Srecno sa animiranim gifovima.. :-)
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mIRC Easter Eggs (2011-05-25 04:14) - w1ndu

Easters (easter eggs/cookies) su namerno skriveni delovi programa koje autori ostavljaju da bi, pre svega, zabavili ko-
risnike kada nalete na njih. Evo npr sta je Khaled sakrio po mIRC-u. :)

Ovo su easteri za mIRC zakljucno sa v6.16 (za novije nisam proveravao) >

—–^*
1) Kliknite desnim klikom na about ikonicu u mircovom toolbar-u (poslednja ikonica u obliku sidra). Od verzije 6.x
dobicete smajli a u prethodnim verzijama seriju poruka.

2) Otvorite about dijalog i kliknite na njega desnim klikom (na samu about formu). Ako obra te paznju na slovo ’I’
u reci ’mIRC’ u prvom redu texta na formi videcete kako skakuce tacka na ’I’.

3) Dok je about forma ak vna ukucajte naslepo slovo po slovo rec ’a-r-n-i-e’ da bi videli Arnija, maskotu mirc-a.
Ponovite isto da vra te Khaleda. :)

4) U about formi kliknite na mirc ikonicu (gore levo) i dobicete staru mirc ikonicu.

5) U about formi kliknite Khaleda po vrhu nosa za cool sound. Ako kliknete po Khaledu bile gde sem po nosu bicete
prebaceni na njegov personal page na mirc.com sajtu.

6) Otkucajte komandu ’/xyzzy’ u bilo kom prozoru, dobicete odgovor ’Nothing happens.’
—–^*

Ako znate koji slican easter iz nekog drugog progija, slobodno podelite.. :)

Povecanje funkcionalnos Avira Home AV-a (2011-05-25 04:16) - w1ndu

Dve su osnovne prituzbe na funkcionalost Home verzije ovog AVa, Splash screen prilikom startovanja i Nagware tokom
update-a. Za pojedine akcije ce bi neophodne rucne izmene u registry bazi pa ako vam tema ka nije bliska, najbolje
da pozovete nekog prijatelja kome jeste. Takodje, obavezno napravite backup baze (File > Export u regeditu) ili jos
bolje celog sistema (System Restore). Regedit se otvara sa Start > Run > upisete: regedit > Ok.

Za iskljucivanje Splash screena:

Nadjete u registry-ju >

[HKEY _LOCAL _MACHINE\SOFTWARE\Microso \Windo ws\CurrentVersion\Run]
2x click avgnt i na kraju doda switch /ns (npr. /min /ns)

U koliko koris te stariju Aviru, switch je bio /nosplash.

Sto se iskljucivanja Nagware-a ce, to varirao od sistema do sistema. Potrazite u Googlu ’disable avira nag screen’.
Verovatno je najlakse zabrani execute avno fy.exe u folderu programa preko Security taba. Medju m od nove verz-
ije Avira pojacava borbu pro v zlih korisnika koji ne vole da ih neko maltre ra pa je pitanje koliko ce bilo koji metod
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radi . Inace nema govora o krsenju EULA jer korisnik radi promene iskljucivo na svom sistemu a ne na samom so ware-
u.

Sto se samog programa ce, u sci su kao i kod Vlade podeljeni. Sa jedne strane ne opterecuje preterano sistem a
daje solidnu zas tu, sa druge kolicina falseva je smesna, pa se pitam koliko su ocene o efikasnos bazirane na broju
detekcija zapravo realne. Recimo prepoznao je virus u igrici koju sam ja sam pravio i stoji mi instalirana (verzija mas-
terminda).

Verujem da je razlog komprimovani (ali potpuno bezazleni) exe. Cisto radi provere (da nije doslo do bilo kakvog
injec ona u medjuvremenu) sam problema cni fajl uploadovao na mul virus scan i dok je nekoliko skenera zaista
prepoznalo da je u pitanju spakovan exe, ni jedan nije pomenuo bilo kakav virus. Doslo mi je da proizvodjacu posal-
jem code igre da je sami pregledaju i kompajliraju. Verujem da bi im se dopala.. :)

Sve u svemu, verujem da cu uskoro i sam preci na Avast. I naravno ocena stoji: AVG, Avira i Avast su i dalje tri na-
jbolja izbora za besplatnu home AV zas tu.

Avast aswMonVd.dll problem (2011-05-25 04:17) - w1ndu

Korisnici Avasta (slican problem ima i Norton AV) prilikom pokretanja 16bitnih aplikacija u pojedinim slucajevima
nailaze na gresku ’An installable virtual device driver failed dll ini aliza on’, koja ukazuje na gore pomenu dll
fajl. Problem ostaje (a ponekad tek tada nastaje) cak iako deinstalirate Avast i primenite aswClear tool sa sajta
proizvodjaca.

Gresku najcesce prijavljuju korisnici WinXP SP2 i mora da se resi rucno. Najpre napravite restore point, takodje u
koliko nemate iskustva u editovanju osnovnih sistemskih fajlova i registry baze, preporucljivo je da pozovete iskusnijeg
prijatelja, da bi dobili instrukcije iz prve ruke.

a) Editovanje fajlova:

Otvorite fajl c:\windows\system32\config.nt i obrisite sve reference vezane za Avast u koliko ih ima. Najcesce
deinstaler i aswClear ovaj deo urade uspesno. U koliko vam je sistem na drugom drive-u, lokacija ce bi nesto
drugacija.

b) Editovanje registry-ja:

1/ Start > Run > upisete: regedit > Ok
2/ Edit > Find > upisete: aswMonVd.dll > Ok

Najcesca lokacija u bazi je:

HKEY _LOCAL _MACHINE\System\CurrentControlSet\ Control\VirtualDeviceDrivers

u kojoj cete naci value VDD koja ce ukaziva na lokaciju dll fajla kako je instaliran u vasem sistemu.

3/ 2x click na VDD value i obrisete vrednost koja ukazuje na Avast. Po defaultu:
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C:\Program Files\Alwil So ware\Avast4\aswMonVd.dll ili
C:\Program Files\Alwil So ware\Avast5\aswMonVd.dll ako koris te poslednju verziju. Kod vas moze izgleda
drugacije u zavisnos gde ste instalirali program.

> Ok

4/ Ponovite proces za svaku instancu u bazi vezanu za aswMonVd.dll. Moguce je da ce vrednost bi upisana
na vise mesta ali redovno u okviru HLM > System > ControlSet0x ..

5/ Zatvorite regedit. Reboot.

Nakon ove operacije sistem ne bi trebalo da prijavljuje gresku prilikom startovanja 16bitnih aplikacija.

Mladen (2012-01-14 15:10:13)
hvala na rješenju. operacija uspjela pacijent živ

Sidebar Bookmark Selector (FireFox) (2011-05-25 04:20) - w1ndu

Addon pomocu koga birate koji ce folderi (kategorije) bi prikazani u Bookmarks Sidebaru sa leve strane. Koristan
zato sto omogucava iskljucivanje Bookmarks Toolbar & Unsorted Bookmarks kategorija pri cemu sadrzaj glavnog Book-
marks Menu-a prelazi u root Sidebara.

Retro Games Korisne Adrese (2011-05-25 04:30) - w1ndu

1/ jrok
addr: [1]h p://www.jrok.com/
Izvanredni remakeovi Ms Pacman, Pacman & Qberta. Obavezno procita uputstva za cheatove i kako izmeni startup
da bi igre bile vizuelno op malizovane.
Recimo u slucaju Ms Pacmana preporucljivo je na kraju shortcuta doda F switch da igra ne bi ”ispadala” tj da se ekran
ne bi scrollovao zbog razlike u rezoluciji.

2/ classic-retro-games
addr: [2]h p://www.classic-retro-games.com/
Mnostvo konverzija klasicnih igara sa Spectruma i Commodore-a.

3/ retrospec
addr: [3]h p://retrospec.sgn.net/
Izabrane i vrhunske konverzije starih igara od kojih je za vecnu ponudjen i source code.

Inace poslednja dva sajta su vec pomenuta na ovom blogu & njihov sadrzaj evociraja prilicno lepe uspomene. :)
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1. http://www.jrok.com/
2. http://www.classic-retro-games.com/
3. http://retrospec.sgn.net/

Portabilne igre (2011-05-25 04:35) - w1ndu

Na stranicama [1]portableapps nedavno su se pojavile brojne popularne open source igre prevedene u portabilne
varijante. Zastupljeni su svi zanrovi, od FPS (AssultCube), preko obicnih i real me strategija (WarZone 2100), puzzles,
breakout, pokera (Texas) ili saha, pa sve do tesko odredivih igara poput besplatnih varijan igara u s lu Guitar Hero
(Fred’s on Fire) itd.

Sjajan dodatak vec bogatoj kolekciji portabilnih open source programa.

1. http://portableapps.com/apps/games

Youtube ’ves ’ (2011-05-25 04:40) - w1ndu

Youtube je nedavno presao na drugaciji nacin kreiranja linkova za download, verovatno zbog ceste upotrebe is h.
Najlaksi nacin za skidanje video materijala sa yt trenutno je koriscenje java apleta, medju m ako iz bilo kog razloga ne
verujete developeru, mozete koris neki od malobrojnih sajtova koji ce vam omoguci non-java opciju. Najpouzdaniji
trenutno je ’[1]keep tube’ - chekirajte Non-java prilikom unosenja linka i u sledecem koraku paste-ujte source youtube
strane, iz koga ce sistem izvuci sve dostupne linkove u flv i mp4 formatu. Ovaj korak je neophodan, zato sto se strana
generise za svakog korisnika posebno, naravno u koliko ne zelite da koriste java aplete iz nepouzdanih izvora.

1. http://keep-tube.com/

darthewok (2011-05-30 00:30:39)
Jos jedan od nacina za skidanje video materijala sa YouTube je vadjenje is h iz kesa web browsera, na primer iz Opere. To je
komplikovaniji nacin, ali barem nisu potrebni dodatni programi ili web servisi. Samo treba saceka da se ceo video klip preuzme
i onda ga treba pronaci u kesu i iskopira u drugi folder, promeni ime i doda ekstenziju mp4 ili flv u zavisnos od kodeka. U
poslednje vreme je u vecini slucajeva mp4.

Snimanje Real Audio Streama (2011-05-25 05:15) - w1ndu

a) Skinite i instalirajte [1]Real Alterna ve i [2]Real7ime Converter (R7C). Za m u Op ons R7C podesite da li zelite samo
video, samo audio ili video+audio u zavisnos da li snimate radio ili video stream. Takodje mozete podesi video /
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audio codece i lokaciju za output.

Za m drag-drop .ram fajl i kliknite Go. File ce bi zavrsno formiran tek nakon sto prekinete snimanje klikom na Stop.
Iz mog iskustva ovaj sistem odlicno radi sa manjim snimanjima (5-10 minuta) ali ne bas najbolje sa duzim streamovima
(>45min).

b) Druga, po meni bolja opcija je [3]Streambox VCR Suite. Nakon instalacije pokrenite verziju pored koje pise >

”Streambox Vcr 1.0 beta 31smf+turbo (try this first - fastest)”

Registrujte se kako god zelite, program je discon nued. Kad se program pokrene idete na View > Se ngs i postavite
Download Loca on na desktop da bi imali bolji pregled. Za m File > Open, promenite File type u *.ram i otvorite
file.ram koji ste skinuli sa radio stanice.

U ovom slucaju ce download format bi .ra (Real Audio) koji se kasnije moze slusa preko Real Playera, Real Alter-
na ve, [4]VLC ili [5]KM Playera.

Za snimanje ogg ili mp3 streama i dalje ostaje kao preporuka koriscenje programa [6]Screamer Radio.

1. http://www.free-codecs.com/download/real_alternative.htm
2. http://www.softpedia.com/get/Multimedia/Video/Video-Recording/Real7ime-Converter.shtml
3. http://www.videohelp.com/tools/Streambox_VCR_Suite
4. http://www.videolan.org/vlc/
5. http://download.cnet.com/The-KMPlayer/3000-13632_4-10659939.html
6. http://www.screamer-radio.com/

Skidanje SATA uredjaja iz Safely Remove Hardware (2011-05-25 05:17) - w1ndu

Opcija Safely Remove Hardware se obicno automatski ak vira kada u USB port ubacite i ak virate prenosivi uredjaj,
recimo USB Flash drive. Problem sa SATA II uredjajima (HD / DVDr) je da, kao novi standard, takodje podrzavaju hot
plug a me i mogucnost da ih diskonektujete preko Safely Remove Hardware bez obzira sto se radi o internim uredja-
jima.

Iako mislim da Win prijavljuje gresku u koliko pokusate da uradite ovu operacije, sama pojava je dovoljno iritantna ali
lako resiva jednostavnom intervencijom u registry bazi.

Upozorenje: Pre editovanja registry baze napravite backup, ili jos bolje restore point, da bi lako vra li sistem u
prethodno stanje u koliko nesto podje naopako. Takodje, u koliko nemate iskustva u radu sa registryijem, nije losa
ideja da za prvi put pozovete iskusnijeg prijatelja i dobijete instrukcije iz prve ruke.

Uputstvo:

1. Start > Run > unesete: regedit > Ok
2. nadjete entry:
HKEY _LOCAL _MACHINE\SYSTEM\CurrentControlSet\ Services\nvata
3. rClick > New > DWORD Value i nazovete je: DisableRemovable
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4. 2x click na DisableRemovable > promenite Value iz 0 u 1 > Ok
5. Zatvorite regedit & reboot.

Interni SATA (HD/DVDr) uredjaji se vise nece pojavljiva u Safely Remove Hardware.

Tweakovanje LCD monitora (2011-05-25 05:18) - w1ndu

Za razliku od CRT monitora, LCD / Plasma tehnologija daje preciznu sliku tek kada se koris u maximalnoj rezoluciji. U
koliko je smanjite (da bi slika bila krupnija), dolazi do manjeg ili veceg blura koji je jako tesko izbeci. Da bi ste op mi-
zovali velicinu slike, slova i ikonica, preoporucljivo je uradi sledeca podesavanja >

1/ Podignite rezoluciju monitora na maximalnu podrzanu radi ostrine slike. Opste uputstvo je rClick na Desktop >
Proper es > Se ngs > Screen Resolu on na max > Apply, Ok
(Napomena: podesavanja mogu da zavisi od specifikacije monitora i graficke karte)

2/ Podignite DPI. rClick na Desktop > Proper es > Se ngs > Advanced. Za m u DPI Se ngs podesite kako vam odgo-
vara, recimo na Custom pa 110 %. Iako ce pojedini elemen prikaza promene odmah nakon Apply, Ok - preporucljiv
je reboot da bi i ostali programi prihva li novo setovanje. DPI = Dots Per Inch.

3/ Za programe koji se i dalje opiru sistemskom DPI setovanju, podesite op malnu rezoluciju u samom programu
gde je to moguce.

4/ Za surfovanje po netu, preporucljivo je skinu NoSquint addon za FireFox koji ce omoguci konstantan Zoom (de-
fault je 110 %) za sve strane koje posecujete. Takodje je moguce podesi Zoom cele strane, samo slova, drugaciju
pozadinu itd.

Uz ovih nekoliko podesavanja rad sa visokim rezolucijama postaje znatno ugodniji.

Skrivanje neak vnog LANa (2011-05-25 05:19) - w1ndu

Ako imate LAN kar cu na ploci a ne koris te je, njena ikonica ce se bez obzira pojavljiva u systray-u. U koliko zelite
da je sklonite, najlaksi nacin je da je disablujete.

1/ Start > Se ngs > Network Connec ons
(alterna vno: Control Panel > Network Connec ons)
2/ rClick na Local Area Connec on vezan za vasu LAN kar cu i Disable.

Ovaj postupak bi trebalo da skloni ikonicu za LAN iz systray-a. U koliko vam kasnije zatreba postupak je iden can,
samo u poslednjem koraku izaberite opciju Enable.
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Recovery Consola iz Una ended Instalacije (2011-05-25 05:21) - w1ndu

U koliko ste pravili ili posedujete customizovanu una ended instalaciju windowsa u kojoj je u fajlu winnt.sif definisano
’Una endedInstall = Yes’, Recovery Consola nece bi dostupna iz standardnog setup menija zato sto se ovaj nece ni
pojavljiva .

RC moze bi korisna medju m, jer pored standardnih DOS komandi poseduje zgodne komande poput fixboot, fixmbr,
chkdsk, diskpart, type (citac texta), map (prikaz diskova i fajl sistema na njima), mogucnost da disabluje odredjene
servise itd. Takodje, komanda format iz RC podrzava NTFS sistem za razliku od standarnog 98 DOSa na kome su bazi-
rani ostali boot diskovi. Ovo poslednje se meni pokazalo kao najkorisnije.

Da bi ste usli u RC iz Una ended Wina, na samom pocetku kada vam instalacija ponudi da pri snete F6 za RAID /
SCSI drivere ’Press F6 if you need to install..’, umesto toga pri snite F10 i drzite dok ne pocne ucitavanje fajlova ’Setup
is loading files’. Ovo traje nekoliko sekundi, nakon toga pus te F10 i sacekajte da se fajlovi ucitaju, bicete direktno
prebaceni u Recovery Console kao da ste izabrali opciju R iz setup menija.

U samoj RC najpre cete bira na kojoj od instaliranih verzija windowsa zelite da radite, kod vecine ce bi samo jedna
pa je izbor 1 i Enter. Za m cete bi pitani za administratorsku sifru, u koliko je nema (nije setovana) samo s snite
Enter. Od ovog trenutka su vam dostupne sve komande. U koliko je HD vec forma ran ili nema instalacije, bicete
prebaceni u RC bez prethodne procedure.

Za spisak komandi kucate help a za pomoc kod pojedinih komandi, kucate /? iza komande (npr. ’format /?’ bez
navodnika). Za izlazak iz RC (nakon cega sledi automatski restart) kucate komandu exit.

Editovanje sub tlova u mkv fajlovima (2011-05-25 05:27) - w1ndu

Za editovanje sub tlova integrisanih u mkv fajl bice vam potrebni Sub tle Workshop (najkorisceniji program za rad sa
sub tlovima), MKV Demux All (za extraktovanje streamova) i mkvtoolnix (paket za rad sa mkv-om) koji cemo koris
da bi muxovali zavrsni fajl.

1/ Skinite i instalirajte [1]Sub tle Workshop, [2]MKV Demux All i [3]mkvtoolnix.

2/ Pokrenite MKV Demux All, prevucite zeljeni mkv fajl u glavni prozor i kliknite Demux Files. Svi streamovi, uklju-
cujuci sub tlove, ce bi extraktovani u is folder u kome je originalni fajl.

3/ Pokrenite Sub tle Workshop, otvorite extraktovani sub tle, napravite zeljene korekcije i snimite fajl. Nemojte
zaboravi da Input i Output FPS podesite na originalni.

4/ Otvorite mkvtoolnix, u Input file kliknite Add i dodajte demuxovane fajlove sa sada izmenjenim sub tlom. U Output
filename kliknite Browse i definisite lokaciju i ime zavrsnog fajla. Selektujte video deo sa input liste i na tabu ’Format
specific op ons’ u polju za FPS unesite originalnu vrednost FPSa. Kliknite Start muxing.

Dobijeni fajl bi trebalo da po svemu bude iden can originalnom, osim po sub tlu. Na ovaj nacin mozete menja ,
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dodava i skida elemente u mkv fajlovima.

Napomena: Postoji vise nacina da saznate originalni FPS, recimo rClick u KMPlayeru dok se emituje video, pa izaberete
opciju Media Info. Pored FPS-a dobicete i druge korisne A/V informacije.

1. http://www.urusoft.net/downloads.php?lang=1
2. http://sourceforge.net/projects/mkv-demux-all/
3. http://www.bunkus.org/videotools/mkvtoolnix/index.html

Iskljucivanje WPAD sistema (2011-05-25 05:30) - w1ndu

Mnogi net programi, od torrent klijenata do mul messengera, imaju tri opcije za kontrolu koriscenja proxyja - direk-
tna konekcija, sistemski default i definisanje proxy adrese. Kod vecine je srednja opcija definisana po defaultu i cesto
se desava da korisnik to ne prime i ne promeni u direktnu konekciju ili definisani proxy. U koliko pra te ponasanje
svojih klijenata na netu, u ovom slucaju cete prime da znacajan broj programa prilikom startupa pokusava da se
poveze na WPAD sistem vaseg provajdera ili mreznog servera da bi preuzeo proxy autoconfig.

Pokazalo se da je ovaj pristup potencijalna opasnost po sigurnost rada na netu pa je najbolje da u potpunos uga-
site WPAD na sistemskom nivou. To je moguce uradi na vise nacine, a verovatno je najlakse da otvorite IE i za m
uradite sledece:
Tools > Internet Op ons > Connec ons > LAN Se ngs i dechekirate Automa cally Detect Se ngs koji je ukljucen po
defaultu.

Kad smo vec kod IE, mada je to individualna stvar, moja preporuka je da u potpunos blokirate pristup netu ovom
browseru i koris te alterna vne solucije - Firefox, Operu, SeaMonkey i / ili Chrome.

Skype Autoupdate (2011-05-25 05:32) - w1ndu

Mnogi korisnici se zale na jos uvek prisutnu bagovitost nove serije (v5.x) i nemogucnost da se autoupdate disabluje.
Ovaj problem je prisutan u mnogim programima, jer veliki broj kompanija ima naviku da upotrebljava svoje korisnike
kao besplatne beta testere.

Autoupdate je moguce disablova iz menija na sledeci nacin:
Tools > Op ons > Advanced > When new version ... i onda dechekira no fy me & autoupdate
... problem je sto su ove opcije po defaultu checkirane a dostupne su tek kad se ulogujete u profil, kada je vec updater
uradio posao. :)

Jedan od nacina da se ovo resi je, da se ulogujete, disablujete autoupdate, kad vam instaler ponudi update odbi-
jete i izadjete iz Skype-a. Nakon toga odete u:
x:\ Docs and se ngs \ <username> \ Local Se ngs \ Temp i obrisete SkypeSetup.exe iz njega.
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Ovaj postupak cete mora da ponovite za svaki novi nalog jer se sve opcije automa ski vracaju na default. Kad smo
vec kod naloga, oni se cuvaju u:
x:\ Docs and se ngs \ <username> \ Applica on Data \ Skype \ skype-username

Brisanjem foldera sa imenom naloga, brisete i sam nalog kao i sve opcije vezane za njega.

Napomena: Ovo ne brise nalog sa Skype servera vec samo u vasem sistemu. Za ovu operaciju trenutno ne postoji
opcija osim da ga ne koris te u duzem periodu.. :)

Nekoliko saveta za poboljsanje bezbednos Windows-a na internetu (2011-05-25 13:04) - darthewok

1. Na internet treba ici sa limited korisnickim nalogom u Windowsu, nikako sa administratorskim. Ovo je prva linija
odbrane, a ujedno i najvaznija. Na ovaj nacin se sprecava ogromna vecina spajvera, advera, trojanaca, virusa i ostalih
stetocina da se instalira na sistem. Jer vecina njih zahteva administratorske privilegije. Tako da ako idete na internet
sa limited nalogom, onda automatski sprecavate instaliranje ovih napas .

2. Izbegava programe Internet Explorer i Outlook Express, jer su puni bezbednosnih propusta. Umesto njih koris-
programe Opera ili Firefox i Thunderbird.

3. Instalira neki an virusni program i redovno azurira an virusnu bazu.

4. Koris firewall.

5. Koris an spyware programe i redovno azurira njihovu bazu.

Disable Last Access Update (2011-05-25 13:07) - darthewok

Da bi poboljsali performanse Windowsa korisno je iskljuci u registry-u Last Access Update, koji belezi vreme i datum
pristupa nekom fajlu. Pre bilo kakvih izmena u registry-u, obavezno napravite bekap.

U registry editoru otvori HKEY _LOCAL _MACHINE - SYSTEM - CurrentControlSet - Control - FileSystem pogleda
da li postoji N sDisableLastAccessUpdate ukoliko postoji, umesto vrednos 0, upisa 1. Ukoliko ne postoji, napravi
novi registry key N sDisableLastAccessUpdate definisa ga kao dword i upisa 1.

U Windows 7 ne morate ovo radi , jer je Last Access Update iskljucen u startu.
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Autoplay i Autorun (2011-05-25 13:10) - darthewok

Iskljucivanje dosadnih autoplay i autorun prilikom ubacivanja CD/DVD-a, USB flash drive i ostalih prenosivih diskova.

Posto se izmene rade u registry bazi, preporucujem da prvo napravite bekap.

Pokrenite registry editor, za m u registry-u otvorite:
HKEY _LOCAL _MACHINE - So ware - Microso - Windows - CurrentVersion - Policies - Explorer
i u kljucu ’NoDriveTypeAutoRun’ upisite ff.
Ova izmena potpuno iskljucuje autoplay prilikom ubacivanja CD/DVD-a, USB-a i ostalih prenosivih diskova.

Sledeca izmena iskljucuje autorun. Tj, automatsko pokretanje programa prilikom ubacivanja CD/DVD.
U registry-u otvorite:
HKEY _LOCAL _MACHINE - SYSTEM - CurrentControlSet - Services - Cdrom
U kljucu ’AutoRun’ umesto 1, upisite 0.

Ukoliko zelite da vra te autoplay i autorun, samo umesto novih vrednos upisite stare, koje su bile pre izmene.

Ovo vazi za Windows XP, u Windows 7 ovo nisam probao.

Iskljucite Remote Assistance (2011-05-25 13:12) - darthewok

Iz bezbednosnih razloga iskljucite Remote Assistance and Desktop Sharing. U Control Panelu kliknite na System, pa
na tab Remote i decekirajte obe stavke Allow Remote Assistance... i Allow users to connect... pa kliknite na Apply i
za m Ok.

HOSTS (2011-05-25 13:35) - darthewok

Vec sam pisao o blokiranju web sajtova preko hosts fajla. Na adresi [1]h p://www.mvps.org/winhelp2002/hosts.ht-
m mozete skinu hosts.zip. U njemu se nalazi hosts fajl sa vise sto na pozna h web lokacija koje su potencijalno
opasne, sadrze tracking kukije, spajvere i koje sadrze reklamne bannere. Napravite rezervnu kopiju originalnog hosts
fajla. Hosts fajl iz zipa iskopirajte umesto originalnog. Time ce bi onemogucen pristup sajtovima sa ’crne liste’.
U Windowsu se taj fajl nalazi u c:/windows/system32/drivers/etc/hosts
U Linuxu se taj fajl nalazi u /etc/hosts
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Samo jedna napomena za Linux. U Linuxu se u prva dva reda nalazi (ili nesto slicno ovome u zavisnos od distribucije
koju koris te):

127.0.0.1 localhost.localdomain localhost
::1 localhost6.localdomain6 localhost6

Ta prva dva reda bi trebalo da ostanu, pa umesto kopiranja hosts fajla, ucitajte u text editor i originalni hosts na
vasem kompjuteru i onaj sa mvps.org, pa samo selektujte stavke iz hostsa sa mvps.org (one stavke iza 127.0.0.1 local-
host) i uradite copy / paste u nastavku vaseg originalnog hosts fajla. Da bi ste to uradili morate bi logovani kao root.

1. http://www.mvps.org/winhelp2002/hosts.htm

Ovo mozda nekome zatreba, nekome ne, ali da bi ste ustedeli zivce i da ne biste bacali cd-ove, procitajte
(2011-05-25 13:36) - darthewok

Ako u svom notebook-u imate dvd snimac Op arc, moze doci do problema sa Nerom u Windows-u XP SP2. Tes rao
sam nekoliko verzija 7.x, 8.x i sve su bile problema cne. Na kraju sam tes rao verziju 6.3.1.25 koja je radila kako treba.
U svakom slucaju prvo tes rajte sa RW diskovima. Na sajtu Nera, postoji program General-CleanTool. Sluzi da ukloni
sve zaostale kljuceve u registry-u i fajlove, koje Nero ostavi posle deinstalacije. Ako prelazite sa jedne verzije Nera na
drugu, posle deinstalacije pokrenite General-CleanTool.

Windows XP i HP 550 laptop (2011-05-25 13:38) - darthewok

Ukoliko instalirate Windows XP na HP 550 laptop, moze da se desi da instalacioni program Windowsa ne prepozna
hard disk i u tom slucaju nece hte da instalira Windows. Restartujte laptop i udjite u bios. U System Configura on
postavite SATA Na ve Mode na Disabled. Sacuvajte izmene i restartujte laptop. Posle ovoga instalirajte Windows XP.

Informacije o Windowsovim procesima (2011-05-25 13:39) - darthewok

Na sajtu [1]h p://www.liu li es.com/products/wint-
askspro/processlibrary/h p:// www.liu li es.com/products/wintaskspro/processlibrary/ mozete naci informacije o

80

http://www.mvps.org/winhelp2002/hosts.htm


Windowsovim procesima i drugim exe fajlovima.

1. http://www.liutilities.com/products/wintaskspro/processlibrary/

Problemi sa ikonom My computer (2011-05-25 13:42) - darthewok

- Problemi sa ikonom My computer na desktopu u Windowsu XP -
Dugo (vise minutno) otvaranje ili zamrzavanje moze da uzrokuje vise faktora:

- Los cd/dvd koji je ostecen i tesko se cita. U tom slucaju izvadite cd/dvd.
- Neki mapirani mrezni uredjaj (Map Network Drive), koji vise nije prisutan. U tom slucaju treba kliknu desnim tas-
terom na taj mrezni uredjaj i diskonektova ga.
Takodje u exploreru kliknu na tools -> folder op ons -> view i iskljuci opciju Automa cally search for network fold-
ers and printers
- Windows Image Acquisi on (WIA) servis moze takodje da prouzrokuje taj problem. U tom slucaju zaustavi i (ako
nemate skener) onemoguci taj servis i ako je potrebno restartova kompjuter.

Zone Alarm firewall (2011-05-25 13:43) - darthewok

Ako koris te Zone Alarm firewall, iskljucite debug opciju. Jer, u suprotnom, tvDebug.log fajl moze da naraste nekoliko
gigabajta i da Vam nepotrebno zauzima veliki prostor na hard disku.
To mozete uradi na sledeci nacin:
1. Pri snite CTRL i SHIFT i desnim tasterom misa kliknite na Zone Alarm ikonu u systray-u.
2. U meniju koji se pojavi, kliknite na Set debug level.
3. Kliknite na Off u Debug categories.
4. Restartujte kompjuter.
5. Udjite u Windowsov Safe Mode.
6. Izbrisite tvDebug.log, Nalazi se u: ”C:\Windows\Internet logs\”
5. Restartujte kompjuter.
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Generic Host Process (2011-05-25 13:45) - darthewok

- Blokiranje Generic Host Process da pristupa internetu -
1. Zaustavi i onemoguci servis DNS Client.
2. U Zone Alarm (ili nekom drugom firewallu, samo da nije ugradjeni windowsov) kompletno zabrani pristup intenetu
za Generic Host Process.
3. Restartova kompjuter, restart nije obavezan, ali ga uradite za svaki slucaj.
4. Proveri da li radi internet. Ako radi, onda je sve ok, uspesno ste blokirali Generic Host Process.

UPOZORENJE!
Ovo sam tes rao na dva razlicita kompjutera sa dve razlicite mrezne konfiguracije i razlici m internet provajderima i
radilo je. Ako slucajno kod Vas to ne radi, nije nista strasno, samo ponovo startujte i stavite na auto servis DNS client
i dozvolite pristup za Generic Host Process u firewallu i eventualno restartujte kompjuter.

windu (2011-05-26 06:35:05)
Neverovatno ali is nito, zaista radi. =) Inace DNS Client servis (koji se podize preko svchosta) sluzi za cachiranje DNS lookup-a
u lokalu i nije neophodan za rad interneta. Misljenja o potrebi za ovim servisom su oprecna i mogu se sumira u sledeca tri:
1) Pozeljan - ali ne i neophodan. Smanjuje broj lookup-a ka DNS serveru jer cachira prethodne, cime bi trebalo da ubrzava
rad na netu. 2) Nepotreban - u koliko je DNS server dobro podesen. U ovom slucaju lokalno cachiranje ne donosi narocitu
korist i samo nepotrebno opterecuje sistem. 3) Nepozeljan - i potencijalno opasan. U pojedinim slucajevima izaziva 100 %
CPU svshost-a, takodje jedan broj experata smatra da je lokalno cachiranje opasno jer je moguca maliciozna manipulacija
(preusmeravanje saobracaja), slicno kao preko hosts fajla. Takodje cuva sve rezultate pregleda ukljucujuci i lose, pa se moze
desi da je DNS server ISPa updateovao sajt a da korisnik i dalje ne moze da ga otvori. Ovo se resava flushovanjem lokalnog
DNSa, kad proces radi. Iskljucivanje procesa sa sobom vuce dva dodatna efekta: 1) Komanda ’ipconfig /flushdns’ prijavljuje
gresku, jer nema sta da se flushuje obzirom da se nista ne cuva. 2) Iz istog razloga nemoguce je uradi repair konkekcije do
kraja, iako bi trebalo da radi i bez tog zavrsnog dela. U koliko ne bude radila, uvek je moguce privremeno ukljuci proces dok
traje repair. U svakom slucaju meni je cela procedure pre svega jako zanimljiva pa tek onda korisna, jer ne vidim neku narocitu
razliku u performansama ili brzini neta. A zanimljiva je zato sto sam nebrojeno puta procitao kako je nemoguce izaci na net sa
blokiranim svchost-om. Izgleda da je ovo sasvim moguce, jer ove redove upravo pisem blokirajuci ga preko Sygate-a. :-) Da
sumiram, svi se slazu da DNS Client nije neophodan, a ovo je samo jos jedna potvrda o mogucnos nesmetanog rada na netu
uz blokiranja svchosta, jer test po ce sa drugacijeg firewalla i sistema..

Firefox 4 korisni save (2011-05-25 13:47) - darthewok

U ovoj verziji, WebGL je moguce pokrenu sa NVidia grafickim kar cama bez problema, ostale kar ce nisu ukljucene
u startu. U narednom primeru cu opisa kako da omogucite WebGL i na ostalim grafickim kar cama, na primer ATI.
Ne znam da li ce ovo radi na svim modelima Intelovig grafickih kar ca. U svakom slucaju, sam ovo tes rao na ATI
kar ci i radi.
- Pokrenite Firefox 4 i u polje za upisivanje web adresa upisite: about:config
- Kliknite na I’ll be careful, I promise!
- U polje filter upisite: webgl
- pronadjite stavku webgl.force-enabled i sa false promenite na true
Ovo ce bi dovoljno, video sam na jednom sajtu da preporucuju i ak viranje i direct 2D akceleracije.
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- u polje filter upisite gfx i pronadjite stavku gfx.direct2d.force-enabled
- stavku gfx.direct2d.force-enabled sa false promenite na true

Idite na sajt: [1]h p://www.khronos.org/webgl/wiki/Demo _Repository
da bi ste isprobali WebGL sa demoima na toj adresi.

1. http://www.khronos.org/webgl/wiki/Demo_Repository

Povecanje bezbednos Windows XP (2011-05-25 13:59) - darthewok

Video tutorijal iz 4 dela.

1/4

[youtube=h p://www.youtube.com/watch?v=PLzZJ4–bdQ]

2/4

[youtube=h p://www.youtube.com/watch?v=AxvUA0Nn38M]

3/4

[youtube=h p://www.youtube.com/watch?v=YnZiYeaek4Q]

4/4

[youtube=h p://www.youtube.com/watch?v=gtzUZtSekTo]

—-

Na kraju instalirajte neki An virus i Firewall koji Vam najvise odgovara.

Bezbednost Windows XP « Kompjuteri (2011-05-25 15:14:25)
[...] Povecanje bezbednos Windows XP [...]

Podesavanje Wireless AP (2011-05-25 14:33) - darthewok

Tutorjial za podesavanje bezicnog access pointa na ruteru.

83

http://www.khronos.org/webgl/wiki/Demo_Repository


UPOZORENJE: Ako ne znate sta radite, najbolje ne dirajte nista!!!

U tutorijalu je objasnjeno osnovno podesavanje i zas ta bezicne pristupne tacke na ruteru.
Potrebno je da imate neko osnovno znanje iz oblas kompjuterskih mreza da bi ste primenili nauceno u tutorijalu.

Takodje, je potrebno da znate kako se podesavaju mreze u opera vnom sistemu koji koris te.
Ako iskljucite SSID, potrebno je da znate kako da se povezete na WLAN koji ne emituje SSID.
Ako ukljucite MAC filter, potrebno je da znate MAC adresu Vaseg bezicnog uredjaja i da tu MAC adresu upisete u MAC
filter na ruteru.

Obra te paznju na WLAN sifru koju kucate na Vasem ruteru. Zapam te sifru, jer istu morate ukuca i na Vasem
kompjuteru kojim se kacite na WLAN!!!

[youtube=h p://www.youtube.com/watch?v=k1R9r7oZLR8]

Povecanje bezbednos Windows XP 2 (2011-05-25 15:11) - darthewok

Vec sam postavio video tutorijal za ovo isto. Mozete ga pogleda ovde:
[1]h p://kompjuteri2011.wordpress.com/2011/05/25/povecanje-bezbednos -w indows-xp/
Kako poveca bezbednost Windowsa na internetu?
(Poslednja izmena: 20090526)
———- Uvod ———-

U Windowsu XP se nalazi dosta servisa koji nisu potrebni obicnom korisniku u svakodnevnom radu. Mnogi
mrezni servisi predstavljaju potencijalnu opasnost na internetu. Zato je najbolje iskljuci ih, ukoliko nemate neke
posebne potrebe bas za m servisima. Pored toga sto ce se poveca sigurost Windowsa na internetu, rastere ce se
Windows, jer se nece trosi memorija i resursi na te nepotrebne servise.

Da bi ste pogledali mrezne konekcije na Vasem kompjuteru, kako dolazne, tako i odlazne upotrebicemo ko-
mandu netstat. Pokrenite komandni prompt i u njega ukucajte netstat -na

Po ”defaultu” Windows, tj, neki njegovi servisi automatski otvaraju odredjene portove:

123 - Network Time Protocol koris ga Windows Time Service
135 - RPC (Remote Procedure Call) i DCOM (Distributed Component Object Model).
137,138,139 - File and printer sharing i network name resolu on koris ga NetBIOS over TCP.
445 - File and Printer sharing za Windows 2000 i novije Windowse. (SMB over TCP)
500 - Ovo je IKE (Internet Key Exchange) koji je deo IPsec protokola.
portovi iznad 1023 - Portovi iznad 1023 su dostupni aplikacijama. Servisi koji koriste RPC ce ima portove iznad 1023.
1900 Universal Plug and Plug (UPnP).
5000 Simple Service Discovery Protocol (SSDP).
3389 The Remote Desktop service.
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Radi probe, pogledao sam mrezne konekcije pre i posle koraka koji su opisani u tekstu ispod. Koris o sam ko-
mandu netstat -na u komandnom promptu. Na kraju je od Windowsovih servisa samo port 135 bio u listening rezimu.
Port 135 koris servis RPC, koji ne moze da se iskljuci. Zbog toga je zatvaranje porta 135 malo komlikovanije. Takodje,
jos 3 porta su bila u listening rezimu, ali te portove koris AVG an virus.

———- Upozorenja - Obavezno procita !!! ———-

- Ukoliko ne znate sta radite ili ste pocetnici, nejbolje preskocite korake 1, 2 i 3!

- Prvo procitajte kompletan tekst pa onda eksperimen site!

- Ukoliko iskljucujete NetBios over Tcpip (NetBT), budite oprezni, jer servis DHCP Client zavisi od NetBT. Ako
Vam je taj servis potreban, na primer za automatsko dodeljivanje IP adrese od strane rutera, onda ne dirajte NetBT.
Jer se moze desi da DHCP ne dodeli automatski IP adresu. Ovo nisam probao, jer je kod mene iskljucen DHCP server
na ruteru i sve parametre veze podesavam rucno, tako da mi DHCP Client nije potreban, a mrzi me da ukljucujem
DHCP server na ruteru, da bih to probao. (Procita 3. korak Iskljucivanje porta 445. Tu se defini vno iskljucuje NetBT
drajver u registry-u, a pod c se mora iskljuci i sam DHCP Client).

- Ne preuzimam nikakvu odgovornost ako nesto zeznete. Sve sam ovo isprobao i sve radi kako treba i kuci i na
poslu. Tako da ako nesto kod Vas krene naopako, onda nesto niste dobro uradili. U svakom slucaju pre nego sto bilo
sta pocnete da radite napravite bekap vaznih podataka, registry-a i napravite novi System Restore point.

———- Koraci za povecanje bezbednos Windowsa na Internetu ———-

1. Otvori network Connec ons, desni klik na mrezni adapter, pa levi klik na Proper es.

- Iskljuci Client for Microso Networks
- Iskljuci File and Printer Sharing for Microso Networks
- Iskljuci QoS Packet Scheduler
- Iskljuci NetBios:
a) desni klik na mrezni adapter
b) levi klik na Proper es
c) levi klik na Internet Protocol (TCP/IP)
d) levi klik na Proper es
e) levi klik na Advanced
f) levi klik na Wins
g) levi klik na Disable NetBIOS over TCP/IP

Gore pomenute stavke uopste nisu potrebne za internet, vec samo za neke lokalne mreze. Njihovo prisustvo
ugrozava bezbednost na internetu. Ako nemate neke posebne zahteve koji bas zahtevaju prisustvo h klijenata,
slobodno ih iskljucite.

2. Zaustavi i onesposobi nepotrebne mrezne servise

- Computer browser
- IPSec services
- QoS RSVP
- TCP/IP NetBIOS Helper
- Server
- SSDP Discovery Service
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- Windows Time
- Worksta on

Ovi servisi nisu potrebni za normalno funkcionisanje interneta, pa ih slobodno iskljucite, ako nemate neke
posebne zahteve za m servisima. Pored povecanja bezbednos , sistem ce bi malo rastereceniji, jer se nece
nepotrebno trosi memorija na te servise.

Samo da napomenem da ovo nisu jedini mrezni servisi, ali su ovi po ”defaultu” ak vni i paredstavljaju potencijalni
sigurnosni rizik.

3. Iskljucivanje porta 445.

Ovaj port je malo specifican i moze da se iskljuci na nekoliko nacina.

a) ”Prljav” nacin. Event Viewer, stavka System, prijavljuje jednu gresku za NetBT.
- Pokrenu Registry Editor
- Pronaci u registry-u HKLM\System\CurrentControlSet\Serv ices\NetBT\
- Na desnoj strani se nalazi kljuc Start. Dvoklik na Start i umesto 1 upisa 0
- Restartova kompjuter
ili
b) ”Prljav” nacin. Event Viewer, stavka System, prijavljuje nekoliko gresaka za NetBT.
- Pokrenu Registry Editor
- Pronaci u registry-u HKLM\System\CurrentControlSet\Serv ices\NetBT\Parameters
- Na desnoj strani se nalazi kljuc TransportBindName. Dvoklik na TransportBindName i izbrisa /Device/
- Restartova kompjuter
ili
c) ”Cist” nacin - Ne prijavljuje nikakvu gresku u Event Viewer, ali u tom slucaju mora da se zaustavi DHCP Client.
Meni to ne predstavlja problem, jer mi je na ruteru iskljucen DHCP server i IP adrese i ostale parametre veze na
kompjuterima podesavam rucno.
- Zaustavi DHCP Client i postavi ga na Manual
- Pokrenu Registry Editor
- Pronaci u registry-u HKLM\System\CurrentControlSet\Serv ices\NetBT\
- Na desnoj strani se nalazi kljuc Start. Dvoklik na Start i umesto 1 upisa 4
- Restartova kompjuter

4. Instalira An virus (na primer AVG), An spajver (na primer Spybot Search & Destroy) i Firewall (na primer
Zone Alarm). Ove programe sam naveo samo kao primer jer ih ja koris m. Vi izaberite programe koji VAMA
odgovaraju.

5. Koris Firefox, Sea Monkey ili Operu. NIKAKO Internet Explorer!!!

6. Instalira Security Update za Windows XP KB958644

7. Iskljucite Remote Assistance. (Desni klik na My computer -> levi klik na Proper es -> Remote)

8. Preuze HOSTS fajl sa adrese [2]h p://www.mvps.org/winhelp2002/hosts.htm i zameni originalni HOSTS
fajl HOSTS fajlom koji ste preuzeli. Prvo ga raspakujte, jer je zipovan i restartujte kompjuter.

Originalni HOSTS fajl se nalazi u folderu:
C:\WINDOWS\SYSTEM32\DRIVERSckslashETC
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U hosts fajlu se nalaze blokirane adrese potencijalno opasnih sajtova i nekih sajtova sa reklamnim banerima.

9. Na internetu, a i u svakodnevnom radu koris limited nalog, a ne administratorski nalog. U administra-
torski nalog treba ulazi samo ako treba nesto sistemski da podesavate ili da instalirate. Mnogi ovo osporavaju
razlici m argumen ma. Moj argument za koriscenje limited naloga je sto, izmedju ostalog mnogi virusi, spajveri,
trojanci itd, traze bas administratorske privilegije korisnika da bi se instalirali u sistemske foldere i da bi se upisali u
registry. Koriscenjem limited naloga je moguce spreci te napas da inficiraju sistem. Neki programi i mnoge igre
zahtevaju administratorske privilegije i nece da rade sa limited nalogom. To nije veliki problem, jer se to resava tako
sto desnim tasterom misa kliknete na ikonu takvog programa/igre i za m levim klikne na Run as. U padajucem meniju
izaberite nalog koji ima administratorske privilegije, eventualno ukucajte sifru ako ste je definisali za administratorski
nalog i program ili igra ce radi . To isto treba radi i prilikom instalaciranja novih programa. Ukoliko niste definisali
limited nalog, idite u Control Panel, za m na User Accounts i tu napravite novi nalog koji ce bi limited (ogranicen).

10. Redovno azurirajte an virusnu bazu i bazu an spajver programa. Ukoliko koris te Spybot Search & De-
stroy, posle svakog azuriranja uradite imunizaciju (Immunize).

Dodatak:
Veliki deo posla mozete odradi sa programcicem koji se zove WWDC. To je stari programcic, na koji sam potpuno
zaboravio, ali me je Windu podse o na njega. Uz pomoc wwdc, mozete sa samo nekoliko klika misem pozatvara sve
nepotrebne portove, ukljucujuci i port 135, koga nije bas lako zatvori rucno. Tes rao sam ga na ”cistom” windowsu
i sve lepo odradi. Na Vama ostaje samo da poiskljucujete jos neke nepotrebne servise koje ne koris te. Listu servisa
koje mozete zaustavi i onesposobi mozete pogleda u prethodnom postu.
WWDC mozete preuze sa ove adrese: [3]h p://www.so pedia.com/progDownload/Windows-Worms-Doors-
Cleaner-Down load-107294.html

Samo da dodam, da kada ukucate netstat -na posle zatvaranja nepotrebnih portova u wwdc, u lis se i dalje
nalaze mrezni servisi koji koriste portove: UDP 500, 4500, 123. Ovo nisu otvoreni portovi, ali ako nemate neke
preterane potrebe za m servisima, mozete i njih zaustavi i onesposobi .

Servisi:
Windows Time: Port 123
IPSec Services: Portovi 500, 4500

1. http://kompjuteri2011.wordpress.com/2011/05/25/povecanje-bezbednosti-windows-xp/
2. http://www.mvps.org/winhelp2002/hosts.htm
3. http://www.softpedia.com/progDownload/Windows-Worms-Doors-Cleaner-Download-107294.html

windu (2011-05-25 17:45:24)
Dodatak na ovo, port 135 moguce je zatvori i pomocu programa DCOM Bobulator koji je projekat Gibson Research-a (grc.com)
i moze da se skine odavde > h p://www.grc.com/freeware/dcom.htm U koliko se jave poteskoce u radu nakon zatvaranja 135
sa pomenu m programima lako je moguce ponovo enable-ova DCOM, mada do sada nisam naisao na takvu potrebu u praksi.
Inace, isto dajem prednost wwdc-u zato sto je sve na jednom mestu.. :)
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Transmission (2011-05-25 19:43) - darthewok

Transmission je mali BitTorrent klijent, ima sve sto je potrebno. Razvija se za Linux, FreeBSD, Mac OS X i Solaris.
[1]h p://www.transmissionbt.com/

1. http://www.transmissionbt.com/

HTTrack website copier (2011-05-25 19:45) - darthewok

HTTrack website copier, sluzi za kopiranje web sajtova na lokalni hard disk i kasniji offline pregled. Razvija se za Win-
dows, Linux, Unix, Mac OSX i BSD.
[1]h p://www.h rack.com/

1. http://www.httrack.com/

inSSIDer (2011-05-25 19:49) - darthewok

inSSIDer je WLAN skener. inSSIDer je zamena za
NetStumbler. Posto je Net Stumbler stari program i vise se ne razvija, a takodje i ne radi dobro na Windows Vista,
Windows XP 64 i Windows 7. [1]h p://www.metageek.net/products/inssider/

1. http://www.metageek.net/products/inssider/

XVidCap (2011-05-25 19:50) - darthewok

XVidCap je screen capture program koji moze da snimi desavanja na ekranu u video formatu ili kao individualne slike.
Razvija se za Linux.
[1]h p://xvidcap.sourceforge.net/

1. http://xvidcap.sourceforge.net/
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CamStudio (2011-05-25 19:52) - darthewok

CamStudio je screen capture program koji moze da snimi desavanja na ekranu u video formatu. Razvija se za Win-
dows.
[1]h p://camstudio.org/

1. http://camstudio.org/

SUPERAn Spyware (2011-05-25 19:53) - darthewok

SUPERAn Spyware Free Edi on - An spajver program. Razvija se za Windows.
[1]h p://www.superan spyware.com/

1. http://www.superantispyware.com/

MakeHuman (2011-05-25 19:54) - darthewok

MakeHuman - Odlican open source program za 3D grafiku i animaciju. Sluzi za generisanje ljudi u 3D. Kasnije 3D ob-
jekte mozete uves u neki od programa za 3D animaciju, kao sto su 3DS Max, Blender, Maya itd... Mozete ga preuze
na adresi: [1]h p://makehuman.org/

1. http://makehuman.org/

Celes a (2011-05-25 19:55) - darthewok

Celes a, 3D svemirki simulator za ljubitelje astronomije. Razvija se za Windows, Linux, i Mac OS X.

[1]h p://celes a.sourceforge.net/

1. http://celestia.sourceforge.net/
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Geoshell (2011-05-25 19:56) - darthewok

Geoshell je alterna vni shell za Windows 2000/XP/Vista. Zamenjuje Windowsov standardni shell Explorer.exe. Po-
drzava skinove i pluginove. Uz pomoc pluginova, moze da mu se prosiri funkcionalnost. Kome je dosadio standardni
izgled Windowsa, moze da proba Geoshell.

[1]h p://www.geoshell.org/

1. http://www.geoshell.org/

Programi sa www.paehl.de/english.php (2011-05-25 19:59) - darthewok

Najzad sam nasao vremena da isprobam programe koje sam preuzeo sa sajta [1]h p://www.paehl.de/english.php

Sledeci programi su mi se najvise dopali:
- UPX Graphical (pomenuo ga je Windu Jet)
- DPA-SFX-Crypther 1.7 - Pravi samoraspakujuce fajlove kriptovane AES/Blowfish, Serpent, Twofish i RC6 algoritmima.
- DPA SHA 1.98 - Preracunava heseve. Podrzava sledece algoritme: MD2, MD4, MD5, RIPEMD128, RIPEMD160, CRC32,
CRC16, ARC-CRC, SHA1, SHA-256, SHA-384, SHA-512, HAVAL128, HAVAL160, HAVAL192, HAVAL224, HAVAL256,
Tiger128, Tiger160, Tiger192, GOST R 34.11-94
- DPCRYPT 1.05 build 2 - Program za kriptovanje, podrzava sledece algoritme: 3DES 192Bit Key, Blowfish 448 Bit Key,
Cast-256 256 Bit Key, Mars 1248 Bit Key, RC6 2048 Bit Key, Rijndael 256 Bit Key, Serpent 256 Bit Key i Twofish 256Bit
Key.
- GUI MEDIAINFO 1.04 - Prikazuje informacije mul medijalnih fajlova. (Kodek, bitrate itd...)
- DP MULTICRYPT version 1.6 - Program za kriptovanje, slicno kao i DPCRYPT, s m sto podrzava drag & drop.

1. http://www.paehl.de/english.php

Advanced SystemCare Free (2011-05-25 20:01) - darthewok

Advanced SystemCare Free - Sluzi za op mizaciju Windows sistema, popravljanje gresaka u registry-u, defragmen -
zaciju registry-a i hard diska i jos dosta toga. Od slicnih programa se razlikuje i po tome sto moze da ukloni i spajvere.
Free verzija je besplatna. Postoji i Pro verzija koja nije besplatna. Free verzija je odlicno uradjena i cak pruza i vise od
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komercijalnih proizvoda nekih drugih proizvodjaca. Cak im je i Pro verzija znatno je inija od konkurencije, a s obzirom
na to kako radi Free verzija i koje sve opcije poseduje, mogu da zamislim kako tek funkcionise pro verzija. Nemam
obicaj da hvalim komercijalne proizvode, ali sam ovde ipak napravio mali izuzetak, bas zbog toga sto su besplatnu
(free) verziju tako profesionalno odradili.
[1]h p://www.iobit.com/

1. http://www.iobit.com/

Smart Defrag (2011-05-25 20:02) - darthewok

Smart Defrag - Program za defragmen zaciju hard diska.

[1]h p://www.iobit.com/

1. http://www.iobit.com/

Artweaver (2011-05-25 20:04) - darthewok

Artweaver besplatni program nemackih autora sluzi za obradu fotografija. Podseca na Photoshop, tako da moze bi
koristan ljudima koji ne mogu da se priviknu na Gimp. Moze se preuze u dve varijante, kao instalacija i zipovani fajl
koji je dovoljno raspakova .

Program mozete preuze sa sledece adrese: [1]h p://www.artweaver.de/

1. http://www.artweaver.de/

Startup Delayer (2011-05-25 20:05) - darthewok

Startup Delayer - Uz pomoc ovog programa mozete podesi kasnjenje podizanja drajvera i programa prilikom pokre-
tanja Windowsa. Na taj nacin mozete op mizova pokretanje Windowsa i rastere ga prilikom podizanja sistema,
da se ne bi ”sve odjednom” pokretalo.
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Program mozete preuze sa adrese: [1]h p://www.r2.com.au/

1. http://www.r2.com.au/

Programi sa pabloso waresolu ons.com (2011-05-25 20:06) - darthewok

Nekoliko zanimljivih programa mozete naci ovde:
[1]h p://www.pabloso waresolu ons.com/html/products.html
Iz kolekcije programa bih izdvojio: Baby FTP server, Baby WEB server, Baby POP3 server, Pablo Commander, FTP Wan-
derer i Li le Install Builder.

1. http://www.pablosoftwaresolutions.com/html/products.html

Gnome Sub tles (2011-05-25 20:07) - darthewok

- Gnome Sub tles - Program za tlovanje filmova na Linuxu.
[1]h p://gnome-sub tles.sourceforge.net/

1. http://gnome-subtitles.sourceforge.net/

Programiranje (2011-05-25 20:09) - darthewok

- Boa Constructor -
Kros pla ormski IDE za programski jezik Python i GUI editor za wxPython.
[1]h p://boa-constructor.sourceforge.net/

- NetBeans -
Kros pla ormski IDE za vise programskih jezika. Podrzano je dosta programskih jezika i tehnologija neki od njih su:
Ajax, C/C++, Java EE, JavaFX, Java ME, Java SE, JavaScript, Kenai, Maven, Python, Ruby itd... Postoji dosta pluginova,
koji prosiruju upotrebljivost programa i podrske za programske jezike.
[2]h p://www.netbeans.org/
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1. http://boa-constructor.sourceforge.net/
2. http://www.netbeans.org/

JDownloader (2011-05-25 20:10) - darthewok

- JDownloader -
Krospla ormski downloader napisan u Javi. Takodje podrzava preuzimanje fajlove sa Rapidshare-a i slicnih sajtova.
Dakle, ako niste registrovani na Rapidu, nema vise dezuranja pored kompjutera. Ubacite sve linkove sa Rapida u listu
i program ce sve automatski odradi .

Program mozete naci na adresi:
[1]h p://www.jdownloader.org/

1. http://www.jdownloader.org/

XBMC (2011-05-25 20:11) - darthewok

- XBMC - Odlican open source media centar, razvija se za Windows, Linux, Mac. Dakle, sve u jednom, audio/video
plejer, plejer za internet radio stanice, moze da sluzi kao media server u mrezi, moze da prikazuje fotografije i od njih
napravi slideshow. Pusta skoro sve popularne audio/video formate. Moze cak da reprodukuje i fajlove unutar zip i rar
arhiva. Takodje poseduje i opciju weather, tu izaberete lokaciju i preko interneta dobijete meteoroloske podatke za
grad koji vas interesuje. Preko skrip i pluginova moze da mu se prosiri funkcionalnost, da na primer pusta video sa
Youtube-a i drugih onlajn servisa za video i fotografije.

[1]h p://xbmc.org/

1. http://xbmc.org/

gMapMaker i Mobile GMaps (2011-05-25 20:13) - darthewok

gMapMaker je downloader mapa za Windows, sluzi za download mapa, satelitskih snimaka i hibridnih mapa sa saj-
tova kao sto su Google Maps, MSN Maps, Yahoo Maps, Open Street Map i jos nekoliko slicnih sajtova. Kada se zavrsi
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download, te fajlove je moguce koris offline, znaci ne morate bi na internetu da bi ih koris li. Postoji vise podesa-
vanja i nacina rada programa i pokazao se korisnim kod pravljenja mapa za Mobile GMaps (takodje je besplatan) java
aplikaciju za mobilne telefone, koji sluzi za GPS navigaciju.

- Zvanicna prezentacija programa Mobile GMaps: [1]h p://www.mgmaps.com/
- gMapMaker i jos neki korisni programi: [2]h p://www.mgmaps.com/cache/
- Koristan sajt za definisanje dela mape za download, takodje sa kratkim uputstvom: [3]h p://www.mapcacher.com/
- Mapa Srbije i nekih vecih gradova prilagodjenih za Mobile GMaps i uputstvo za instalaciju:
[4]h p://www.serbiamap.net/symbian.html

Prilikom GPS navigacije na vasem mobilnom telefonu, vise niste ograniceni na mape koje su vec gotove, vec ih mozete
na ovaj nacin i sami napravi . Sto je jako korisno, posebno ako planirate neki put ili izlet van vecih gradova koji nisu
podrzani. Dovoljno je samo odabra deo mape koji vas zanima, saceka da program zavrsi download i prebaci mape
na mobilni telefon. Naravno, u ovom primeru, morate podesi Opera ng mode u gMapMaker-u da bude MGMaps.

1. http://www.mgmaps.com/
2. http://www.mgmaps.com/cache/
3. http://www.mapcacher.com/
4. http://www.serbiamap.net/symbian.html

MyViewPad (2011-05-25 20:14) - darthewok

- MyViewPad - Mali i besplatni program za pregled slika, razvija se za Windows. Podrzava dosta formata za prikaz
slika, a u neke formate moze i da upisuje, pa ga donekle mozete koris i za konvertovanje iz jednog formata u drugi.
Poseduje neke najosnovnije funkcije za korigovanje slika. Ima lep i funkcionalan korisnicki interfejs. Pored toga sto
moze da se korsi kao i svaki drugi program, takodje moze da se koris i kao plugin za Total Commander.
Mozete ga naci na adresi:
[1]h p://www.myviewpad.com/

1. http://www.myviewpad.com/

Kicad (2011-05-25 20:15) - darthewok

- Kicad-
Open Source programski paket za pravljenje elektronskih sema i dizajniranje stampanih plocica. Razvija se za Linux i
Windows.
h p://kicad.sourceforge.net/wiki/Main _Page
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HashCalc (2011-05-25 20:16) - darthewok

- HashCalc -
HASH, CRC i HMAC kalkulator za Windows.
Podrzava sledece algoritme: MD2, MD4, MD5, SHA-1, SHA-2( 256, 384, 512), RIPEMD-160, PANAMA, TIGER, ADLER32,
CRC32.
Moze da radi sa fajlovima, tekst stringom i hex stringom.
Podrzava velike fajlove do 15 GB.

[1]h p://www.slavaso .com/hashcalc/

1. http://www.slavasoft.com/hashcalc/

Tor (2011-05-25 20:17) - darthewok

Tor - [1]h p://www.torproject.org/
Tor je slobodan so ver i otvorena mreza koja sluzi za zas tnu privatnos na internetu. Razvija se za Linux, Mac i Win-
dows. Detaljan opis mozete naci u Svetu kompjutera 8/2010 i na zvanicnom sajtu Tor projekta.
Ako korsi te windows, onda imate opciju da preuzmete dva instalaciona fajla: Tor Browser Bundle for Windows i/ili
Installa on Bundle for Windows. Na Vama je da odlucite koja Vam verzija vise odgovara.
Ako koris te Linux, neku od popularnih distribucija: Fedora, Ubuntu itd... Onda potrazite u repozitorijumu Tor, Vi-
dalia i Polipo i
preuzmite ih. Za m preuzmite konfiguracioni fajl za Polipo sa adrese: [2]h ps://svn.torproject.org/svn/torbrowse-
r/trunk/build-scripts/config/p olipo.conf i postavite ga u /etc/polipo/config ili /.polipo
Za m preuzmite Torbu on ([3]h ps://addons.mozilla.org/en-US/firefo x/addon/2275/) dodatak za Firefox. Pokren-
ite program Vidalia i u njemu podesite da Proxy aplikacija bude polipo, a kao argumente za polipo stavite
-c /etc/polipo/polipo.conf ili -c /.polipo/polipo.conf u zavisnos gde ste postavili konfiguracioni fajl.
Detaljno uputstvo za instalaciju mozete naci na zvanicnopm sajtu.
Takodje i za Linux postoji ”bundle” verzija za download. To je jednostavnije resenje od gore pomenutog. Dovoljno je
da preuzmete arhivu sa sajta, raspakujete u neki folder na hard disku. Prilikom pokretanja skripte start-tor-browser,
automatski ce se pokrenu svi programi koji su potrebni, ukljucujuci i internet browser.

1. http://www.torproject.org/
2. https://svn.torproject.org/svn/torbrowser/trunk/build-scripts/config/polipo.conf
3. https://addons.mozilla.org/en-US/firefox/addon/2275/
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Polipo (2011-05-25 20:18) - darthewok

- Polipo - [1]h p://www.pps.jussieu.fr/ jch/so ware/polipo/
Mali proxy server za Linux, FreeBSD, Windows, Mac.
S obzirom da podrzava IPv4 i IPv6, moze da sluzi kao most za IPv4 i IPv6 mreze. Tako sto moze da obezbedi pristup sa
IPv6 hosta na IPv4 server i obrnuto.
Takodje moze da blokira nepozeljne adrese.
Podrzava SOCKS protokol, pa se moze koris u Tor mrezi.

1. http://www.pps.jussieu.fr/%7Ejch/software/polipo/

LibreOffice (2011-05-25 20:19) - darthewok

- LibreOffice -
[1]h p://www.documen ounda on.org/

Office paket koji ce nastavi Open Office tradiciju. OpenOffice.org je razvijala firma Sun, ali od kako je Oracle ku-
pio Sun, tada je i projekat Open Office presao u ruke firme Oracle. Medju m, posto je buducnost Open Office-a pod
okriljem firme Oracle neizvesna, nezavisna fondacija pod nazivom Document Founda on nastavlja razvoj ovog pro-
jekta pod nazivom Libre Office.
Document Founda on je samostalna fondacija koju su stvorili vodeci clanovi OpenOffice.org projekta.
Document Founda on nastavlja radi na temeljima 10 godina rada od strane OpenOffice.org zajednice.

LibreOffice se razvija za Linux, Windows i Mac.

1. http://www.documentfoundation.org/

TrueCrypt (RealCrypt) (2011-05-25 20:20) - darthewok

- TrueCrypt - [1]h p://www.truecrypt.org/

Besplatan open source program za enkripciju. Razvija se za Windows 7/Vista/XP, Mac OS X i Linux. Aktuelna verz-
ija je 7.0a.
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U repozitorijumima nekih Linux distribucijama (Fedora i Mandriva) se pominje naziv RealCrypt umesto TrueCrypt. Ali
je u sus ni rec o istom programu. Razlike su minimalne i sto je najvaznije, kompa bilni su.

Osnovne karakteris ke:
Pravi virtuelne kriptovane diskove u fajlu i mount-uje ih kao realne diskove.
Moze da kriptuje celu par ciju ili uredjaj kao na primer USB fles ili hard disk.
Moze da kriptuje sistemsku par ciju.
Enkripcija je automatska, u realnom vremenu i transparentna.

Algoritmi koje podrzava: AES-256, Serpent i Twofish.

1. http://www.truecrypt.org/

OOoTranslit (2011-05-25 20:21) - darthewok

OOoTranslit, autor Aleksandar Urošević
[1]h p://oootranslit.info/
O projektu (preuzeto sa sajta [2]h p://oootranslit.info/)

OOoTranslit (OpenOffice.org Transliterator) je skup makroa koji predstavljaju jezički dodatak za programe Writer i Calc
kancelarijskog paketa OpenOffice.org/LibrOffice. Omogućava dvosmerno prebacivanje (preslovljavanje) ćiriličnog tek-
sta u la nični (podrazumevano), kao i la ničnog u ćirilični, u okviru izabranog teksta i ćelija ili nad kompletnim doku-
mentom. Obuhvaćen je rad sa svim slovima srpske azbuke i abecede, što omogućava upotrebu i za druge srodne
jezike (hrvatski, bošnjački, crnogorski). Pored standardnih rasporeda, podržani su „kvazirasporedi“ YUSCII, CIRSCII i
„novinarski“ raspored Nezavisnog društva novinara Vojvodine (koje koris slobodan so ver zahvaljujući LUGoNS).

OOoTranslit je prevashodno pisan za GNU/Linux verziju paketa OpenOffice.org, ali je potpuno funkcionalan i na ostalim
pla ormama za koje postoji osnovni paket (Windows i Mac OS X). Ovo je moguće zbog toga što se za funkcionisanje
koris interni skript jezik OOoBasic (slobodna izvedba jezika StarBasic), koji je sastavni deo paketa OpenOffice.org.

1. http://oootranslit.info/
2. http://oootranslit.info/

Microemulator (2011-05-25 20:25) - darthewok

- Microemulator -
Emulator Java aplikacija mobilnih telefona napisan u Javi. Posto je pisan u Javi, moze da se pokrene na Linux-u,
Windows-u i OSX-u. Moze da radi kao Web Browser aplet ili kao samostalna aplikacija.
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Microemulator je koristan programerima koji razvijaju Java programe i igre za mobilne telefone. Takodje, koristan je i
sa aspekta obicnih korisnika, koji ne moraju da prebacuju Java programe i igre u mobilni telefon da bi ih tamo probali,
vec je dovoljno da ih ucitaju u Microemulator i probaju, pa ako im se svidi, mogu da ih tada prebace u telefon.
Aktuelna verzija programa je: 2.0.4
Program mozete naci na zvanicnom web sajtu: [1]h p://www.microemu.org/

1. http://www.microemu.org/

Liferea (2011-05-25 20:26) - darthewok

- Liferea -
Liferea (Linux Feed Reader) je citac za online RSS feedove. Postoje mnogi drugi citaci feedova, ali oni ili ne postoje u
Linux verziji ili zahtevaju mnogo dodatnih biblioteka koje treba instalira . Liferea nastoji popuni tu prazninu stvara-
juci brz, jednostavan za koriscenje i instalaciju RSS feed citac za Gtk / Gnome.
Razvija se za Linux. Mozete ga skinu sa Sourceforgea ili iz repozitorijuma Vase Linux distribucije.
[1]h p://liferea.sourceforge.net/

1. http://liferea.sourceforge.net/

Streamtuner2 (2011-05-25 20:27) - darthewok

- Streamtuner2 -
Streamtuner2 je internet radio pretrazivac. Ima listu muzickih stanica rasporedjenih po zanrovima. U samom pro-
gramu, mozete podesi da se strimovi sa interneta pustaju u programu koji Vama odgovara. Podrazumevano podesa-
vanje je da se strimovi pustaju uz pomoc programa Audacious, pa je pozeljno ima i njega instaliranog. Takodje, ako
zelite snimi strimove, treba da imate instaliran program Stream Ripper.
Navedene programe mozete instalira sa repozitorijuma Vase Linux dris bucije. Ili ih skinu sa zvanicnog sajta.

Streamtuner2: [1]h p://sourceforge.net/projects/streamtuner2/
Audacious: [2]h p://audacious-media-player.org/
Stream ripper: [3]h p://streamripper.sourceforge.net/

1. http://sourceforge.net/projects/streamtuner2/
2. http://audacious-media-player.org/
3. http://streamripper.sourceforge.net/
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Link-O-Rama pt1 (2011-05-26 05:01) - w1ndu

[1]Portable Apps

Sadrzi gomilu free / open source programa preradjenih tako da se ponasaju portabilno.

Ovo znaci da rade iz sopstvenog foldera bez potrebe da na bilo koji nacin koriste ostale elemente sistema (npr.
koriste .ini fajlove umesto registry baze, koriste sopstvene a ne sistemske graficke engine (poput Gtk+ za portabilni
GIMP & Pidgin) itd). Da bi se ovakva prerada uradila na legalan nacin program mora bi GNU open tako da sajt moze
da posluzi i kao spisak i baza za kvalitetne programe ovog pa.

[2]OpenDisc

Projekat koji je nasledio OpenCD. U pitanju je ISO image raznih programa koji zadovoljavaju free / open kriteri-
jum. Iako postoji vise slicnih projekata ODisc je jedina up to date kolekcija. Isto kao i sa portapps, moze da se koris
kao dobra baza kvalitetnog so ware-a.

XChat.FrE3

Besplatne verzije XChat-a za Win:

[3]Silverx & [4]Prot.XChat *

Prvi je poznat, stabilan, up-2-date i jako popularan build. Drugi je portabilni pre-release koji sudeci po testovima radi
odlicno. Oba su bazirana na 2.8.6 source-u.

Ovi buildovi postoje zato sto je oficijalna verzija za windows trail ali je code ipak dostupan. Ko voli sam da
experimen se, na oficijalnom sajtu > [5]h p://xchat.org/ moze da skine source i dodje do vise informacija za
samostalno kompajliranje.

[6]Dorgem

Webcam capture za Win (9x/Me/2000/XP), ne razvija se vise ali poslednja verzija 2.10 radi odlicno.

[7]aMSN

Besplatna open source zamena za msn messenger. Razvija se za lin, win, macos & bsd. Poslednja verzija
0.98.4 ne koris standardne smajlije obzirom da ih je microso stavio pod copyright pa se preporucuje neki skin koji
ih podrzava (aqua, kubuntu, brushed metal itd). Nova serija, koja je u beta fazi, predvidjena je kao potpuni recode u
python-u.

[8]Video Thumbnails Maker

Program za pravljenje video thumbnail preview-a. Iako pojedini playeri (poput mpc-a) imaju ovu funkciju ugradjenu,
VTM poseduje neverovatnu flexibilnost i gomilu opcija za output, snimanje se ngsa, setovanje custom banera itd.
Takodje podrzava gotovo sve video fajlove uz odgovarajuce codec-e.
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Trenutna v1.0.1.1 trazi .NET 2.0 Framework.

[9]WinCatalog Light

Zgodan program za katalogizaciju diskova, najbolji besplatni na koji sam naisao. Razvija se za Win.

Besplatni text editori

1/ PSPad > [10]h p://www.pspad.com/

Odlican text editor sa ugradjenom syntaxnom podrskom za niz programskih jezika, toolovima za razne op -
mizacije html coda, hex editorom i gomilom slicnih stvari.

2/ notepad++ > [11]h p://notepad-plus.sourceforge.net/

Jos jedan odlican text editor koji gravi ra uglavnom ka programerskoj populaciji, takodje krcat brojnim koris-
nim mogucnos ma. Tesko mi je da ocenim koji je objek vno bolji od ova dva, mada je moj licni izbor na PSPad-u.

3/ AbiWord > [12]h p://www.abisource.com/

Dok su 1/ & 2/ uglavnom napredne zamene za notepad, AbiWord po izgledu i funkcijama podseca na Word
(Office) & Writer (Open Office). Razvija se za Win/Lin/Mac, poslednja verzija 2.6.5 dostupna je u Win binaries i
sourceu.

Hexing

[13]HxD - odlican stand-alone hex editor sa gomilom naprednih opcija i funkcija u koliko ne koris te vec posto-
jeci u okviru nekog programa (recimo iz PSPad-a).

[14]UPX Graphical - userfriendly GUI za UPX sa dosta mogucnos za podesavanje, ugradjenim upx-om i dodat-
nim dllovima, tako da nije potreban nikakav externi program. Ugradjen je i opcioni scrambler da bi se sprecio unpack.
Takodjem na istom sajtu se mogu naci i ostali besplatni ala nemackog autora Dirk Paehl-a.

[15]SMPlayer

Lepo uradjen crosspla orm media player koji u osnovi ima mplayer. Ima razne napredne opcije pregledno
uredjenje za pustanje VCD / DVD / mHD ...

[16]Mp3 Tag Tools

Mp3 Tag Tools - mp3 tag editor, izmedju ostalog koristan za batch brisanje svih ID3 tagova kao i ostalog djubreta iz
mp3-ja ( lyrics / pictures ) ..

1. http://portableapps.com/
2. http://www.theopendisc.com/
3. http://www.silverex.org/download/
4. http://portableapps.com/node/15971
5. http://xchat.org/
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6. http://dorgem.sourceforge.net/
7. http://www.amsn-project.net/
8. http://www.suu-design.com/downloads.html
9. http://www.wincatalog.com/light.html
10. http://www.pspad.com/
11. http://notepad-plus.sourceforge.net/
12. http://www.abisource.com/
13. http://mh-nexus.de/en/hxd/
14. http://www.paehl.de/cms/upxg
15. http://smplayer.sourceforge.net/
16. http://massid3lib.sourceforge.net/

Link-O-Rama pt2 (2011-05-26 05:18) - w1ndu

[1]CDex

Odlican CD extractor, converter i reencoder sa standardnim i naprednim opcijama. Za razliku od slicnih ima
ugradjene sve potrebne .dll-ove (lame, ogg, vorbis itd) tako da nema potrebe za dodatnim download-ima.

MAC changeri

Besplatni programi za menjanje MAC adrese:

[2]Techni um MAC Address Changer &

[3]MacIdChanger by Nishant Sivakumar

Oba su free a poslednji je i open source (u VC5++) ali je potrebna registracija na codeproject sajtu.

Monitoring procesa

Napredni programi za monitoring procesa u sistemu:

[4]Process Explorer by Mark Rusinovich, sysinternals &

[5]ProcX by gkweb (Guillaume Kaddouch), Ghost Security

Oba daju detaljan pregled procesa ukljucujuci lokacije, vezane dllove, hijerarhiju procesa, mogucnost pretrazi-
vanja na googlu itd.

[6]CurrPorts

Program za napredni monitoring konekcija (sta se kaci, gde, sa kog i na koji port) uz razne mogucnos izvoza
podataka, integracije sa whois programima itd.
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Na nirso -ovom sajtu se takodje mogu naci brojni besplatni ala vezani za net monitoring, dolazenje do pass-
worda, gledanje ispod zvezdica i slicno. Svi su besplatni & spy/ad/bullshit free.

[7]WinDirStat

Sta s ka upotrebe HD-a, korisno kad nesto jede hard a ne znate sta je i gde. Postoji i portabilna verzija na
portableapps.

Kvalitetn(ij)e zamene za Adobe Reader

1/ [8]Foxit Reader - mali, brzo ucitavanje. Podrzava bookmarke, search, resize i mnoge druge standardne i
napredne opcije poput cachiranja poslednjih pozicija itd. Ima i mogucnost editovanja uz ostavljanje bookmarka koje
je moguce skinu samo uz kupovinu pro verzije.

2/ [9]PDF-XChange Viewer - nesto veci i malo sporiji od Foxit-a. Moguce je osnovno editovanje PDF fajlova
bez watermarka dok je za napredniji edit (poput bookmarka) potrebna puna verzija.

3/ [10]Sumatra PDF Reader - najmanji i najbrzi od pomenu h. Rudimentaran izgled za danasnje standarde i
bez naprednih ali sa svim osnovnim i neophodnim opcijama. Dobra strana je sto pam definisani zoom (ne radi
autoresizing na fajl default) prilikom setanja po dokumentu putem bookmarka. Iz nekog razloga ova opcija ne postoji
u drugim PDF readerima i pored stalnih apela korisnika.

Iako XChange Viewera ima neke manje prednos , moja preporuka za sistemski reader je Foxit zbog brzine i
velicine. Sumatra je izbor u specificnim slucajevima, kad je default zoom fajla nepregledan a materijal takav da je
potrebno / pozeljno koriscenje bookmarka.

Portabilne verzije Foxit i XChange je moguce skinu sa ma cnih sajtova dok je Sumatra, kao jedini Open Source od
pomenu h, podrzan od strane [11]PortableApps.

[12]Screamer Radio

Lightweight program za slusanje i ripovanje online radio stanica. Ima brojne standardne i napredne opcije. Di-
rektno snimanje (bez gubitka) mp3 & ogg streamova kao i mogucnost reencodinga u mp3 iz mp3/ogg/wma/acc
stream-a preko Lame encodera. Takodje ima napredne opcije za buffering (da u snimku ne bi bilo seckanja),
mogucnost snimanja u jednom fajlu ili po pesmama, automatsko davanje imena pesama, ogromnu bazu sa radio
stanicama svih zanrova itd. Postoji u standardnoj i portabilnoj verziji.

[13]CPUID

Grupa codera pod e ketom CPUID razvija zgodne i korisne alate za rad sa sistemom:

- CPU-Z - program koji prikazuje osnovne informacije o hardware-u i sistemu.
- PC-Wizard - isto samo uz izuzetno detaljan prikaz i naprednu analizu svih elemenata.
- PerfMonitor - program za detaljno pracenje rada i performansi procesora.
- HWMonitor - pracenje senzora na ploci (voltaza, temp, cooleri).
- HWMonitor Pro - prosirena verzija prethodnog uz napredne mogucnos poput pravljenja sta s ckih grafova ili
monitoringa udaljenog PC-ja preko neta.

Svi programi su besplatni (izuzev poslednjeg) i mogu se skinute u portabilnoj ili setup verziji.
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[14]ThumbHTML

Program za automa zaciju pravljenja galerija sa thumbnailovima uz brojna podesavanja i opcije - od jednos-
tavnih stvari poput predefinisanih s lova pa do slideshow podrske. U poslednjoj verziji dodat je i php output.

[15]CryptLoad

Automa zacija downloada sa rapidshare-a i jos nekoliko filehos ng servisa. Takodje brojne napredne opcije i
podesavanja uz odlicanu podrsku na forumu sajta.

1. http://cdexos.sourceforge.net/
2. http://www.technitium.com/tmac/index.html
3. http://www.codeproject.com/KB/applications/MacIdChanger.aspx
4. http://technet.microsoft.com/en-us/sysinternals/bb896653
5. http://www.ghostsecurity.com/procx/
6. http://www.nirsoft.net/utils/cports.html
7. http://windirstat.info/
8. http://www.foxitsoftware.com/pdf/reader/
9. http://www.tracker-software.com/product/pdf-xchange-viewer
10. http://blog.kowalczyk.info/software/sumatrapdf/free-pdf-reader.html
11. http://portableapps.com/apps/office/sumatra_pdf_portable
12. http://www.screamer-radio.com/
13. http://www.cpuid.com/
14. http://landscapeimage.com/thumbhtml/
15. http://cryptload.info/

Kreiranje PDF dokumenata | Kompjuteri (2013-05-18 16:27:17)
[…] dokumen su standard dugi niz godina. O readerima je vec bilo reci, a sada cemo pomenu dva laka nacina da se oni […]

Link-O-Rama pt3 (2011-05-26 05:46) - w1ndu

[1]MPC-Homecinema

U potpunos baziran na Gabestovom MPC-u ali obogacen sa brojnim filterima i naprednim opcijama. Od play-
era koji samostalno (bez codeca) pustaju sve formate, verovatno najlaksi po sistemske resurse. Takodje izuzetno
zgodan za tesko izvodljive akcije sa drugim slicnim playerima, recimo za pravljenje thumbnails preview-a iz .flv
formata i sl.

Poslednja verzija 1.3.1249 dostupna je u install i portabilnoj verziji, 32bit & 64bit. Podrzava sve verzije Win-a
(od NT-a do Win7).

HD par cionisanje

Besplatni programi za par cionisanje HD-a:
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[2]Par on Master

Vrhunski program za par cionisanje firme Easeus - precizan, kvalitetan i ugodan za rad. Besplatni Home Edi-
on je namenjen privatnim korisnicima i podrzava 32bitne sisteme (2k, XP, Vista & Win7). Jos jedno prijatno

iznenadjenje je brza, kvalitetna i profesionalna podrska na forumu proizvodjaca.

[3]gParted

Sourceforge projekat, besplatan, open source & cross-pla orm. Omogucava sve osnovne operacije sa win &
lin par cijama. Na sajtu je dostupna Live CD verzija, kompletna dokumentacija i bogata podrska na forumu. Kao
open source standard u svojoj oblas , program je ukljucen u poslednje verzije Knoppixa & paketa Parted Magic.

[4]MKV Demux All

Program koji sluzi da extraktuje sve streamove (audio, video i sub tles) iz mkv fajlova, izuzetno korisno u ko-
liko zelite da dodajete, izbacujete ili editujete pojedine elemente. Program je opensource, podrzan od strane
sourceforge-a i trenutno u prilicno stabilnoj RC1 fazi.

[5]mkvtoolnix

Besplatan, opensource i crosspla orm program za rad sa mkv formatom. Pre svega je zgodan za muxovanje
(spajanje) razlici h elemenata u jedinstven mkv fajl, pri cemu nudi razne napredne opcije. Demuxovanje (splitovanje,
extraktovanje) je podrzano samo iz komandne linije, makar sa oficijalnog sajta.

Direktno su pake ma podrzani svi pozna ji Linux distroi, za m MacOS, FreeBSD i Windows za koji postoji in-
stalaciona i portabilna verzija u .7z arhivi. U koliko se odlucite za poslednju opciju, mmg.exe predstavlja GUI.

dotnet ala

Ko god je imao problema sa updateovanjem, instaliranjem i deinstaliranjem raznih verzija dotneta, sledeci
ala bi mogli da mu olaksaju zivot ubuduce. Iako je logicno da naredne verzije podrzavaju prethodne, da instalirani
program ima deinstaler (koji radi), da je sa lakocom moguce utvrdi koje sve verzije imate instalirane, da vam je
potrebna samo poslednja verzija programa itd, MSovi proizvodi se ponekad opiru logici. Ova dva alata ce vam nadam
se pomoci >

[6]Free DotNet VersionCheck U lity

Razvija ga TMG Development Ltd i daje precizne informacije koje verzije i podverzije dotneta imate instalirane,
ukljucujuci popularna imena za verziju, datum kad se pojavila, koji update je u pitanju kao i informacije da li vam neki
program fali da bi pokretali dotnet aplikacije uz lokacije odakle mozete da skinete neophodne komponente.

[7].NET Framework Cleanup Tool

Ovaj izuzetno koristan program razvija Aaron Stebner, program menadzer XNA ma MS-a (gaming devel), verovatno
najkvalitetnijeg dela ove kompanije. :) Alat podrzava skidanje svih verzija dotneta od prve od 3.5, u paketu ili po
zelji. Takodje sadrzi naprednu logiku, pa recimo nece ponudi skidanje onih verzija koje su sastavni deo sistema a uz
skidanje izabrane verzije, skinuce i update za nju da ne bi pravili probleme.

Nadam se da ce vam pomenu ala bi od pomoci.
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[8]Join VOB Files Tool

Alat za lossless spajanje vob fajlova bez reencodinga. Ovo moze bi prilicno korisno obzirom da programi za
backup DVDova ponekad ne uspevaju da prepoznaju automatski koje elemente VIDEO _TS foldera treba iskoris .
Ovim programom mozete spoji tacno ono sto vam treba za dalju obradu u drugim ala ma.

[9]Handbrake

Izuzetno napredan program za reencoding DVDova i video fajlova u HD mkv & mp4 format. Moguc je izbor
vise codeca za audio i video, ripovanje chaptera, dodavanje sub tlova, fino podesavanje izabranih codeca, primena
filtera i kropovanja, pravljenje profila itd. Narocito je korisna mogucnost odredjivanja duzine output fajla u koliko
zelite uklapanje u vec postojece fajlove na mediju kao i mogucnost brzog preview-a za trenutne se ngse.

[10]Pazera mp4 to avi

Program za brzo prebacivanje iz mp4 formata, recimo skinu h sa youtube, u avi ili mpg format. Omogucava
brojne napredne opcije poput izbora audio i video codeca, njihovog finog podesavanja, ubacivanja tagova, croppinga,
promene rezolucije itd. Program koris ffmpeg i ostale open source lib-ove za interni encoding tako da sve moze da
se uradi i bez instaliranih codeca. Konverter je portabilan i izuzetno jednostavan za upotrebu, a na sajtu proizvodjaca
se mogu naci slicni korisni i besplatni ala .

[11]Youtube Downloader HD

Odlicno jednostavno desktop resenje za skidanje filmova sa youtube u svim forma ma. Portabilna verzija pro-
grama se moze naci na portablefreeware i radi odlicno. Jedino treba ima u vidu da se dodatni ini fajl formira u >
user/Applica on Data/Youtube Downloader HD/
.. kao i u normalnoj verziji. Ovo je bitno u koliko kasnije pozelite da ga skinete iz sistema u potpunos .

Program je lagan po pitanju resursa, jednostavan za upotrebu, omogucava skidanje clipova u svim forma ma i
nova v2.9 takodje podrzava novi youtube format kreiranja video linkova.

[12]WinMerge

Program za merge-ovanje (spajanje) i poredjenje fajlova i foldera. Druga funkcija je izuzetno korisna, i dok
mnogi programi veoma kvalitetno porede fajlove, retki imaju mogucnost kvalitetnog poredjenja kompletnih foldera
i subfoldera, uz detekciju razlika u fajlovima koji su u njima. Ovaj alat je pre svega od znacaja za developere, jer je
ponekad jako tesko naci sitnu razliku u jednoj od 100 na malih skrip unutar komplexne aplikacije.

Obzirom na brojne napredne opcije i kvalitet, WinMerge u mnogim stvarima prevazilazi svoju shareware konkurenciju.
Program je dostupan u installer & zipovanoj portabilnoj verziji.

1. http://mpc-hc.sourceforge.net/
2. http://www.partition-tool.com/download.htm
3. http://gparted.sourceforge.net/
4. http://mkv-demux-all.sourceforge.net/
5. http://www.bunkus.org/videotools/mkvtoolnix/
6. http://www.tmgdevelopment.co.uk/versioncheck.htm

105

http://mpc-hc.sourceforge.net/
http://www.partition-tool.com/download.htm
http://gparted.sourceforge.net/
http://mkv-demux-all.sourceforge.net/
http://www.bunkus.org/videotools/mkvtoolnix/
http://www.tmgdevelopment.co.uk/versioncheck.htm


7. http://blogs.msdn.com/b/astebner/archive/2008/08/28/8904493.aspx
8. http://download.cnet.com/Join-VOB-Files-Tool/3000-13631_4-10718007.html
9. http://handbrake.fr/
10. http://www.pazera-software.com/products/mp4-to-avi-converter/
11. http://www.youtubedownloaderhd.com/
12. http://winmerge.org/

Link-O-Rama pt4 (2011-05-26 06:24) - w1ndu

[1]Ashongso GiF Resizer

Jednostavan program za brzu promenu velicine GIF fajla. Najbitnija razlika izmedju ovog i ostalih slicnih ap-
likacije je sto ova uspesno radi resize animiranih gifova, cuvajuci originalnu animaciju u smislu brzine i kvaliteta.
Druge prednos su portabilnost programa i izuzetno jednostavna upotreba.

Program medju m nema batch resize opciju, pa ako zelite da resizujete veliki broj animiranih gifova, preporu-
cujem da koris te GIMP addon DBP (David’s Batch Processor). Obzirom da addon ima problem sa poslednjom
verzijom pod Win pla ormom (gubi animaciju), preporucujem batch procesovanje prethodno snimljenog resize
ac ona u ImageReady iz Photoshopa (u koliko radite obradu u Windowsu).

U svakom slucaju, za svakodnevnu i brzu upotrebu GiF Resize je vise nego koristan.

[2]DamnVid

Opensource aplikacija za video konverziju (preko FFmpeg-a) i skidanje clipova sa svih popularnih video hos ng
sajtova. Ima brojne napredne opcije, mogucnost skidanja preko proxyja, podesavanja encodinga, snimanje profila,
modularnu strukturu itd. Program je podrzan od strane googlecode-a & portableapps, te je od skora dostupan i u
portabilnoj verziji.

Mala napomena - kad instalirate program, preporucujem da updateujete module vezane za zeljene video hos-
tove, da bi dobili punu funkcionalnost.

[3]Yet Another Avi Info

Koristan opensource program uradjen u Delphiju i publikovan na sourceforge-u. Iako mislim da bi neki detalji
mogli bi i bolji, program nudi korisne i napredne opcije poput menjanja podataka fajla, nekoliko nacina sinhro-
nizacije zvuka i slike itd, te daje detaljne informacije o samom avi fajlu sto mu je i osnovna svrha.

Ako sinhronizacija nije moguca, preporucujem da se avi fajl najpre provuce kroz [4]AviDemux i nakon toga
uskladjuje. Ovo zato sto AviDemux nudi opciju ’razbijanja’ dodatno op mizovanog zvuka u normalnu kompresiju koju
je moguce obradjiva .

YAAI je pre svega koristan u koliko je async slike i zvuka konstantan. U koliko se menja tokom trajanja filma
(postaje sve veci), onda je moguce dobi zeljeni efekat kroz blagu promenu frame rate-a u samom AviDemuxu.
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Delphi 6 source je dostupan za entuzijaste.. :)

[5]Lightscreen

Zanimljiva zamena za brojne komercijalne screenshot programe. Poslednja v1.01 donosi nekoliko naprednih
mogucnos , poput podizanja sa sistemom tako da je program uvek pri ruci, konfigurabilne trigere za razlicite brze
nacine shotova koji se smestaju u predefinisani folder i format, pravljenje odlozenih screenshotova itd.

Iako je program podrzan od strane portableapps i sourceforge-a, mislim da je i dalje u razvoju te ipak preporu-
cujem poslednju besplatnu verziju (v5.3) FastStone Capture za ovu namenu. :)

[6]AquaSnap

Zanimljiv program firme Nurgo So ware koji donosi Aero efekte za XP pla ormu, mada je kompa bilan sa
svim aktuelnim verzijama Windowsa. Pored standardnog snapovanja za ivice u cilju op mizacije prostora na
desktopu, program omogucava semitransparenciju, shakeovanje, fino podesavanje snapa, mul monitor podrsku i
sto je narocito zanimljivo, trazi samo 1mb sistemske memorije. Iako nisam ljubitelj ovakvih programa, pomenute
karakteris ke zavredjuju paznju.

Program je dostupan i u portabilnoj verziji na sajtu proizvodjaca, a setup je podesen tako da omogucava laku
instalaciju u mreznom okruzenju.

[7]Webcam Timershot

Microso ov Powertoy (serija poznata po TweakUI) koji omogucava periodicno snimanje shotova sa cam-a u
definisanom intervalu na definisanoj lokaciji.

[8]MagicDisk

Odlican besplatan program za virtuelizaciju CD/DVD drive-a. Omogucava mountovanje svih pozna jih image
formata, kreiranje do 15 virtualnih drajvova, kompresiju / dekompresiju / password zas tu (UIF format), te kreiranje
imagea na osnovu medija u nekoliko formata (ISO, BIN + CUE, NRG, UIF).

Poslednja verzija 2.7 (build 106) podrzava sve novije opera vne sisteme (xp, vista, 7) dok su 98, Me & 2k po-
drzani u buildu 105. Iako je program logicno organizovan i jednostavan za upotrebu, svi neophodni tutoriali dostupni
su na sajtu proizvodjaca kroz linkove u help meniju.

Nove verzije & najave

* [9]Youtube Downloader HD 2.2 (sada 2.5)
- ispravljen download bug i dodata podrska za p480 flv & re-encoding u mp4/avi

* [10]WinSCP 4.2.9 (sada 4.3.x)
- sitniji bugovi, zadrzana exchange podrska sa Pu y-jem u okviru portableapps

* [11]Pidgin 2.7.5 (sada 2.7.11)
- ispravljene glupos iz 2.7.4, zadrzana podrska za custom teme u okviru portableapps

* [12]aMSN 0.9.84 (2.x u najavi)
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Verovatno najpopularnija zamena za MSN pojavila se u novoj verziji. v-98.4 je poslednji bugfix u seriji nakon
cega sledi nova serija u kojoj ce bi vracena AV podrska jer se u pozadini uveliko radilo na implementaciji novog WLM
protokola.

Zanimljivo je da je takodje u pripremi aMSN-2 kao kompletan rewrite u python programskom jeziku ispod
haube. Frontendovi ce bi prirodni za podrzane OSove, recimo Cocoa za Mac ili GTK/Qt4 za Win & Nixe itd. Trenutno
ne postoji meline zato sto je primarni focus na upotrebnoj verziji.

1. http://www.ashongsoft.com/product/gif-resizer.html
2. http://code.google.com/p/damnvid/
3. http://yaai.sourceforge.net/
4. http://avidemux.sourceforge.net/
5. http://lightscreen.sourceforge.net/
6. http://www.nurgo-software.com/products/aquasnap
7. http://download.cnet.com/Webcam-Timershot/3000-12511_4-10628510.html
8. http://www.magiciso.com/tutorials/miso-magicdisc-history.htm
9. http://www.youtubedownloaderhd.com/
10. http://winscp.net/
11. http://www.pidgin.im/
12. http://www.amsn-project.net/

Blender i limited user nalog (2011-05-30 02:23) - darthewok

Da bi ste bili u mogucnos da normalno koris te Blender u limited user nalogu. Prilikom instalacije Blendera u prozoru
”Choose Install Loca on” treba izabra opciju: Use installa on directory. Za m kliknu na Install.

[1]

1. http://kompjuteri2011.files.wordpress.com/2011/05/blendinstall.png
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1.2 June

Free Morphing (2011-06-01 23:33) - darthewok

Free Morphing pravi niz slika koje se postepeno transformisu od pocetne slike, do ciljne slike. Time se pravi iluzija da
se predmet na jednoj slici transformise u predmet na drugoj slici. Slike treba da imaju 24-bitnu palet boja (true color)
i da budu is h dimenzija.

Program je besplatan, postoji u Windows verziji.

[1]h p://download.cnet.com/Free-Morphing/3000-2186 _4-10611758.html

1. http://download.cnet.com/Free-Morphing/3000-2186_4-10611758.html

FotoMorph (2011-06-01 23:49) - darthewok

FotoMorph je besplatan program za morfing, warping i kombinovanje slika u animaciju. Efek se dobijaju tako sto se
ucita pocetna i krajnja slika i u zavisnos od toga sta zelite, podesite opcije u programu. Kada je u pitanju morfing,
tada treba da postavite kontrolne tacke na pocetnoj i krajnjoj slici. Pozeljno je da slike budu is h dimenzija. Dimenzije
mozete korigova u nekom programu za obradu slika.

Program je besplatan i postoji u verziji za Windows.

[1]h p://www.diphso.no/FotoMorph.html

Ovaj video je uradjen u programu FotoMorph.

[youtube=h p://www.youtube.com/watch?v=5 _BN7iZBJ _w]

1. http://www.diphso.no/FotoMorph.html

FotoMix (2011-06-01 23:59) - darthewok

FotoMix je program uz pomoc koga mozete na lak nacin da obradite slike. Mozete seci, ro ra , menja dimenzije,
miksova , i na drugi nacin obradjiva slike.

Program je besplatan i postoji u verziji za Windows.
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[1]h p://www.diphso.no/FotoMix.html

1. http://www.diphso.no/FotoMix.html

WinMorph (2011-06-04 16:08) - darthewok

WinMorph je program za mofring i warping. Moze da radi kao zaseban program ili kao plugin za Wax.

Besplatan je, postoji u verziji samo za Windows.

[1]h p://www.debugmode.com/winmorph/

1. http://www.debugmode.com/winmorph/

OpenShot (2011-06-05 14:01) - darthewok

OpenShot je ne linearni video editor za Linux. Jednostavan je za upotrebu i nije prenatrpan kojekakvim opcijama koje
nikada necete koris .

- Podrzava mnogo audio video formata, kao i formata slika.
- Integrise se u Gnome (podrska za drag and drop).
- Vise traka za audio video sadrzaj. Na pocetku se vide samo dve, ali ih mozete doda koliko vam treba.
- Moguce je skraciva , seci, spoji i ubaci video.
- Video tranzicije sa prikazom u realnom vremenu.
- 3D animirani tlovi (Potrebno je da je instaliran Blender).
- Templej za naslove i tlove.
- Skrol teksta.
- Enkodovanje videa se zasniva na FFmpeg.
- Dosta predefinisanih efekata.
- Dosta templejta za efekte tranzicije.

i jos dosta toga...

[1]h p://www.openshot.org/

1. http://www.openshot.org/
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darthewok (2011-06-23 01:48:27)
Malo sam preuranio sa pohvalama. Prilikom detaljnijeg tes ranja verzije 1.3.1 na Fedori 14. Desavalo se da program izle u
Linux, bez ikakvog upozorenja. To se u vecini slucajeva desavalo, kada sam hteo da primenim efekat tranzicije na naslov ( tle).
Tako da preporucujem cesto snimanje projekta ili ukljucivanje opcije za automatsko snimanje na odredjeni vremenski period,
na primer na 10 minuta. Ovo cu da tes ram i na Fedori 15 na drugom kompjuteru. Pa cu napisa komentar o tome.

AV Linux (2011-06-05 14:09) - darthewok

AV Linux je live distro baziran na Debianu. Moguce ga je i instalira na hard disk. AV Linux pretvara PC u radnu stan-
icu za audio i video obradu. Svi znacajniji open source projek vezani za audio, video i grafiku su zastupljeni u ovoj
distribuciji.

[1]h p://www.bandshed.net/

1. http://www.bandshed.net/

Fedora 15 i Gnome 3 (2011-06-09 15:23) - darthewok

Proslo je nekih dvadesetak dana od kako se pojavila Fedora 15 (finalna verzija) i nekoliko dana kako sam je instalirao i
tes rao. Kao sto verovatno znate ili mozda ne, Fedora 15 dolazi sa Gnome 3 desktopom. Prelazak sa Fedore 14 na Fe-
doru 15 se moze uporedi sa prelaskom sa Windowsa XP na Windows 7. Gnome 3 se dras cno razlikuje od prethodne
verzije.

Prvi u sci o Fedori 15 su pozi vni. Instalacija je prosla iznenadjujuce brzo (dvd verzija), s obzirom na kolicinu so -
vera koji se instalira. Fedora 15 se mnogo brze ucitava od Fedora 14 sto je znacajan napredak, jer se i Fedora 14
pristojno brzo ucitavala.

Sto se ce Gnome 3, na forumima se podiglo dosta prasine. Moje misljenje je da se ljudi tesko privikavaju na promene,
pogotovo na dras cne. Posle malo privikavanja, meni Gnome 3 desktop sasvim odovara. Ergonomski je jako lepo re-
sen i brzo se dolazi do programa koji mi trebaju. Ima nekoliko sitnica koje mi se ne svidjaju kod Gnome 3. Kao prvo,
odmah upada u oci da na desktopu vise ne funkcionise desni taster misa, pa je promena wallpapera na desktopu malo
komplikovanija, morate uci u podesavanje sistema i odande promeni wallpaper. Ostale stvari koje mi se nisu dopale
se lako resavaju isntaliranjem dodatnih paketa koje cu naves u sledecem pasusu.

Preporucio bih Vam instalaciju sledecih paketa za poboljsanje Gnome 3 desktopa. Preporucujem Vam da ih instali-
rate odmah posle instalacije Fedore 15.
- gnome-shell-extensions-alterna ve-status-menu - (razdvaja suspend i power off i dodaje hibernate)
- gnome-shell-extensions-common
- gnome-shell-extensions-places-menu - (dodaje menu u sistem status koji podseca na Places menu iz Gnome 2.x)
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- gnome-tweak-tool

Mali tutorijal o koriscenju Gnome 3 u Fedori 15 mozete pogleda ovde:

[youtube=h p://www.youtube.com/watch?v=joBXc3IGRBw]

acinic (2011-07-08 13:45:07)
Gnome 3 je jos uvek slabo podesiv! Ja se mucim sa ovim extenzijama za shell! Najbolja stvar kod Fedore 15 je sto instaler radi
savrseno. Za razliku od Ubuntu instalera 11.04 verzija! Iri ra kod Fedore 15 i to sto sam morao da dopisujem u liniju kernela
”ro nomodese”. Za sada sam zadovoljan Fedorom 15. Mada mi je Mint 11 default.

darthewok (2011-07-08 15:46:40)
Kada sam instalirao Fedoru 15, nista nisam morao da dopisujem. Jedina stvar, koju sam rucno uradio je izbor paketa koji ce
se instalira . Sto se ce ekstenzija, ne znam koje prave problem i koje zelis da instaliras, ove sto sam naveo u tekstu rade
kako treba. Ako trebaju jos neke ekstenzije, lako ih mozes instalira . Idi u System Tools meni i odatle pokreni Add/Remove
So ware u pretragu ukucaj gnome-shell-extensions i izlistace ekstenzije koje se nalaze na Fedorinom repozitorijumu.

Kako modifikova sat da prikazuje i datum u Fedori 15 (2011-06-11 00:04) - darthewok

Ovo mozete uadi na vise nacina.

1. Pokrenite terminal

Za prikaz datuma ukucajte komandu u terminalu:
gse ngs set org.gnome.shell.clock show-date true

Da bi ste prikazali sekunde ukucajte komandu u terminalu:
gse ngs set org.gnome.shell.clock show-seconds true

2. Instalirajte dconf-editor ako ga niste instlairali.
U terminalu ukucajte: dconf-editor, kada se otvori prozor editora, kliknite na org -> gnome -> shell -> clock
Za prikaz datuma s klirajte show-date, a za prikaz sekundi s klirajte show-seconds

3.Instalirajte gnome-tweak-tool ako ga niste instalirali.
Iz menija Applica ons -> Accessories pokrenite Tweak Advanced Se ngs, kliknite na shell i tu ukljucite opciju za prikaz
datuma (Show date in clock).
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Podesavanje dugmica na naslovnoj liniji prozora ( tlebar) u Fedori 15 (2011-06-11 00:11) - darthewok

Po defaultu se ne vide dugmici za minimiziranje i maksimiziranje prozore. Da bi ste ih ukljucili instalirajte gnome-
tweak-tool.

Iz menija Applica ons -> Accessories pokrenite Tweak Advanced Se ngs, kliknite na shell i tu u padajucem meniju
stavke Arrangement of bu ons on the tlebar izaberite opciju All da bi ste ak virali dugmice za maksimizaciju i mini-
mizaciju prozora.

Ak viranje ikona na desktopu u Fedori 15 (2011-06-11 00:15) - darthewok

Instalirajte gnome-tweak-tool ako ga niste instalirali.
Iz menija Applica ons -> Accessories pokrenite Tweak Advanced Se ngs, kliknite na File Manager i ak virajte opciju
Have file manager handle the desktop.

Op mizacija Fedore 15 i zatvaranje nepotrebnih otvorenih portova (2011-06-11 17:20) - darthewok

Ovako sam op mizovao moju instalaciju Fedore 15 i prilagodio mojim potrebama.
O ostalim podesavanjima Fedore 15 mozete cita u prethodnim clancima.
Ako su Vam neki programi ili servisi potrebni ili ne znate cemu sluze, nemojte ih iskljuciva !!!

- Podesavanje fstab:

Dodao sam opciju noa me u stavke u fajlu fstab. O tome sam vec pisao, ali da podse m. Da bi poboljsali performanse
u Linuxu i (kazu ljudi) produzili vek hard diska, korisno je u fajlu etc/fstab postavi za svaku stavku opciju noa me ili
barem tamo gde to nije potrebno. Opcija noa me je posebna opcija za mountovanje fajl sistema koja sprecava upi-
sivanje vremena pristupa odredjenom fajlu. Prilikom citanja fajla se vrsi upisivanje vremena pristupa fajlu, pa samim

m, ukljucivanjem opcije noa me, se dobija na performansama sistema. Da bi ste mogli menja fstab fajl, morate
koris root nalog. U terminalu ukucajte: su -, za m ukucajte root sifru, pa ukucajte: gedit /etc/fstab

U mom primeru to izgleda ovako:

/dev/mapper/vg _disc-lv _root / ext4 defaults,noa me 1 1
UUID=d35169d8-578e-4d81-b7e3-743a6eccf3a9 /boot ext4 defaults,noa me 1 2
/dev/mapper/vg _disc-lv _home /home ext4 defaults,user _xa r,noa me 1 2
/dev/mapper/vg _disc-lv _swap swap swap defaults,noa me 0 0
tmpfs /dev/shm tmpfs defaults,noa me 0 0
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devpts /dev/pts devpts gid=5,mode=620 0 0
sysfs /sys sysfs defaults,noa me 0 0
proc /proc proc defaults,noa me 0

Dodato 27.1.2012:
Ako radite neke bekape podataka gde je potreban podatak o vremenu pristupa fajlu ili imate neke servere
kojima je potreban podatak o vremenu pristupa fajlu, ili Vam je iz nekog razloga potreban podatak o
vremenu pristupa fajlu, onda ne treba postavlje noa me u fstab.

- Podesavanje firewalla

Firewall mi je podesen da blokira sve dolazne upite. Ako imate neki server, onda morate podesi firewall da
propusta podatke na portovima koji su potrebni serveru. Ja Fedoru koris m kao desktop sistem i nisu mi potrebni
nikakvi serveri prema internetu.

Ovako mi izgleda iptables konfiguracioni fajl (/etc/sysconfig/iptables):

# Firewall configura on wri en by system-config-firewall
# Manual customiza on of this file is not recommended.
filter
:INPUT ACCEPT [0:0]
:FORWARD ACCEPT [0:0]
:OUTPUT ACCEPT [0:0]
-A INPUT -m state –state ESTABLISHED,RELATED -j ACCEPT
-A INPUT -p icmp -m icmp –icmp-type des na on-unreachable -j DROP
-A INPUT -p icmp -m icmp –icmp-type echo-reply -j DROP
-A INPUT -p icmp -m icmp –icmp-type echo-request -j DROP
-A INPUT -p icmp -m icmp –icmp-type parameter-problem -j DROP
-A INPUT -p icmp -m icmp –icmp-type redirect -j DROP
-A INPUT -p icmp -m icmp –icmp-type router-adver sement -j DROP
-A INPUT -p icmp -m icmp –icmp-type router-solicita on -j DROP
-A INPUT -p icmp -m icmp –icmp-type source-quench -j DROP
-A INPUT -p icmp -m icmp –icmp-type me-exceeded -j DROP
-A INPUT -p icmp -j ACCEPT
-A INPUT -i lo -j ACCEPT
-A INPUT -j DROP
-A FORWARD -j DROP
COMMIT

Slicno izgleda i ip6tables (/etc/sysconfig/ip6tables). Evo primera:

# Firewall configura on wri en by system-config-firewall
# Manual customiza on of this file is not recommended.
filter
:INPUT ACCEPT [0:0]
:FORWARD ACCEPT [0:0]
:OUTPUT ACCEPT [0:0]
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-A INPUT -m state –state ESTABLISHED,RELATED -j ACCEPT
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type des na on-unreachable -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type echo-reply -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type echo-request -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type parameter-problem -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type redirect -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type router-adver sement -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type router-solicita on -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type me-exceeded -j DROP
-A INPUT -p ipv6-icmp -j ACCEPT
-A INPUT -i lo -j ACCEPT
-A INPUT -j DROP
-A FORWARD -j DROP
COMMIT

- Iskljucivanje nepotrebnih servisa i portova:

Otvoreni portovi posle instalacije Fedore 15:

22/tcp open ssh (koris ga sshd)
25/tcp open smtp (koris ga sendmail)
111/tcp open rpcbind (koris ga rpcbind)
631/tcp open ipp (koris ga cups)
50022/tcp open rpc.statd (rpc.statd tcp port je promenljiv)

Da bi iskljucili nepotrebne servise i pozatvarali nepotrebne portove, otvori Terminal, ukuca su -, ukuca
root sifru, za m,

chkconfig mdmonitor off
chkconfig sendmail off
chkconfig sshd off
chkconfig pcscd off

CUPS
Servis za printer. Ako koris te printer ne iskljuciva cups servis.
chkconfig cups off

Servisi vezani za NFS
Ovde treba bi oprezan. Servisi nfs, nfslock i ne s zavise od rpc* servisa. Ako su rpc* servisi onesposobljeni, a nfs,
nfslock i ne s ukljuceni, moze doci do toga da sistem nece moci da se podigne. U tom slucaju treba pri snu taster
I (inerac ve boot, odmah na pocetku podizanja sistema, pre toga pri snu ctrl alt backspace) prilikom podizanja
sistema i rucno dozvoljava ili ne dozvoljava servisima da se pokrecu prilikom podizanja sistema i pri tome ne treba
pokreta servise nfs, nfslock i ne s, jer zavise od rpc* servisa. To sam sve probao u Fedori 14. U Fedori 15 nisam
tes rao kako se ponasa kada se iskljuce rpc* servisi, a nfs, nfslock i ne s ostanu ukljuceni, vec sam ih sve iskljucio.
Samo rpcbind drzi otvoren port 111, ali ako deljenje fajlova preko mreze nije potrebno, iskljuci i ostale servise.

chkconfig nfs off
chkconfig nfslock off
chkconfig ne s off
chkconfig rpcbind off
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chkconfig rpcgssd off
chkconfig rpcidmapd off
chkconfig rpcsvcgssd off

- Isklucivanje stavki koje Vam nisu potrebne iz startupa (gnome-session-proper es):

Caribou
Evolu on Alarm No fy
Orca Screen Reader
Remote Desktop

Op mizacija Fedore 16, zatvaranje nepotrebnih otvorenih portova i instaliranje nekih programa. « Kompjuteri (2011-11-26
09:20:39)
[...] Postupak za zatvaranje otvorenih portova i op mizaciju je skoro is kao u tekstu za Fedoru 15. [...]

Kako pronaci podesavanja za adsl modem ili ruter? (2011-06-14 14:49) - darthewok

Kako pronaci podesavanja za adsl modem ili ruter? Ova pitanja sam dobio kao komentar na video tutorijal za podesa-
vanje Wireless AP na Youtube. Tamo sam postavio saze odgovor, ovde je malkice detaljnije.

U podesavanja adsl modema ili rutera se ulazi iz nekog web browsera. Pokrenite Operu ili Firefox i ukucajte IP adresu
adsl modema ili rutera u adress bar (polje gde se kucaju adrese, NE ONO za PRETRAGU sto ljudi imaju obicaj da rade,
pa im posle ne radi) lol. Obicno je 192.168.1.1, ali moze bi i neka druga. Adresu mozete sazna u opcijama za pode-
savanje mreze na kompjuteru. Pod stavkom Gateway se nalazi IP adresa za adsl modem, odnosno ruter i tu adresu
kucate u Firefox ili Operu. Ako ste ukucali tacnu adresu, pojavice se podesavanja za adsl uredjaj ili ruter. Moze da se
desi da su podesavanja zas cena sifrom. U tom slucaju morate zna sifru. Kada su u pitanju ruteri, default (fabricka)
sifra pise u uputstvu za upotrebu (ako je Vi ili neko drugi nije naknadno promenio). Ako je u pitanju neki adsl uredjaj
domacih provajdera, onda uredjaj moze bi bez sifre ili sa sifrom koju postavi provajder, nekad se desi da bude i de-
fault sifra proizvodjaca uredjaja.

Uputstvo za povezivanje i podesavanje EchoLife HG520s. (2011-06-17 21:53) - darthewok

Uputstvo za povezivanje i podesavanje EchoLife HG520s.

Lampice na uredjaju i njihovo znacenje (s leva na desno):
- WLAN
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svetli - ak viran WLAN
trepce - u toku je prenos podataka
ne svetli - WLAN nije ak van
- LAN
svetli - prikljucen uredjaj na LAN port
trepce - u toku je prenos podataka
ne svetli - nije prikljucen uredjaj na LAN port
- INTERNET
svetli - uspostavljena internet veza
trepce - u toku je prenos podataka
ne svetli - nije uspostavljena internet veza
- ADSL
svetli - uspostavljena DSL veza
trepce - u toku je prenos podataka
ne svetli - nije uspostavljena DSL veza ili nije povezana telefonska linija
- POWER
svetli - HG520s je ukljucen
ne svetli - HG520s nije ukljucen

Tasteri i portovi sa zadnje strane:
- Antena - Antena za WLAN
- RESET - Taster za resetovanje uredjaja, ako se drzi pri snut duze od 3 sekunde, sva podesavanja ce bi resetovana
na fabricko podesavanje i sva korisnicka podesavanja izbrisana. Zato budite oprezni i NE PRITISKAJTE ga bez potrebe
i ako ne znate sta radite!
- POWER - U cnica za prikljucivanje ispravljaca za napajanje strujom.
- ON/OFF - Ukljucivanje i iskljucivanje
- LAN 1-4 - LAN portovi za prikljucivanje kompjutera i drugih mreznih uredjaja.
- ADSL - Prikljucak na telefonsku liniju.

Spliter:
Na spliteru se nalazi 3 prikljucka:
- LINE - Prikljucuje se kablom u telefonsku u cnicu u zidu.
- PHONE - Prikljucak za telefon. Ako imate vise telefona, svi telefoni moraju bi prikljuceni preko ovog prikljucka,
veza se ne sme paralelisa razdelnicima izmedju splitera i zidne u cnice. Ako imate vise telefona, telefonski razdelnik
prikljuci na PHONE prikljucak, a ostale telefone na telefonski razdelnik.
- MODEM - Prikljucak za prikljucivanje HG520s.

LAN portovi:
Kompjutere i ostale mrezne uredjaje prikljucujete mreznim kablovima na ove portove.

Podesavanje:
Prilikom podesavanja treba koris parametre za pristup internetu koje ste dobili od Vaseg internet provajdera, ako
su podesavanja pogresna, necete moci pristupi internetu.
- Fabricka IP adresa HG520s je 192.168.1.1, subnet mask je 255.255.255.0
- Da bi veza funkcionisala, Vas kompjuter mora da bude u istom mreznom opsegu kao i HG520s. U vecini slucajeva
kompjuteru ce bi automatski dodeljena IP adresa. Ako se to ne dogodi, proverite podesavanje mrezne kar ce i even-
tualno je rucno podesite, na primer da IP adresa bude 192.168.1.2 i subnet mask 255.255.255.0
- Pokrenite neki web browser, na primer Firefox ili Operu. U adress bar upisite h p://192.168.1.1
- Upisite korisnicko ime i sifru. Preporucujem da sifru kasnije promenite.
- HG520s bi trebalo da je automatski podesen od strane provajdera za pristup internetu, ako nije, izaberite Basic ->
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WAN Se ngs da bi se prikazala strana za podesavanje WAN veze. I tu upisite podesavanja koja ste (ako ste) dobili od
provajdera.

Podesavanje WLAN:
- Pokrenite neki web browser, na primer Firefox ili Operu. U adress bar upisite h p://192.168.1.1
- Izaberite opciju Basic -> Wireless Lan.
- U podesavanjima za WLAN mozete ukljuci ili iskljuci WLAN.
Access Point - moze bi Enable (ukljucen) ili Disable (iskljucen)
Channel ID - podesavanje kanala (frekvencije)
Authen ca on Type - Ovde birate vrstu zas te, ogranicenja pristupa
Opensystem - otvoreni sistem, moze se pristupi bez sifre (OVO NIKAKO NE SMETE KORISTITI)
WEP - slab sistem zas te, ni njega ne preporucujem
WPA-PSK/WPA2-PSK - preporuceni sistem za zas tu
Encryp on - Sifrovanje, postoje dve vrste u okviru WPA-PSK/WPA2-PSK, a to su TKIP i AES. Preporucujem da se koris
AES.

Telekom Srbije isporucuje ove uredjaje sa ak viranim WLAN i bez zas te sifrom, pa preporucujem da, ako ne ko-
ris te WLAN, da ga obavezno iskljucite. Ako ga koris te postavite WPA-PSK/WPA2-PSK zas tu i ukucajte sifru, koja je
dovoljno dugacka i dovoljno komplikovana da ne moze svako da je provali, a koju cete lako zapam .
Preporucujem i podesavanje Wireless MAC Address Filtera, kao dodatni nivo zas te.
Na kraju kliknite na Submit.

darthewok (2012-07-21 12:07:47)
Samo si mi poslao log, ali nisi prokomentarisao sta radis u trenutku kada imas taj problem i da li je na ruter/modem povezan
jedan kompjuter ili vise njih. Ako ih je povezano vise, proveri IP adrese povezanih kompjutera, ne smeju bi iste. Moguce da
automatsko dodeljivanje IP adresa pravi problem, na primer DHCP rutera automatski dodeli IP adresu povezanom kompjuteru,

ukljucis drugi, gde je rucno podesena IP adresa i IP adrese se preklope. Proveri IP adresu rutera, pretpostavljam da je
192.168.1.1 i subnet mask je 255.255.255.0. Takodje proveri i Lease Time na ruteru. Proveri da li je DHCP na ruteru ukljucen.
Na svim kompjuterima podesi automatski DHCP i automatski DNS. Ako to ne pomogne, probaj rucno da podesis. Povezanim
kompjuterima rucno dodelis IP adrese. Na primer stavi da IP adresa prvog kompjutera bude 192.168.1.10, drugom 192.168.1.11,
a subnet mask na oba kompjutera treba da bude 255.255.255.0 i iskljuci automatski DHCP na ruteru.

Nikola (2012-07-20 07:18:24)
1/1/2000 20:41:30> Last errorlog repeat 2 Times 1/1/2000 20:41:32> netMakeChannDial: err=-3001 rn _p=804d9b30 1/1/2000
20:41:39> Last errorlog repeat 9 Times 1/1/2000 20:41:40> ADSL Line:Show me 1/1/2000 20:41:40> netMakeChannDial:
err=-3001 rn _p=804d9b30 1/1/2000 20:41:41> Last errorlog repeat 5 Times 1/1/2000 20:41:41> MPOA Link Up 1/1/2000
20:41:41> Quick bridge not allow mul -channel 1/1/2000 20:41:41> bridge only stop 1/1/2000 20:41:41> Quick bridge not
allow mul -channel 1/1/2000 20:41:41> bridge only stop 1/1/2000 20:41:42> netMakeChannDial: err=-3000 rn _p=804d9b30
1/1/2000 20:41:42> ppp:PAP Opening 1/1/2000 20:41:42> ppp _ready: ch:805284f0, iface:804733e0 1/1/2000 20:41:42>
ppp:ch Up 1/1/2000 20:41:43> netMakeChannDial: err=-3000 rn _p=804d9b30 1/1/2000 20:41:44> Last errorlog repeat 5
Times 1/1/2000 20:41:44> Accept() fail 1/1/2000 20:41:44> Accept() fail 1/1/2000 20:41:46> netMakeChannDial: err=-3000 rn
_p=804d9b30
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Aleksandar (2012-08-16 22:52:35)
Pozz imam problem internet mi nestaje svakih 2 minuta na router su prikljucena 2 kompa i na oba se kubi internet probao
sam da rucno promenim IP ali nista i onda sam vra o DHCP I DNS na automatski ali i dalje nista evo errror log 1/1/2000
9:31:24> netMakeChannDial: err=-3000 rn _p=804d9b30 1/1/2000 9:31:34> Last errorlog repeat 136 Times 1/1/2000
9:31:34> netMakeChannDial: err=-3000 rn _p=804d9b30 1/1/2000 9:31:34> Last errorlog repeat 1 Times 1/1/2000 9:31:34>
netMakeChannDial: err=-3000 rn _p=804d9b30 1/1/2000 9:31:44> Last errorlog repeat 125 Times 1/1/2000 9:31:44> net-
MakeChannDial: err=-3000 rn _p=804d9b30 1/1/2000 9:31:44> netMakeChannDial: err=-3000 rn _p=804d9b30 1/1/2000
9:31:44> Last errorlog repeat 5 Times 1/1/2000 9:31:44> netMakeChannDial: err=-3000 rn _p=804d9b30 1/1/2000 9:31:45>
netMakeChannDial: err=-3000 rn _p=804d9b30 1/1/2000 9:31:55> Last errorlog repeat 110 Times 1/1/2000 9:31:55>
netMakeChannDial: err=-3000 rn _p=804d9b30 1/1/2000 9:31:55> Last errorlog repeat 1 Times 1/1/2000 9:31:55> net-
MakeChannDial: err=-3000 rn _p=804d9b30 molim te pomagaj :D

darthewok (2012-08-17 10:02:17)
Pozdrav, Probaj ovo jos jednom: Proveri IP adresu rutera, pretpostavljam da je 192.168.1.1 i subnet mask je 255.255.255.0.
Takodje proveri i Lease Time na ruteru. Proveri da li je DHCP na ruteru ukljucen. Na svim kompjuterima podesi automatski
DHCP i automatski DNS. Ako to ne pomogne, probaj rucno da podesis. Povezanim kompjuterima rucno dodelis IP adrese. Na
primer stavi da IP adresa prvog kompjutera bude 192.168.1.10, drugom 192.168.1.11, a subnet mask na oba kompjutera treba
da bude 255.255.255.0 i iskljuci automatski DHCP na ruteru. Takodje, probaj da iskljucis jedan od kompjutera, pa onda vidi da
li ce se pojavi ista greska. Ako ovo ne pomogne, onda ne znam sta bi moglo da bude, u tom slucaju, najbolje da se obra s
telekomu, jer ili su nesto poremeceni ADSL parametri u ruteru ili ruter nije ispravan. Nemam vise taj ruter, a ni ADSL, pa ne
mogu nista da probam kod mene.

Goran Pjevalica (2012-11-09 17:53:46)
Imam problem.stari ruter nije radio kako treba pa su mi poslali novi.Sada nece da ocita IP adresu,salje pakete ali ih neprima(local
area connec on limited connec vity or no connec vity) svasta sam pokusavao,cmd,reset,pravio novu konekciju,nemam iskustva
sa takvim stvarima.Jel mi moze neko pomoci?Na Wlan mogu preko laptopa al mi je neophodan kompijuter....

Goran Pjevalica (2012-11-09 21:28:56)
da napomenem da sam pre imao 520c a sada 520s

darthewok (2012-11-10 05:48:56)
Ako sam te dobro razumeo, radi konekcija preko wlana sa laptopa, a ne radi preko kompjutera koji je nakacen na ruter
preko lan kabla. Pogledaj parametre mreze na laptopu i uporedi ih sa onima na kompjuteru. Podesi iste parametre na
kompjuteru, samo na kompjuteru stavi drugu ip adresu. Na primer, ako je na laptopu ip adresa, 192.168.1.10, na kompjuteru
stravi neku drugu, na primer 192.168.1.20, a ostale parametre stavi iste kao na laptopu. Proveri da li je lan kabal ispravan,
probaj ga da li radi kod nekog tvog druga i obrnuto, uzmi neki lan kabal od druga i probaj kod tebe. Ako nije problem
do kabla, povezi ga na drugi lan port na ruteru. Da li svetli lan lampica na ruteru kada je ukljucen kompjuter u odgovara-
juci lan port? Proveri da li je ispravna lan kar ca na kompjuteru. Povezi laptop preko lan kabla i vidi da li ce tada radi konekcija.

Bozo (2014-07-21 06:59:30)
hvala

Bozo (2014-07-20 21:40:40)
kako da znam koje mi je korisnicko imme i sifra???

darthewok (2014-07-21 06:20:29)
Ako si uredjaj kupio u prodavnici, fabricko korisnicko ime i sifra pisu u uputstvu za upotrebu. Ako si uredjaj dobio od telekoma,
probaj jednu od ove dve kombinacije za korisnicko ime i sifru: user name: admin password: ztonpk ili user name: telekom
password: telekom
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Facebook i bezbedna konekcija (secure connec on - h ps) (2011-06-23 02:22) - darthewok

Prilikom logovanja na Facebook koris te bezbednu konekciju (h ps).

[1]h ps://www.facebook.com - Obra te paznju da u adresi umesto standardnog h p stoji h ps. Ako ukucate samo
www.facebook.com, uci cete na standardni h p, a ne h ps. Tako da u ovom slucaju morate kuca kompletnu adresu
h ps://www.facebook.com

Takodje, mozete, koristeci bezbednu (h ps) konekciju pregleda sadrzaj Facebook-a (gde god je to moguce). Da bi ste
to pos gli, treba da udjete u podesavanje Vaseg naloga na FB-u.

Kliknite na mali trouglic u gornjem desnom uglu (desno od Home) -> Account Se ngs -> Security
Tu kliknite na Secure Browsing i s klirajte opciju Browse Facebook on a secure connec on (h ps) when possible i na
kraju kliknite na Save Changes.

1. https://www.facebook.com/

Kdenlive (2011-06-24 03:45) - darthewok

Kdenlive je Open Source ne linearni video editor za Linux i FreeBSD. Kdenlive se oslanja na nekoliko drugih Open source
projekata, kao sto su FFmpeg, MLT Video Framework i FreiOr efek . Kdenlive je dizajniran da zadovolji podrebe od
osnovne do polu-profesionalne video montaze. Podrzan je veliki broj formata slika, audio i video kodeka. Poseduje
sirok spektar efekata i tranzicija. Mogucnost dodavanja novih efekata i tranzicija. Kdenlive poseduje sve ostale stvari
sto treba da poseduje so ver za obradu videa. Za razliku od OpenShot-a, Kdenlive nema fensi korisnicki interfejs i
nema integraciju sa Blenderom da bi se dobili fensi efek za 3d naslove/ tlove, ali je znatno stabilniji u radu. To sto
nije integrisan sa Blenderom, nije neka mana, jer ako Vam zatrebaju 3d efek za neki tekst naslova/ tla ili nesto drugo,
lako mozete to izrenderova u Blenderu i ubaci video klip u Kdenlive.

U komentaru koji sam napisao u clanku za OpenShot, sam najavio tes ranje u Fedori 15, da proverim da li se tamo sta-
bilnije ponasa, ali sam umesto toga tes rao Kdenlive, koga preporucujem za video montazu. Razvojni m OpenShota
ce mora da se potrudi da poradi na stabilnos programa, ako misli da bude konkurencija Kdenlive-u.

Lista default sifri za neke mrezne uredjaje (2011-06-29 23:41) - darthewok

Listu default sifri za neke mrezne uredjaje mozete vide na adresi:

[1]h p://www.phenoelit-us.org/dpl/dpl.html
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1. http://www.phenoelit-us.org/dpl/dpl.html

1.3 July

Save Images (2011-07-03 19:40) - darthewok

Save Images je dodatak za Firefox uz pomoc koga mozete jednim potezom sacuva sve slike na web strani u folder na
Vasem disku. Vrlo koristan dodatak, jer ne morate za svaku sliku klikta desnim tasteron na sliku, pa za m na Save
Image As.

Vise informacija o ovom dodatku za Firefox mozete naci na adresi:

[1]h ps://addons.mozilla.org/en-US/firefox/addon/save-images/

Takodje, na gore navedenoj adresi ga mozete i instalira .

1. https://addons.mozilla.org/en-US/firefox/addon/save-images/

TP-Link TL-WN722NC Wireless USB Adapter (2011-07-08 16:35) - darthewok

TL-WN722NC je bezicni WLAN USB adapter firme TP-Link. Podrzava WiFi b,g i n standarde. Tes rao sam ga par dana
i moji u sci su pozi vni. U pakovanju se, pored samog uredjaja dobija cd sa drajverima za Windows, uputstvo i pos-
tolje sa produznim USB kablom. Uredjaj sam tes rao u Linuxu, Fedora 15. Uredjaj je bio odmah prepoznat, cim sam
ga ukljucio u USB port, bez potrebe za instalacijom dodatnih drajvera ili nekih dodatnih podesavanja. Ako planirate
nabavku USB Wireless adaptera, preporucujem da razmislite o nabavci ovog modela. Ovaj uredjaj ima dve stvari koje
ga izdvajaju od mase slicnih uredjaja, a to su izmenjiva antena i elegantno postolje na kome stoji uredjaj.

Ono sto ga izdvaja od vecine drugih Wireles USB adaptera je sto poseduje antenu koja se nalazi prikacena sa spoljne
strane uredjaja. Antena moze i da se skine, i da se na dzek prikljuci produzni wifi kabl (na primer TP-Link TL-ANT24EC5S,
duzine 5m) i da se antena postavi na primer na terasu, gde je bolji prijem. Moguce je prikaci i druge pove antena,
na primer, omni antena firme TP-Link TL-ANT2408C ili usmerena yagi antena, takodje firme TP-Link sa oznakom TL-
ANT2409A cime se znacajno povecava kvalitet i domet signala.

Napomena za Fedoru 15!!! - dodato 12. oktobra 2011.

Ako Vam posle apdejta kernela na verziju 2.6.40.* ne radi vise TL-WN722NC, onda morate preuze noviju verziju firmw-
era za ovaj uredjaj. Noviji firmver mozete preuze sa adrese: [1]h p://wireless.kernel.org/download/htc _fw/1.3/htc
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_9271.fw
Za m, pokrenite terminal, ukucajte:
su - pri snite enter
ukucajte root sifru
iskopirajte fajl htc _9271.fw u folder /lib/firmware/ umesto originalnog (ako ga ima). Izvadite TL-WN722NC iz USB
prikljucka na kompjuteru i restartujte kompjuter, kada se sistem podigne, ponovo ukljucite TL-WN722NC u USB priklju-
cak na kompjuteru, sacekajte nekoliko sekundi i TL-WN722NC bi trebalo ponovo da radi kako treba.

1. http://wireless.kernel.org/download/htc_fw/1.3/htc_9271.fw

Nikola (2012-02-04 20:14:06)
Ljudi pomagajte imam problem sa predhodno pomenu m usb wireless adapterom. Nece da se konektuje.

Nikola (2012-02-04 20:17:43)
Ljudi pomagajte imam problem sa predhodno pomenu m usb wireless adapterom. Nece da se konektuje. :(

darthewok (2012-02-04 21:37:18)
Ako koris s Linux i Gnome graficki interfejs. Klikni desnim tasterom misa na ikonu mrezne konekcije (pored sata) i za m
levim tasterom klikni na Enable Wireless (ako je disable-ovan). Ponovo klikni, ovaj put, levim tasterom misa na ikonu mrezne
konekcije i bice prikazan spisak bezicnih pristupnih tacaka (access point) koji su u dometu. Klikom misa na neki od slobodnih
”access pointa” (dosta kafica u centru grada i na Adi ima slobodan pristup) ili na onaj koji predstavlja tvoj ruter uspostavljas
vezu, ako si svoju bezicnu mrezu zas o sifrom, onda jos ukucaj i sifru u dijalog za unos sifre koji se pojavi kada kliknes na
zas cen ”access point”.

Prebacivanje .mdx u .iso (2011-07-15 00:13) - w1ndu

Iako image format .mdx (mds + mdf) ima odredjenih prednos , ponekad zaista nema potrebe za njim a nedostatak
kompa bilnos koju pruza .iso moze da predstavlja problem. Da bi se ovo premos lo, lak nacin za konverziju pruza
program Daemon Tools Lite. Potpuno je besplatan za licnu i nekomercijalnu upotreba, a mdx podrska je ugradjena od
v4.35.6.

Uputstvo:

1. Skinite i instalirajte [1]DTL.
2. U koliko ni jedan virtuelni cd/dvd nije napravljen kliknite Add Device da bi ste ga formirali.
3. Desni klik na Device > Mount > izaberite zeljeni mdx fajl. Ovo ce pokrenu image, izadjite iz njega i vra te se u DTL.
4. Kliknite Make Disc Image, pod Device izaberite prethodno formirani virtuelni dvd u kome je sad mdx image & pod
Des na on image file izaberite .iso extenziju.
5. Kliknite Start i program ce snimi novi image sa .iso extenzijom.

Iso fajl mozete dalje koris na standardan nacin (mountovanje, rezanje) u gotovo svim programima za rad sa diskovima.
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1. http://www.daemon-tools.cc/eng/products/dtLite

Goran (2011-08-25 23:19:35)
Hvala Za Savet

Gimp tutorijal 01 (2011-07-17 19:40) - darthewok

Prvi u nizu, od nekoliko planiranih, tutorijala za Gimp sam postavio na Youtube.

[youtube=h p://www.youtube.com/watch?v=u5IJTnTz49Y]

Gimp tutorijal 02 (2011-07-18 12:11) - darthewok

Posto sada mogu da postavljam video klipove koji su duzi od 15 minuta na Youtube, ponovo sam postavio drugu epi-
zodu tutorijala za Gimp, ovog puta je iz jednog dela i nije vise podeljen u dva dela. :)

U ovom tutorijalu je prikazan proces fotomontaze, ubacivanje elemenata jedne slike u drugu, alat za selekciju, lejeri,
lejer mask.

[youtube=h p://www.youtube.com/watch?v=MJTpZ37KwEQ]

Gimp tutorijal 03 (2011-07-19 12:49) - darthewok

Treci u nizu, od nekoliko planiranih, tutorijala za Gimp sam postavio na Youtube.

Primena layer mask prilikom promene boje objekata na fotografiji.

[youtube=h p://www.youtube.com/watch?v=FcrobCWV7BI]
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Gimp tutorijal 04 (2011-07-20 12:44) - darthewok

Cetvr tutorijal za Gimp sam postavio na Youtube.

Paterni, promena pozadine slike, promena boje ociju alatom colorize.

[youtube=h p://www.youtube.com/watch?v=BbcHWWTIR08]

Gimp tutorijal 05 (2011-07-21 01:45) - darthewok

Pe tutorijal za Gimp sam postavio na Youtube.

Poredjenje alata Hue-Satura on i Colorize.

[youtube=h p://www.youtube.com/watch?v=aMssTP2USOs]

Gimp tutorijal 06 (2011-07-21 13:19) - darthewok

Ses tutorijal za Gimp sam postavio na Youtube.

U ovom tutorijalu je prikazan jednostavan proces obrade fotografije. Upotrebljeni su ala za rotaciju, secenje, pode-
savanje kontrasta i izostravanje.

[youtube=h p://www.youtube.com/watch?v=0bvdzaCN2Qo]
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Gimp tutorijal 07 (2011-07-21 15:51) - darthewok

Uklanjanje efekta crvenih ociju.

[youtube=h p://www.youtube.com/watch?v=sIgBlQGLM4A]

Gimp tutorijal 08 (2011-07-22 11:52) - darthewok

Zamucenje pozadine fotografije i is canje subjekta u prvi plan uz pomoc gaussian blur filtera.

[youtube=h p://www.youtube.com/watch?v=9kC8eGlmbdQ]

Gimp tutorijal 09 (2011-07-23 17:21) - darthewok

Konverzija kolor fotografije u crno belu i filter Old Photo iz FX Foundry i G’MIC pluginova.

[youtube=h p://www.youtube.com/watch?v=v987pumJnAQ]

Gimp tutorijal 10 (2011-07-24 09:37) - darthewok

Pravljenje wallpapera za desktop. Smanjenje zrnastos fotografije (uklanjanje digitalnog suma), layer modovi, layer
mask, blend tool.

[youtube=h p://www.youtube.com/watch?v=f1IH8NhLvb0]
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Gimp tutorijal 11 (2011-07-25 10:42) - darthewok

Pravljenje novih braseva.

[youtube=h p://www.youtube.com/watch?v=qvoFs1T2Cvw]

Gimp tutorijal 12 (2011-07-26 09:59) - darthewok

Pravljenje pa erna.

[youtube=h p://www.youtube.com/watch?v=4BDSOJ8SkTQ]

Screengrab (2011-07-26 13:08) - darthewok

Screengrab je dodatak za Firefox koji moze da sacuva web stranu, kao sliku. Moze ”uhva ” kompletnu web stranu,
deo koji trenutno vidite u prozoru ili deo koji izaberete. Slika moze bi snimljena na disk ili iskopirana u clipboard.

[1]h ps://addons.mozilla.org/en-US/firefox/addon/screengrab/

1. https://addons.mozilla.org/en-US/firefox/addon/screengrab/

Video DownloadHelper (2011-07-26 13:16) - darthewok

Video DownloadHelper je dodatak za Firefox koji omogucava jednostavan nacin za preuzimanje video klipova sa
YouTube-a i slicnih sajtova.

[1]h ps://addons.mozilla.org/en-US/firefox/addon/video-downloadhelper/

1. https://addons.mozilla.org/en-US/firefox/addon/video-downloadhelper/
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Gimp tutorijal 13 (2011-07-26 17:57) - darthewok

U ovoj epizodi je opsian alat za tekst i primer koriscenja tekst alata za pravljenje logoa.

[youtube=h p://www.youtube.com/watch?v=M28Pb7lUdvM]

Gimp tutorijal 14 (2011-07-26 21:17) - darthewok

Pravljenje Logo-a.

[youtube=h p://www.youtube.com/watch?v=2gVE _HzkoKg]

Gimp tutorijal 15 (2011-07-27 07:51) - darthewok

Foto montaza, koriscenje layera, layer mask.

[youtube=h p://www.youtube.com/watch?v=B8ND2ChkWVM]

Gimp tutorijal 16 (2011-07-27 22:49) - darthewok

Prikaz Wacom Bamboo One tableta i olovke. Retusiranje portreta, uklanjanje bora, mladeza i bubuljica upotrebom
heal, blur, smudge i wavelet decompose.

[youtube=h p://www.youtube.com/watch?v=ZNcOcK9BdIo]
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Gimp tutorijal 17 (2011-07-28 15:50) - darthewok

Liquid rescale.

[youtube=h p://www.youtube.com/watch?v=VpUXakAifC0]

Gimp tutorijal 18 (2011-07-28 23:08) - darthewok

U ovom tutorijalu su prikazani pluginovi IWarp i Smart remove selec on.

[youtube=h p://www.youtube.com/watch?v=x2FtKWg8pHU]

UFO Alien Invasion (2011-07-30 21:22) - darthewok

UFO AI je Open Source strateska igra, koja nastavlja tradiciju X-COM igara s pocetka devedese h. Razvija se za Win-
dows, Linux i MAC. Koris modifikovani Quake 2 endzin. Igra se moze igra u ”single player” ili ”mul player” rezimu.
Mul player se moze igra u lokalnoj mrezi ili preko interneta. U ”single player” rezimu postoje dva moda za igranje
kampanja i skirmish. Skirmish je tak cki ”squad-based” okrsaj, dok je kampanja potpuna igra koja se sastoji iz tak-

ckog dela na skirmis mapama i menadzerskog dela, gde se grade baze i regrutuju vojnici, naucnici, kupuju oruzja i
slicno.

Ako koris te Linux, vrlo verovatno da ce se igra naci u repozitorijumu Vase Linux distribucije.

[1]h p://ufoai.ninex.info/

1. http://ufoai.ninex.info/
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1.4 August

20 godina Linuxa (2011-08-01 15:26) - darthewok

Promo vni video povodom 20 godina Linuxa :)

[youtube=h p://www.youtube.com/watch?v=5ocq6 _3-nEw]

Slobodni so ver (2011-08-02 09:36) - darthewok

Ovde je deo teksta iz [1]clanka na Wikipediji. Na [2]Wikipediji mozete vide [3]kompletan tekst.

Slobodni so ver, kako ga definiše [4]Zadužbina za slobodni so ver, je [5]so ver koji se može koris , umnožava ,
proučava , menja i distribuira dalje bez ograničenja. [6]Sloboda od takvih ograničenja je u središtu koncepta ”slo-
bodnog so vera”, tako da suprotnost slobodnom so veru čini [7]vlasnički so ver, a ne so ver koji se prodaje radi
zarade, kao što je [8]komercijalni so ver. Prethodno se često naglašava zato što reč free na [9]engleskom ima dva
značena - slobodan i besplatan. Slobodan so ver se zbog toga ponekad naziva i libre so ware i [10]FLOSS a koris se
i sintagma [11]so ver otvorenog izvornog koda (open source so ware), koja ima srodno, ali ne i isto, značenje.

Po Stalmanu i [12]ZSS, licenca ”slobodnog” so vera dozvoljava:

• slobodu da se program pokreće u bilo koju svrhu (zvana ”nulta sloboda” - ”freedom 0”)

• slobodu da se program proučava i menja (”prva sloboda” - ”freedom 1”)

• slobodu da se program umnožava da bi se pomoglo bližnjem (”druga sloboda” - ”freedom 2”)

• slobodu da se program poboljšava i da se te promene puštaju u javnost, tako da cela zajednica ima koris (”treća
sloboda” - ”freedom 3”)

1. http://sr.wikipedia.org/wiki/%D0%A1%D0%BB%D0%BE%D0%B1%D0%BE%D0%B4%D0%BD%D0%B8_%D1%81%D0%BE%D1%84%D1%82%D0%B
2%D0%B5%D1%80
2. http://sr.wikipedia.org/wiki/%D0%A1%D0%BB%D0%BE%D0%B1%D0%BE%D0%B4%D0%BD%D0%B8_%D1%81%D0%BE%D1%84%D1%82%D0%B
2%D0%B5%D1%80
3. http://sr.wikipedia.org/wiki/%D0%A1%D0%BB%D0%BE%D0%B1%D0%BE%D0%B4%D0%BD%D0%B8_%D1%81%D0%BE%D1%84%D1%82%D0%B
2%D0%B5%D1%80
4. http://sr.wikipedia.org/wiki/%D0%97%D0%B0%D0%B4%D1%83%D0%B6%D0%B1%D0%B8%D0%BD%D0%B0_%D0%B7%D0%B0_%D1%81%D0%
BB%D0%BE%D0%B1%D0%BE%D0%B4%D0%BD%D0%B8_%D1%81%D0%BE%D1%84%D1%82%D0%B2%D0%B5%D1%80
5. http://sr.wikipedia.org/wiki/%D0%A1%D0%BE%D1%84%D1%82%D0%B2%D0%B5%D1%80
6. http://sr.wikipedia.org/wiki/%D0%A1%D0%BB%D0%BE%D0%B1%D0%BE%D0%B4%D0%B0
7. http://sr.wikipedia.org/w/index.php?title=%D0%92%D0%BB%D0%B0%D1%81%D0%BD%D0%B8%D1%87%D0%BA%D0%B8_%D1%81%D0%
BE%D1%84%D1%82%D0%B2%D0%B5%D1%80&action=edit&redlink=1
8. http://sr.wikipedia.org/w/index.php?title=%D0%9A%D0%BE%D0%BC%D0%B5%D1%80%D1%86%D0%B8%D1%98%D0%B0%D0%BB%D0%B
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D%D0%B8_%D1%81%D0%BE%D1%84%D1%82%D0%B2%D0%B5%D1%80&action=edit&redlink=1
9. http://sr.wikipedia.org/wiki/%D0%95%D0%BD%D0%B3%D0%BB%D0%B5%D1%81%D0%BA%D0%B8_%D1%98%D0%B5%D0%B7%D0%B8%D0%B
A
10. http://sr.wikipedia.org/w/index.php?title=FLOSS&action=edit&redlink=1
11. http://sr.wikipedia.org/wiki/%D0%A1%D0%BE%D1%84%D1%82%D0%B2%D0%B5%D1%80_%D0%BE%D1%82%D0%B2%D0%BE%D1%80%D0
%B5%D0%BD%D0%BE%D0%B3_%D0%B8%D0%B7%D0%B2%D0%BE%D1%80%D0%BD%D0%BE%D0%B3_%D0%BA%D0%BE%D0%B4%D0%B0
12. http://sr.wikipedia.org/wiki/%D0%97%D0%B0%D0%B4%D1%83%D0%B6%D0%B1%D0%B8%D0%BD%D0%B0_%D0%B7%D0%B0_%D1%81%D
0%BB%D0%BE%D0%B1%D0%BE%D0%B4%D0%BD%D0%B8_%D1%81%D0%BE%D1%84%D1%82%D0%B2%D0%B5%D1%80

Brisanje Flash Cache-a (2011-08-07 14:29) - w1ndu

Dok je brisanje cache-a browsera i Jave rela vno jednostavno, kod Flash plugina stvari su do skora bile malo komp-
likovanije. Ponekad je ovo neophodno i preporucljivo iz sigurnosnih razloga, a isto vazi i za promenu pojedinih Flash
se ngsa.

Da bi ste obrisali Flash cache, jednostavno pose te [1]ovaj link i kliknite Delete all sites. Na istoj stranici mozete
podesava razlicite parametre vezane za sigurnost i privatnost. Recimo pristup kameri i mikrofonu po pojedinacnim
sajtovima, jer se desi da korisnik dozvoli nekom sajtu stalni pristup ovim resursima, bez ociglednog nacina da vra na
always ask.

Ovo sve vazi za prethodne verzije Flasha, jer je Adobe u poslednjoj verziji (10.3) dodao veoma zgodan interfejs za
podesavanje u lokalu. Moguce mu je pristupi kroz Control Panel i ima sve funkcije kao i online verzija.

1. http://www.macromedia.com/support/documentation/en/flashplayer/help/settings_manager07.html

zsnes (2011-08-14 22:04) - darthewok

Zsnes je emulator za Super Nintendo igracku konzolu. Razvija se za Windows, Linux i DOS. Da bi ste igrali igre za Super
Nintendo, potrebni su Vam jos i ROM fajlovi, koji predstavljaju imidz fajlove kertridza, koji su se koris li na ovoj konzoli.
ROM fajlove mozete naci i skinu na mnogim internet sajtovima koji se bave emulatorima. Dostupno je vise sto na
igara za ovu konzolu.

Ako koris te Linux, vrlo verovatno da ce se zsnes naci u repozitorijumu Vase Linux distribucije. Ako ga slucajno nema
u Vasoj distribuciji ili koris te Windows, mozete ga preuze sa zvanicnog sajta.

[1]h p://www.zsnes.com/

1. http://www.zsnes.com/
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MAME (2011-08-15 00:17) - darthewok

MAME je emulator arkadnih masina. Rec MAME je skracenica za ”Mul ple Arcade Machine Emulator”. MAME radi u
kombinaciji sa ROM fajlovima. MAME emulira nekoliko hiljada klasicnih arkadnih igara iz kasnih 1970- h godina, pa
sve do savremenih igara. ROM fajlove mozete naci i skinu na mnogim internet sajtovima koji se bave emulatorima.

Na oficijelnom sajtu mozete preuze izvorni kod ili prekompajlirani binarni fajl za Windows. Ako koris te Linux, vrlo
verovatno da ce se MAME naci u repozitorijumu Vase Linux distribucije.

[1]h p://mamedev.org/

1. http://mamedev.org/

Be erPrivacy (2011-08-19 15:48) - darthewok

Be erPrivacy je dodatak za Firefox koji omogucava prikaz i upravljanje fles kolacicima (Flash-cookies), odnosno LSO
objek ma (Local Shared Objects). Fles kolacici (LSO) su informacije koje postavlja Flash plugin. LSO se cesto koriste
kao i standardni kolacici (cookies).

Be erPrivacy moze automatski izbrisa LSO na vise nacina, koje mozete definisa . Prilikom pokretanja Firefoxa, izlaska
iz Firefoxa i posle isteka vremenskog perioda koji mozete definisa po zelji. Takodje nudi i opciju rucnog brisanja LSO.
Postoji i mogucnost zas te od brisanja, pojedinih LSO koji su Vam potrebni.

Mozete ga preuze i pogleda detaljnije informacije na adresi: [1]h ps://addons.mozilla.org/en-US/firefox-
/addon/be erprivacy/

1. https://addons.mozilla.org/en-US/firefox/addon/betterprivacy/

Cookie Monster (2011-08-19 16:44) - darthewok

Cookie Monster pruza proak vno upravljanje kolacicima (cookies) na web sajtu ili na nivou domena, ukljucujuci i 3rd
party kolacice. Preko status bara, pruza jednostavan pristup do opcija za funkcionalnost kolacica.
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Dodatak mozete preuze sa adrese: [1]h ps://addons.mozilla.org/en-US/firefox/addon/cookie-monster/

1. https://addons.mozilla.org/en-US/firefox/addon/cookie-monster/

PrivacySuite (2011-08-19 16:59) - darthewok

PrivacySuite je najkompletniji dodatak za Firefox iz oblas zas te privatnos . Takodje je i ubedljivo najveci dodatak
koji sam video, fajl koji sam preuzeo sa interneta je oko 1.5 Mb.

Neke od opcija:
Pregled informacija koje se cu privatnos na sajtu
Blokira web trackere i web bugove
Kontrola browser, DOM i Flash kolacica
Kontrola Vasih naloga s jednog mesta
AutoFill s iden te ma pod Vasom kontrolom
Opt-out ciljanog oglasivaca

Mozete ga preuze sa ove adrese: [1]h ps://addons.mozilla.org/en-US/firefox/addon/privacysuite/

Ovde mozete vide kratak uvodni video za PrivacySuite.

[youtube=h p://www.youtube.com/watch?v=6uyG6YT9rKc]

1. https://addons.mozilla.org/en-US/firefox/addon/privacysuite/

Do Not Track Plus « Kompjuteri (2012-04-28 01:24:28)
[...] je sprecavanje pracenja korisnika. Dodatak razvija firma Abine. Ista firma razvija i dodatak Privacy Suite za Firefox, o kome
sam vec pisao. Dodatak blokira vise od 600 reklamnih i drugih kompanija koje prate korisnikove ak vnos na [...]

shouldichangemypassword.com (2011-08-21 07:13) - darthewok

ShouldIChangeMyPassword.com je stvoren da pomogne prosecnom internet korisniku da proveri da li je njegova email
sifra ugrozena i da li je treba obavezno promeni .
Ovaj sajt koris nekoliko baza podataka koje su objavljene u javnost.

[1]h ps://shouldichangemypassword.com/
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1. https://shouldichangemypassword.com/

User Agent Switcher (2011-08-24 03:29) - darthewok

User Agent Switcher je dodatak za Firefox koji menja ”iden fikaciju” Firefoxa u neki drugi web browser, da izgleda,
kao da surfujete internetom iz nekog drugog web browsera na primer Internet Explorer, Googlebot, IPhone itd...

[1]h ps://addons.mozilla.org/en-US/firefox/addon/user-agent-switcher/

1. https://addons.mozilla.org/en-US/firefox/addon/user-agent-switcher/

Advanced Cookie Manager / Editor (2011-08-24 03:32) - darthewok

Advanced Cookie Manager / Editor je dodatak za Firefox koji omogucava izmenu postojecih kolacica (cookies) ili ubaci-
vanje novih. Koristan alat za pravljenje i tes ranje web stranica sa kolacicima.

[1]h ps://addons.mozilla.org/en-US/firefox/addon/cookie-manager/

1. https://addons.mozilla.org/en-US/firefox/addon/cookie-manager/

RefControl (2011-08-24 03:40) - darthewok

RefControl je dodatak za Firefox koji konrolise sta se salje kao HTTP Referer. Koristan dodatak za kontrolu privatnos .
Mozete definisa ”default” referer koji se salje svim sajtovima koje posecujete ili mozete napravi listu sajtova i za
svaki definisa koji ce referer bi poslat za svaki sajt pojedinacno. Ne mora svako da zna sa kog ste sajta dosli.

[1]h ps://addons.mozilla.org/en-US/firefox/addon/refcontrol/

1. https://addons.mozilla.org/en-US/firefox/addon/refcontrol/

133

https://shouldichangemypassword.com/
https://addons.mozilla.org/en-US/firefox/addon/user-agent-switcher/
https://addons.mozilla.org/en-US/firefox/addon/cookie-manager/
https://addons.mozilla.org/en-US/firefox/addon/refcontrol/


KBasic (2011-08-25 11:37) - darthewok

KBasic je programski jezik, koji je jednostavan, intui van i lako se uci. KBasic je jos jedna verzija Basic programskog
jezika. Podseca na Visual Basic, autori kazu da je kompa bilan sa Visual Basic, VBA i QBasic. Dakle, mozete ucita neki
Basic izvorni kod iz h starih programa i koris ga. Naravno s jednim ogranicenjem, jer ako je u VB-u koriscen neki
Windows API, to nece radi u Linuxu, pa to morate preradi , isto vazi i za QB, ako je koriscen neki programski kod koji
je specifican za DOS. Za razliku od jedne od ranijih verzija koju sam probao pre nekoliko godina, prime o sam znaca-
jan napredak u op mizaciji kompajliranog fajla. Ranije je kompajlirani fajl bio preko 70 mb sto je stvarno previse!! U
verziji 1.89 iz prvog decembra 2010. kompajlirani fajl je sveden na nekih 8 mb, sto je podnosljivo.

KBasic se razvija za Linux, Windows i Mac. Jedino je verzija za Linux besplatna za Open Source So ver.

[1]h p://www.kbasic.com/

1. http://www.kbasic.com/

Highpass sharpening (2011-08-26 19:57) - darthewok

Highpass sharpening je skripta za Gimp koja vrsi izostravanje slike tehnikom koja je opisana u videopodcast serijalu
Meet the Gimp u epizodi 164.

Skriptu mozete preuze sa sajta Gimp Plugin Registry.
[1]h p://registry.gimp.org/node/25527

Skripta se pokrece iz menija: Filters -> SkYNeT -> Enhance -> High Pass Sharpening

Skripta pravi novi lejer od vidljivih, tako da preporucujem da iskljucite vidljivost svim lejerima osim onog koga zelite
da izostrite ovom skriptom.

1. http://registry.gimp.org/node/25527

darthewok (2014-06-05 09:50:50)
Naravno, moze i iz synap ca, da se ukloni ppa. :) Nema na cemu, poz

Milovanović Siniša (2014-06-04 22:49:58)
Rešio sam problem,ručno sam uklonio ppa u synap c p.m i lepo se instalirao 2.8.10,hvala

darthewok (2014-06-05 09:49:50)
gimp-2.8.10.tar.bz2 je source i moras ga kompajlira , ne mozes ga tek tako instalira kako si navikao.
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darthewok (2014-06-05 09:48:39)
Poktrala mi se greska, mislio sam da moze opcija -r, ali mora da se kuca – remove sudo add-apt-repository –remove ppa:ime
_repozitorijuma/ppa

Milovanović Siniša (2014-06-02 19:22:44)
Здраво,користим тренутно Линукс Минт 17 и прешао се па инсталирао нову верзију Гимпа 2.9.1,сада ми гомила скрипти
не ради и неки додаци а мало и закуцава процесор.Обрисао га али сада не умем да се вратим на стабилну верзију 2.8.8
која ми је радила одлично.Свуда само нова верзија Гимпа.Постоји ли неки начин,поздрав Синиша

darthewok (2014-06-03 17:22:42)
Zdravo. Da bi instalirao stariju verziju Gimpa, prvo moras da uklonis noviju verziju i ppa odakle si ga instalirao. Prvo ukloni gimp
komandom: sudo apt-get autoremove gimp* Za m ukloni ppa, pretpostavljam da si ga instalirao sa o o-kesselgulasch ppa, pa
cu ovde naves primer kako da ga uklonis: sudo add-apt-repository -r ppa:o o-kesselgulasch/gimp-edge sudo apt-get update
Na kraju instaliraj Gimp iz zvanicnog repozitorijuma komandom: sudo apt-get install gimp

Milovanović Siniša (2014-06-03 18:57:39)
Kad hoću da uklonim ppa dobijem sledeće ”nula@nula-System-Product-Name $ sudo add-apt-repository -r ppa:o o-
kesselgulasch/gimp-edge Usage: add-apt-repository [op ons] repository add-apt-repository: error: no such op on: -r” i onda
mi opet instalira 2.9.1 verziju

Milovanović Siniša (2014-06-03 19:08:20)
Pronašao sam gimp-2.8.10.tar.bz2,ali ne znam kako da ga instaliram

1.5 September

Kako poveca WIFI domet? (2011-09-09 22:07) - darthewok

WIFI je nacin povezivanja elektronskih uredjaja bezicnim putem. Uredjaji koji poseduju WIFI, na primer kompjuteri,
mobilni telefoni i drugi, mogu se poveza na internet preko bezicne pristupne tacke (Wireless Access Point).

WLAN je veza dva ili vise uredjaja povezanih bezicnim putem.

Bezicna mreza se ostvaruje putem radio signala. Tako da je za vezu potrebno da se uredjaji koji poseduju WIFI nalaze
u dometu. Sto je signal jaci i veza je kvalitetnija. Kao i kod ostalih radio uredjaja, potrebna je antena. Sto je antena
kvalitetnija, signal je jaci, pa samim m i domet. Jacina signala i domet, takodje zavise i od toga, gde se nalazite. Ako
ste u zatvorenoj prostoriji, domet ce bi manji zbog raznih prepreka, na primer zidovi izmedju prostorija.

Domet mozete poveca na dva nacina:

Prvi i je iniji nacin je da Vas bezicni uredjaj postavite na mesto koje ima bolji signal. Na primer, da Vas ruter ili laptop
postavite blize prozoru. Ali to nije uvek najbolje resenje i u mnogim situacijama, nije bas izvodljivo.

Drugi nacin je koriscenje neke eksterne antene. Na vecini bezicnih rutera, fabricka antena moze da se skine i da se
umesto nje postavi neka bolja antena koja se zasebno kupuje. Takodje, i neki USB bezicni adapteri poseduju antenu
koja moze da se skine. Na primer TP-Link TL-WN722NC. Umesto fabricke antene mozete postavi , na primer, omni
antenu firme TP-Link TL-ANT2408C ili usmerenu yagi antenu, takodje firme TP-Link sa oznakom TL-ANT2409A cime
se znacajno povecava kvalitet i domet signala. Te antene mozete stavi i na prozor ili na terasu, tako sto ih mozete
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prikljuci preko WIFI kabla, na primer TP-Link TL-ANT24EC5S, duzine 5m.

Sta je to Easter Egg? (2011-09-09 22:19) - darthewok

Definicija preuzeta sa [1]Wikipedije.
Kompletan tekst, mozete vides u [2]clanku na Wikipediji.

Easter Egg (Uskrsnje jaje) u virtuelnom smislu te reci oznacava namernu i sakrivenu poruku ili salu u medijumu poput
filma, knjige, veb strane ili kompjuterskom programu ili igri.

1. http://sr.wikipedia.org/sr-ec/%D0%A3%D1%81%D0%BA%D1%80%D1%88%D1%9A%D0%B5_%D1%98%D0%B0%D1%98%D0%B5_%28%D0%
BC%D0%B5%D0%B4%D0%B8%D1%98%D0%B8_%D0%B8_%D0%BF%D1%80%D0%BE%D0%B3%D1%80%D0%B0%D0%BC%D0%B8%29
2. http://sr.wikipedia.org/sr-ec/%D0%A3%D1%81%D0%BA%D1%80%D1%88%D1%9A%D0%B5_%D1%98%D0%B0%D1%98%D0%B5_%28%D0%
BC%D0%B5%D0%B4%D0%B8%D1%98%D0%B8_%D0%B8_%D0%BF%D1%80%D0%BE%D0%B3%D1%80%D0%B0%D0%BC%D0%B8%29

Google Beatbox « Kompjuteri (2012-07-14 15:48:11)
[...] jedan zanimljiv easter egg iz googla. [...]

Sta je NetBIOS over TCP/IP (NetBT ili NBT)? (2011-09-16 12:28) - darthewok

NetBIOS preko TCP / IP (NBT) je protokol koji omogucava primenu kompjuterskih aplikacija baziranih na NetBIOS API-
ju da koriste savremene TCP / IP mreze. NetBIOS je razvijen ranih 80- h godina dvadesetog veka i bio je namenjen
malim mrezama (desetak kompjutera). Neke aplikacije i dalje koriste NetBIOS i nisu dovoljno fleksibilne da koriste
mrezu hiljada kompjutera ako koris te NetBIOS protokol. Pravilno podesen protokol NetBIOS preko TCP / IP omogu-
cava takvim aplikacijama, koje koris te NetBIOS, da rade bez problema u mrezama hiljada kompjutera, kao sto je
Internet. NetBIOS preko TCP / IP i NBT je definisan u RFC 1001 i RFC 1002 standardima.

Ovo je deo prevedenog teksta iz clanka na [1]Wikipediji. Kompletan tekst i detaljnije informacije mozete pogleda na
ovoj adresi: [2]h p://en.wikipedia.org/wiki/NetBIOS _over _TCP/IP

1. http://en.wikipedia.org/wiki/NetBIOS_over_TCP/IP
2. http://en.wikipedia.org/wiki/NetBIOS_over_TCP/IP
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Recuva (2011-09-16 12:52) - darthewok

Recuva je besplatan program za Windows koji vraca izbrisane fajlove sa hard diska, MP3 plejera, kar ce sa digitalnog
fotoaparata, USB Flasha.

Program mozete preuze sa adrese: [1]h p://www.piriform.com/recuva

1. http://www.piriform.com/recuva

Double Driver (2011-09-18 21:46) - darthewok

Double Driver je besplatan program za pravljenje rezervnih kopija (i kasnije eventualno vracanje) instaliranih drajvera
u Windowsu. Zasto pravi rezervnu kopiju instaliranih drajvera? Ima vise razloga, na primer, ako nemate CD/DVD
sa drajverima, korisno je napravi rezervnu kopiju drajvera, za slucaj da nesto krene naopako, na primer, ako morate
ponovo instalira Windows, a nemate diskove sa drajverima. Double Driver je jednostavan alat koji analizira sistem i
izlistava instlairane drajvere, prikazujuci najvaznije podatke o njima, kao sto su, verzija, datum, proizvodjac.

Double Driver, mozete preuze sa zvanicnog sajta: [1]h p://www.boozet.org/dd.htm

1. http://www.boozet.org/dd.htm

Firefox i Facebook (2011-09-19 00:48) - darthewok

Ako Facebook ne radi kako treba, moze da se desi da je neki problem na samom Facebook-u, ali problem moze da
bude i na lokalnom kompjuteru. Dakle, ako postoji neki problem na Facebook-u, ono sto mozete da probate je da
ispraznite ”Cache” iz Firefoxa lili nekog drugog web pregledaca i za m restartujte Firefox.

Praznjenje kesa (Cache) u Firefoxu:
Windows verzija: u meniju kliknite na Tools -> Op ons -> Advanced -> Network -> Clear Now
Linux verzija: u meniju kliknite na Preferences -> Advanced -> Network -> Clear Now

Jos da dodam, da mogu i neki dodaci za Firefox da naprave problem sa Facebook-om. Na primer PrivacySuite mi
je u poslednjih par dana pravio problem, jer su nesto izmenili na Facebook-u. Pa sam PrviacySuite podesio da na
Facebook-u bude iskljucen, a da radi na ostalim sajtovima. Kada budu napravili update za PrivacySuite, ponovo cu ga
ak vira na FB-u.
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Wolfenstein: Enemy Territory (2011-09-25 23:14) - darthewok

Wolfenstein: Enemy Territory je besplatna mul plejer igra za Windows, Linux i Mac. Postoji i mod za botove uz
pomoc koga mozete igra pro v botova. Wolfenstein: Enemy Territory je pucacka igra iz prvog lica sa tema kom
drugog svetskog rata.

Igru mozete preuze sa vise sajtova:

[1]h p://www.splashdamage.com/content/wolfenstein-enemy-territory-barrac ks

[2]h p://www.planetwolfenstein.com/files/files.shtml

Mod za botove ”Bobot” mozete preuze sa ovog linka:

[3]h p://returntocastlewolfenstein.filefront.com/file/ET _BOTS _all _lang;24977

U verziji za Linux postoji problem sa zvukom. Ako nemate zvuka uradite sledece:

1. Preuzmite fajl sa adrese: [4]h p://nullkey.kapsi.fi/et-sdl-sound/et- sdl-sound.gz

2. Raspakujte fajl et-sdl-sound u folder gde ste instalirali igru.

3. Fajl et-sdl-sound otvorite u nekom tekst editoru i pronadjite liniju sa sledecim sadrzajem:
# You can set this in GAME _PATH environment variable
# GAME _PATH=””

4. U liniji # GAME _PATH=”” izbrisite znak # i pod navodnike postavite putanju do foldera gde je instalirana
igra. U mom primeru to izgleda ovako: GAME _PATH=”/home/user/Games/enemy-territory/” zato sto sam igru
instalirao u folder /home/user/Games/enemy-territory/
Ako ste igru instalirali u drugi folder, navedite pod navodnike tacnu lokaciju foldera. Sacuvajte izmene i izadjite iz
tekst editora.

5. Kliknite desnim tasterom na ikonu fajla et-sdl-sound i za m levim tasterom kliknite na Proper es, pa kliknite na
kar cu Permissions i tu s klirajte Allow execu ng file as a program. Da bi dodali dozvolu skrip da se izvrsava kao
program. Na kraju kliknite na Close.

6. Igru pokrecete dvoklikom na ikonu et-sdl-sound. Ako ste sve dobro uradili, trebalo bi da dobijete zvuk.

7. Ako i dalje nema zvuka, proverite da li imate instaliran SDL, ako nemate instaliran SDL, instalirajte SDL iz re-
pozitorijuma Vase Linux distribucije.

1. http://www.splashdamage.com/content/wolfenstein-enemy-territory-barracks
2. http://www.planetwolfenstein.com/files/files.shtml
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3. http://returntocastlewolfenstein.filefront.com/file/ET_BOTS_all_lang;24977
4. http://nullkey.kapsi.fi/et-sdl-sound/et-sdl-sound.gz

1.6 October

Zas ta fajla grub.conf od nedozvoljenih izmena prilikom podizanja sistema (2011-10-01 22:33) - darthewok

Ako imate instaliran Linux, sigurno znate sta je grub. U ovom clanku cu pisa o zas fajla grub.conf. Pozeljno je
postavi sifru u fajl grub.conf da bi se sprecila nedozvoljena izmena tog fajla i me povecala bezbednost sistema. To
uradite na sledeci nacin:

1. Otvorite termninal, ukucajte su - pri snite enter i ukucajte root sifru.
2. Ukucajte grub-md5-crypt i ukucajte sifru kojom zelite zas grub.conf, pri snite enter i za m ponovo ukucajte
sifru. Pojavice se md5 hash Vase sifre.
3. U nekom tekst editoru otvorite fajl grub.conf (na primer kucajte gedit /boot/grub/grub.conf i pri snite enter)
4. Kada se otvori grub.conf pronadjite sledece linije:

default=0
meout=5

splashimage=(hd0,1)/grub/splash.xpm.gz
hiddenmenu

5. Ispod linije meout=5 ukucajte: password –md5 OVDE _STAVITE _MD5 _HASH
Pazite, md5 MORA BITI TACNO UNET zato koris te copy/paste. Kada zavrsite, treba da izgleda ovako:

default=0
meout=5

password –md5 OVDE _STAVITE _MD5 _HASH
splashimage=(hd0,1)/grub/splash.xpm.gz
hiddenmenu

6. Sacuvajte izmenu.

Sada, kada udjete u grub, prilikom podizanja sistema, ako dodajete ili menjate stavke u grubu, morate prvo pri s-
nu p, za m kuca sifru da bi imali mogucnost izmena u grubu.
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Otvaranje Google pretrazivaca na engleskom (2011-10-10 14:05) - w1ndu

Google je od skora uveo puni redirect na .rs domen uz otvaranje na srpskom jeziku cirilicnim pismom. Ovo je lepo ko
voli, ali za nas ostale resenja su sledeca:

1) Otvaranje na engleskom - promenite bookmark u:

[1]h p://www.google.com/ncr

ncr = no country redirect

2) Otvaranje na srpskom la nica - bookmark:

[2]h p://www.google.rs/webhp?hl=sh

Poslednje resenje nije savrseno zato sto pojedini linkovi vracaju na cirilicno pismo. Do neke bolje ideje, srecno u
borbi sa web op mizacijama. :)

1. http://www.google.com/ncr
2. http://www.google.rs/webhp?hl=sh

Otvaranje Google pretrazivaca na engleskom u Operi. « Kompjuteri (2011-11-10 21:56:04)
[...] Windu je vec pisao na ovu temu, njegov tekst mozete vide ovde. [...]

Ripovanje mp3 is avi fajla (2011-10-10 14:14) - w1ndu

Postoji puno nacina da se ovo uradi, jedan besplatan i jednostavan je sledeci:

1. Skinite i instalirajte [1]AviDeMux.

2. Ucitajte zeljeni avi fajl i isecite pesmu koju zelite da snimite koristeci alate iz edit menija.

3. Iz Audio opcija (sa leve strane) izaberite MP3 (LAME), za m kliknite Configure i podesite output parametre.

4. Iz Audio menija (gornji red) izaberite Save i snimite mp3.

Ovaj metod je izabran zbog vece flexibilnos . U koliko je akcenat na jednostavnos , vredi proba [2]AoA Audio Ex-
tractor ili [3]Video Mp3 Extractor.

1. http://avidemux.sourceforge.net/
2. http://www.aoamedia.com/audioextractor.htm
3. http://www.geovid.com/video_mp3_extractor/
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˜ nrg2iso ˜ (2011-10-10 14:39) - w1ndu

Iako vecina programa podrzava mountovanje / rezanje nrg formata, on ipak nije kompa bilan kao iso. Nero sa druge
strane, prilikom pravljenja imagea gotovo uvek nudi i po defaultu kreira iskljucivo nrg. Jedini nacin da se napravi iso
je da se otvori novi data cd i iskopiraju fajlovi, pri cemu se naravno gube ostale karakteris ke originalnog medija.

U koliko se nadjete u prilici da imate nrg fajl a ne mozete da ga narezete jer ga so ware ne podrzava, [1]nrg2iso
ce vam bi od pomoci. Program je veoma jednostavan za upotrebu i efikasan u onome sto radi. Napisan je u Delphiju
i dostupan u nemackoj i engleskoj verziji.

1. http://www.roland-illig.de/lang.delphi.nrg2iso.html

Kako instalira dll fajl? (2011-10-29 15:56) - darthewok

Neko me je pitao kako da instalira dll fajl? U ovom clanku cu objasni postupak instalacije.

Ali, najpre da napisem sta su fajlovi sa ekstenzijom dll. Ukratko, to su fajlovi koji sadrze kod ili podatke, koje pozi-
vaju i koriste neki programi. Dakle, ako nema odgovarajuceg dll fajla ili se ne nalazi tamo gde treba, programi koji
traze dll fajlove nece radi .

Zasto se nekad desava da nema odgovarajuceg dll fajla?
Postoji vise mogucih razloga, od toga da su greskom obrisani ili premesteni u drugi folder, obrise ih ili oste virus ili je
instalacija programa lose odradjena, pa ne ukljucuje i dll fajlove.

Instalacija preko instalera:
Neki dll fajlovi se instaliraju preko instalera, u tom slucaju je dovoljno pokrenu instaler i dll ce da se instalira tamo
gde treba, potrebno je eventualno restartova kompjuter.

Rucna instalacija:
U zavisnos kako dobijete dll fajl, mozda ce bi potrebno da ga prvo raspakujete, ako je na primer zipovan.
Za m treba dll fajl iskopira , ili u folder programa kome je potreban, u ovom slucaju ce samo taj program moci da
ga koris ili u Windowsov sistemski folder, tada ce svi programi, kojima je potreban taj dll, moci da ga koriste. Za m
probajte da li radi program kome je potreban dll koji ste instalirali. Ako i dalje ne radi, onda kliknite na Start, pa na Run
i ukucajte cmd da pokrenete komandni prompt i tu ukucajte regsvr32 ime _dll _fajla.dll i pri snite enter. I restartujte
kompjuter.

Sistemski folderi u raznim verzijama Windowsa:
Windows 95, 98, Me: c:\windows\system
Windows NT, 2000, XP, Vista, 7: c:\windows\system32
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64-bitne verzije Windowsa: c:\windows\syswow64

luka (2011-12-23 13:37:06)
hteo sam da instaliram menadzera2012 ali kad pokrenem igru izadje mi da nemam d3dx9 _41.dll pokusao sam da uradim sve
kao sto pise u teksu ali i dalje ne mogu da pokrenem igricu...sta sad da radim?

luka (2011-12-23 13:52:02)
regsvr32 mi izbaci the specified module could not found

darthewok (2011-12-24 11:27:44)
Instaliraj DirectX. DirectX se obicno nalazi na disku sa igrom i instaler ponudi da se instalira i DirectX prilikom instalacije igre.
Takodje ga mozes preuze sa adrese: h p://www.microso .com/download/en/details.aspx?id=8109

darthewok (2011-12-24 11:29:06)
Sta si tacno ukucao kada je regsvr32 izbacio poruku the specified module could not found?

1.7 November

˜ MiPony ˜ (2011-11-09 18:15) - w1ndu

Program za automa zaciju skidanja sa file sharing sajtova. Pored najpozna jih poput RS ili MU, pokriva na dese ne
manjih hostova. Izuzetno stabilan i pouzdan, sa brojnim korisnim opcijama. Dostojna konkurencija [1]JDownloaderu,
narocito ako iz bilo kog razloga ne koris te JRE.

Download, tutorijale, screenshotove i vise informacija o programu mozete naci na sajtu >

[2]h p://www.mipony.net

1. http://jdownloader.org/
2. http://www.mipony.net/

Otvaranje Google pretrazivaca na engleskom u Operi. (2011-11-10 21:55) - darthewok

Windu je vec pisao na ovu temu, njegov tekst mozete vide [1]ovde.

Ja cu se u ovom tekstu pozabavi konkretno podesavanjem Google pretrazivaca u Operi.
Dakle, podrazumevani pretrazivac u okviru za pretragu (gore desno) je Google. Koji po podrazumevanim parametrima
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otvara lokalizovanu verziju Google pretrazivaca. To mozete promeni .

U adresnu liniju kucajte about:config ili opera:config u mojoj verziji Opere (11.60 beta Build 1147) je sve jedno da
li kucate about:config ili opera:config.
Kada se otvori Preferences Editor u polje za pretragu ispod teksta Preferences Editor
kucajte, goolge tld da bi ste filtrirali prikaz, ako ste dobro uradili treba da se pojave podesavanja samo za Google TLD.
U stavci User Prefs, se nalaze tri podesavanja za Google TLD.
U prvo podesavanje Google TLD Default, umesto .google.rs ukucajte .google.com.
Google TLD Downloaded treba da bude s klirano. To znaci da je Opera preuzela Google TLD podesavanja i vise ne
postavlja upit Google-u.
Poslednje podesavanje, Google TLD URL nema potrebe da dirate.

1. http://kompjuteri2011.wordpress.com/2011/10/10/otvaranje-google-pretrazivaca-na-engleskom/

Gimp tutorijal 19 (2011-11-11 16:51) - darthewok

U ovom tutorijalu je prikazan skript filter Highpass sharpening by SkYNeT i opisan postupak promene pozadine na
fotografiji.

[youtube=h p://www.youtube.com/watch?v=8LaGrvFkzXM]

Gimp tutorijal 20 (2011-11-13 12:37) - darthewok

U ovom tutorijalu je prikazana jedna od tehnika uz pomoc koje mozete napravi dugu.

[youtube=h p://www.youtube.com/watch?v=QK55KRI05qY]

Gimp tutorijal 21 (2011-11-14 13:26) - darthewok

Dopuna prethodne epizode o pravljenju duge i prikaz filtera Rainbow i Edges on fire u pluginu G’MIC.
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[youtube=h p://www.youtube.com/watch?v=-v204OCLdlw]

Dodaci za Firefox da Facebook radi normalno... (2011-11-19 15:07) - darthewok

Dobio sam jedno zanimljivo pitanje: ”Koje dodatke za Firefox da instaliram da bi Facebook radio normalno?”

Osoba nije precizirala, sta to konkretno ne radi na Facebook-u.

Facebook radi normalno bez ikakvih dodataka za Firefox. Desava se da po nekad postoje problemi u radu Facebook-a,
ali to su njihovi interni problemi i nikakav dodatak za Firefox to ne moze da popravi. Sledeci uzrok moze bi trenutno
losa veza, ali to je problem do provajdera. Takodje, moze da se desi da neki dodaci za Firefox naprave problem sa
nekim web sajtovima. Tako da je najbolje deinstalira te dodatke ili, ako je moguce, u podesavanjima za te dodatke,
podesi ih da ne rade na sajtovima sa kojima su u konfliktu. Na primer razni bezbednosni dodaci i dodaci za uklan-
janje reklama mogu pravi problem. Na primer PrivacySuite i Adblock Plus mogu da naprave neke probleme. Ali u m
dodacima postoji opcija da, na problema cnim sajtovima budu onesposobljeni. Takodje, ako imate problema u radu
Facebook-a, mozete isprazni cache i izbrisa kolacice (cookies) iz Firefoxa, izadjite iz Firefoxa i ponovo ga ucitajte i
probajte da li ce tada bi bolje.

Drago Filipovic (2012-01-05 18:12:45)
Ija imam slican Problem,ja nemogu da se ulogujem ni u Facebook nalog,a ni u google naloge,tj.kada upisem te adrese od
facebook i od pr.you tube tesko ih otvara i FirefoxBrowser iChrome Browser,a i kad otvori i ukucam moje podatke kliknem OK
samo tako stoji i posle 2 do 3 minuta se prekine kao da nema veze sa provajderom od interneta.Hvala Drago Filipovic

Eraser [FF] (2011-11-20 07:26) - w1ndu

Dodatak koji omogucava laksi pristup brisanju privatnih podataka nakon ili tokom surfovanja. Dodaje opciju na desni
klik i takodje je moguce doda dugme u toolbar. Nakon poziva funkcije, privatni podaci su obrisani.

Izuzetno je lak za koriscenje a podesavanja jednostavna i logicno organizovana. Pored svih standardnih podataka,
omogucava i brisanje LSO (Flash Cookies).

Eraser mozete preuze [1]ovde.

1. https://addons.mozilla.org/en-US/firefox/addon/eraser-13009/
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Gimp tutorijal 22 (2011-11-20 12:51) - darthewok

U ovom tutorijalu je opisana tehnika pravljenja vatrenih kontura na fotografijama.

[youtube=h p://www.youtube.com/watch?v=7a2i0Ih5Hjg]

Linux Free So ware Catalog and Packages Search (2011-11-21 12:16) - darthewok

[1]Linux Free So ware Catalog and Packages Search je sajt na kome mozete naci sve sto Vam je potrebno za Linux.
Podrzano je dosta Linux distribucija. [2]Pkgs.org je stvoren kako bi Vam pruzio najjednostavniji nacin trazenja i preuz-
imanja najnovijih verzija najboljeg so vera za Linux. Takodje ga mozete koris da bi pronasli besplatnu alterna vu
skupom komercijalnom so veru.

[3]h p://pkgs.org/

1. http://pkgs.org/
2. http://pkgs.org/
3. http://pkgs.org/

GIMP Matrix Plugin (2011-11-22 03:28) - darthewok

Dodatak za Gimp koji pravi efekte slicne, kao u filmu Matrix, mozete preuze [1]ovde.
Kada preuzmete zip fajl, raspakujte ga i *.scm fajlove iskopirajte u Gimpov scripts folder.
Matrix Plugin mozete naci u meniju: File -> Create -> Matrix Like Effects

Na slici je primer kakav rezultat dobijate primenom Matrix Plugin-a.
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1. http://whereyouwantto.bplaced.net/wiki/index.php?title=GIMP_Matrix_Plugin

Pixlr Grabber (2011-11-25 15:57) - darthewok

Pixlr Grabber je dodatak za Firefox koji moze da sacuva web stranu, kao sliku. Moze “uhva ” kompletnu web stranu,
deo koji trenutno vidite u prozoru ili deo koji izaberete. Slika moze bi snimljena na disk, iskopirana u clipboard ili
obradjena u online grafickom editoru. Da, tako je, Pixl Grabber poseduje i editor slika, tako da mozete, prvo izmeni
sliku, pre nego sto je sacuvate. Editor lepo izgleda, poseduje dosta funkcija i po malo podseca na Photoshop. Takodje
u onlajn editor, mozete ucita sliku sa Vaseg kompjutera i obradi je.

Pixlr Grabber mozete preuze na ovoj adresi: [1]h ps://addons.mozilla.org/en-US/firefox/addon/pixlr-grabber/

Editor slika se nalazi na ovoj adresi: [2]h p://pixlr.com/editor/

1. https://addons.mozilla.org/en-US/firefox/addon/pixlr-grabber/
2. http://pixlr.com/editor/

Photo editor online « Kompjuteri (2011-11-26 17:38:29)
[...] Inace, is razvojni m razvija i Pixlr Grabber dodatak za Firefox. O tom dodatku mozete procita ovde. GA _googleAd-
dA r(”AdOpt”, ”1”); GA _googleAddA r(”Origin”, ”other”); [...]

Fedora 16 i Grub2 (2011-11-25 16:46) - darthewok

Juce sam probao Fedoru 16. U glavnom su mi pozi vni u sci. Ono sto mi se nije dopalo je nova verzija Grub loadera.
Grub2 sigurno ima svojih prednos , jer ima mnogo vise mogucnos za podesavanje. Medju m, postavlja se pitanje,
da li je potrebno toliko komplikova stvari? Pogotovo sto, barem u Fedori 16, ne znam za druge Linux distribucije, pos-
toji ozbiljan bezbednosni propust u Grub2 loaderu. Kada se izabere opcija Recovery, moguce je dobi root privilegije
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bez ikakve sifre. Taj se problem lako resava, ali manje ves m korisnicima, to moze da bude problem.

Dakle, problem se resava na sledeci nacin:

- U terminalu ukucajte:
su - pri snite enter i ukucajte root sifru
- kao root ukucajte:
gedit /etc/default/grub da ucitate konfiguracioni fajl u gedit tekst editor
- u konfiguracionom fajlu dodajte liniju:
GRUB _DISABLE _RECOVERY=true Time ste iskljucili Recovery opciju i vise se nece pojavljiva u Grub2 boot meniju
- Sacuvajte izmenu i izadjite iz tekst editora.
- Za m u terminalu ukucajte:
grub2-mkconfig -o /boot/grub2/grub.cfg da bi Grub2 prihva o izmene.

Inace, kada god napravite neku izmenu, obavezno morate kuca :
grub2-mkconfig -o /boot/grub2/grub.cfg da bi Grub2 prihva o izmene.
To je pravilan nacin izmene Grub2 konfiguracije. Naravno, mozete direktno menja konfiguracioni fajl grub.cfg u Boot
folderu, ali to nije preporucljivo, a i te izmene ce bi pregazene, kada se apdejtuje Kernel.

Op mizacija Fedore 16, zatvaranje nepotrebnih otvorenih portova i instaliranje nekih programa. « Kompjuteri (2011-11-26
09:31:46)
[...] Takodje, procitajte i tekstove za Grub2: Fedora 16 i Grub2 Grub2 – Izmena podrazumevane boot opcije i izmena vremena
LD _AddCustomA r(”AdOpt”, ”1”); [...]

Grub2 - Izmena podrazumevane boot opcije i izmena vremena (2011-11-25 17:06) - darthewok

Ako imate dual boot, na primer Windows i Fedora 16. Posle instalacije Fedore 16, Fedorin Grub2 loader ce automatski
names da se po isteku 5 sekundi podize Fedora 16. Ako zelite da se Windows automatski podize po isteku 5 sekundi,
to se moze izmeni na sledeci nacin:

- U terminalu ukucajte:
su - pri snite enter i ukucajte root sifru
- kao root ukucajte:
cat /boot/grub2/grub.cfg | grep Windows
- Trebalo bi da dobijete ovako nesto:
menuentry ”Windows XP Home (loader) (on /dev/sda1)” –class windows –class os {
Iskopirajte u clipboard tekst koji se nalazi izmedju navodnika
- Za m kucajte:
grub2-set-default ”Windows XP Home (loader) (on /dev/sda1)”
Ovo gore je primer, Vi umetnite tekst iz clipboarda izmedju navodnika (onaj koji ste iskopirali u prethodnom koraku)
- Proverite da li ste dobro uradili komandom:
grub2-editenv list
- Upisite izmene u Grub2:
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grub2-mkconfig -o /boot/grub2/grub.cfg

Ako zelite da promenite onih podrazumevanih 5 sekundi, to mozete uradi na sledeci nacin:
- U terminalu ukucajte:
su - pri snite enter i ukucajte root sifru
- kao root ukucajte:
gedit /etc/default/grub
- Izmenite sledecu liniju:
GRUB _TIMEOUT=5 Umesto broja 5 upisite broj sekundi koji zelite
- Upisite izmene u Grub2:
grub2-mkconfig -o /boot/grub2/grub.cfg

Op mizacija Fedore 16, zatvaranje nepotrebnih otvorenih portova i instaliranje nekih programa. « Kompjuteri (2011-11-26
09:31:49)
[...] Takodje, procitajte i tekstove za Grub2: Fedora 16 i Grub2 Grub2 – Izmena podrazumevane boot opcije i izmena vremena
LD _AddCustomA r(”AdOpt”, ”1”); LD _AddCustomA r(”Origin”, ”other”); [...]

Op mizacija Fedore 16, zatvaranje nepotrebnih otvorenih portova i instaliranje nekih programa.
(2011-11-26 09:20) - darthewok

Postupak za zatvaranje otvorenih portova i op mizaciju je skoro is kao u tekstu za [1]Fedoru 15.

Ovako sam op mizovao moju instalaciju Fedore 16:

- Podesavanje fstab:

Dodao sam opciju noa me u stavke u fajlu fstab. O tome sam vec pisao, ali da podse m. Da bi poboljsali performanse
u Linuxu i (kazu ljudi) produzili vek hard diska, korisno je u fajlu etc/fstab postavi za svaku stavku opciju noa me ili
barem tamo gde to nije potrebno. Opcija noa me je posebna opcija za mountovanje fajl sistema koja sprecava upi-
sivanje vremena pristupa odredjenom fajlu. Prilikom citanja fajla se vrsi upisivanje vremena pristupa fajlu, pa samim

m, ukljucivanjem opcije noa me, se dobija na performansama sistema. Da bi ste mogli menja fstab fajl, morate
koris root nalog. U terminalu ukucajte: su -, za m ukucajte root sifru, pa ukucajte: gedit /etc/fstab

U mom primeru to izgleda ovako:

/dev/mapper/vg _hp-lv _root / ext4 defaults,noa me 1 1
UUID=4d4a6dd8-3c69-49c0-b381-dac0207ca832 /boot ext4 defaults,noa me 1 2
/dev/mapper/vg _hp-lv _swap swap swap defaults,noa me 0 0

Dodato 27.1.2012:
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Ako radite neke bekape podataka gde je potreban podatak o vremenu pristupa fajlu ili imate neke servere
kojima je potreban podatak o vremenu pristupa fajlu, ili Vam je iz nekog razloga potreban podatak o
vremenu pristupa fajlu, onda ne treba postavlje noa me u fstab.

- Podesavanje firewalla

Firewall mi je podesen da blokira sve dolazne upite. Ako imate neki server, onda morate podesi firewall da
propusta podatke na portovima koji su potrebni serveru. Ja Fedoru koris m kao desktop sistem i nisu mi potrebni
nikakvi serveri prema internetu.
U terminalu, kao root, ukucajte gedit /etc/sysconfig/iptables da bi ste izmenili iptables konfiguracioni fajl.
Ovako mi izgleda iptables konfiguracioni fajl (/etc/sysconfig/iptables):

# Firewall configura on wri en by system-config-firewall
# Manual customiza on of this file is not recommended.
filter
:INPUT ACCEPT [0:0]
:FORWARD ACCEPT [0:0]
:OUTPUT ACCEPT [0:0]
-A INPUT -m state –state ESTABLISHED,RELATED -j ACCEPT
-A INPUT -p icmp -m icmp –icmp-type des na on-unreachable -j DROP
-A INPUT -p icmp -m icmp –icmp-type echo-reply -j DROP
-A INPUT -p icmp -m icmp –icmp-type echo-request -j DROP
-A INPUT -p icmp -m icmp –icmp-type parameter-problem -j DROP
-A INPUT -p icmp -m icmp –icmp-type redirect -j DROP
-A INPUT -p icmp -m icmp –icmp-type router-adver sement -j DROP
-A INPUT -p icmp -m icmp –icmp-type router-solicita on -j DROP
-A INPUT -p icmp -m icmp –icmp-type source-quench -j DROP
-A INPUT -p icmp -m icmp –icmp-type me-exceeded -j DROP
-A INPUT -p icmp -j ACCEPT
-A INPUT -i lo -j ACCEPT
-A INPUT -j DROP
-A FORWARD -j DROP
COMMIT

U terminalu, kao root, ukucajte gedit /etc/sysconfig/ip6tables da bi ste izmenili ip6tables konfiguracioni fajl.
Slicno izgleda i ip6tables (/etc/sysconfig/ip6tables). Evo primera:

# Firewall configura on wri en by system-config-firewall
# Manual customiza on of this file is not recommended.
filter
:INPUT ACCEPT [0:0]
:FORWARD ACCEPT [0:0]
:OUTPUT ACCEPT [0:0]
-A INPUT -m state –state ESTABLISHED,RELATED -j ACCEPT
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type des na on-unreachable -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type echo-reply -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type echo-request -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type parameter-problem -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type redirect -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type router-adver sement -j DROP
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-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type router-solicita on -j DROP
-A INPUT -p ipv6-icmp -m icmp6 –icmpv6-type me-exceeded -j DROP
-A INPUT -p ipv6-icmp -j ACCEPT
-A INPUT -i lo -j ACCEPT
-A INPUT -j DROP
-A FORWARD -j DROP
COMMIT

- Iskljucivanje nepotrebnih servisa i portova:

Otvoreni portovi posle instalacije Fedore 16:

22/tcp open ssh (koris ga sshd)
25/tcp open smtp (koriste ga sendmail i sm-client)
111/tcp open rpcbind (koris ga rpcbind)
631/tcp open ipp (koris ga cups)
50022/tcp open rpc.statd (rpc.statd tcp port je promenljiv)

Da bi iskljucili nepotrebne servise i pozatvarali nepotrebne portove, otvori Terminal,
ukuca su -, ukuca root sifru, za m,

chkconfig mdmonitor off
chkconfig sshd off
chkconfig pcscd off

SENDMAIL

chkconfig sendmail off
chkconfig sm-client off

Iz nekog razloga, uz pomoc chkconfig nekad nije moguce iskljuci sendmail servis. Instalirao sam i system-
config-services i ni iz tog programa po nekad nije moguce iskljuci sendmail i sm-client, jer se posle restarta ponovo
ak viraju servisi. Za slucaj da se i Vama to desava, probajte sa systemctl.

systemctl disable sendmail.service

CUPS
Servis za printer. Ako koris te printer ne iskljuciva cups servis.
chkconfig cups off

Servisi vezani za NFS
Ovde treba bi oprezan. Servisi nfs, nfslock i ne s zavise od rpc* servisa. Ako su rpc* servisi onesposobljeni, a nfs,
nfslock i ne s ukljuceni, moze doci do toga da sistem nece moci da se podigne. U tom slucaju treba pri snu taster
I (inerac ve boot, odmah na pocetku podizanja sistema, pre toga pri snu ctrl alt backspace) prilikom podizanja
sistema i rucno dozvoljava ili ne dozvoljava servisima da se pokrecu prilikom podizanja sistema i pri tome ne treba
pokreta servise nfs, nfslock i ne s, jer zavise od rpc* servisa. To sam sve probao u Fedori 14. U Fedori 16 ne radi
interac ve boot pri skom na I, malo cu da potrazim na internetu kako da ak viram interac ve boot u Fedori 16, pa
cu napisa ovde kako to uradi . Zato, ako iskljucujete rpc* servise, obavezno iskljucite i nfs, nfslock i ne s. Zbog toga
u Fedori 16 nisam tes rao kako se ponasa kada se iskljuce rpc* servisi, a nfs, nfslock i ne s ostanu ukljuceni, vec sam
ih sve iskljucio.
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Samo rpcbind drzi otvoren port 111, ali ako deljenje fajlova preko mreze nije potrebno, iskljuci i ostale servise.

chkconfig nfs off
chkconfig nfs-lock off
chkconfig ne s off
chkconfig nfs-idmap off
chkconfig rpcbind off
chkconfig rpcgssd off
chkconfig rpcidmapd off
chkconfig rpcsvcgssd off

- Isklucivanje stavki koje Vam nisu potrebne iz startupa (gnome-session-proper es).
U terminalu, kao root, ukucajte gnome-session-proper es

Caribou
Evolu on Alarm No fy
Orca Screen Reader
Remote Desktop

- Podesavanje Gnome 3:
Instalirajte gnome-tweak-tool ako ga niste instalirali.
Iz menija Applica ons -> Accessories pokrenite Advanced Se ngs

Ak viranje ikona na desktopu: U programu Advanced Se ngs, kliknite na Desktop i ak virajte opciju Have file
manager handle the desktop.

Podesavanje dugmica na naslovnoj liniji prozora ( tlebar): Po defaultu se ne vide dugmici za minimiziranje i
maksimiziranje prozore.

U programu Advanced Se ngs, kliknite na shell i tu u padajucem meniju stavke Arrangement of bu ons on
the tlebar izaberite opciju All da bi ste ak virali dugmice za maksimizaciju i minimizaciju prozora.

- Instaliranje RPM Fusion Free i RPM Fusion Non Free repozitorijuma:
U terminalu, kao root, ukucajte:
yum localinstall –nogpgcheck h p://download1.rpmfusion.org/free/fedo ra/rpmfusion-free-release-stable.noarch.r-
pm h p://download1.rpmfusion.org/nonfree/fedora/rpmfusion-nonfree-release-stabl e.noarch.rpm

- Instaliranje MS Core TTF fontova:
U terminalu, kao root, ukucajte:
wget h p://www.my-guides.net/en/images/stories/fedora12/ms core-fonts-2.0-3.noar ch.rpm
Za m,
yum localinstall –nogpgcheck ms core-fonts-2.0-3.noarch.rpm

- Instaliranje Audacius audio plejera i podrske za MP3:
U terminalu, kao root, ukucajte:
yum install audacious audacious-plugins

- Instaliranje VLC media plejera:
U terminalu, kao root, ukucajte:
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yum install vlc

- Instaliranje Adobe repozitorijuma i adobe Flash:
U terminalu, kao root, ukucajte:
rpm -ivh h p://linuxdownload.adobe.com/adobe-release/adobe-release-i386-1.0-1.noarch. rpm
Za m,
rpm –import /etc/pki/rpm-gpg/RPM-GPG-KEY-adobe-linux
Za m,
yum install flash-plugin

- Instaliranje Inkscape-a:
U terminalu, kao root, ukucajte:
yum install inkscape

- Instaliranje unrar (raspakuje rar arhive):
U terminalu, kao root, ukucajte:
yum install unrar

- Instaliranje Midnight Commander:
U terminalu, kao root, ukucajte:
yum install mc

- Takodje, procitajte i tekstove za Grub2:
[2]Fedora 16 i Grub2
[3]Grub2 – Izmena podrazumevane boot opcije i izmena vremena

1. http://kompjuteri2011.wordpress.com/2011/06/11/optimizacija-fedore-15-i-zatvaranje-nepotrebnih-otvorenih-
portova/
2. http://kompjuteri2011.wordpress.com/2011/11/25/fedora-16-i-grub2/
3. http://kompjuteri2011.wordpress.com/2011/11/25/grub2-izmena/

Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Inter-
net za pone (Fedora 15 i 16). (2011-11-26 13:58) - darthewok

Vec sam opisivao postupak povezivanja za [1]Fedoru 13 i 14. U Fedori 15 i 16, postupak je malo drugaciji. Pretpostavl-
jam da je postupak slican i za druge Linux distribucije sa Gnome 3 grafickim okruzenjem.

1. Prikljucite modem u USB port. Modem bi trebalo da bude prepoznat posle desetak sekundi.
2. Kliknite na ikonu za mrezne konekcije, koja se nalazi gore desno i kliknite na autobroadband. Tada ce se otvori
prozor za izbor konekcije.
3. U prozoru za izbor konekcije podesite mrezu. U spisku drzava, izaberite Serbia.
4. Ni u ovoj verziji Fedore, nema domacih provajdera u spisku. Tako da morate rucno zada ime provajdera. Kliknite
na I can’t find my provider and I wish to enter it manually: u polje za naziv provajdera, ukucajte Orion.
5. Na kraju kliknite na Apply i prozor ce se zatvori . Takodje zatvorite i network prozor, jer odatle nije moguce podesi
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korisnicko ime i sifru.
6. Kliknite na Ac vi es i pokrenite Network connec ons
7. U prozoru Network connec ons kliknite na Mobile Broadband
8. Kliknite na Orion i za m na Edit
9. U prozoru koji se otvorio kliknite na Mobile Broadband
10. U polju Number treba da pise: #777, u polje Username ukucajte Vase korisnicko ime, a u polje Password ukucajte
Vasu sifru. Ostale parametre ne dirajte.
11. Na kraju kliknite na Save.

U nekim slucajevima mozda nece da se pojavi autobroadband kada kliknete na ikonu za mrezne konekcije, koja se
nalazi gore desno.
U tom slucaju uradite sledece:

1. Kliknite na Ac vi es i pokrenite Network connec ons
2. U prozoru Network connec ons kliknite na Mobile Broadband
3. Kliknite na Add
4. Ispod teksta Create connec on for this mobile broadband device:, u padajucem meniju treba odmah da pise Any-
DATA CDMA Products, kliknite Con nue.
5. U lis drzava izaberite Serbia i kliknite na Con nue.
6. Kliknite na I can’t find my provider I wish to enter manualy. U polje upis te ime provajdera, na primer Orion. Za m
kliknite na Con nue.
7. Kliknite na Apply. Otvorice se prozor Edit Orion Connec on.
8. U polju Number treba da pise: #777, u polje Username ukucajte Vase korisnicko ime, a u polje Password ukucajte
Vasu sifru. Ostale parametre ne dirajte.
9. Na kraju kliknite na Save.

Time ste podesili konekciju i mozete ici na internet, klikom na ikonu mrezne konekcije gore desno i za m klikom
na Orion connec on.

1. http://kompjuteri2011.wordpress.com/2011/05/24/postupak-povezivanje-cdma-modema-anydata-adu-520e-koji-fir
ma-orion-telekom-nudi-u-paketu-internet-za-poneti/

Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Internet za pone (Mint 12).
« Kompjuteri (2012-01-22 11:13:32)
[...] je i u Gnome, s m, sto je ikona za mreznu konekciju gore desno pored sata (pogledajte opis za Fedoru 15 i 16, tamo sam
opisao postupak u Gnome [...]

Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Internet za pone (Ubuntu
12.04 LTS). « Kompjuteri (2012-05-19 16:35:05)
[...] sam opisivao postupak povezivanja u Fedori i Mintu u Ubuntu je slican postupak. Podesavanje sam radio u Gnome Classic
(no effects) grafickom [...]
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Photo editor online (2011-11-26 17:38) - darthewok

Odlican editor slika mozete pronaci na adresi: [1]h p://pixlr.com/editor/
Editor lepo izgleda, poseduje dosta funkcija i po malo podseca na Photoshop. Editor je napravljen u Flash-u, tako da je
neophodno da ga imate instaliranog. Sve radi iz web browser-a i (osim Adobe Flash-a) nije potrebna nikakva instalacija
na lokalni kompjuter.
Inace, is razvojni m razvija i Pixlr Grabber dodatak za Firefox. O tom dodatku mozete procita [2]ovde.

1. http://pixlr.com/editor/
2. http://kompjuteri2011.wordpress.com/2011/11/25/pixlr-grabber/

MyPaint (2011-11-28 02:40) - darthewok

MyPaint je brza i jednostavna open source aplikacija za digitalne slikare. Omogucava Vam da se fokusirate na umet-
nost, a ne na program.
Mnogi ce sada pomisli , sta ce mi jos jedan graficki program, kada imam Gimp. I ako oba programa rade sa raster-
skom grafikom, imaju razlicite namene. Prvenstvena namena Gimpa je obrada slika i fotografija, naravno da mozete
i crta i slika u Gimpu, ali, to mu nije primarna namena. Gimpove cetkice (brushes) nisu bas najzgodnije za slikanje.
Kada pokrenete MyPaint, shva cete o cemu pricam. MyPaint ima veliki broj ”braseva” koji simuliraju prave slikarske
cetkice, krede, sprejeve, vodene boje i jos dosta toga.

Razvija se za Windows i Linux
Podrzava graficke tablete koji su osetljivi na pri sak
Jednostavno i minimalis cko graficko korisnicko okruzenje
Veliki broj cetkica (brushes) ugradjenih u sam program
Moguce je uvozi i nove cetkice, kao i menja postojece
Neogranicena velicina (virtuelnog) platna
Osnovna podrska za lejere

Vise detalja o programu mozete naci na zvanicnom sajtu: [1]h p://mypaint.in linux.com/
Dodatne setove ”braseva” mozete naci na ovoj adresi: [2]h p://wiki.mypaint.info/Brush _Packages
Gimp dodatak za uvoz/izvoz Open Raster formata mozete naci na ovoj adresi: [3]h p://registry.gimp.org/node/18435

1. http://mypaint.intilinux.com/
2. http://wiki.mypaint.info/Brush_Packages
3. http://registry.gimp.org/node/18435
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1.8 December

Global Conflict Blue 2 (2011-12-01 00:38) - darthewok

Global Conflict Blue 2 je strateska igra u realnom vremenu za Windows. Simulira savremene pomorsko - vazdusne
borbe. U standardnoj verziji trenutno ima 15 borbenih scenarija i 4 tutorijal scenarija. Igra poseduje i editor scenarija,
kao i editor baze podataka, tako da je moguce dodava nove scenarije i borbene pla orme (avione, brodove, pod-
mornice...)
Igru mozete preuze sa zvanicnog sajta: [1]h p://www.gcblue.com/wiki/index.php? tle=Main _Page

1. http://www.gcblue.com/wiki/index.php?title=Main_Page

Sta je TCP/IP? (2011-12-02 06:28) - darthewok

TCP/IP protokol je skup protokola razvijen da omoguci umrezenim kompjuterima da dele resurse putem mreze. Razvi-
jen je od strane agencije DARPA u okviru ARPANET-a ranih 1970ih. U periodu od juna 1987. do juna 1998. vise od
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300 razlici h proizvodjaca imalo je proizvode koji su podrzavali TCP/IP protokole, a postojalo je na dese ne hiljada
mreza, razlici h velicina i pova, koji su ih koris li. Njihov broj se iz dana u dan povecava, sto je najbolji primer znacaja
TCP/IP-a u kompjuterskim telekomunikacijama.

Ovo je deo teksta objavljenog na [1]Wikipediji. Kompletan tekst i detaljnije informacije mozete pogleda na ovoj
adresi: [2]h p://sr.wikipedia.org/wiki/TCP/IP

1. http://sr.wikipedia.org/wiki/TCP/IP
2. http://sr.wikipedia.org/wiki/TCP/IP

Gimp tutorijal 23 - Layer Mask (2011-12-04 15:56) - darthewok

Neki ljudi su mi pisali na email da im pojasnim kako se radi u lejer masku. Zbog toga je ova epizoda u potpunos
posvecena lejer masku.

[youtube=h p://www.youtube.com/watch?v=AjYlfaSegL8]

Fedora 16 boot problem posle poslednjeg apdejta (2011-12-14 20:28) - darthewok

Posle poslednjeg apdejta, imao sam izvesnih problema u Fedori 16. Sistem nije hteo da se podigne.
Simptomi su bili sledeci:
Fedora pocne da se podize, ali se u jednom trenutku zaustavi i nece dalje.

Ponovo sam instalirao Fedoru, ali posle instalacije NVidia drajvera iz programa Add / Remove So ware se desila ista
stvar, sto naravno ukazuje na neki problem sa NVidia vlasnickim drajverom.

- Pri snuo sam CTRL+ALT+F2, logovao sam se kao root u terminal rezimu.
Deinstalirao sam NVidia drajvere.
yum erase nvidia*

Kada sam restartovao kompjuter, uspeo sam da udjem u graficko okruzenje sa Nouveau drajverom.

Za m sam radio sledece korake:
U terminalu sam ukucao: su - i za m root sifru.

- Za svaki slucaj sam ponovo apdejtovao rpm pakete
U terminalu sam ukucao: yum update
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Ako se apdejtuju kernel i/ili selinux-policy, restartujte kompjuter.

- Instalacija NVidia vlasnickih drajvere iz RPM Fusion repozitorijuma.
U terminalu sam ukucao:
yum install kernel-PAE-devel kmod-nvidia-PAE

- Ako koris te verziju kernela koja nije PAE, onda kucajte:
yum install kmod-nvidia xorg-x11-drv-nvidia-libs

- Na kraju sam iskljucio Nouveau drajver iz kernel initramfs
U terminalu sam ukucao:
mv /boot/initramfs- $(uname -r).img /boot/initramfs- $(uname -r)-nouveau.img
za m,
dracut /boot/initramfs- $(uname -r).img $(uname -r)

- Na kraju sam restartovao kompjuter i problem sa podizanjem sistema i NVidia vlasnickim drajverom je bio resen.

Second Life u Linuxu (2011-12-19 11:33) - darthewok

Za Windows, Linux i Mac postoji vise Second Life klijenta, tj, programa za igranje Second Life-a. Ovaj put sam probao,
pored dve zvanicne verzije, jos dva SL klijenta koji se nezavisno razvijaju. Razlog, zasto sam ih isprobavao je taj sto je
zvanicni Second Life klijent sa adrese: [1]h p://secondlife.com/ prilicno netsabilan i casto pada, barem na mom kom-
pjuteru i sa Linux distribucijom Fedora 16. Tako da je pristojno igranje skoro nemoguce. Isprobao sam dve zvanicne
verzije, stariju 3.0.0.238864 i noviju 3.2.4.246439. Ali obe verzije su dosta nestabilne.
Zato sam potrazio alterna vne Second Life klijente.
Prvo sam probao Phoenix Viewer verziju 3.2.2.24336 ([2]h p://www.phoenixviewer.com/). Ali i ta verzija je nesta-
bilna i cesto pada.
Singularity, verziju 1.6.0 _3 sam tes rao oko sat vremena i jedini je od tes ranih programa bio stabilan. Mozete ga
preuze sa adrese: [3]h p://www.singularityviewer.org/

Takodje, postoji jos klijenata za Second Life. Kompletan spisak mozete vide na ovoj adresi:
[4]h p://wiki.secondlife.com/wiki/Downloads

1. http://secondlife.com/
2. http://www.phoenixviewer.com/
3. http://www.singularityviewer.org/
4. http://wiki.secondlife.com/wiki/Downloads
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Fedora 16 & Virtual Box (2011-12-25 16:23) - darthewok

Prilikom instalacije extension pack-a za Virtual Box u Fedori 16 se javlja greska u /etc/shells fajlu.
To je zbog neke greske u instalaciji Bash-a. Probelem se resava reinstaliranjem Bash-a.
U terminalu ukucajte: su -, pri snite enter i ukucajte Vasu root sifru.
Za m, takodje u terminalu ukucajte: yum reinstall bash
Posle instalirajte Virtual Box extension pack.

Fedora 16 & vlasnicki NVidia i ATI drajveri (2011-12-26 19:03) - darthewok

Ako koris te vlasnicke NVidia ili ATI drajvere, savetujem da iskljucite automatsku instalaciju apdejta.
Po defaultu je ukljucena opcija da se automatski instaliraju Security updates. To moze da napravi problem, na primer
u situacijama, kada se automatski instalira Security update za Kernel, jer se u tom slucaju, najverovatnije, nece au-
tomatski instalira i vlasnicki drajver za odgovarajucu verziju Kernela i sistem nece moci da se podigne u graficki rezim.
Taj problem nije neresiv i lako se resava, ali manje iskusnim kirisnicima moze napravi problem.

Ako Vam se desi situacija da se Kernel automatski apdejtuje, a ne i vlasnicki drajver za graficku kar cu, to mozete
resi u Grub meniju, tako sto izaberete prethodnu verziju Kernela i podignete sistem i za m u grafickom rezimu resite
problem sa novim Kernelom i drajverom.
Ili da podignete sistem sa novim Kernelom i kada se podizanje sistema ”zamrzne”, pri snete CTRL+ALT+F2 i logujete
se kao root i u terminalu ukucate:
yum update
Tom komandom se apdejtuje kompletan so ver, ukljucujuci i drajver za graficku kar cu. Kada se apdejt zavrsi, ukuca-
jte reboot da restartujete sistem i ako je sve u redu, sistem bi trebalo normalno da se podigne sa poslednjom verzijom
Kernela i odgovarajucim vlasnickim drajverom za video kar cu.

Postupak za iskljucivanje Security update automatske instalacije:
1. kliknu na Ac vi es -> Applica ons -> Other -> So ware Se ngs
2. u padajucem meniju Automa cally install, opciju Only security updates promeni u Nothing
3. kliknu na Close

Srecna Nova Godina!!! (2011-12-30 01:48) - darthewok

Svim pose ocima bloga Kompjuteri zelim srecnu novu godinu!

[1]
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1. http://www.flickr.com/photos/l-i-n-u-x/6597258029/

acinic (2011-12-30 01:58:53)
Hvala! Takodje sve najbolje u 2012. god!

Jhead (2011-12-31 15:15) - darthewok

Jhead je mali, ali mocan public domain program za manipulaciju Exif zaglavlja u jpg slikama. Pored menjanja, moze i
da izbrise Exif i me smanji duzinu jpg slike.
Razvija se za Linux, Mac i Windows. Jhead se koris iz terminala, odnosno komandne linije.
Listu komandi iz komandne linije mozte vide na ovoj adresi: [1]h p://www.sentex.net/ mwandel/jhead/usage.html
Takodje, listu komandi mozete vide ako u terminalu ukucate: jhead -h

Mozete ga preuze sa adrese: [2]h p://www.sentex.net/ mwandel/jhead/
Ako koris te Linux, u zavisnos od distribucije koju koris te, Jhead je vec instaliran ili ga mozete instalira iz repozi-
torijuma Vase Linux distribucije.

1. http://www.sentex.net/~mwandel/jhead/usage.html
2. http://www.sentex.net/~mwandel/jhead/
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2011 in review (2012-01-01 12:25) - darthewok

The WordPress.com stats helper monkeys prepared a 2011 annual report for this blog.
[1]

Here’s an excerpt:

A New York City subway train holds 1,200 people. This blog was viewed about 4,700 mes in 2011. If it
were a NYC subway train, it would take about 4 trips to carry that many people.

[2]Click here to see the complete report.

1.
2.

Instaliranje custom firmware-a na PSP 3000 (2012-01-02 21:41) - darthewok

Uputstvo za instalaciju custom firmware-a na Playsta on Portable 3000 i linkove za download mozete vide na adresi:
[1]h p://wololo.net/wagic/installing-pro-cfw-on-a-psp-3000-psp-brite/

161



Inace, u tekstu na gore pomenutoj adresi se potkrala jedna greska. Pise, da firmware update raspakujete u PSP folder
u PSP-u. To je greska, fw update treba raspakova u GAMES folder umesto u PSP folder u PSP-u.

1. http://wololo.net/wagic/installing-pro-cfw-on-a-psp-3000-psp-brite/

Srecan Bozic! (2012-01-07 12:33) - darthewok

Hristos se rodi! Srecan Bozic!

Gimp tutorijal 24 – Ray Studio (2012-01-11 03:22) - darthewok

U epizodi 24 je predstavljen filter Ray Studio.

[youtube=h p://www.youtube.com/watch?v=GBoluv3WAYk]

Fedora 16 i VLC problem posle poslednjeg update-a (2012-01-15 22:49) - darthewok

Od poslednjeg ”apdejta” postoji problem sa VLC-om. VLC nece da se pokrene i u ABRT-u se pojavljuje greska: Process
/esr/bic/vlc was killed by signal 11 (SIGSEGV). A kada se VLC pokrene iz terminala, dobija se poruka: Segmenta on
fault (core dumped).

Problem se resava na sledeci nacin:
1. pokrenite terminal
2. u terminalu ukucajte: su -
3. u terminalu ukucajte: prelink -ua i sacekajte da zavrsi
4. zatvorite terminal i VLC bi trebalo da radi kako treba
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darthewok (2012-01-16 20:04:54)
Postovanje, Niste napisali koji web browser koris te i koju verziju. Da li je to Firefox, Opera, Chrome ili nesto drugo. Pokusajte
da prvo ”apdejtujete” web browser i flash plejer. Za m, ako update ne pomogne, izbrisite kolacice (cookies) i ispraznite
cache browsera. Probajte da problema cnim stranicama pristupite iz nekog drugog web browsera. Ako koris te Firefox, onda
iskljucite sve dodatke (ako ih imate). Neki dodaci znaju da prave probleme. Takodje, proverite brzinu Vase internet konekcije.
Na adresi h p://www.speedtest.net/ mozete proveri brzinu Vase internet konekcije.

Drago Filipovic (2012-01-16 10:32:33)
Koristm PC LinuxOS 2011 O.Sistem.Postovani imam problem oko logovanja ja cu vam to ukratko opisa :Logovanje u Face-
book,google dtranice(osim Google + on se moze ulogova )Windows live i mozda jos neke tesko se loguje na te stranice,a i
ako se ulogujem ponekad u te stranice onda posle nista nece da se otvori u m stranicama(samo jedan primer kod You tube
ponekad kad se ulogujem onda nijedan klip nece da se otvori,akad se izlogujem onda radi normalno,ko Gmail isto tako kad se
ulogujem posle nece nist da mi otvori i dobijem obavjestenje da je veza spora i da otvorim stranicu u HTLM formatu inda ide u
tom formatu,u facebook isto tako udjem i posle nece da mi otvara nista.Saljem vam graficki prikaz da bi to mogli jasnije da mi
objasnite.Sa postovanjem: Drago Filipovic

Gimp tutorijal 25 - 3D TV foto montaza (2012-01-17 21:09) - darthewok

U epizodi 25 se govori o foto montazama. U primerima su napravljene dve foto montaze objekata kako izlaze iz tele-
vizora.
[youtube=h p://www.youtube.com/watch?v=T0yT0iMYW ]

Protest na internetu... (2012-01-18 04:49) - darthewok

Neki sajtovi su vec poceli protest pro v SOPA i PIPA, neki ce uskoro poce .
Evo, kako to izgleda...

[1]

[2]
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1. http://www.flickr.com/photos/l-i-n-u-x/6718152967/
2. http://www.flickr.com/photos/l-i-n-u-x/6718152609/

”PROTECT IP / SOPA” akt rusi Internet (2012-01-18 05:24) - darthewok

[vimeo h p://www.vimeo.com/31100268 w=640 &h=360]

Linux Mint 12 - kako sam podesio i koje sam programe dodatno instalirao (2012-01-22 11:04) - darthewok

Juce sam instalirao Linux Mint 12 32-bitnu DVD verziju na laptop, za sada su mi u sci pozi vni. U ovom tekstu cu
napisa kako sam podesio i koje sam programe dodatno instalirao.

Ostale postupke sam radio kao root. Dakle u terminalu ukucajte su - za m vasu sifru.

Podesavanje swappiness:
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U terminalu sam ukucao: gedit /etc/sysctl.conf i kao poslednju stavku u sysctl.conf sam upisao: vm.swappiness = 10

Dodato 27.1.2012:
Ako imate 4 GB RAM memorije ili vise, mozete stavlja vrednos za swappiness 10 do 20. Ako imate 2
GB RAM memorije, eksperimen site izmedju 30 i 50, i vidite sta Vam najvise odgovara. Ako imate manje
od 2 GB RAM memorije, najbolje da ne dirate opciju swappiness.

Dodavanje opcije noa me u fstab:
U terminalu sam ukucao: gedit /etc/fstab
po ”defoltu” fstab je izgledao ovako:

# /etc/fstab: sta c file system informa on.
#
# Use ’blkid’ to print the universally unique iden fier for a
# device; this may be used with UUID= as a more robust way to name devices
# that works even if disks are added and removed. See fstab(5).
#
#
proc /proc proc nodev,noexec,nosuid 0 0
# / was on /dev/sda5 during installa on
UUID=44687105-2b6f-41f0-a8f1-4ae6557667a2 / ext4 errors=remount-ro 0 1
# swap was on /dev/sda6 during installa on
UUID=8ec6b5a4-99d8-4c0c-917b-49aaa734b198 none swap sw 0 0

Posle izmene izgleda ovako:

# /etc/fstab: sta c file system informa on.
#
# Use ’blkid’ to print the universally unique iden fier for a
# device; this may be used with UUID= as a more robust way to name devices
# that works even if disks are added and removed. See fstab(5).
#
#
proc /proc proc nodev,noexec,nosuid 0 0
# / was on /dev/sda5 during installa on
UUID=44687105-2b6f-41f0-a8f1-4ae6557667a2 / ext4 noa me,errors=remount-ro 0 1
# swap was on /dev/sda6 during installa on
UUID=8ec6b5a4-99d8-4c0c-917b-49aaa734b198 none swap sw 0 0

Dodato 27.1.2012:
Ako radite neke bekape podataka gde je potreban podatak o vremenu pristupa fajlu ili imate neke servere
kojima je potreban podatak o vremenu pristupa fajlu, ili Vam je iz nekog razloga potreban podatak o
vremenu pristupa fajlu, onda ne treba postavlje noa me u fstab.

Pokrenuo sam firewall konfigurator iz terminala komandom: gufw. Podesio sam firewall da odbija sve dolazne upite.
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Blokirao sam Ping odgovore na Ping upite na sledeci nacin:
U terminalu sam ukucao: gedit /etc/ufw/sysctl.conf i promenio sam vrednost 0 u 1 u sledecoj liniji:
net/ipv4/icmp _echo _ignore _all=0
Posle izmene linija izgleda ovako:
net/ipv4/icmp _echo _ignore _all=1

Instalacija startupmanager:
U terminal ukuca : apt-get install startupmanager

Podesavanje grub meout iz programa startupmanager:
U terminal ukuca : startupmanager
U startapmanageru sam promenio: Timeout in seconds: sa 10 na 3 sekunde

Instalacija MS Core fontova:
U terminal ukuca : apt-get install -mscorefonts-installer

Instalacija Midnight Commander:
U terminal ukuca : apt-get install mc

Ostali so ver sam instalirao iz So ware Manager-a (naravno, Vi instalirajte so ver koji je Vama potreban, ne morate
instalira sve sto i ja):
linux-generic-pae - PAE Kernel instalirajte ako imate 4 GB ili vise RAM memorije i ako koris te 32-bitnu verziju Mint
12.
Gparted
Opera
Skype
Google Chrom
Audacious
Audacity
K3b
Google Earth
Inkscape
Dropbox
Keepassx
Stellarium
Avidemux
Kompozer
Streamtuner
H rack
X ghtvncviewer
Acetoneiso
Transmageddon
Cheese
SoundConverter
Mypaint
WinFF
Dia
Gimp-resynthesizer
Gimp-ufraw
Jhead
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Dosbox
Hedgewars
Freecol
Glchess
Foobillard
Gnome-commander
Par mage
Ghex
Python3
Gnome Syb tles

Na kraju sam instalirao:
TrueCrypt preuzet sa adrese: [1]h p://www.truecrypt.org
VirtualBox i VirtualBox Extension Pack preuze sa adrese: [2]h ps://www.virtualbox.org
OOoTranslit 0.4.0 preuzet sa adrese: [3]h p://oootranslit.info/

1. http://www.truecrypt.org/
2. https://www.virtualbox.org/
3. http://oootranslit.info/

Aleksandar (2012-01-22 20:38:59)
Zasto podesavanje swappiness-a? Zasto dodavanje opcije noa me u fstab? Cemu to sluzi? Moze neki nteks c o TeamViewer-u?
Neke Gnu zamene. Ne volim da koris m wine. Poz

darthewok (2012-01-22 21:35:36)
Swappiness je opcija koja odredjuje koliko ce kernel da korsi virtuelnu memoriju na swap par ciji. Minimalni swappiness je 0,
maksimalni je 100. Po ”defoltu” swappiness je 60 i ta opcija po ”defoltu”nije navedena u fajlu /etc/sysctl.conf. Sto je vrednost
manja, kernel ce vise koris RAM memoriju, a manje ce ”swapova ” i obrnuto, ako je vrednost veca, vise ce koris swap, a
manje RAM. Time se dobija na performansama sistema, jer je RAM memorija mnogo brza od swap par cije na hard disku. Na
raznim forumima i blogovima ljudi preporucuju da swappiness bude 10 do 20 na desktop sistemima. Opcija noa me u fstab,
takodje sluzi za op mizaciju, a takodje i smanjuje broj upisa na hard disk, pa samim m i hard disk se manje trosi. Sto je korisno
na SSD diskovima. Opcija noa me je posebna opcija za mountovanje fajl sistema koja sprecava upisivanje vremena pristupa
odredjenom fajlu. Prilikom citanja fajla se vrsi upisivanje vremena pristupa fajlu, pa samim m, ukljucivanjem opcije noa me,
se dobija na performansama sistema. Ako radis neke bekape podataka gde je potreban podatak o vremenu pristupa fajlu ili
imas neke servere kojima je potreban podatak o vremenu pristupa fajlu, onda ne treba postavlje noa me u fstab. Nikada
nisam koris o TeamViewer, pa ne mogu za sada nista pisa o tome. Sada sam na brzinu video cemu sluzi, u principu, koliko
vidim slican je VNC-u, samo verovatno ima vise opcija. VNC mi sasvim dobro zavrsava posao u retkim situacijama kada mi je
potrebno tako nesto. Ni ja ne volim da koris m Wine. :)
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Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Inter-
net za pone (Mint 12). (2012-01-22 11:13) - darthewok

Vec sam opisivao postupak povezivanja u Fedori. U Mintu je slican postupak.
Sve sam radio u MATE Shell interfejsu. Slicno je i u Gnome, s m, sto je ikona za mreznu konekciju gore desno pored
sata.

1. Ukljucite modem. Trebalo bi da bude prepoznat posle desetak sekundi.
2. Kliknu na ikonu mrezne konekcije dole desno pored sata
3. Kliknu na New Mobile Broadband (CDMA) Connec on...
4. Kada se otvori prozor New Mobile Broadband Connec on kliknu na Con nue
5. U lis drzava izabra Serbia i kliknu na Con nue
6. Kliknu na I can’t find my provider and I wish to enter it manually: i upisa ime provajdera Orion i kliknu na
Con nue i za m na Apply
7. Kliknu desnim tasterom na ikonu mrezne konekcije dole desno pored sata
8. Kliknu na Edit Connec ons...
9. U prozoru Network Connec ons kliknu na Mobile Broadband
10. Kliknu na Orion Connec on, za m na Edit...
11. U prozoru Edi ng connec on kliknu na Mobile Broadband
12. U polju Number: treba da pise #777
13. U polju Username: ukucajte Vase korisnicko ime
14. U polju Password: ukucajte Vasu sifru
15. Kliknu na Save...
Ostale parametre ne dira .
Vezu uspostavljate tako sto kliknete na ikonu mrezne konekcije i kliknete na Orion Connec on (EVDO).
Vezu prekidate tako sto kliknete na ikonu mrezne konekcije i kliknete na Disconnect.

Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Internet za pone (Ubuntu
12.04 LTS). « Kompjuteri (2012-05-19 16:35:07)
[...] sam opisivao postupak povezivanja u Fedori i Mintu u Ubuntu je slican postupak. Podesavanje sam radio u Gnome Classic
(no effects) grafickom [...]

Gimp tutorijal 26 - ubacivanje Photoshop braseva u Gimp (2012-01-23 00:13) - darthewok

U epizodi 26 se govori o ubacivanju braseva napravljenih za Photoshop u Gimp.

[youtube=h p://www.youtube.com/watch?v=LNU0DXhyzaM]

168



Gimp tutorijal 27 - munje, varnice i neonske reklame (2012-01-24 19:14) - darthewok

U epizodi 27 se govori o pravljenju munja, varnica, neonskih reklama uz pomoc braseva i filtera difference clouds.

[youtube=h p://www.youtube.com/watch?v=7tPmjgUzHTw]

Mint 12 i Kdenlive (2012-01-27 15:55) - darthewok

Kdenlive 0.8-4, koji se trenutno nalazi u zvanicnom repozitorijumu za Mint 12 ne radi i izbacuje neku gresku prilikom
pokretanja.
Ako imate problem s tom verzijom, deinstalirajte je, za m idite na ovu web adresu: [1]h p://www.kdenlive.org/user-
manual/downloading-and-installing-kdenliv e/pre-compiled-packages/ubuntu-packages
Na gore navedenoj adresi se nalazi uputsvo kako da ak virate Sunab alterna vni repozitorijum. Sa Sunab repozitori-
juma instalirajte Kdenlive. Trenutno aktuelna verzija Kdenlive je: 0.8.2.1, takodje, trebace Vam i MLT 0.7.6, tako da
kada zavrsite sa instalacijom Kdenlive, u Update Manager-u kliknite na Refresh, za m na Install Updates, da bi ste
azurirali MLT na potrebnu verziju.

1. http://www.kdenlive.org/user-manual/downloading-and-installing-kdenlive/pre-compiled-packages/ubuntu-pack
ages

Mint 12, Skype i izvrnuta slika na integrisanoj web kameri na Asus laptopu (2012-01-27 19:46) - darthewok

U Mint 12 i Skype 2.2 na Asus K52J laptopu sa integrisanom web kamerom sam imao problem da u Skajpu bude izvr-
nuta slika sa kamere. Dakle, propisno sam se namucio dok sam ovo names o, a resenje je bilo tako jednostavno. Sto
bi rekao jedan moj drug, lako je bi general posle bitke. :)

Instalirajte libv4l ako ga nemate instaliranog.
U terminalu kucajte:
sudo add-apt-repository ppa:libv4l/ppa
sudo ap tude update
sudo ap tude install libv4l-0

Za m, takodje u terminalu ukucajte: gedit /Desktop/skype.sh
U text editoru ukucajte sledece linije:

#!/bin/bash
LD _PRELOAD=/usr/lib/i386-linux-gnu/libv4l/v4l1compat.so /usr/bin/skype
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Sacuvajte fajl i izadjite iz Gedita.

U terminalu ukucajte: chmod u+x /Desktop/skype.sh

Time ste zavrsili pravljenje skripte za pokretanje Skajpa.

Skype pokrecete dvoklikom na ikonu skype.sh na desktopu i klikom na Run.
Kada se pokrene Skype, udjite u Op ons, pa na Video Devices i kliknite na Test u crnom pravougaoniku.
Ako je sve u redu, videcete normalnu sliku sa web kamere.

Sigurnosni Uredjaji (2012-01-30 21:23:09)
Hvala! Mogu li stavi svoj baner na stranicu?

darthewok (2012-01-31 07:36:19)
Nema na cemu. Ne ovde. Ne volim reklame. Ako si mozda ovde video neke banere, to ih je postavio Wordpress i to je jedan od
uslova koriscenja besplatnih servisa poput Wordpress-a.

Nikola (2012-02-04 13:16:44)
ja imam problem da ne mogu da pokrenem skype uopste , kad pokusam da pokrenem iz terminala dobijem: skype: error
while loading shared libraries: libXss.so.1: .... kontam da je skype i386 a da ja imam amd64 , kako mogu da updateujem i386
dependencies?

darthewok (2012-02-04 21:09:08)
Nasao sam dva resenje za Fedoru i Ubuntu, ali ne mogu da ih proverim, jer nemam instaliran 64-bitni Linux. Ako ko-
ris s Ubuntu (izvor: h ps://bugs.launchpad.net/ubuntu/+source/ia32-libs/+bug/830440): $ echo foreign-architecture
i386 | sudo tee /etc/dpkg/dpkg.cfg.d/mul arch $ sudo apt-get update $ sudo apt-get install libxss1:i386 libqtcore4:i386
libqt4-dbus:i386 $ sudo apt-get install libqtgui4:i386 Ako koris s Fedoru (izvor: h p://lists.fedoraproject.org/pipermail-
/users/2010-February/366776.html): # yum install libXScrnSaver.i586

Skype i izvrnuta slika na integrisanoj web kameri na Asus laptopu – Ubuntu 12.04 LTS « Kompjuteri (2012-05-31 05:36:45)
[...] sam o ovoj temi pisao u clanku: Mint 12, Skype i izvrnuta slika na integrisanoj web kameri na Asus laptopu. Ovaj tekst se
odnosi na is problem u Ubuntu 12.04 LTS na Asus K52J laptopu sa integrisanom web [...]

Besplatni web hos ng - 000webhost.com (2012-01-30 11:45) - darthewok

[1]000webhost.com je industrijski lider u pruzanju besplatnih web hos ng usluga bez reklama!

Izmedju ostalog, za Vasu prezentaciju su Vam na raspolaganju: 1500 MB na serveru i mesecni protok podataka do 100
GB, takodje, kao besplatan korisnik mozete koris PHP i MySQL bazu podataka, pa, osim klasicnih web prezentacija,
mozete postavlja forume i blogove.

170



[2]h p://www.000webhost.com/

1. http://www.000webhost.com/
2. http://www.000webhost.com/

YoWindow - vremenska prognoza (2012-01-30 12:17) - darthewok

[gigya src=”h p://swf.yowindow.com/yowidget3.swf” width=”640”
height=”480” allowfullscreen=”true” wmode=”opaque” bgcolor =” #FFFFFF” flashvars=”loca on _id=gn:792680 &lo-
ca on _name=Belgrade & me _format=24 &unit _system=custom &u _temperature=c &u _wind _speed=mps &u
_pressure=mbar &u _distance=km &u _rain _rate=mm &lang=sr &background= #FFFFFF &copyright _bar=false”]

[1]YoWindow.com

Forecast by [2]yr.no

YoWindow je zanimljiv nacin prikazivanja trenutnih vremenskih prilika i prognoze za narednih 10 dana.

Razvija se u vise verzija:
Kao desktop aplikacija i cuvar ekrana (screen saver) (Windows i Mac).
Kao web widget i kao takav se moze ubaciva u web prezentacije, forume i blogove, kao sto vidite u ovom clanku (na
slici).
Kao dodatak za Chrome web pregledac.
Na sajtu postoji i Live Weather! i kada podesite parametre, mozete ”bukmarkova ” web adresu i kasnije je
otvori . Kao u ovom primeru: [3]h p://yowindow.com/weather.php #loca on _id=gn:792680 &ln=Belgrade &u
_wind _speed=mps &u _pressure=mbar &us=metric & =24

YoWindow mozete naci na adresi:
[4]h p://yowindow.com/

1. http://yowindow.com/weatherwidget?client=widget&link=copyright
2. http://yr.no/
3. http://yowindow.com/weather.php#location_id=gn:792680&ln=Belgrade&u_wind_speed=mps&u_pressure=mbar&us=metri
c&tf=24
4. http://yowindow.com/
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2.2 February

Gimp tutorijal 28 - sneg (2012-02-05 16:08) - darthewok

U epizodi 28 se govori o dodavanju sneznih pahuljica na fotografiju.
[youtube=h p://www.youtube.com/watch?v=pVJknrjsLEI]

Gimp tutorijal 29 - dopuna prethodne epizode (2012-02-05 17:48) - darthewok

Dopuna prethodne epizode.
[youtube=h p://www.youtube.com/watch?v=h-cgnW1TqQk]

Gimp tutorijal 30 - Animirani GIF-ovi (2012-02-07 20:17) - darthewok

U jubilarnoj 30. epizodi se govori o pravljenju kratkih GIF animacija.

[youtube=h p://www.youtube.com/watch?v=4PkTxc3lIjc]

Milkac1 (2012-02-08 14:56:36)
Sjajno uradjen tutorijal..posebno za početnike...samo nastavire tako....Gif-ovi su širok spektakl i izazov za nove tutori-
jale....Nastavite dalje

darthewok (2012-02-08 15:50:40)
Hvala.

Gimp tutorijal 31 - Hockney fotografija (2012-02-09 00:43) - darthewok

U 31. epizodi se govori o pravljenju Hockney fotografija.
[youtube=h p://www.youtube.com/watch?v=KPOXNdj5Dco]
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Dogfight Ba le In The Skies (2012-02-10 02:31) - darthewok

Dogfight Ba le In The Skies je zarazna 2D pucacka igra sa avionima. Pogled na igru je sa strane. Igra se razvija za
Windows i moguce je igra na tastaturi ili dzojs kom.

Igra se moze igra pro v kompjutera, a takodje je mogu igra dva igraca medjusobno na kompjuteru.
Takodje mozete izabra nemacki ili engleski jezik u podesavanjima igre.

U igri postoji oko 150 pova aviona (tako pise na sajtu, nisam proveravao) iz raznih vremenskih perioda. Sto moze
bi zabavno, jer je moguce da se sukobe avioni iz drugog svetskog rata, pro v savremenih mlaznih aviona. :) Takodje,
te avione je moguce opremi raznim oruzijima, od mitraljeza i bombi to raketa. Uz igru dolazi i nekoliko mapa. Na
mapama postoje baze gde mozete slete i popravi avion, naoruza ga i napuni gorivo. Naravno, pro vnicku bazu
mozete bombardova .

Igru mozete preuze sa zvanicnog sajta:
[1]h p://dogfight.kuto.de/

Evo i nekoliko slika iz igre:
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1. http://dogfight.kuto.de/

Gimp tutorijal 32 - Valen ne’s Vampir (2012-02-12 15:06) - darthewok

U 32. epizodi se govori o fotomontazama. Ovaj put sam na zelju jednog od gledalaca napravio fotomontazu na licu.
Napravio sam plavokosog vampira sa srcem u ocima. :)

[youtube=h p://www.youtube.com/watch?v=cFluffpsQjo]

Aviary Tools (2012-02-15 02:31) - darthewok

Aviary Tools je paket mocnih i krea vnih aplikacija koje mozete koris iz vaseg web browsera. Nije potrebna nikakva
instalacija i sve radi u Firefoxu.
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Paket cini 8 programa.

Image Editor - Za obradu bitmap slika i fotografija. Image Editor ima lejere, maske, filter efekte, undo i jos
dosta toga.

Screen Capture - Snima ”skrinsotove” web strana iz vaseg browsera ili desktopa, koje mozete seci, menja
velicinu i snimi .

Vector Editor - Za crtanje vektorskih slika.

Effects Editor - Inova vni program za efekte sa slikama. Podseca na ”node editor” u Blenderu.

Music Creator - Pravljenje muzickih loop-ova i paterna. Simulira dese ne muzickih instrumenata, ukljucujuci
bibnjeve, gitaru, klavir itd...

Audio Editor - Audio editor. Moguce je dodava audio efekte, obradjiva audio fajlove, snima sopstveni glas.
Podrzava vise trekova (kanala).

Image Markup - Radi isto sto i Scree Capture. Nije mi jasno zasto su stavili dva razlicita programa za istu na-
menu. Nisam probao Image Markup.

Swatch Editor - Editor palete boja.

[1]h p://advanced.aviary.com/

1. http://advanced.aviary.com/

Aviary Tools « O štetnos duvana (2012-02-15 08:07:38)
[...] h p://kompjuteri2011.wordpress.com/2012/02/15/aviary-tools/ Share this:TviterFejsbukLike this:Sviđa mi seBudite prvi
kome će se sviđa ovo . Posted in [...]

Start Page - pretrazivac (2012-02-15 03:00) - darthewok

[1]Start Page je internet pretrazivac koga razvija Ixquick. Ixquick vec ima pretrazivac o kome sam ranije pisao. Taj
clanak mozete vide [2]ovde.

Start Page, kao i Ixquick ne pam IP adrese korisnika koji posecuju pretrazivac i ne deli licne informacije trecim licima.
Poseduje SSL (HTTPS) enkripciju, tako da je privatnost pretrage zagarantovana.

Razlikuje se od Ixquick pretrazivaca, po tome sto daje rezultate pretrage sa Google-a. Tako da je Start Page kombi-
nacija privatnos koju poseduje Ixquick sa Google rezulta ma pretrage.

Jos samo da pomenem da ispod svakog linka koji se dobije kao rezultat pretrage stoji i link ”View by Ixquick Proxy”. To

178

http://advanced.aviary.com/


je dodatni nivo privatnos , jer mozete pose link kroz Ixquick-ov web proxy.

[3]h ps://startpage.com/

1. https://startpage.com/
2. http://kompjuteri2011.wordpress.com/2011/05/24/ixquick-pretrazivac/
3. https://startpage.com/

Gimp tutorijal 33 - Svemir (2012-02-17 19:42) - darthewok

U 33. epizodi, po zelji jednog gledalaca, prikazujem tutorijal o pravljenju scena u svemiru.
[youtube=h p://www.youtube.com/watch?v=w-HBm3YeyjM]

2.3 March

Gimp tutorijal 34 - Nazubljene ivice na fotografijama (2012-03-05 15:30) - darthewok

U 34. epizodi, po zelji jednog gledalaca, prikazujem tutorijal o pravljenju nazubljenih ivica na fotografijama.

[youtube=h p://www.youtube.com/watch?v=r2Yn _UvnCJM]

Hidden and Dangerous Deluxe (2012-03-08 09:55) - darthewok

Hidden and Dangerous Deluxe je besplatna igra za Windows koju mozete preuze sa ove adrese:
[1]h p://www.gamershell.com/news _9714.html
Takodje na toj adresi mozete sazna vise detalja o igri. Ovde cu samo ukratko reci da u igri vodite grupu SAS koman-
dosa koji obavljaju razlicite zadatke iza neprijateljskih linija za vreme drugog svetskog rata. Evo i nekoliko ”skrinsotova”
iz igre.

[2]
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[3]
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[4]

[5]
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[6]

[7]
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1. http://www.gamershell.com/news_9714.html
2. http://www.flickr.com/photos/l-i-n-u-x/6817665430/
3. http://www.flickr.com/photos/l-i-n-u-x/6963789245/
4. http://www.flickr.com/photos/l-i-n-u-x/6817665726/
5. http://www.flickr.com/photos/l-i-n-u-x/6963789623/
6. http://www.flickr.com/photos/l-i-n-u-x/6963789533/
7. http://www.flickr.com/photos/l-i-n-u-x/6963789363/

Gimp tutorijal 35 - Foto montaza (2012-03-08 16:24) - darthewok

Epizoda 35 je takodje uradjena po zelji jednog od gledalaca. U ovoj epizodi se opet govori o foto montazama.
[youtube=h p://www.youtube.com/watch?v=T9kZ3qSV2VU]
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NBUExplorer (2012-03-19 11:29) - darthewok

NBUExplorer je Open Source program koji moze da pregleda i raspakuje Nokia NBU, NBF, NFB, NFC i ARC fajlove. Za-
hteva da imate instaliran MS .Net Framework 2. Razvija se za Windows. Osnovna namena programa je da obezbedi ko-
risnicima Nokia telefona i Nokia so vera (PC Suite i Ovi Suite) pristup podacima sacuvanim u rezervnoj kopiji (backup)
koji pravi Nokia so ver.

Mozete ga preuze sa adrese: [1]h p://sourceforge.net/projects/nbuexplo rer/

1. http://sourceforge.net/projects/nbuexplorer/

˜ Razdvajanje integrisanog Flac-a pomocu Cue fajla ˜ (2012-03-23 13:33) - w1ndu

Postoji vise nacina da se ovo uradi, ovde cemo objasni jedan koji koris besplatne programe i codece. Bice vam
potrebni player [1]Foobar2000 & [2]Flac encoder. Za ove potrebe sam koris o F2000 u verziji 1.1.7 sa portabilnom
instalacijom, i Flac encoder v1.2.0 u zipovanom obliku. Iako je generalno bolje koris poslednje stabilne verzije
programa, pomenuta kombinacija se pokazala kao stabilna i efikasna.

Instrukcije:

1/ Skinite i instalirajte [3]Foobar2000. Skinite zipovani [4]Flac encoder i raspakujte ga. Ovde su linkovi ka pre-
porucenim verzijama, ako zelite koris te poslednje.

2/ Pokrenite Foobar i prevucite preko njega Cue fajl koji treba da se nalazi u istom folderu sa odgovarajucim
Flac-om. Pojavice se playlista sa razdvojenim pesmama.

3/ Selektujte sve pesme > Desni klik > Convert > Convert...; Output Format > Flac > kliknite Back; Des na on
> klinite dugme ’...’ pod Name Format > izaberite format imena (Npr. nn. tle). Zatvorite Forma ng prozor i pri dnu
cete vide output preview > Back. Opciono mozete snimi preset konverzije sa Save.

4/ Kliknite Convert > Izabarete lokaciju (Npr. Desktop) > Ok.

5/ Na ovom mestu ce vas Foobar pita za lokaciju flac.exe. Browsujte do foldera gde ste raspakovali zipovani
flac, za m u subfolder ’bin’ i izaberite flac.exe. Od ovog trenutka pocinje konverzija.

Napomena 1: Ako ste sacuvali preset konverzije, prilikom sledece upotrebe ce bi ponudjena u Convert sub-
meniju. U koliko zelite da napravite novi preset, jednostavno izaberite ’...’ (tri tacke) kao opciju.

Napomena 2: Na iden can nacin je moguce konvertova flac u mp3 (bilo integrisani ili odvojeni) pomocu
lame encodera. Razlika je sto ce vam Foobar trazi lame.exe. U koliko zelite ovu vrstu konverzije preporucujem lame
3.92.2 koji mozete skinu [5]ovde.

Naponema 3: Stepen kompresije Flaca ne u ce na kvalitet (on je lossless), vec na zahtevnost koja se stavlja
pred procesorom. Danas je ovo manji problem, ali su slabije kompresije (duzi fajl) zadrzane zbog starijih masina.
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Srecno sa audio konverzijama.. :)

1. http://www.foobar2000.org/
2. http://flac.sourceforge.net/
3. http://www.filehippo.com/download_foobar2000/9970/
4. http://sourceforge.net/projects/flac/files/flac-win/flac-1.2.0-win/
5. http://rarewares.org/files/mp3/lame3.98.2-vc6.zip

˜ WinLame ˜ (2012-03-23 13:38) - w1ndu

Opensource program za encoding i rekompresiju audio fajlova. Za razliku od slicnih alata, u sebi vec ima ugradjene
sve neophodne kodeke. Izuzetno je zgodan za prebacivanje iz flac formata u mp3, po zada m kriterijumima uz is-
tovremeno prebacivanje tagova. Iako postoji vise nacina da se ovo uradi preko besplatnih alata, elegantniji je tesko
zamisli .

Takodje izvlaci maximum iz Lame encodera, koji je moguce koris preko odlicno definisanih preseta ili finog ”ruc-
nog” podesavanja outputa. Narocito je zanimljiv preset transparentnog encodinga, koji koris op mizovanu mp3
kompresiju pri cemu velika vecina ljudi ne moze da razlikuje mp3 od originala tokom ABX testa.

Program je podrzan od strane SourceForge-a, i moze se skinu [1]ovde.

1. http://winlame.sourceforge.net/

˜ CDDB Mp3 Tool ˜ (2012-03-23 13:42) - w1ndu

Vecina programa za ripovanje CDova ima ugradjen sistem koji omogucava prepoznavanje i automatsko reimenovanje
pesama. Problem obicno nastaje kada vec imamo ripovan album sa default imenima (Track 1, Track 2 itd) zato sto
CD riperi ne podrzavaju naknadno reimenovanje, cak i kad podrzavaju rekompresiju. Ovde na scenu stupa CDDB Mp3
Tool autora Mar na Hammera.

Iako rudimentarnog izgleda za danasnje standarde, funkcionalnost je na najvisem nivou. Pregled freedb baze je brzi i
precizan, omogucava rename po zada m kriterijumima, formiranje tagova, playliste, razlicita koriscenja velikih slova
itd.

Program je besplatan i mozete ga skinu [1]ovde.
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1. http://www.softpedia.com/get/Multimedia/Audio/Other-AUDIO-Tools/CDDB-MP3-Tool.shtml

2.4 April

Linux IDX - pretrazivac (2012-04-22 23:30) - darthewok

[1]Linux IDX je pretrazivac koji pretrazuje web strane koje se odnose na Linux. Tako da je interesantan korisnicima koji
koriste Linux.
Linux IDX ne prikuplja nikakve podatke o pretragama pose laca.
[2]h p://www.linuxidx.com/

1. http://www.linuxidx.com/
2. http://www.linuxidx.com/

FreeCol (2012-04-23 04:20) - darthewok

FreeCol je potezna strateska igra, bazirana na hit igri iz 1994. godine Coloniza on. Igru zapocinjete sa dva kolonista i
jednim brodom. Cilj igre je da se od kolonije napravi nezavisna drzava.

Igra je napisana u Javi i moze se igra na Linux, Windows i Mac OSX.

Mozete je prauze sa adrese: [1]h p://www.freecol.org/
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1. http://www.freecol.org/

Adblock Plus (2012-04-26 12:34) - darthewok

Adblock Plus je dodatak za Mozilla Firefox, Google Chrome i K-Meleon koji blokira dosadne reklame koje cesto odvra-
caju paznju od glavnog sadrzaja.

Na adresi [1]h p://adblockplus.org/ mozete procita vise o projektu i preuze dodatak, takodje dodatak mozete
preuze i iz samog internet pregledaca.

1. http://adblockplus.org/
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Blur (nekada se zvao DoNotTrackMe) (2012-04-28 01:24) - darthewok

Blur je dodatak za Chrome i Firefox koji s privatnost korisnika. Osnovna namena dodatka je sprecavanje pracenja
korisnika. Dodatak razvija firma Abine.
Osnovna namena Blura je da blokira veliki broj reklamnih i drugih kompanija koje prate korisnikove ak vnos na in-
ternetu i sakupljaju licne podatke. Blur, takodje omogucava zas tu email korisnika i jos neke mogucnos .
Dodatak se automatski azurira, kako bi mogao da blokira nove reklamne kompanije.
Vise informacija mozete sazna na zvanicnom sajtu. Takodje na zvanicnom sajtu ga mozete i preuze . Ako koris te
Chrome ili Firefox, mozete ga preuze iz samog pregledaca sa repozitorijuma za dodatke.
[1]h p://www.abine.com/

Ovde mozete vide kratak uvodni video za Blur.
[youtube=h p://www.youtube.com/watch?v=rFXgezs8dk0]

1. http://www.abine.com/

Sumo Paint (2012-04-28 03:09) - darthewok

Sumo Paint je jos jedan od ”online” programa za obradu fotografija i crtanje. Nije potrebna nikakva instalacija, jer radi
iz internet pregledaca, na primer Firefox ili Chrome. Mozete ucita sliku sa Vaseg kompjutera ili interneta i obradjenu
sliku sacuva na Vasem kompjuteru ili na serveru. Ako se odlucite za cuvanje na serveru, morate se registrova . Reg-
istracija je besplatna.
Adresa je: [1]h p://www.sumopaint.com/

[2]
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1. http://www.sumopaint.com/
2. http://www.flickr.com/photos/l-i-n-u-x/7120128747/

Adobe flash player i poremecene boje u flash videu na Linuxu (2012-04-29 12:58) - darthewok

Verzije od 11.2.202.228 do 11.2.202.233 Adobe flash plejera cesto prave probleme prilikom reprodukcije flash videa
sa YouTube i slicnih sajtova u Linuxu. Greska se manifestuje u vidu poremecenih boja na videu. Tako da na primer
ljudi izgledaju plavicasto, crvena boja je plava itd...

Dok se greska ne ispravi opisacu dva moguca resenja problema.

Prvo i jednostavnije resenje koje radi u Firefox-u i u Chrome-u je da iskljucite hardversku akceleraciju.
Idite na YouTube, pus te bilo koji video, za m desnim tasterom misa kliknite na video koji ste pus li, za m na Se ngs.
Iskljucite opciju Enable hardware accelera on i u web pregledacu ponovo ucitajte stranu sa videom.

Drugo i komplikovanije resenje je da preuzmete neku stariju verziju flash plejera. Arhivu prethodnih verzija mozete
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pronaci na adresi: [1]h p://helpx.adobe.com/flash-player/kb/archived-flash-player-versions. html

Verzija 11.1.102.63 kod mene radi bez problema u Firefox-u, ali problem i dalje postoji u Chrome-u. Tako da, ako
koris te Chrome, probajte sa nekom starijom verzijom. Cela arhiva je oko 174 MB. Arhiva ukljucuje verzije za Win-
dows, Linux i Mac, kako 32-bitne verzije, tako i 64-bitne verzije.

Kada preuzmete fajl, raspakujte Linux verziju i sa root privilegijama iskopirajte fajl libflashplayer.so u folder
/usr/lib/flash-plugin umesto postojeceg. Preporucujem da pre kopiranja napravite rezervnu kopiju originalnog fajla
za svaki slucaj.

Za m u terminalu sa root privilegijama ukucajte:
cd /usr/lib/flash-plugin
chmod 755 libflashplayer.so
chown root:root libflashplayer.so

1. http://helpx.adobe.com/flash-player/kb/archived-flash-player-versions.html

2.5 May

DOSBox (2012-05-04 17:26) - darthewok

DOSBox je emulator DOS opera vnog sistema. DOSBox se razvija za dosta opera vnih sistema, kao sto su: Windows,
BeOS, Linux, MacOS X...

DOSBox takodje emulira procesore 286 i 386 u realmode/protected rezimu rada, dos direktorijume, fajl sistem, XMS,
EMS, Tandy/Hercules/CGA/EGA/VGA/VESA graficke standarde, SoundBlaster/Gravis Ultra Sound audio kar ce, sto
omogucava odlicnu kompa bilnost sa starim igrama.

Uz pomoc DOSBox-a mozete se podse starih dobrih dana jer DOSBox moze da pokrene veliki broj starih igara i
programa za DOS opera vni sistem, koji vise ne mogu da rade na savremenim kompjuterima.

DOSBox je open source (program otvorenog koda) i potpuno je besplatan.

DOSBox mozete preuze sa zvanicne web prezentacije na adresi: [1]h p://www.dosbox.com/ Na toj adresi, takodje
mozete sazna vise informacija o DOSBox-u.
Ako koris te Linux, vrlo verovatno da se DOSBox nalazi u repozitorijumu Vase Linux distribucije.

Za kraj ovog clanka da napomenem, da je za potpuno uzivanje u DOSBox-u vrlo pozeljno poznava barem osnovne
komande DOS opera vnog sistema.

1. http://www.dosbox.com/
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Gimp 2.8.0 i Fedora 16 (instaliranje) (2012-05-07 04:40) - darthewok

Najzad se pojavila nova stabilna verzija Gimp-a. U pitanju je verzija 2.8.0.

Binarne verzije za Windows, Mac i neke Linux distribucije se mogu preuze .
Na zalost u Fedori 16 se jos nije pojavila verzija 2.8.0, a pitanje je i da li ce se uopste pojavljiva . sudeci po
informacijama sa raznih foruma, verzija 2.8.0 ce bi dostupna u Fedori 17.

Ali uz malo truda i malo vise vremena, moguce je kompajlira Gimp 2.8.0. U ovom clanku cu Vam opisa
kako to da uradite.

Kao prvo, da Vas upu m na ovu adresu: [1]h p://gimper.net/viewtopic.php?f=30 &p=112944
Jer sam na gore pomenutoj adresi nasao detaljno uputstvo kako to uradi u Fedori 16. Medju m, na mom kompjuteru
se pojavila greska Could not find PyGTK 2.10.4 or newer, a i uputstvo na tom forumu je na engleskom, ja cu ga ovde
preves sa jos par dodatnih koraka koje sam uradio. Takodje se zahvaljujem korisniku foruma sa nadimkom sagteck
koji je napisao uputstvo za kompajliranje, koje mi je ustedelo puno vremena prilikom kompajliranja.

1. Pokrenite terminal i u terminalu ukucajte: su - pri snite enter i za m ukucajte root sifru, za m opet en-
ter.
2. Deinstalirajte prethodnu verziju Gimp-a: yum erase gimp
3. Azurirajte sistem: yum update
4. Restarujte kompjuter, opet pokrenite terminal i u terminalu ukucajte: su - pri snite enter i za m ukucajte root
sifru, za m opet enter.

U terminalu ukucajte sledece komande da bi se instalirali potrebni pake :

5. yum install pygtk2-devel (ovo sam morao instalira jer se kod mene pojavila greska: Could not find PyGTK
2.10.4 or newer)
6. yum groupinstall ”Development Libraries”
7. yum groupinstall ”Development Tools”
8. yum groupinstall ”Legacy So ware Development”
9. yum install wget git exiv2 exiv2-devel libspiro libspiro-devel libv4l libv4l-devel lua lua-devel enscript asciidoc v4l-
u ls libopenraw libopenraw-devel jasper jasper-devel graphviz graphviz-devel SDL SDL-devel librsvg2 librsvg2-devel
OpenEXR OpenEXR-devel lib ff lib ff-devel libjpeg libjpeg-devel libpng libpng-devel aalib aalib-devel ghostscript
ghostscript-devel webkitgtk webkitgtk-devel lcms lcms-devel libmng libmng-devel poppler poppler-devel librsvg2
librsvg2-devel libwmf libwmf-devel libXpm libXpm-devel libexif libexif-devel libgudev1 libgudev1-devel xorg-x11-
server-Xv -y

Za m promenite sledece putanje tako sto ce te u terminal ukuca sledece komande:
10. export PKG _CONFIG _PATH=/usr/local/lib/pkgconfig
11. export LD _LIBRARY _PATH=/usr/local/lib
12. cd /usr/local/src/

Da bi ste preuzeli i raspakovali potrebne fajlove sa interneta ukucajte:
13. git clone git://git.gnome.org/babl
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14. git clone git://git.gnome.org/gegl
15. wget h p:// p.gnome.org/pub/gnome/sources/gtk+/2.24/gtk+-2.24.10.tar.xz
16. tar -xf gtk+-2.24.10.tar.xz
17. wget p:// p.gimp.org/pub/gimp/v2.8/gimp-2.8.0.tar.bz2
18. tar -xf gimp-2.8.0.tar.bz2

Kompajlirajte pakete po sledecem redosledu:
Babl:
19. cd babl
20. ./autogen.sh
21. ./configure
22. make & & make install
23. cd ..

Gegl:
24. cd gegl
25. ./autogen.sh
26. ./configure
27. make & & make install
28. cd ..

gtk+-2.24.10:
29. cd gtk+-2.24.10
30. ./configure
31. make & & make install
32. cd ..

i najzad gimp-2.8.0
33. cd gimp-2.8.0
34. ./configure
35. make & & make install
36. cd ..

Gimp pokrecete komandom gimp iz terminala. Takodje mozete napravi simbolicki link (precicu) na desktopu.

1. http://gimper.net/viewtopic.php?f=30&p=112944

Gimp tutorijal 36 - Gimp 2.8.0 prvi u sci (2012-05-07 20:48) - darthewok

U 36. epizodi je predstavljena nova stabilna verzija Gimp-a 2.8.0.

[youtube=h p://www.youtube.com/watch?v=CSn0DNNCF8c]
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Dodaci za Gimp koji ne rade u verziji 2.8.0 (2012-05-09 13:06) - darthewok

Posle dugo cekanja dobili smo novi Gimp sa brojnim unapredjenjima. Na zalost, izmenili su nesto u kodu, tako da neki
stari dodaci (pluginovi) ne rade u novoj verziji.

Sledeci dodaci mi ne rade:
Gmic
Liquid Rescale
Resynthesizer
Gimpsave for web
GREYCstora on

Nadam se da ce Gmic za verziju Gimp 2.8.0 da se ubrzo pojavi, jer se taj projekat ak vno razvija.
Gimpsave for web i GREYCstora on mi nisu toliko bitni dodaci, samo sam ih jednom probao.
Sto se ce Liquid Rescale, ne koris m ga cesto, ali je odlican dodatak. Video sam na zvanicnom sajtu da se pojavio
instaler za Windows, nadam se da ce se uskoro pojavi i za Linux.
Resynthesizer je takodje odlican dodatak, ali nisam siguran da li ce se pojavi za Gimp 2.8.0 jer se ne razvija tako in-
tenzivno kao Gmic. Poslednja verzija je izasla jos pre godinu dana, ako se ne varam.

bakasenovic (2012-05-09 22:18:59)
Meni je Gmic sasvim dovoljan,obzirom na moje veš ne sa Gimpom :-)

Ubuntu 12.04 LTS (2012-05-18 02:17) - darthewok

Napravio sam novu podkategoriju Ubuntu 12.04 LTS u kategoriji Linux ps.

Juce sam instalirao Ubuntu 12.04 LTS, kad mi obaveze i slobodno vreme dozvole, pisacu o tome kako sam instali-
rao i podesio Ubuntu i koje sam dodatne programe instalirao.

Ubuntu 12.04 LTS – kako sam podesio i koje sam programe dodatno instalirao (2012-05-18 17:50) - darthewok

U ovom clanku cu Vam pisa kako sam podesio moju instalaciju Ubuntu i koje sam programe dodatno instalirao.
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Za pocetak da Vam napomenem, da ako se posle par minuta pojavi crn ekran prilikom podizanja sistema sa in-
stalacionog diska i kompjuter ostane tako zamrznut sa crnim ekranom, treba da ukljucite opciju nomodset. Dakle,
ako se pojavi crn ekran i kompjuter ostane zamrznut vise minuta, restartujte kompjuter (pri snite reset taster na
kucistu). Kada se pojavi ljubicas ekran i Ubuntu logo u donjem delu ekrana, pri snite space ili esc na tastaturi da se
pojavi meni i u op ons (F6) ak virajte opciju nomodset. Za m podignite sistem sa instalacionog diska. Tada mozete
isproba Ubuntu ili ga instalira na hard disk.

Pozeljno je da imate ak vnu internet konekciju prilikom instalacije da bi se azurirane verzije so vera preuzele
sa interneta. Da bi ste to pos gli, ak virajte opciju Download updates while installing. Takodje, ak virajte i opciju
Tick this box to install the so ware for this func onality. Kada je ta opcija ak virana, instaliraju se jos neke dodatne
stvari, kao na primer podrska za MP3.

Instalacija je prosla brzo i bez problema.

Posle instalacije sam poceo da podesavam sistem.

Prvo sam dodao opciju noa me u fstab.
U terminalu ukuca : sudo gedit /etc/fstab
Liniju: UUID=96f8ef88-34bb-4b68-86e3-cbb2f8391257 / ext4 errors=remount-ro 0 1
sam izmenio da izgleda ovako: UUID=96f8ef88-34bb-4b68-86e3-cbb2f839125 7 / ext4 noa me,errors=remount-ro 0
1
sacuvao sam izmenu i zatvorio text editor.
Da bi se ak virale izmene u fstab potrebno je restartova kompjuter, ali to ne morate odmah uradi , moze i kasnije.

Podesavanje firewall-a
Preuzimanje grafickog okruzenja za podesavanje firewall-a: sudo apt-get install gufw
Ak viranje firewall-a: sudo ufw enable
Pokrenuo sam firewall konfigurator iz terminala komandom: sudo gufw. Podesio sam firewall da odbija sve dolazne
upite.
Blokirao sam Ping odgovore na Ping upite na sledeci nacin:
U terminalu sam ukucao: sudo gedit /etc/ufw/sysctl.conf i promenio sam vrednost 0 u 1 u sledecoj liniji:
net/ipv4/icmp _echo _ignore _all=0
Posle izmene linija izgleda ovako:
net/ipv4/icmp _echo _ignore _all=1
Za m sam restartovao firewall da bi se ak virale izmene
sudo ufw disable
sudo ufw enable

Instaliranje dodatnih programa iz terminala. Na adresi: [1]h p://www.my-guides.net/en/guides/linux/330-
ubuntu-1204-precise-pango lin-post-installa on-guide sam video spisak paketa koje je korisno instalira posle
instalacije Ubuntu 12.04. Nisam sve instalirao sto je navedeno na toj adresi.

Restricted Extras:
sudo apt-get install ubuntu-restricted-extras

Ubuntu Tweak:
sudo add-apt-repository ppa:tualatrix/ppa
sudo apt-get update
sudo apt-get install ubuntu-tweak
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Gnome Tweak Tool:
sudo apt-get install gnome-tweak-tool

Mul media:
sudo apt-get install libdvdread4
sudo /usr/share/doc/libdvdread4/install-css.sh
sudo apt-get install mplayer smplayer
sudo apt-get install vlc
sudo apt-get install k9copy
sudo apt-get install dvdrip
sudo apt-get install devede

Java:
sudo apt-get install openjdk-7-jre icedtea-plugin

Google Earth:
sudo apt-get install googleearth-package
make-googleearth-package –force
sudo dpkg -i googleearth*.deb

Google Chromium:
sudo apt-get install chromium-browser

XChat:
sudo apt-get install xchat

Pidgin:
sudo apt-get install pidgin

Skype:
sudo apt-add-repository ”deb h p://archive.canonical.com/ $(lsb _release -sc) partner”
sudo apt-get update
sudo apt-get install skype

Podrska za NTFS:
sudo apt-get install n s-config

Flash player:
sudo apt-get install flashplugin-installer

Iskljucivanje ”globalnog” menija:
sudo apt-get remove appmenu-gtk3 appmenu-gtk appmenu-qt
Ako zelite da ga ukljucite: sudo apt-get install appmenu-gtk3 appmenu-gtk appmenu-qt

Midnight Commander:
sudo apt-get install mc

Sledece programe sam instalirao iz grafickog instalera (Ubuntu So ware Center):
Gimp + dodaci
Gimp-resynthesizer
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Gimp-ufraw
Inkscape
Gparted
Audacious
Audacity
K3b + dodaci
Dropbox
Keepassx
Stellarium
Avidemux
Kompozer
Streamtuner2
H rack
Remote Desktop Viewer
Acetoneiso
Transmageddon
Cheese
SoundConverter
Mypaint
WinFF
Dia
Liferea Feed Reader
Jhead
Dosbox
Hedgewars
Freecol
Foobillard
Gnome-commander
Par mage
Ghex
Python3
Gnome Sub tles
kdenlive
RecordMyDesktop
KeyMon
Zsnes
E-uae

Naredna tri programa sam preuzeo sa zvanicnih sajtova i instalirao:
TrueCrypt preuzet sa adrese: [2]h p://www.truecrypt.org
VirtualBox i VirtualBox Extension Pack preuze sa adrese: [3]h ps://www.virtualbox.org
OOoTranslit 0.4.1 preuzet sa adrese: [4]h p://oootranslit.info/

1. http://www.my-guides.net/en/guides/linux/330-ubuntu-1204-precise-pangolin-post-installation-guide
2. http://www.truecrypt.org/
3. https://www.virtualbox.org/
4. http://oootranslit.info/
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darthewok (2012-05-19 16:30:58)
Ne znam, nisam instalirao Operu. Probacu veceras, pa cu da javim radi li ili ne.

bakasenovic (2012-05-18 22:48:39)
Radi li opera na dvanaes ci ?

darthewok (2012-05-19 19:50:30)
Sad sam je probao. Radi. Citao sam na forumima da ljudi imaju nekih problema sa Operom. kod mene nije bilo nikakvih
problema. Preuzeo sam deb paket sa zvanicnog operinog sajta. Verzija 11.64.1403

bakasenovic (2012-05-20 14:08:46)
hvala puno,pitam jer sam i ja imao problema na 11.1o verziji

Adobe flash player i poremecene boje u flash videu na Linuxu (Ubuntu 12.04 LTS) (2012-05-18 18:20)
- darthewok

Dakle i u Ubuntu se desavaju iste stvari, kao i u Fedori. Da poslednje verzije Flash plejera imaju problem sa pore-
mecenim bojama prilikom reprodukcije flash videa sa YouTube i slicnih sajtova. Greska se manifestuje u vidu pore-
mecenih boja na videu. Tako da na primer ljudi izgledaju plavicasto, crvena boja je plava itd…

Ako se i kod Vas desavaju slicni problemi prilikom reprodukcije flash videa, uradite sledece:

Ako koris te Unity ili Gnome Classic, prvo se izlogujte. Jer aplikacija za podesavanje flasha ima neki bug u kombi-
naciji sa Unity i Gnome Classic (Gnome 3 nisam probao). Bug se manifestuje tako sto kada kliknete desnim tasterom
misa na flash video i kliknete se ngs, tada necete moci nista promeni u se ngs prozoru. Zato se logujte u Unity 2D
ili Gnome Classic (no effects).

Iskljucite hardversku akceleraciju. Idite na YouTube, pus te bilo koji video, za m desnim tasterom misa kliknite na
video koji ste pus li, za m na Se ngs. Iskljucite opciju Enable hardware accelera on i u web pregledacu ponovo
ucitajte stranu sa videom.

Vice Commodore emulator i Ubuntu 12.04 LTS (2012-05-18 18:38) - darthewok

Kada sam instalirao paket Vice, emulator mi nije radio. Problem je u tome sto paket nije kompletan, jer fale neki
fajlovi.

Evo resenja:
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Instalirajte Vice: sudo apt-get install vice
Sa adrese h p://www.zimmers.net/anon p/pub/cbm/crosspla orm/emulators/VICE/ preuze odgovarajuci fajl u za-
visnos od verzije Vice emulatora koga imate instaliranog. U trenutku pisanja ovog teksta, verzija za Ubuntu 12.04 je
2.3, pa shodno tome, potrazite verziju 2.3 za Windows. Dakle, u spisku potrazite fajl WinVICE-2.3-x86-pale e-fixed.zip,
preuzmite ga i raspakujte ga u neki privremeni folder.
To je verzija Vice za Windows, ali nas to trenutno ne zanima, jer nam trebaju neki fajlovi koji se koriste i u Linux i u
Windows verziji.
U terminalu ukucajte: sudo -i, za m sifru.
Iskopirajte direktorijume iz fajla preuzetog sa interneta, koji ste prethodno raspakovali.
Direktorijumi koje treba da kopirate u /usr/lib/vice su: C128, C64, C64DTV, CBM-II, DRIVERS, PET, PLUS4, PRINTER,
VIC20, fonts.
Kada se kopiranje fajlova koji nedostaju zavrsi, pokrenite Vice emulator. Trebalo bi da Vice radi bez problema.

Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Inter-
net za pone (Ubuntu 12.04 LTS). (2012-05-18 22:31) - darthewok

Vec sam opisivao postupak povezivanja u [1]Fedori i [2]Mintu u Ubuntu je slican postupak.
Podesavanje sam radio u Gnome Classic (no effects) grafickom okruzenju.

1. Ukljucite modem. Trebalo bi da bude prepoznat posle desetak sekundi.
2. Kliknu na Applica ons -> System Tools -> Preferences -> Network Connec ons
3. U prozoru Network Connec ons kliknu na kar cu Mobile Broadband, pa na Add
4. U prozoru New Mobile Broadband Connec on u padajucem meniju Create a connec on for this mobile broadband
device treba da bude AnyDATA DCMA Products i kliknu na Con nue
5. U lis drzava izabra Serbia i kliknu na Con nue
6. Kliknu na I can’t find my provider and I wish to enter it manually: i upisa ime provajdera Orion i kliknu na
Con nue i za m na Apply
7. U prozoru Edi ng connec on u kar ci Mobile Broadband
8. U polju Number: treba da pise #777
9. U polju Username: ukucajte Vase korisnicko ime
10. U polju Password: ukucajte Vasu sifru
11. Kliknu na Save…
Ostale parametre ne dira .
Vezu uspostavljate tako sto kliknete na ikonu mrezne konekcije i kliknete na Orion Connec on (EVDO).
Vezu prekidate tako sto kliknete na ikonu mrezne konekcije i kliknete na Disconnect.

1. http://kompjuteri2011.wordpress.com/2011/11/26/postupak-povezivanje-cdma-modema-anydata-adu-520e-koji-fir
ma-orion-telekom-nudi-u-paketu-internet-za-poneti-fedora-15-i-16/
2. http://kompjuteri2011.wordpress.com/2012/01/22/postupak-povezivanja-cdma-modema-anydata-adu-520e-koji-fir
ma-orion-telekom-nudi-u-paketu-internet-za-poneti-mint-12/
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bokibalac (2013-11-06 17:04:08)
Zahvaljujem na odgovoru, ustanovio sam o cemu se radi, a problem je u sledecem: Trenutno posedujem AnyDATA ADU-895E
koji sam zamenio sa / jer nisam znao / AnyDATA ADU-520E sa kojim sam bez problema koris o net u Linux-u, na nacin koji si Ti
odlicno i detaljno opisao u ovom tutorijalu, sto znaci da Linux prepoznaje samo, AnyDATA ADU-520E, pa stoga svi ostali koji zele
da imaju od Oriona-a net za pone u Linux-u, neka traze iskljucivo AnyDATA ADU-520E, ako ga ima u ponudi. A ja koji nisam
imao iskustva pa sam pogresio, cu se obra Orion-u da mi izvrse zamenu navedenih modema. Jos jedanput zahvaljujem na
pomoci. Pozzz

bokibalac (2013-11-04 00:51:25)
Da li ovo vazi i za CDMA modem AnyDATA ADU-895E Hvala Pozzz

darthewok (2013-11-05 20:24:15)
Ne znam, nemam taj model. Imam AnyDATA ADU-520E. Ako postoji mogucnost da ga probas, probaj ga. Postupak bi trebalo
da bude is , naravno, pod uslovom da je prepoznat.

LiBRE! - Časopis o slobodnom so veru (2012-05-19 16:45) - darthewok

LiBRE! je nekomercijalni časopis o slobodnom so veru na srpskom jeziku iza koga stoji grupa entuzijasta okupljenih oko
jedne ideje. Ta ideja podrazumeva nesebično deljenje svoga znanja u cilju približavanja slobodnog so vera običnim
ljudima koji nisu programeri ali takođe obezbeđuje i izvesnu količinu informacija namenjenu programerima i napred-
nijim korisnicima računara. Cilj ovog časopisa je da dos gne ugled kod domaće (a delom i strane) publike i da bude
jedan od omiljenih izvora informisanja u svetu slobodnog so vera.

Ovo je deo teksta preuzet sa zvanicne web adrese, casopis je u PDF formatu, postoji cirilicno i la nicno izdanje i
mozete ga naci na adresi:
[1]h ps://libre.lugons.org/

1. https://libre.lugons.org/

Citanje .ePub formata (2012-05-20 16:53) - w1ndu

Format [1]ePub postaje sve popularniji medju izdavacima elektronskih knjiga. Usvojen je kao standard pre svega zato
sto je besplatan i otvoren. Lako se moze desi da nale te na ovaj format pa cemo pomenu nekoliko programa koji
ce vam bi od koris .

1) Citanje

a) [2]ePubReader - Firefox Addon
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Lak nacin za citanje formata je iz samog Firefoxa. Jednostavno instalirajte ePubReader, i moci cete da citate
knjige iz samog browsera. Aktuelna verzija u trenutku pisanja je 1.4.2.1 i radi bez problema na portabilnom FF 12
final. Addon podrzava i SeaMonkey.

b) [3]FBReader* - Free eBook Reader

Program podrzava citanje raznih formata na brojnom pla ormama. Izmedju ostalog moguce je cita i ePub na
Winu. Sve verzije, source kod i dokumentacija dostupni su na sajtu proizvodjaca.

c) [4]Calibre

Izvanredan eBook menadzer sa brojnim opcijama. Pored citanja ePub ima mogucnost konverzije u vise for-
mata, nalazenje knjiga na netu po cenama i izdavacima, editovanje meta-podataka, izmene covera, sor ranje i
organizaciju itd. Program je open source i podrzan od strane SourceForge-a. Portabilna verzija je takodje dostupna
pocevsi od 0.8.4.

d) [5]Adobe Digital Edi ons

Adobeovo resenje za citanje elektronskih formata, izmedju ostalih i ePub. Mnogi korisnici odlucuje se upravo
za ovo resenje, verovatno zato sto dolazi od velike i poznate firme.

2) Konverzija

a) Online

Najbolje rezultate imao sam sa [6]epub-to-pdf.com, pre svega zato sto kreira TOC. [7]Druga opcija takodje daje
korektne rezultate.

b) Desktop

Vec pomenu Calibre ima opciju konverzije u brojne formate. Ako citate na PCju, pretpostavljam da cete koris-
PDF (ne pravi TOC) ili htmlz. Poslednja opcija je zapravo integrisani zipovani html, i prilicno je precizna. Nakon

konverzije jednostavno dodajte extenziju zip, extraktujte i otvorite u bilo kom browseru.

3) Editovanje

a) [8]Sigil

Open source program za editovanje eBook formata, uz podrsku za Win, Lin & Mac. Na Dev sajtu mozete naci
detaljna uputstva i objasnjenja za razlicite funkcije. Projekat je podrzan od Google Code.

b) HTML Editor

ePub format je zapravo zip fajl sa x/html, css i jpg sadrzajem. Ovakva koncepcija mu je i donela popularnost.
Mozete ga jednostavno extraktova i uz malo ves ne editova sadrzaj direktno.

Napomena za one koji se opredele za FBReader:

U trenutnoj Win v0.12.10 postoji bug koji u pojedinim ePub knjigama forsira centralizovan text. Ovo je nemoguce
promeni iz programa sa alignment opcijama. U ovoj situaciji, jedini efikasan nacin je intervencija u samom ePub
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fajlu na sledeci nacin ->

Extraktujte ePub fajl pomocu WinZipa ili neceg slicnog. Na pocetku stylesheet.css upisite liniju:

[code]body { text-align: jus fy }[/code]

Zipujte sve nazad i vra te extenziju u .ePub. Ovo bi trebalo da resi problem sa forma ranjem.

Srecno sa novim eBook forma ma. :)

1. http://en.wikipedia.org/wiki/EPUB
2. http://www.epubread.com/en/
3. http://www.fbreader.org/
4. http://calibre-ebook.com/
5. http://www.adobe.com/products/digitaleditions/
6. http://www.epub-to-pdf.com/
7. http://www.convertfiles.com/convert/ebook/EPUB-to-PDF.html
8. http://code.google.com/p/sigil/

True Crypt - Ubuntu 12.04 LTS (2012-05-21 15:08) - darthewok

Ukljucivanje read/write za usere u True Crypt.

U Linuxu moze doci do problema prilikom mount-ovanja kriptovanih diskova/fajlova u True Crypt-u, jer to morate
uradi kao root, pa iz tog razloga dolazi do problema prilikom pristupa fajlovima na kriptovanom disku/fajlu ili pri-
likom upisivanja fajlova na kriptovani disk/fajl, ako to radite iz korisnickog naloga, a ne root naloga.

Evo, kako sam taj problem resio kod mene.
Pokrenite True Crypt, kada trazi sifru, upisite je i kliknite OK.
Idite u: Se ngs -> Preferences -> Mount Op ons
U okviru Filesystems u polje Mount op ons ukuca :

rw,nosuid,nodev,noa me,uhelper=devkit,uid=1000,
gid=1000,shortname=lower,dmask=0077,u 8=1,flush

Gore navedene opcije sam napisao u 2 reda, jer je kod dugacak i ne vidi se lepo. Vi ga ukucajte u jednom redu.

Iz True Crypt-a mount-ujte Vas kriptovani disk/fajl i moci cete mu pristupa normalno iz korisnickog naloga.
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Grub Customizer - Izmena grub menija na lak nacin - Ubuntu 12.04 LTS (2012-05-23 12:32) - darthewok

Ako iz nekog razloga zelite da pravite izmene u Grub meniju, to najlakse mozete uradi uz pomoc programa Grub
Customizer.

Evo postupka kako instalira Grub Customizer:

1. Kliknite na Applica ons -> Ubuntu So ware Center.
2. U prozoru Ubuntu So ware Center kliknite na Edit -> So ware Sources.
3. U prozoru So ware Sources kliknite na kar cu Other So ware.
4. Kliknite na Add.
5. U APT line ukucajte: ppa:danielrichter2007/grub-customizer.
6. Kliknite na Add Source.
7. Ukucajte sifru.
8. Vra te se na Ubuntu So ware Center.
9. Potrazite grub-customizer i kada ga nadjete, instalirajte ga. (Mozda nece odmah bi vidljiv u lis , sacekajte neko
vreme, i probajte ponovo kasnije, ako se ne pojavi odmah. Ili kliknite na mali trouglic desno od ikone All So ware i
kliknite na Launhpad PPA for Grub Customizer, tu bi trebalo da je odmah vidljiv).

Grub Customizer pokrecete tako sto kliknete na Applica ons -> System Tools -> Administra on -> Grub Customizer.
Prilikom pokretanja Grub Customizer moracete ukuca sifru.
Kada zavrsite sa izmenama Grub menija kliknite na Save i izadjite iz programa.

Root pristup bez sifre - Ubuntu 12.04 LTS (2012-05-23 12:55) - darthewok

U Ubuntu 12.04 LTS se moze pristupi bez root sifre u root nalog kada se u Grub meniju izabere opcija recovery i za m
iz recovery menija treba da se izabere opcija Down to root shell.

To je opasan bezbednosni propust. Na srecu, taj propust se lako resava na sledeci nacin.
Podignite sistem kao sto to obicno radite, za m otvorite terminal i definisite root sifru tako sto ukucate: sudo passwd
root
Moracete ukuca korisnicku sifru za sudo i za m dva puta ukuca root sifru.
Naravno, podrazumeva se da morate zapam root sifru!
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Sledeci put kada udjete u recovery i izaberete opciju down to root shell, moracete kuca root sifru za pristup sis-
temu.

Korisnici i grupe za Virtual Box - Ubuntu 12.04 LTS (2012-05-23 14:15) - darthewok

Javila mi se potreba da definisem korisnike u grupi vboxusers da bi korisnici programa Virtual Box imali mogucnost
koriscenja USB uredjaja u Virtual Box-u. Dodavanje korisnika je moglo da se odradi i uz pomoc komandi iz terminala.
Ali mi je lakse da to radim iz grafickog alata.

Da bi ste to uradili iz grafickog alata, morate prvo instalira gnome-system-tools. Pokrenite Ubuntu So ware Cen-
ter, za m pronadjite i instalirajte gnome-system-tools. Kada se instalacija zavrsi, zatvorite Ubuntu So ware Center.

1. Kliknite na applica ons -> System Tools -> Administra on -> Users and Groups.
2. U prozoru User Se ngs kliknite na Manage Groups.
3. U lis pronadjite grupu vboxusers i kliknite na vboxusers da ga markirate i kliknite na Proper es sa desne strane.
4. S klirajte korisnike koje zelite da dodate u grupu, kliknite na Ok i upisite sifru kada kompjuter zatrazi.
5. Zatvorite Users and Groups, izlogujte se i ponovo se logujte.

Sada bi trebalo da mozete da koris te USB uredjaje u Virtual Box-u.

Nau lus Image Converter - Ubuntu 12.04 LTS (2012-05-23 14:53) - darthewok

Nau lus Image Converter je dodatak za Nau lus koji moze masovno da menja rezoluciju slike ili da ro ra slike. Jako je
jednostavan za rad. Dovoljno je samo da selektujete slike kojima zelite da promenite rezoluciju ili da ih ro rate, za m
kliknite desnim tasterom misa na neku od selektovanih slika da bi se otvorio kontekst meni i kliknite na Resize Images
ili Rotate Images da bi selektovanim slikama promenili rezoluciju ili ih ro rali. U zavisnos sta ste odabrali otvorice se
odgovarajuci prozor gde mozete da unesete parametre za promenu rezolucije ili rotaciju.

Pored opcija koje se odnose na promenu rezolucije, odnosno ugla rotacije, treba da obra te paznju na opcije ispod
stavke Filename.

Prva opcija Append znaci da se izmene nece vrsi na originalnim slikama i da ce se na ime izmenjenih slika doda
nastavak .resized ili .rotated ili sta vec izaberete. Originalne slike ce osta ne promenjene.

Druga opcija Resize in place, odnosno Rotate in place ce promeni rezoluciju, odnosno ro ra originalne slike. Tako
da treba da budete pazljivi s ovom opciojom i da je koris te samo ako ste apsolutno sigurni da zelite da menjate orig-
inalne slike.
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Dodatak instalirate tako sto pokrenete Ubuntu So ware Center u pretragu upisite nau lus-image-converter i kada
ga pronadjete instalirajte ga. Posle instalacije se izlogujte i ponovo ulogujte.

Skype i izvrnuta slika na integrisanoj web kameri na Asus laptopu - Ubuntu 12.04 LTS (2012-05-31 05:36)
- darthewok

Vec sam o ovoj temi pisao u clanku: [1]Mint 12, Skype i izvrnuta slika na integrisanoj web kameri na Asus laptopu.
Ovaj tekst se odnosi na is problem u Ubuntu 12.04 LTS na Asus K52J laptopu sa integrisanom web kamerom i Skype
2.2. Resenje problema je slicno kao i u clanku koji se odnosi na Mint 12.

1. Proverite da li imate instaliran libv4l. Trebalo bi da je instaliran, ako ste instalirali ubuntu-restricted-extras.

2. Za m, u terminalu ukucajte: gedit /Desktop/skype.sh

3. U text editoru ukucajte sledece dve linije linije:
#!/bin/bash
LD _PRELOAD=/usr/lib/i386-linux-gnu/libv4l/v4l1compat.so /usr/bin/skype

4. Sacuvajte fajl i izadjite iz Gedita.

5. U terminalu ukucajte: chmod u+x /Desktop/skype.sh

Time ste zavrsili pravljenje skripte za pokretanje Skajpa.

Skype pokrecete dvoklikom na ikonu skype.sh na desktopu i klikom na Run.
Kada se pokrene Skype, udjite u Op ons, pa na Video Devices i kliknite na Test u crnom pravougaoniku.
Ako je sve u redu, videcete normalnu sliku sa web kamere.

1. http://kompjuteri2011.wordpress.com/2012/01/27/mint-12-skype-i-izvrnuta-slika-na-integrisanoj-web-kameri-
na-asus-laptopu/

2.6 June

Gimp tutorijal 37 - Crop (2012-06-18 16:22) - darthewok

37. epizoda govori o osnovama isecanja slike (crop), najosnovnijem poboljsanju fotografije, osnovnoj pripremi za
razne namene kao sto su prikaz na monitoru, deljenje prijateljima, pravljenje wallpapera i priprema fotografije za
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izradu u fotografskoj radnji.

[youtube=h p://www.youtube.com/watch?v=AiYS0MJ3ecM &list]

Gimp tutorijal 38 - Popravka fotografije (2012-06-20 04:13) - darthewok

U 38. epizodi se govori o koriscenju fotomontaze za popravku fotografije.
[youtube=h p://www.youtube.com/watch?v=lbADo0cRRNw]

Universal USB Installer (2012-06-26 03:08) - darthewok

Universal USB Installer je besplatan open source program za instaliranje Live Linux distribucija na USB Flash. Izuzetno
je lak za upotrebu. Da bi ste instalirali Live Linux na USB, potrebno je da prvo preuzmete ISO fajl zeljene Linux distribu-
cije, za m pokrenete Universal USB Installer i u njemu izaberete zeljenu Live Linux distribuciju, za m izaberete ISO
fajl za odgovarajucu distribuciju, izaberete USB Flash uredjaj i kliknete na Install.

Program moze bi izuzetno koristan, u situacijama kada zelite pokrenu neku Live Linux distribuciju na netook-ovima
ili instalira neku od distribucija sa Live CD-a ili DVD-a. Jer netbook kompjuteri nemaju op cki uredjaj, pa da Live Linux
pokrecete sa CD-a ili DVD-a.

Da bi ste pokrenuli program, potrebno je da imate Windows XP/Vista/7 ili Linux sa instaliranim WINE.
Da bi ste mogli da podignete sistem sa USB Flah-a, potrebno je da Vas kompjuter ima BIOS koji moze da podize sistem
sa USB-a.

Na zvanicnom sajtu mozete vide kompletan spisak trenutno podrzanih Linux distribucija, raznih boot/rescue cd-a
i dvd-a, kao i Windows instalera.

Adresa na kojoj mozete sazna vise
informacija i odakle mozete preuze program je: [1]h p://www.pendrivelinux.com/universal-usb-installer-easy-as-
1-2-3/

1. http://www.pendrivelinux.com/universal-usb-installer-easy-as-1-2-3/
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read more (2014-11-15 05:27:37)
If you would like to improve your know-how only keep visi ng this web site and be updated with the most recent news update
posted here.

Sardu (2012-06-26 03:29) - darthewok

Sardu je program za pravljenje mul boot USB, CD ili DVD. Ako koris te razne Live Linux distribucije i razne rescue i boot
cd/dvd-ove i dosadilo Vam je da nosite sa sobom gomilu diskova, Sardu je program za Vas. Uz pomoc Sardu mozete
na lak nacin napravi mul boot dvd. Na primer mozete na jednom dvd-u da imate System Rescue CD, Hirens Boot CD,
Ul mate Boot CD, Ubuntu, Parted Magic, Clonezilla i mnoge druge. Prilikom podizanja sistema sa tako napravljenog
dvd-a, prikazace Vam se meni gde mozete izabra jednu od opcija za podizanje sistema. Da bi ste napravili mul boot
disk, potrebno je prvo preuze sa interneta ISO fajlove i za m izabra odgovarajuce opcije u Sardu.

Program se razvija za Windows i besplatan je.

Adresa sa koje mozete preuze program i sazna vise informacija je:
[1]h p://www.sarducd.it/

1. http://www.sarducd.it/

2.7 July

Brisanje deak viranih facebook kontakata (2012-07-01 19:54) - w1ndu

Facebook je od skora promenio nacin rada friends liste i poceo da racuna deak virane profile u ukupnom broju
prijatelja. Ovo je uradjeno neselek vno, tako da su uracuna ne samo korisnici koji su sami deak virali profil, vec i
oni kojima je nalog ukinut od strane FB zbog krsenja TOSa. Ako koris te FB na takav nacin da imate veliku listu, onda
moze doci do problema i potrebe da se ovi virtuelni profili sklone. Kao i uvek do sada, FB je izasao sa saopstenjem i
ostavio korisnicima da se sami snalaze.

Postoje dva nacina da se ocis nalog, rucno i preko skripte:

a) Rucni metod.

- Otvorite friends listu i kliknite na prvi blank account. Dobicete obavestenje da je nalog deak viran i opciju za
Unfriend.
- Kada kliknete Unfriend bicete pitani za potvrdu, i nakon potvrde dobicete obavestenje da je nalog sklonjen sa liste.
Na obavestenju je dugme Okay...
- Ignorisite ovo Okay, ostavite obavestenje da stoji i predjite odmah na sledeci blank account. Ovo ce znatno ubrza
ciscenje profila. U koliko kliknete Okay, friends lista ce bi refreshovana.
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b) Skripta metod.

Ovu skriptu je razvio [1]Brandon Venery za potrebe Mafia Wars igraca.

Koris se jednostavno:

- Ulogujte se na svoj FB account i otvorite [2]friends listu.
- Iskopirajte sledeci text-link u Address Bar browsera i pokrenite ga:

[code]
javascript: %28func on %28 %29 %7Bvar a %3Ddocument.createElement %28”script” %29 %3Ba.type %3D”text
%2Fjavascript” %3Ba.src %3D”h p://resdogs.us/Scripts/disableremover.js %3F” %2BMath.random %28 %29 %3Bdoc-
ument.getElementsByTagName %28”head” %29 %5B0 %5D.appendChild %28a %29 %7D %29 %28 %29 %3B
[/code]

- Izaberite jednu od tri opcije za remove i pra te uputstva. Vise o metodama mozete vide [3]ovde.

Tes rani su Auto & FS pod SeaMonkey, i oba metoda su radila korektno. Skripta je inace predvidjena za FF i
Chrome. Za one koji poznaju JS, code mozete vide [4]ovde. U trenutku pisanja ovog texta sve radi pouzdano. Ipak
bih prednost dao rucnom metodu, zato sto je sigurniji.

Postoji jos jedan p disablovanih profila koji se ponasaju kao normalni, tj. imaju sve opcije kao da su ak vni.
Sa druge strane imaju blank profil slike a u koliko stanete misem na ime videcete da link salje na vas sopstveni profil.
Njih je moguce ukloni jedino rucno kao da su ak vni, jer se tako i ponasaju.

Sve u svemu, srecno sa jos jednom genijalnom idejom FB dev ma. :)

1. http://www.facebook.com/notes/brandon-venery/remove-disabled-fb-friends-updated-non-timeline-version/1015
1028816110767
2. http://www.facebook.com/friends/edit/
3. http://www.mafiawarslootlady.com/2012/06/remove-disabled-fb-friends-by-brandon.html
4. http://resdogs.us/Scripts/disableremover.js

Gimp tutorijal 39 (2012-07-05 23:12) - darthewok

Epizoda 39 se sastoji iz dva dela. Prvi deo je prikaz filtera Light rays iz G’mic plugin-a. U drugom delu je prikaz dva
nacina pravljenja magle, uz pomoc plugin-a i rucnom metodom.

[youtube=h p://www.youtube.com/watch?v=W74rHetIybs]
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Gimp tutorijal 40 - Kratka animacija (2012-07-06 14:16) - darthewok

U epizodi 40 je predstavljen plugin Spinning globe i prikazan primer pravljenja kratke animacije uz pomoc plugin-a
spinning globe.

[youtube=h p://www.youtube.com/watch?v=lLqGTXfNLfA]

Video tutorijali za Blender na srpskom jeziku (2012-07-08 14:06) - darthewok

Dosta video tutorijala na srpskom jeziku za Blender mozete pogleda na adresi:
[1]h p://www.youtube.com/user/mintsrbija

1. http://www.youtube.com/user/mintsrbija

Pravopis srpskog jezika (2012-07-08 14:26) - darthewok

Ova tema na prvi pogled nema veze sa kompjuterskim temama kojima se bavi ovaj blog. Ali ako pisete po raznim
domacim forumima, blogovima ili samo caskate, lepo je da se pravilno pise i postuje pravopis.

Pravopis srpskog jezika, azbuku i abecedu mozete pronaci na adresi:
[1]h p://pravopis.tripod.com/

1. http://pravopis.tripod.com/

Google Beatbox (2012-07-14 15:48) - w1ndu

Jos jedan zanimljiv [1]easter egg iz googla. :)

1/ Pose te [2]google translate i iskopirajte sledeci text:

[code]
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pv zk bschk pv zk pv bschk zk pv zk bschk pv zk pv bschk zk bschk pv bschk bschk pv kkkkkkkkkk bschk bschk bschk pv
zk bschk pv zk pv bschk zk pv zk bschk pv zk pv bschk zk bschk pv bschk bschk pv kkkkkkkkkk pv zk bschk
[/code]

Ili jednostavno kliknite ovaj [3]link..

2/ Kliknite Play (dugme u obliku zvucnika).

Za beatbox codove pose te sledeci [4]sajt. :)

1. http://kompjuteri2011.wordpress.com/2011/09/09/sta-je-to-easter-egg/
2. http://translate.google.com/
3. http://goo.gl/VCoF6
4. http://techcrunch.com/2010/11/29/google-beatbox/

Inkscape tutorijal 01 - Uvod u Inkscape (2012-07-17 22:57) - darthewok

U prvoj epizodi tutorijala za Inkscape su opisane neke osnovne opcije i ala koji se najcesce koriste.

[youtube=h p://www.youtube.com/watch?v=c31QQl10Gg8]

Inkscape tutorijal 02 - Efek sa slovima i tekstom (2012-07-22 14:15) - darthewok

U drugoj epizodi tutorijala za Inkscape su malo detaljnije opisani ala i efek koji mogu da se primene na slova i tek-
stove.

h p://www.youtube.com/watch?v=I9vnczM2YnY

h p://www.youtube.com/watch?v=I9vnczM2YnY

Dragan Stanisavljevic (2013-04-27 08:55:19)
Korins m zadnju verziju Inkscape-a pod Win 7 i imam problem kada radim sa tekstom jer mi ne rade opcije horizontal i ver cal
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kerning kao i zadnja opcija character rota on. Jednostavno su sive, tj. nisu ak vne.

darthewok (2013-04-27 10:06:35)
Koris m verziju Inkscape 0.48.3.1 r9886 pod Ubuntu 12.04 i nisam imao takvih problema. Probaj precicom sa tastature da
promenis kerning i rotaciju. Kombinacija tastera za kerning je ALT i strelice, s m sto su strelice levo i desno za horizontal
kerning, a strelice gore dole za ver cal kerning. Kombinacija tastera za rotaciju je ALT [ za rotaciju u levo i ALT ] za rotaciju u desno.

Gimp tutorijal 41 - ”Iskljucivanje” providnos piksela (2012-07-31 16:10) - darthewok

U epizodi 41 se govori o prebacivanju providnih piksela u totalno ne providne piksele i uklanjanju an aliasa na jednos-
tavan nacin.
[youtube=h p://www.youtube.com/watch?v=wFYxDGHlSGw]

2.8 August

Gimp tutorijal 42 - Pravljenje i stampanje plakata (2012-08-07 15:54) - darthewok

U epizodi 42, po zelji jednog od gledalaca, se govori o pravljenju plakata i stampanju plakata. Iskoris o sam gotov
templejt za A4 papir, koji je automatski podesio dimenzije za stampanje na A4 papiru u 300 DPI. U ovoj epizodi sam
napravio futuris cki plakat za epizodu 42 Gimp tutorijala, koristeci filtere u G’Mic pluginu.
[youtube=h p://www.youtube.com/watch?v=8hWqJMHKdz0]

Milovanović Siniša (2013-01-28 21:17:22)
Pa da,kako se nisam se o,hvala puno

darthewok (2013-01-28 21:29:22)
Nema na cemu. Pozdrav.

darthewok (2013-01-28 13:10:57)
Napravi novi projekat u zeljenoj rezoluciji ili ucitaj gotovu sliku i obradi je kako si zamislio. Za m, ako pravis plakat na 4 A4
papira. Izdeli sliku na 4 jednaka dela uz pomoc linija vodjica (guides). Na ovaj nacin: klikni na Image -> Guides -> New Guide
(by Percent) tu postavi horizontalni guide na 50 %. Isto to uradi i za ver kalni guide. Dobices dve linije koje ce da izdele sliku na
4 jednaka dela. Za m, klikni na Filters -> Web -> Slice tu izaberi izlazni format slike (gif, jpg ili png), izaberi folder gde ce da se
sacuvaju slike (path for html export) i klikni na ok. Taj filter je namenjen za web dizajnere, da izdeli vecu sliku na odredjen broj
manjih slika, koristeci guides. Ali, takodje moze da posluzi i za tvoje potrebe da napravis plakat na 4 ili vise A4 papira.
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Milovanović Siniša (2013-01-28 10:05:33)
A,kad hoćeš da ga štampaš na većem papiru od A4 ? Kako se tada pravi,npr na 4 a4 papira

Inkscape tutorijal 03 - Uvoz i izvoz bitmapiranih slika u Inkscape (2012-08-10 15:44) - darthewok

U trecoj epizodi tutorijala za Inkscape se govori o uvozu i izvozu bitmapiranih slika u Inkscape i primeni bitmapiranih
slika u Inkscape-u.
[youtube=h p://www.youtube.com/watch?v=512coMu9weA]

Inkscape i Gimp Specijal (2012-08-19 10:26) - darthewok

Inkscape i Gimp specijalna epizoda o tome kako pripremi sliku za stampanje na majice na CafePress-u.
[youtube=h p://www.youtube.com/watch?v=h39jUrx7XII]

Gimp tutorijal 43 - Xsane i odgovori na pitanja gledalaca (2012-08-19 23:18) - darthewok

U prvom delu je dat kratak prikaz dodatka za Gimp XSane. U drugom delu odgovaram na pitanja gledalaca.
[youtube=h p://www.youtube.com/watch?v=Con5acJ8LOM]

Ime (2012-08-20 20:15:57)
Ja imam very beginner ques on :) Šta znači GNU u skr. GIMP? Ako je ime GNU image manipula on program?

darthewok (2012-08-20 22:14:06)
Ovo je, nadam se, odgovor na tvoje pitanje. Preuzeo sam deo teksta sa Vikipedije. :) h p://sh.wikipedia.org/wiki/GNU
GNU јe opera vni sistem sastavljen iskljucivo od slobodnog so vera. Njegovo ime јe rekurzivna skracenica za ”GNU Niјe
Unix” (”GNU’s Not Unix”). Richard Stallman јe 1983. obјavio Proјekat GNU, u cilju stvaranja potpunog UNIX kompa bilnog
opera vnog sistema — poznatog kao GNU sistem ili prosto GNU — koјi јe slobodan so ver. Proјekat GNU se danas odviјa pod
pokroviteljstvom Fondacije za slobodni so ver (Free So ware Founda on). Razvoј GNU sistema јe znacio i pisanje mnogih
programa, pozna h kao GNU programi ili GNU pake . Medju njima su i uredjivac teksta Emacs, GCC, GNU-ov debugger i
radno okruzenje GNOME. GNU sistem se obicno koris u kombinaciјi sa Linux kernelom, koјi јe razviјen van proјekta GNU.
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Ova kombinaciјa cini potpuno funkcionalan opera vni sistem, GNU/Linux, koјi se medju m cesto pogresno naziva samo ”Linux”.

2.9 September

Free Falcon (2012-09-04 11:50) - darthewok

[1]

Free Falcon je besplatni borbeni simulator letenja koji se razvija za Windows.

Projekat je bio obustavljen od strane ljudi koji su ga razvijali 17. januara 2013. godine. Originalni linkovi vise nisu
ak vni i uklonio sam ih iz clanka.
—————————————-————————————- -
Na srecu projekat je preuzeo drugi razvojni m vec 19. januara 2013. godine.
Adresa foruma je: h p://freefalcon.org/index/
Na gore pomenutoj adresi mozete pronaci detaljnije informacije o projektu, linkove za download itd...

Prvobitno je nastao kao dodatak za Microprose-ov simulator letenja Falcon 4.0. Medju m sada je to samostalan
simulator letenja i nije mu potrebna isntalacija Falcon 4.0. Tim koji razvija Free Falcon je uradio odlican posao na
ovom projektu. I sada je to mnogo naprednija igra, kako u pogledu grafike, tako i u ostalim aspek ma igre.

Na primer u originalnom Falcon 4.0 je bilo moguce lete samo na F-16, sada je moguce lete na dese nama drugih
aviona. Neki avioni imaju svoje kokpite, neki jos uvek nemaju svoje kokpite, to jest, koriste ”default” F-16 kokpit.
Medju m projekat je u stalnom razvoju i stalno se unapredjuje. Tako da je samo pitanje vremena, kada ce i preostali
avioni ima svoje kokpite. Vazno je jos napomenu da razvojni m unapredjuje i izvrsni (exe) fajl. Tako da sa svakom
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narednom verzijom se unapredjuju stabilnost i sam ”endzin”.

Inace, izvorni kod (source code) igre Falcon 4.0 je nekako ”procureo”, kada je kompanija koja ga je prvobitno razvi-
jala propala.

[2]

Igra je modularna i moguce je ubaciva nove sadrzaje. Na primer, na internetu se mogu naci skinovi za avione, do-
datni kokpi , avioni, kampanje, misije, mape itd...
Igra, takodje poseduje ”endzin” za dinamicke kampanje, pa kampanje koje dolaze uz igru, kao i dodatne kampanje
koje se mogu naci na internetu su dinamicke. Inace, igra dolazi sa tri kampanje, koje obradjuju moguci sukob u Koreji.
To je koliko znam jedina igra koja ima potpuno dinamicku kampanju.

Sta to znaci dinamicka kampanja?

To znaci da ne morate zavrsava jednu misiju da bi ste presli na sledecu, kao u klasicnim ne-dinamickim kampan-
jama kakve poseduje vecina igara. Ovde se misije generisu u zavisnos od situacije na virtuelnom ra stu.
Da, virtuelnom ra stu. Mnogo stvari je povezano. Na primer ako je unistena pista na aerodromu, avioni nece moci da
polecu sa tog aerodroma dok se pista ne popravi. Ili na primer ako je unisten radar SAM baterije, ta SAM baterija nece
moci da lansira rakete na avione i samim m napadacka grupa ce moci lakse i bez gubitaka da ostvari cilj. Ili obrnuto...
Inace, borbe se ne vode samo u vazduhu, vec i na kopnu.
Postoji na sto ne kopnenih jedinica koje se bore, pa vazdusna podrska moze bi od presudnog znacaja za ishod. Na
mapi i radaru mozete vide kako se rat odvija, dakle ne zavisi sve od Vas, vec i od kompjuterski vodjenih saboraca,
kako na nebu, tako i na zemlji. Ako igrate igru sa maksimalnim nivoom realnos , ne sumnjam da bi ste sve letacke
operacije obavili i na pravom avionu. U igri se nalazi i editor misija, pa mozete napravi pojedinacne misije ili cak i
neku mini kampanju.

Sve u svemu, uz ovu igru nikada nece bi dosadno.

Da bi ste u potpunos uzivali u igri, preporucujem da je igrate dzojs kom!
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[3]

Da ne bi sve bilo savrseno, igra pa od bagova, koji se javljaju s vremena na vreme. Po nekad, u kampanjama, nije
moguce polete , vec umesto da Vas smes u kokpit aviona, igra vra na ”brifing” ekran. Tada izaberite neku drugu
misiju, ako se to ponovi, izadjite iz igre i ponovo odaberite misiju. Za m, desava se da se igra zablokira kada krene
ucitavanje pred poletanje ili, da igra izle u Windows.
Zato je pozeljno cesto snima aktuelnu kampanju. Po ”defaultu” je ukljucena opcija automatskog snimanja aktuelne
kampanje pre poletanja, tako da ako se igra zablokira ili izle u Windows, mozete nastavi tamo gde ste stali.

Jos jedan problem se javlja je kod podesavanja parametara igre u meniju setup u samoj igri.
Prilikom promene podesavanja u setup meniju avionika se stalno resetuje na realis c. Tako da iz same igre, nije
moguce names realizam za avioniku na bilo sta osim realis c. Nisam siguran da li je to bag ili su programeri namerno
zakljucali podesavanje avionike na realis c. Ako ipak zelite da igrate sa easy avionikom, to mozete uradi na sledeci
nacin:
Podesi sva podesavanja za igru, izaci iz igre i za m otvori fajl:
C:\FreeFalcon6\config\(imepilota ).pop u nekom Hex Editoru.
U bajtu 40 je upisan realizam za avioniku. Treba ga promeni sa 03 na 00.
03 je realis c, 00 je easy.

Na taj nacin se ukljucuje easy avionika i radar ce da radi u svih 360 stepeni. I da prikazuje objekte u plavoj i crvenoj
boji u zavisnos da li su prijateljski ili nisu.

Kada je ak vna easy avionika, prime o sam dva baga:
Kod pri skanja tastera F3 i F4 koji sluze za povecanje i smanjenje razmere radara. Kada pri snete neki od h tastera
igra ce da se prekine i izaci ce u Windows. Zato razmeru radara menjajte kliktanjem misa na za to predvidjene tastere
u kokpitu.
I drugi bag je kada sam hteo da koris m raketu AGM-65G, prilikom prebacivanja u A-G rezim, isto se desava da igra
izle u Windows.

Tako da ili igrajte igru sa realis c avionikom ili ako bas hocete easy avioniku izbegavajte koriscenje testera F3 i F4 i
A-G rezim sa raketom AGM-65G. Ne znam da li je bag prisutan i na ostalim Maverick raketama, jer nisam probao, jer
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u glavnom igram sa realis c avionikom.

Da bi ste igrali igru, potrebno je da preuzmete fajl sa instalerom i kokpi ma.
Mozete naci dodatna ra sta koje mozete preuze .
Postupak instalacije je sledeci:
1. Instalirajte igru
2. Instalirajte kokpite
Dodatna ra sta instalirajte na kraju.

Za kraj i jedan dodatak koji ce bi zanimljiv korisnicima sa nasih prostora.
A to je Balkans Theater. Koga mozete takodje preuze sa adrese koju sam gore napisao.

To je dodatna mapa, koja obuhvata veci deo Balkanskog poluostrva i Italiju sa tri kampanje. Prva kampanja obrad-
juje rat iz 1999, druga kampanja je hladni rat, smestena u 1985. godinu i treca je moderna kampanja, smestena u
2012. godinu. U m kampanjama mozete bira stranu. Tako da na primer, mozete izabra nasu stranu i pokusa
odbrani Srbiju od Nato bompardovanja 1999. U toj kampanji, mozete lete na Mig-21, Mig-29, koji imaju nase oz-
nake, a kao posebna poslas ca je sto mozete lete i na G-4 Supergaleb.

[4]

Kada instalirate Balkans Theater, u igri promenite ra ste sa korejskog na balkansko, mozda ce te mora da izadjete
iz igre i da je ponovo pokrenete kada promenite ra ste. To isto vazi i za ostala ra sta ako ih eventualno preuzmete i
instalirate.

[5]
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[6]

[7]
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1. http://www.flickr.com/photos/l-i-n-u-x/6687687827/
2. http://www.flickr.com/photos/l-i-n-u-x/6687690325/
3. http://www.flickr.com/photos/l-i-n-u-x/6687689509/
4. http://www.flickr.com/photos/l-i-n-u-x/6687688225/
5. http://www.flickr.com/photos/l-i-n-u-x/6687686831/
6. http://www.flickr.com/photos/l-i-n-u-x/6687683853/
7. http://www.flickr.com/photos/l-i-n-u-x/6687687369/

Gimp Magazin (2012-09-15 20:31) - darthewok

5. septembra 2012. je izasao prvi broj Gimp Magazina, besplatnog internet magazina u PDF formatu. Kao sto mu ime
kaze, posvecen je programu Gimp. Izlazi na engleskom jeziku. U casopisu mozete procita razne tekstove o Gimpu,
obradi fotografije, pogleda galeriju slika napravljenih ili obradjenih u Gimpu, a tu su i tekstovi sa tutorijalima.

Mozete ga preuze sa adrese: [1]h p://gimpmagazine.org/

1. http://gimpmagazine.org/
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Opsiran odgovor na pitanje zasto pravim tutorijale za Gimp, a ne za Photoshop (2012-09-18 04:15) - darthewok

Juce sam dobio mail sa pitanjem: ”Zasto pravim tutorijale za Gimp, a ne za Photoshop, kad je Photoshop bolji?”

Pitanje je konkretno i direktno. Na mail sam odgovorio konkretno i direktno, ali me je to inspirisalo da ovaj
put malo pisem o slobodnom so veru i zasto koris m slobodan so ver, a izbegavam vlasnicki so ver kad god mogu.

Kao prvo, zasto Gimp, a ne Photoshop?

Postoji vise razloga, koje cu nabroja . Kao prvo za moje potrebe je Gimp vise nego dovoljan. Samim m se
nadovezuje i cena, koja je za nase uslove astronomska, krece se oko 977 dolara (kod jednog od domacih uvoznika).
Tako da mi se ne ispla da placam nesto tako skupo, a taj is posao moze da mi zavrsi besplatni Gimp. Za m,
ako zanemarim cenu, hardversku zahtevnost i to sto ne postoji u verziji za Linux, dolazim do glupavih vlasnickih
ogranicenja, koji ogranicavaju krajnjeg korisnika da ak vira proizvod na vise kompjutera. Ako se ne varam, licenca
za Photoshop dozvoljava ak vaciju proizvoda na dva kompjutera. S m sto licenca zabranjuje koriscenje na oba
kompjutera u isto vreme. Sto mi je malo bez veze da licenca ogranicava krajnjeg korisnika na koliko ce kompjutera da
ga instalira i ak vira, ako je vec korisnik toliko skupo pla o proizvod. Hm, bolje receno da korisnik placa licencu, tj,
dozvolu za koriscenje proizvoda, a ne sam proizvod...
Za razliku od Photoshopa, gde su neke slobode jako ogranicene, korisnik moze slobodno da skine Gimp sa interneta,
instalira i koris na koliko god hoce kompjutera bez ogranicenja.
Ovde cu da zavrsim odgovor zasto Gimp, a ne Photoshop, jer sam poceo da zalazim u temu o kojoj hocu da pisem u
drugom i trecem delu ovog teksta.
Samo za kraj prvog dela da napomenem, da ne bude zabune, Photoshop je generalno bolji u odnosu na Gimp i tu
nema nikakve dileme. Mozda su u Gimpu neke stvari bolje resene u odnosu na Photoshop, ali, generalno Photoshop
je bolji bez dalje diskusije. Ovo napominjem, da se ne bi otvorila diskusija na temu ko je bolji. Jer mi nije bio cilj da
poredim tehnicke mogucnos samih programa.

U prvom delu sam pomenuo ak vaciju. To je jos jedna od glupos koje se javljaju kod nekih vlasnickih pro-
grama i so verskih paketa. Zamislite, da bi ste mogli koris Photoshop, Windows, Office i jos neke programske
pakete, a u poslednje vreme i igre, morate ih ak vira preko interneta. Znaci nije dovoljno samo pla , vec ih
morate i ak vira . Od velikih so verskih firmi, ako se ne varam, prvo je poceo Micrsoso da uvodi ak vaciju u
opera vnom sistemu Windows XP. Neki programi, cak imaju i ogranicen broj ak vacija. I jos pored ak vacije treba
kuca i ”kilometarski” serijski broj. Valjda su mislili da ce me, ako ne spreci , a ono bar smanji pirateriju. Jedino
sto su pos gli je maltre ranje legalnih korisnika, koji su skupo pla li licencu za koriscenje. I bar da je so ver koji se
isporucuje bezbedan i stabilan. Napro v. Cesto se isporucuju polugotovi proizvodi, prepuni bagova i bezbednosnih
propusta. Pa se posle izbacuju razne zakrpe, koje treba skinu sa interneta i instalira . Ne kazem da takvih propusta
nema i u slobodnom so veru, ali je taj so ver besplatan i razvija se od strane entuzijasta koji u to ulazu svoje
slobodno vreme. Pa se takvim propus ma u tom slucaju moze progleda kroz prste, ali u slucaju skupog vlasnickog
so vera, mislim da je to nedopus vo.

Kada ste instalirali neki vlasnicki so ver, verovatno niste nikada procitali kompletan EULA tekst, vec samo kliknete na
”I Agree with...” i klinete na ”Next”. Jednom davno sam probao da procitam ceo EULA tekst, ali je bio toliko dugacak,
suvoparan, dosadan i prepun pravnih termina, da bi mi bio potreban advokat sa odlicnim znanjem engleskog jezika
da bi mi rastumacio sta sve tamo pise.
EULA je skracenica za ”End-User Licence Agreement” ili u prevodu ”Ugovor o licenci s krajnjim korisnikom”. EULA je
ugovor koji prihvatate kada god kliknete na ”I Agree with...” i kada kliknete na ”Next” prilikom instalacije nekog so -
vera. Ukratko, EULA garantuje korisniku so versku licencu. Ugovor, takodje odredjuje granice slobode garantovane
od strane vlasnika. Znaci, odredjuje se granica slobode u kojima se sme ili ne sme koris so ver. EULA s so ver
tako sto ogranicava slobodu korisnika.
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U trecem delu cu pisa o slobodnom so veru.

Rec ”Free” u recenici ”Free So vere” se odnosi na slobodu koriscenja so vera, a ne na cenu. Tako da slobo-
dan so ver ne mora uvek bi i besplatan so ver. Na primer, preuzeli ste program sa interneta i ne znate kako da ga
instalirate. Pozovete nekog ko to zna da instalira i on Vam moze napla uslugu instaliranja. :)

Slobodan so ver definisu 4 slobode:

- Sloboda koriscenja programa u bilo koje svrhe.
Ogranicenja koriscenja so vera, kao sto su vremenska, geografska i ogranicenja svrhe koriscenja program cine
neslobodnim.

- Sloboda uvida u nacin funkcionisanja programa (otvoreni kod - open source).
Ogranicenja uvida u izvorni kod programa, shvatanje njegovog funkcionisanja i modifikovanja program cine neslobod-
nim.

- Sloboda distribucije kopija.
So ver moze bi kopiran i distribuiran bez ogranicenja. Ako ovo nije dozvoljeno program nije slobodan. Ako korisnik
to zeli, kopiranje i distribuciju moze napla .

- Sloboda unapredjivanja programa i objavljivanje unapredjenja, kako bi zajednica imala koris .
Ova sloboda omogucava programerima da unaprede program bez ogranicenja. Ovo moze, a i ne mora bi naplaceno.

Najcesce koriscena slobodna licenca je GNU opsta javna licenca (GPL). Za razliku od EULA licence, koja s
so ver na racun slobode korisnika, GNU/GPL licenca s so ver ne ogranicavajuci slobode korisnika.

Neka od svojstava GNU/GPL licence su:
- So ver se moze instalira na koliko god zelite kompjutera.
- So ver odjednom moze koris bilo koji broj ljudi.
- Mozete napravi koliko god zelite kopija i da ih kome god zelite.
- Nema ogranicenja u menjanju so vera, osim zadrzavanja odredjenih obavestenja nedirnu ma.
- Nema ogranicenja u distribuciji, koja moze bi besplatna ili se moze napla .

Vitomir Kovanovic (2012-09-20 07:46:32)
Po meni, postavlja se pitanje, zašto bi svoje slobodno vreme trošio da pomažeš nekoj tamo firmi (Adobe) da njihov so ware
bude bolji? On bi defini vno postajao pisanjem tutorijala tako da korisnicima bude lakše da ga koriste. Ako njihovi korisnici
hoće da plate Adobe-u 1000 $ za njegovo korišćenje, onda neka im Adobe piše tutorijale. Sa druge strane pišući tutorijale za
slobodan so ware, učestvuješ u razvoju samoga so ware-a, jer je podjednako bitno da postoje resursi na netu o tome kako se
program koris . A me ceo svet postaje boga ji ne samo jedna kompanija :)

Ne, ne i ne, Photoshop CS2 NIJE besplatan!!! « Kompjuteri (2013-01-08 12:22:46)
[...] Ovo je jos jedan primer, o pogresnom konceptu “online” ak vacije proizvoda koje so verske kuce prak kuju u poslednjih
desetak godina. Vec sam o tome pricao u ovom clanku: Opsiran odgovor na pitanje zasto pravim tutorijale za Gimp, a ne za
Photoshop [...]
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XnView (2012-09-18 13:18) - darthewok

XnView je program za pregled i konverziju grafickih fajlova. Podrzava oko 400 grafickih formata koje moze da ucita i
oko 50 grafickih formata u koje moze da konvertuje ucitane fajlove. XnView dolazi sa ugradjenim filterima i efek ma
kojima mozete obradi sliku, takodje moze da isece parce slike, da ro ra sliku, podrzava i takozvanu ”Lossless” rotaciju.
To jest, rotaciju bez gubitka kvaliteta kod jpg fajlova. Takodje je moguce podesavanje kontrasta, osvetljenos slike i
jos dosta toga...

Postoji u verziji za vecinu opera vnih sistema koji se danas koriste, ukljucujuci i iOS i Android.

Program je besplatan za licnu, ne komercijalnu upotrebu, za eduka vne svrhe ukljucujuci ne profitabilne organizacije.

Adresa zvanicne web prezentacije: [1]h p://www.xnview.com/

1. http://www.xnview.com/
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Make Human (2012-09-21 02:06) - darthewok

Make Human je open source program za generisanje 3D modela ljudskih figura. Make Human se razvija za Linux, Win-
dows i Mac. Program je dizajniran da bude lak za upotrebu i fleksibilan. Modeli su bazirani na realnim podacima o

pu tela i polu. Takodje, u samom programu, mozete podesi pozu koju zelite i renderisa gotovu sliku ili mozete da
3D model izvezete u neki program za 3D animaciju, na primer Blender i da ga u Blenderu doradite, animirate ili samo
izrenderisete sliku.

Zvanicna web prezentacija programa je na adresi: [1]h p://www.makehuman.org/

Postoje problemi prilikom instalacije deb paketa u Ubuntu 12.04. Jer je potrebno da imate instaliran Python 2.6, a te
verzije Pythona nema na zvanicnom repozitorijumu. Zato preuzmite tbz2 arhivu i raspakujte je u zeljeni direktorijum.
Za m uradite sledece:
U terminalu ukucajte:
sudo ln -s /usr/lib/libpython2.7.so.1.0 /usr/lib/libpython2.6.so.1.0
za m,
sudo ln -s /usr/include/python2.7 /usr/include/python2.6
na kraju u Ubuntu So ware Center pronadjite paket: glew-u ls1.5 i instalirajte ga.
Ako ste sve dobro uradili, Make Human bi trebalo da radi.

Ako se desi da, Blender prijavi gresku ”expected 1.2 but got 1.3”, prilikom uvoza mhx fajla. Tada otvorite direktorijum
gde je instaliran Make Human i potrazite fajl io _import _scene _mhx.py. Takodje, potrazite taj is fajl u direktorijumu
gde je instaliran Blender. Kada pronadjete lokacije oba fajla, iskopirajte fajl io _import _scene _mhx.py iz Make Human
umesto originalnog Blenderovog. Ako ste to dobro odradili, trebalo bi uvoz mhx fajlova da radi bez problema.

1. http://www.makehuman.org/

C-evo (2012-09-30 13:31) - darthewok

C-evo je besplatna open source igra u kojoj gradite svoje carstvo. Igra je radjena po ugledu na Civiliza on. Grafika je
na nivou Civiliza on 2 iz devedese h godina, ali neka vas to ne zavarava, igra je jako dobro uradjena i zarazna je. Ako
ste igrali Civiliza on, od prilike znate sta ce da vas ocekuje u C-evo. U C-evo, naglasak je na unapredjenoj ”inteligen-
ciji” kompjuterski vodjenih igraca i pazljivog dizajna pravila u igri. Igru zapocinjete tako sto, na pocetku podesite neka
podesavanja, na primer, koliko ce civilizacija bi u igri. Kada to podesite, pojavice se mapa, gde ce se vide vas prvi
grad, jedan setler, i neposredna okolina grada. U pocetku ce veci deo mape bi crn, sto znaci da taj deo jos niste
istrazili. Kako napredujete u igri, gradicete nove gradove, vojne jedinice, gradjevine u gradovima, farme, puteve, rud-
nike, istraziva nove tehnologije. Bicete u kontaktu sa drugim civilizacijama, s kojima mozete razmenjiva tehnologiju,
ratova ...

Zvanicna prezentacija igre se nalazi na adresi: [1]h p://www.c-evo.org/

Evo i nekoliko slika iz same igre:
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1. http://www.c-evo.org/

2.10 November

Windows XP i Fujitsu Siemens Amilo Li 2735 laptop (2012-11-01 15:13) - darthewok

Ako instalirate Windows XP na Fujitsu Siemens Amilo Li 2735 laptop, moze da se desi da instalacija Windowsa XP ne
prepozna hard disk i u tom slucaju nece hte da instalira Windows. Restartujte laptop i udjite u bios. U biosu potrazite
opciju AHCI configura on i iskljucite je tako sto je postavite na Disabled. Sacuvajte izmene u biosu i restartujte laptop.
Posle ovoga instalacija bi trebalo da prepozna hard disk i tada mozete nastavi sa instalacijom Windowsa XP na Fujitsu
Siemens Amilo Li 2735 laptop.
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Obrada PDF-a u Open/Libre Office-u (2012-11-19 00:29) - w1ndu

Od kad je Oracle odlucio da kupi Javu i promeni EULA, puno korisnika i distribucija se prebacilo na [1]Libre Office. To
je i moja preporuka. Poslednja Sun verzija OOo bila je 3.20 i mozete je skinu za Win u portabilnoj verziji [2]ovde.

Da bi ste editovali PDF u Openu, trebace vam addon kojim mozete skinu [3]ovde. Nakon instalacije mozete da uvezete
PDF u Open Draw i editovanje je slicno kao i u Corelu.

F2 ce vam otvori (po defaultu) Text Editor, a F11 mogucnost da ga editujete (promenite font itd). Nakon toga jednos-
tavno snimite obradjeni PDF. Takodje mozete izabra izvoz u PDF sa naprednijim opcijama.

Srecno u besplatnoj obradi PDF fajlova. :)

1. http://www.libreoffice.org/
2. http://portableapps.com/apps/office/openoffice_portable
3. http://extensions.openoffice.org/en/project/pdfimport

bakasenovic (2012-11-19 15:49:33)
Nisam znao iskreno da može i editovato pdf,hvala za ovo

Gimp tutorijal 44 - Dim u boji (2012-11-24 14:45) - darthewok

Jedan od gledalaca je gledao Photoshop tutorijal kako se pravi dim u boji i pitao je kako se to radi u Gimpu.
[youtube=h p://www.youtube.com/watch?v=SmHb5J2vcdw]

AutoIt (2012-11-25 01:09) - darthewok

AutoIt je besplatan skript jezik, slican Basic-u, namenjen za automa zaciju raznih operacija u opera vnom sistemu
Windows. Takodje se mogu pravi i razne skripte koje prevazilaze samo automa zaciju raznih operacija u Windows-u,
moguce je napravi i programe za neku konkretnu primenu. Kada se skripta kompajlira, dobija se izvrsni (exe) fajl koji
je samostalan i ne trazi dodatne dll-ove.

AutoIt se razvija za Windows i mozete ga preuze sa zvanicne web prezentacije.
[1]h p://www.autoitscript.com/site/autoit/

1. http://www.autoitscript.com/site/autoit/
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hawksmont Universe :) (2012-11-28 05:05) - darthewok

hawksmont Universe je blog namenjen grafici i grafickom dizajnu. Na blogu mozete pronaci mnogo besplatnih braseva
za Gimp i Photoshop. Takodje ima dosta fotografija i slika. Ima i nesto malo tutorijala za Gimp i Photoshop.

Adresa bloga je: [1]h p://hawksmont.com/

1. http://hawksmont.com/

2.11 December

Korisnicka uputstva za upotrebu (2012-12-05 08:09) - darthewok

Ako su vam potrebna korisnicka uputstva za upotrebu za razne uredjaje, kao sto su televizori, frizideri, kompjuteri,
kompjuterska oprema, automobili, klima uredjaji, ves masine i mnogi drugi, mozete ih pronaci i preuze sa sledecih
adresa:

[1]h p://www.manualslib.com

[2]h p://www.docsfilepdf.com/

1. http://www.manualslib.com/
2. http://www.docsfilepdf.com/

Krita (2012-12-08 16:38) - darthewok

Krita je program za graficki dizajn i prvenstveno je namenjena umetnicima koji ”prave slike od nule”. Naravno, Kritu
mozete koris i za obradu gotovih fotografija i slika. Krita, kao i Gimp, podrzava rad sa lejerima, ima pristojnu kolicinu
filtera i braseva. Krita ce pun potencijal da pokaze, kada je koris te u kombinaciji sa olovkom i tabletom.

Razvija se za Linux, FreeBSD i Windows. S m sto je, sudeci po tekstu na zvanicnom sajtu, verzija za Windows jos
bagovita. Izgleda da su tek od skoro poceli da razvijaju i Windows verziju.
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Detaljnije informacije mozete pogleda na zvanicnom sajtu: [1]h p://krita.org

1. http://krita.org/

Gimp tutorijal 45 - Refleksija na vodi (2012-12-15 14:12) - darthewok

U prvom delu je prikazan jedan od nacina za poboljsanje fotografije, u drugom delu su prikazana dva nacina za pravl-
jenje refleksije na vodi.
[youtube=h p://www.youtube.com/watch?v=exw7LthQ2bo]

Srpski jezik za Gimp - Ubuntu 12.04 (2012-12-23 10:23) - darthewok

Nekoliko ljudi me je pitalo da li postoji prevedena verzija Gimpa?

Postoji. U Linuxu (ne znam za Windows verziju), da bi imali Gimp na srpskom, morate instalira podrsku za ceo sistem,
pa ce onda i Gimp bi preveden, kao i sve ostalo. S m, sto postoji jedno ogranicenje, a to je, da je Gimp sa ugradjenim
filterima preveden, ali ne i dodatni filteri, koje ste mozda naknadno instalirali u Gimp. Pa ce na kraju bi mesavina
srpskog i engleskog jezika.

Postupak instaliranja podrske za srpski jezik u Linuxu (Ubuntu 12.04 - Gnome Classic graficko okruzenje):

Kliknu na: Applica ons -> System Tools -> System Se ngs -> Language Support

Ako je instalirana podrska za srpski jezik onda preskoci korake 1 i 2.
1. Kliknu na Install / Remove Languages
2. S klira Serbian i kliknu na Apply Changes
3. Prevuci srpski (la nicno ili cirilicno pismo) da bude prvi u lis
4. Kliknu na Apply System-Wide
5. Izlogova se, pa se ponovo logova u sistem

P.S.
U medjuvremenu sam naisao i na ovu adresu:
[1]h p://forum.ubuntu-rs.org/Thread-kubuntu-kako-ak vira -srpsku-lokal izaciju-gimpa
Gde su vec postavljeni odgovori u vezi prevoda Gimpa na srpski jezik.
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1. http://forum.ubuntu-rs.org/Thread-kubuntu-kako-aktivirati-srpsku-lokalizaciju-gimpa

CODE:FREE (2012-12-25 13:06) - darthewok

CODE:FREE je besplatan online casopis koji je fokusiran na slike napravljene raznim open source programima.
Vecina slika je napravljena uz pomoc programa Inkscape, Gimp, MyPaint, Blender i Alchemy.
Sam casopis se distribuira u PDF formatu i mozete ga preuze sa ove adrese:
[1]h p://codefreemagazine.wordpress.com/

1. http://codefreemagazine.wordpress.com/

Skype - nema audio obavestenja o dolazecim pozivima, chat porukama... - Ubuntu 12.04 (2012-12-30 12:32)
- darthewok

Ako u Skype-u nemate audio obavestenja o dolazecim pozivima, dolazecim chat porukama, prijateljima koji se po-
javljuju online ili odu offline itd... Prvo proverite no fica ons podesavanja. Trebalo bi da je s klirana opcija Play
sound file i da je izabran audio fajl za da dogadjaj. Ako je to u redu, a i dalje nemate audio obavestenja za dogadjaje,
onda kliknite na ikonu zvucnika gore desno pored sata, u meniju koji se pojavi, kliknite na Sound Se ngs -> Sound
Effects. Tu ukljucite Alert volume i pojacajte ga do zeljene jacine. Za m u Skype-ovim no fica ons podesavanjima
proverite da li se cuju audio obavestenja, klikom na Test Event.

Srecna Nova Godina!!! (2012-12-31 10:09) - darthewok

Svim pose ocima bloga Kompjuteri zelim srecnu novu godinu!
[1]
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1. http://www.flickr.com/photos/l-i-n-u-x/8314999690/

2012 in review (2012-12-31 10:33) - darthewok

The WordPress.com stats helper monkeys prepared a 2012 annual report for this blog.
[1]
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Here’s an excerpt:

4,329 films were submi ed to the 2012 Cannes Film Fes val. This blog had 21,000 views in 2012. If each
view were a film, this blog would power 5 Film Fes vals

[2]Click here to see the complete report.

1. http://kompjuteri2011.wordpress.com/2012/annual-report/
2. http://kompjuteri2011.wordpress.com/2012/annual-report/

Animate It! (2012-12-31 16:40) - darthewok

[1]Animate It! je sajt sa kolekcijom animiranih gifova, koji pruza na hiljade animiranih gifova rasporedjenih po kate-
gorijama. Takodje poseduje i pretrazivac, radi lakseg pronalazenja zeljenog animiranog gifa.

[2]h p://www.animateit.net/

1. http://www.animateit.net/
2. http://www.animateit.net/

LibreCAD (2012-12-31 17:08) - darthewok

LibreCAD je besplatna open source 2D CAD aplikacija za Linux, Windows i Mac.

Zvanicna web prezentacija projekta se nalazi na adresi: [1]h p://librecad.org/cms/home.html

1. http://librecad.org/cms/home.html
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Izbacivanje Suspend - Ubuntu 12.04 (2012-12-31 17:46) - darthewok

Preporucujem da izbacite Suspend opciju (nalazi se iznad Shut Down). Jer to na nekim kompjuterima radi, na nekima
stvara problem da ne mogu da se ”probude”. To sam par puta greskom kliknuo na mom kompjuteru.

To mozete uradi na sledeci nacin:

Otvorite terminal i ukucajte sledecu liniju u terminal (ovde se zbog forma ranja teksta linija vidi u dva reda, u ter-
minalu treba da se ukuca u jednom redu i na kraju pri snu enter):

sudo gedit /etc/polkit-1/localauthority/50-local.d/com.ubuntu.disable-suspend.pkla

Otvorice se tekst editor, u tekst editoru ukucajte sledece linije i sacuvajte fajl.

[Disable suspend]
Iden ty=unix-user:*
Ac on=org.freedesktop.upower.suspend;
ResultAny=no
ResultInac ve=no
ResultAc ve=no

Izlogujte se, za m se ponovo logujte da bi izmena bila vidljiva. Ako ste sve uradili kako treba, opcija Suspend vise
nece bi vidljiva.
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3.1 January

Dconf Editor - Configura on Editor (2013-01-05 13:01) - darthewok

Uz pomoc Dconf Editora mozete fino podesi razne opcije, koje su inace skrivene u Vasem Ubuntu opera vnom sis-
temu.

Ako ga nemate instaliranog, instalirajte ga komandom u terminalu:
sudo apt-get install dconf-tools

Za m ga pokrenite ili iz terminala komandom:
dconf-editor

Ili iz menija:
Applica ons -> System Tools -> dconf Editor

Na primer, ako zelite da prikazete datum i dan pored sata, pokrenite Dconf Editor,
otvorite: com -> canonical -> indicator -> date me
tu s klirajte opcije: show-date i show-day

Takodje mozete izabra nacin prikaza vremena 12h ili 24h:
to radite izborom opcije u padajucem meniju pored me-format

Jos dosta toga mozete da podesite u Dconf Editoru, ovde sam napisao samo mali deo onoga sta sve moze.

Strut (2013-01-06 10:51) - darthewok

Strut je open source aplikacija za pravljenje prezentacija. Jednostavan je i lak za upotrebu, lako je ubaci tekst, web
strane, slike i video. Kompletna prezentacija je u HTML5, pa se za gledanje prezentacija koris neki od web pregledaca,
koji podrzavaju HTML5 na primer Chrome i Firefox.

Samo da dodam, da je jos uvek u Alpha fazi razvoja, pa deluje malo nedoradjeno, ali je potpuno funkcionalan za
pravljenje prezentacija.

Strut mozete koris kao online aplikaciju na adresi:
[1]h p://tantaman.github.com/Strut/dist/index.html #

Ili preuze kod iz download sekcije i koris ga offline:
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[2]h ps://github.com/tantaman/Strut/downloads

1. http://tantaman.github.com/Strut/dist/index.html
2. https://github.com/tantaman/Strut/downloads

Ubuntu telefon (2013-01-06 15:20) - darthewok

Promo vni video za Ubuntu telefon. Po najavama trebalo bi da se pojavi 2014. godine. Ako pla orma zazivi, bice to
pravo osvezenje na trzistu smart telefona.

[youtube=h p://www.youtube.com/watch?v=cpWHJDLsqTU]

[youtube=h p://www.youtube.com/watch?v=LoXpLUr5WB4]

FreetuxTV (2013-01-06 16:21) - darthewok

FreetuxTV je web tv i radio plejer za Linux. Pored toga sto moze da reprodukuje tv i radio strimove sa interneta, moze
i da ih snimi na disk i da se kasnije snimljeni sadrzaj pregleda.

Vise detalja o projektu mozete pronaci na sledecim adresama:
[1]h p://code.google.com/p/freetuxtv/
[2]h p://code.google.com/p/freetuxtv/wiki/HomePage?wl=en

Da bi ste ga instalirali na Ubuntu pokrenite terminal i kucajte sledece linije:
sudo add-apt-repository ppa:freetuxtv/freetuxtv
sudo apt-get update
sudo apt-get install freetuxtv
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1. http://code.google.com/p/freetuxtv/
2. http://code.google.com/p/freetuxtv/wiki/HomePage?wl=en

Ne, ne i ne, Photoshop CS2 NIJE besplatan!!! (2013-01-08 12:22) - darthewok

Juce i danas se diglo dosta prasine na internetu oko pogresno protumacene ves da Adobe daje paket Crea ve Suite
2 besplatno. Mogu misli , kako su samo serveri firme Adobe bili preoptereceni, a verovatno su i dalje.

O cemu se zapravo radi?
Od 13. decembra 2012. Adobe je iskljucio servere za ak vaciju programa iz CS2 paketa. Tako da korisnici koji su kupili
CS2 ne mogu vise da ga ak viraju. Adobe je hteo da pomogne korisnicima tako sto je na svoje download servere
postavio kompletan paket Crea ve Suite 2, kao i pojedinacne programe iz paketa ukljucujuci i serijske brojeve.
To je pogresno protumaceno od strane mnogih na internetu da Adobe daje besplatno programe iz paketa CS2.

Evo i nekih linkova sa sajtova koji su objavili tu vest:

[1]h p://www.forbes.com/sites/adriankingsleyhughes/2013/01/07/download-a dobe-cs2-applica ons-for-free/

[2]h p://www.gizmodo.co.uk/2013/01/grab-photoshop-and-cs2-for-absolutely -free-right-now/

[3]h p://www.theverge.com/2013/1/7/3847146/get-adobe-crea ve-suite-prem ium-plus-for-free
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[4]h p://reviews.cnet.com/8301-13727 _7-57562515-263/adobe-releases-crea ve-suite-2-for-free/

[5]h p://www.electronista.com/ar cles/13/01/07/download.intended.only.f or.exis ng.license.holders/

Evo saopstenja sa Adobe foruma [6]h p://forums.adobe.com/message/4974662 #4974662:
Effec ve December 13, Adobe disabled the ac va on server for CS2 products and Acrobat 7 because of a technical
glitch. These products were released over 7 years ago and do not run on many modern opera ng systems. But to
ensure that any customers ac va ng those old versions can con nue to use their so ware, we issued a serial number
directly to those customers. While this might be interpreted as Adobe giving away so ware for free, we did it to help
our customers.

Po poslednjoj informaciji koju sam procitao na internetu, Adobe ce prilikom pokusaja downloada proverava
da li korisnici imaju legalnu licencu za CS2.

Ipak, steta je nacinjena. Na hiljade kopija, koje ne moraju da se ak viraju, sa sve serijskim brojem je ”o slo u
etar”. Greska je obostrana i medija koji su pogresno preneli informaciju i Adobe-ova greska, jer, kao prvo nigde na
download strani nije pisalo da kopije mogu da preuzmu samo korisnici koji vec poseduju licencu za CS2. I kao drugo,
nigde se nije proveravalo da li korisnik koji preuzima kopiju poseduje validnu licencu za CS2. Ne bi me cudilo da
Adobe pokrene i neke sudske parnice pro v sajtova koji su objavili pogresnu vest. Ali mislim da bi to bilo kontra
produk vno, jer su velikim delom sami krivi za nesporazum koji je nastao.

Ovo je jos jedan primer, o pogresnom konceptu ”online” ak vacije proizvoda koje so verske kuce prak kuju u
poslednjih desetak godina. Vec sam o tome delimicno pisao u ovom clanku: [7]Opsiran odgovor na pitanje zasto
pravim tutorijale za Gimp, a ne za Photoshop

1. http://www.forbes.com/sites/adriankingsleyhughes/2013/01/07/download-adobe-cs2-applications-for-free/
2. http://www.gizmodo.co.uk/2013/01/grab-photoshop-and-cs2-for-absolutely-free-right-now/
3. http://www.theverge.com/2013/1/7/3847146/get-adobe-creative-suite-premium-plus-for-free
4. http://reviews.cnet.com/8301-13727_7-57562515-263/adobe-releases-creative-suite-2-for-free/
5. http://www.electronista.com/articles/13/01/07/download.intended.only.for.existing.license.holders/
6. http://forums.adobe.com/message/4974662#4974662
7. http://kompjuteri2011.wordpress.com/2012/09/18/opsiran-odgovor-na-pitanje-zasto-pravim-tutorijale-za-gimp
-a-ne-za-photoshop/

bakasenovic (2013-01-09 11:02:46)
Na ovoj adresi se lepo vidi šta je ljudima draže Gimp naravno h p://alterna veto.net/category/phots-and-graphics/

Cinnamon desktop na Ubuntu 12.04 (2013-01-11 11:18) - darthewok

Na mom Ubuntu 12.04 koris m GNOME Classic (No effects) desktop okruzenje. Jer, nikako da se naviknem na Unity.
Medju m, probao sam Cinnamon desktop na mom Ubuntu i mogu reci da mi odgovara to desktop okruzenje. Imao
sam nesto malo iskustva sa Cinnamon prilikom tes ranja Mint 13, ali ga sada prvi put probam na Ubuntu.

Cinnamon je prvobitno razvijen za Linux Mint, ali je dostupan i za druge Linux distribucije.

238

http://www.forbes.com/sites/adriankingsleyhughes/2013/01/07/download-adobe-cs2-applications-for-free/
http://www.gizmodo.co.uk/2013/01/grab-photoshop-and-cs2-for-absolutely-free-right-now/
http://www.theverge.com/2013/1/7/3847146/get-adobe-creative-suite-premium-plus-for-free
http://reviews.cnet.com/8301-13727_7-57562515-263/adobe-releases-creative-suite-2-for-free/
http://www.electronista.com/articles/13/01/07/download.intended.only.for.existing.license.holders/
http://forums.adobe.com/message/4974662#4974662
http://kompjuteri2011.wordpress.com/2012/09/18/opsiran-odgovor-na-pitanje-zasto-pravim-tutorijale-za-gimp-a-ne-za-photoshop/
http://kompjuteri2011.wordpress.com/2012/09/18/opsiran-odgovor-na-pitanje-zasto-pravim-tutorijale-za-gimp-a-ne-za-photoshop/


Zvanicna web prezentacija Cinnamon se nalazi na adresi:
[1]h p://cinnamon.linuxmint.com/

Da bi ste na Vasem Ubuntu instalirali Cinnamon, pokrenite terminal i kucajte:

sudo add-apt-repository h p://ppa.launchpad.net/gwendal-lebihan-dev/cinnamon-stable/ubuntu
sudo apt-get update
sudo apt-get install cinnamon

Kada se zavrsi instalacija izlogujte se i ponovo se logujte, s m sto prilikom logovanja treba da, umesto Unity ili Gnome
Classic izaberete Cinnamon.

Za Cinnamon postoji dosta dodataka kao sto su razne teme, aple i ekstenzije.
Probao sam dva apleta, a to su Weather i Places.

Weather prikazuje trenutne vremenske prilike, posle instalacije, potrebno je podesi aplet, tako sto se definisu neki
parametri, kao na primer, da li ce prikaz brzine vetra bi u m/s, km/h ili da li ce se temperatura prikaziva u stepenima
C ili stepenima F.
[2]h p://cinnamon-spices.linuxmint.com/applets/view/17

Places dodaje klasicni places meni, na kakav ste navikli, ako ste koris li Gnome 2 ili Gnome Classic.
[3]h p://cinnamon-spices.linuxmint.com/applets/view/5
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Dodato 13.01.2013.
Posle dana koriscenja i tes ranja Cinnamon, mogu reci da je dobar i ugodan za rad, ali sam prime o da malo vise
opterecuje procesor u odnosu na GNOME Classic (No effects), koji inace koris m na mom laptopu. Vece opterecenje
procesora znaci i povecano zagrevanje i povecanu potrosnju baterije, tj smanjenje autonomije rada laptopa, kada radi
na beterije. Pa, ako nista drugo, bar zbog duzeg trajanja baterije cu se zadrza na dobrom starom GNOME Classic (No
effects). :)

1. http://cinnamon.linuxmint.com/
2. http://cinnamon-spices.linuxmint.com/applets/view/17
3. http://cinnamon-spices.linuxmint.com/applets/view/5

Iskljucivanje Jave u Firefox-u i Chromium-u - Ubuntu 12.04 (2013-01-15 01:29) - darthewok

Zbog cuvenog bezbednosnog propusta u Javi 7 update 11 i starijim verzijama Jave 7, koji Oracle nikako da zakrpi,
pozeljno je iskljuci u web pregledacima podrsku za Javu. Bar dok se ne pojavi verzija Jave sa odgovarajucom zakr-
pom.

Inace, pored tradicionalno ugrozenog Windowsa, ovoga puta su potencijalno ugrozeni i Linux i Mac.

Evo i jednog od linkova sa tekstom gde se mozete detaljnije informisa o bezbednosnom propustu:
[1]h p://betanews.com/2013/01/14/java-7-update-11-security-patch-fixes-n othing/

U Ubuntu 12.04, kao i u drugim Linux distribucijama, podrska za javu u web pregledacima se iskljucuje iskljucivan-
jem IcedTea plugin-a.

Iskljucivanje u Firefoxu:
Add-ons -> Plugins -> IcedTea-Web Plugin -> Disable

Iskljucivanje u Chromium-u:
Se ngs -> Show advanced se ngs -> Privacy -> Content se ngs -> Plugins -> Disable individual plugins... -> IcedTea-
Web Plugin
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Ako ste sve dobro uradili, Java aple vise nece moci da se pokrenu.
To mozete proveri na ovoj adresi:
[2]h p://www.java.com/en/download/testjava.jsp
Kada je IcedTea iskljucen, pojavice se sivo polje. Kada je ukljucen, prikazace se Java logo sa tekstom Your Java is work-
ing, takodje ce bi prikazana i verzija Jave koju imate instaliranu.

Ako su Vam Java aple iz nekog razloga neophodni za rad na nekom web sajtu, onda, ili ukljucujte IcedTea-Web Plugin
po potrebi, a kada Vam ne treba iskljucite ga.
Ili koris te, na primer dva razlicita web pregledaca, jedan, za svakodnevno krstarenje internetom na kome ce bi isklju-
cen IcedTea-Web Plugin, a drugi, sa ukljucenim IcedTea-Web Plugin-om, koji ce te koris samo na sajtovima gde Vam
je neophodna Java.

Samo da napomenem, da ne bude zabune, ovo se NE odnosi na Java Script, vec na Java aplete!

1. http://betanews.com/2013/01/14/java-7-update-11-security-patch-fixes-nothing/
2. http://www.java.com/en/download/testjava.jsp

Midnight Commander (2013-01-15 04:34) - darthewok

Fajl menadzer za Linux i Windows, Midnight Commander, inace klon, nekadasnjeg Norton Commandera. Razvija se
za Linux i Windows. To je open source aplikacija koja radi iz konzole, tj, terminala, ako koris te Linux, odnosno ko-
mandnog prompta ako koris te Windows. Ima tekstualni korisnicki interfejs.

Glavni interfejs se sastoji iz dva panela u kojima se nalazi lista fajlova i direktorijuma. Pored, osnovnih funkcija, kao
sto su kopiranje, premestanje, menjanje imena fajlova i direktorijuma, poseduje i mnoge dodatne funkcije, kao sto su
FTP, ASCII i HEX editor, pretragu, poredjenje fajlova i direktorijuma, podrzan je rad sa nekim forma ma za arhiviranje
i jos dosta toga.

Ako koris te Linux, u zavisnos od distribucije, moze se instalira automatski prilikom instaliranja pojedinih Linux
distribucija. Ili, ako ga nema u osnovnoj instalaciji , mozete ga instalira iz repozitorijuma Vase Linux distribucije.

Verziju za Windows mozete preuze na ovoj adresi:
[1]h p://sourceforge.net/projects/mcwin32/
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1. http://sourceforge.net/projects/mcwin32/

Zašto koris š linux? (2013-01-16 07:12) - darthewok

Zašto koris š linux?

To pitanje mi je postavljeno, u komentaru na jedan od mojih tutorijala na YouTube.
Odgovorio sam na taj komentar, ali mislim da je zgodno da odgovor napisem i ovde, jer me to mnogi ljudi pitaju i u
stvarnom zivotu, ne samo na internetu.
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Linux koris m iz vise razloga. Ovo su najvazniji... Za razliku od Windowsa, Linux je slobodan so ver. Pocevsi od
Windowsa XP, krenule su i glupos poput ak vacije Windowsa, znaci nije dovoljno samo kupi Windows, vec moras
i da ga ak viras, takodje postoje i jos neka ogranicenja. Linux mogu slobodno koris na koliko god hocu kompjutera,
jer me ne ogranicavaju glupava vlasnicka ogranicenja. Takodje, besplatan je. I na kraju, veci Windowsov problem sa
virusima. Toga u Linuxu nema.

Virusa u glavnom nema, tacnije ima ih nekoliko, koji su bili ak vni jako davno, tako da na savremenim Linux distribu-
cijama verovatno ne bi ni radili. Linux je daleko bezbedniji od Windowsa, tako da nema potrebe za an virusnim
programima. Naravno an virusi postoje, ali nije ih neophodno instalira kao u Windowsu.
Od kako koris m Linux ne moram da razmisljam o tako trivijalnim problemima, koje sam nabrojao.

Naravno, Linux nije savrsen ima i on svojih bubica, kao u ostalom i svi opera vni sistemi. Razlika je u tome, sto se
Linux razvija od strane open source zajednice i besplatan je  (osim nekoliko distribucija koje nisu besplatne), pa se m
bubicama moze progleda kroz prste. Za razliku od preskupih vlasnickih opera vnih sistema, gde korisnik skupo placa
licencu za so ver, takvi propus su nedous vi.

Calligra Flow (2013-01-18 01:07) - darthewok

Calligra Flow je besplatan open source program za crtanje sema, algoritama, blok dijagrama itd... Podseca na Visio.

Calligra Flow dolazi u paketu Calligra Suite i razvija se za Linux, Windows i Mac.
U Ubuntu So ware Center mozete preuze ceo Calligra Suite paket ili samo Flow.

Web prezentacija Calligra Suite: [1]h p://www.calligra.org/
Web prezentacija Calligra Flow: [2]h p://www.calligra.org/flow/
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1. http://www.calligra.org/
2. http://www.calligra.org/flow/

Brython (2013-01-19 20:19) - darthewok

Brython je zanimljiv projekat da se umesto Java skripta na web stranama koris Python. Trenutno je samo Java skript
podrzan u web pregledacima, zato se mora koris Java skripta brython.js koja sluzi kao prevodilac, koja Python kod
prevodi u Java skript.

Da bi Python skripta radila u web pregledacu, potrebno je, prilikom pisanja HTML koda ucita Brython na sledeci
nacin:
<script src=”brython.js”></script>

Za m treba pozva funkciju brython():
<body onload=”brython()”>

Takodje, fajl brython.js i folder libs, moraju bi u istom folderu gde i HTML fajl.

Malo sam se igrao i za probu napravio kratku skripu koja izbacuje prozor na kome pise ”Zdravo ja sam Brython.” Evo i
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kako to izgleda u praksi:

<html>
<head>
<script src=”brython.js”></script>
</head>

<body onload=”brython()”>
<script type=”text/python”>
alert (”Zdravo ja sam Brython.”)
</script>
</body>
</html>

Detaljnije informacije, kao i razne demonstracije mogucnos Brython-a mozete vide na zvanicnom web sajtu na
adresi:
[1]h p://www.brython.info/index _en.html
Na download strani, na zvanicnom sajtu mozete preuze arhivu sa potrebnim fajlovima.

1. http://www.brython.info/index_en.html

Gimp tutorijal 46 - Gif animacija (2013-01-21 14:06) - darthewok

(Ponovo sam postavio video zbog losijeg zvuka u prvoj verziji)
Po zelji jednog od gledalaca, napravio sam video tutorijal po uzoru na tekstualni tutorijal sa ove adrese:
h p://www.gimpdome.com/anima on-tutori als/crazy-animated-sphere-tutorial/

[youtube=h p://www.youtube.com/watch?v=sgHUXPYfr9U]

darthewok (2013-01-22 21:46:40)
Facebook ne podrzava opciju da se direktno ubace gif animacije na zid ili u album. Ali zato postoje aplikacije koje podrzavaju
animirane gifove. Jedna od takvih aplikacija je Animated Picture. Ali ne znam da li postoji mogucnost slanja sopstvenih gif
animacija u takve aplikacije.

Malcinovic Ševal (2013-01-22 18:21:54)
Druže, ako može tutorijal za ubacivanje gif animacija na facebook
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Malcinovic Ševal (2013-01-25 09:34:03)
hvala na pojašnjenju

Malcinovic Ševal (2013-01-25 09:55:58)
ako ima kakav jednostavan tutorijal za Animated Picture ubacivanje gif animacija da se objavi bio bih zahvalan, postoje na
engleskoma ali slabo baratan sa engleskip pa ne mogu da se snađem, pozzzz

darthewok (2013-01-25 22:37:00)
Samo da se ispravim. Sad sam probao aplikaciju Animated Picture i jos nekoliko aplikacija koje barataju sa animiranim slicicama
i ni jedna od h koje sam probao ne podrzava slanje sopstvenih gif animacija. Mozda i postoji neka, ali nisam nasao. Jedino
sto mi pametno pada na pamet je da gif animaciju konvertujes u video i da taj video postavis na Facebook. U Linuxu se to
radi ovako: 1. Napravi neki privremeni folder i u taj folder iskopiraj zeljenu gif animaciju. 2. Pokreni terminal i komandom cd
udji u folder gde je gif animacija. 3. U terminalu ukucaj: convert ime _fajla.gif slicice %02d.png pri sni enter i sacekaj da se
operacija zavrsi. Gif animacija ce da se razlozi na pojedinacne slicice. 4. U terminalu ukucaj: ffmpeg -r 25 -i slicice %02d.png
-y -an video.avi Ovom poslednjom komandom ce slicice da se spoje u fajl video.avi, koji mozes postavi na Facebook. Deluje
komplikovano, ali nije. Javi, ako treba da pravim video tutorijal na ovu temu. Pozzz

darthewok (2013-01-28 21:10:47)
Nema na cemu. Pozzz

darthewok (2013-01-28 16:11:25)
To na videu, u prvom linku, ako je nekada radilo, sada ne radi. Neko je u komentaru napisao jos pre 9 meseci da ne radi:
—————————————-— ”AceTrainerKayden пре 9 месеци Ok Facebook has just disabled it We need to find a new way”
—————————————-— U drugom linku covek verovatno koris neke aplikacije za animirane gifove. Pitaj ga sta koris
od aplikacija.

Seval Malcinovic (2013-01-28 19:06:34)
Poštovani, hvala Vam na strpljenju i na odgovorima na moje upite pozzz

darthewok (2013-01-28 12:18:04)
Nema na cemu. :) Nego, sta bi sa tvojim blogom?

Milovanović Siniša (2013-01-28 10:03:53)
Hvala lepo :-)

Malcinovic Ševal (2013-01-28 15:39:46)
Poštovani, primjeri na ovim linkovima pokazuju šta bih ja ustvari h o da uradim, ovi tutorijali na youtube su za mene brzi i
ne poznajem engleski jezik, kada pogledate linkove bit će vam jasnije sta bih ja volio zna kako se ubacuju gif animacije na

primjeri : h p://youtu.be/sw6 _ _sz7564 h p://youtu.be/L-BC _6sBVJw dosta primjera gig animacija ima na ovom linku
h ps://www.facebook.com/T.E.Benim.Dunyam?sk=app _123053501108456 &app _data...See More hvala vam na trudu i na
dosadašnjim objašnjenjima

Gimp tutorijal 47 - Lightsaber Effect (2013-01-24 13:06) - darthewok

U ovoj epizodi je predstavljena nova verzija skripte LSE koja sluzi za pravljenje efekata svetlosnog maca. Skriptu za
Gimp mozete preuze sa ove adrese: h p://registry.gimp.org/node/21369

[youtube=h p://www.youtube.com/watch?v=odp9pX3wYZE]
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Gimp tutorijal 48 – Instaliranje Gimp 2.8.2 u Windowsu (2013-01-26 22:02) - darthewok

Po zelji jednog od gledalaca u ovoj epizodi prikazujem kako se instalira Gimp u Windows XP. On je trazio tutorijal za
Windows 7, ali posto nemam Windows 7, napravio sam tutorijal za Windows XP.

[youtube=h p://www.youtube.com/watch?v=aimRV056QfI]

Gimp tutorijal 49 - Prikaz filtera Highpass sharpening i Kalendar (2013-01-27 17:40) - darthewok

U ovoj epizodi predstavljam filtere Highpass sharpening i Kalendar.

[youtube=h p://www.youtube.com/watch?v=XE1ZQmmKpxo]

Virtual Box - Prikaz (2013-01-29 22:54) - darthewok

Prikaz programa Virtual Box. Vec sam radio prikaz pre nekoliko godina, ali se u medjuvremenu dosta toga promenilo,
pa sada predstavljam aktuelnu verziju.

[youtube=h p://www.youtube.com/watch?v=92cEeYIIu2A]

Malcinovic Ševal (2013-01-30 12:44:03)
Poštovani, kada se instalira virtualni OS, naprimjer instalirao sam virtualni XP na windows7, treba li na virtualni instalira
an virus ili se integrira an virus sa win7, Pozz.
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darthewok (2013-01-30 16:08:16)
Ne integrise se nista i ponasa se kao zaseban kompjuter. Jedine stvari koje se dele su deljeni folder i clipboard. Naravno, ako
si ukljucio te opcije. An virus nije obavezan, ali ako planiras da ides na ”problema cne sajtove” i da instaliras ”problema cne
programe” onda mozes instalira an virus. U tom slucaju savetujem da za deljeni folder ukljucis opciju read only da se
eventualni virus ne bi prosirio na deljeni folder u Win7. Pozz

Gimp tutorijal 50 - efekat sa tekstom (2013-01-30 16:18) - darthewok

Po zelji jednog od gledalaca napravio sam tutorijal inspirisan tutorijalom za Photosho sa ove adrese:
h p://orangetutorials.com/premium/create-a-strong-grunge-stone-text-effect-i n-photoshop/
Gimp ne poseduje neke alate koji su korisceni u Photoshop turoijalu, pa da bi se pos gao slican efekat, tehnika koja
se primenjuje je totanlo razlicita u odnosu na tehniku prikazanu u tutorijalu na gore pomenutoj adresi.

[youtube=h p://www.youtube.com/watch?v=oe1s1DWP8dY]

windbag4 (2013-01-31 10:08:30)
Hvala

darthewok (2013-01-31 19:17:59)
Nema na cemu. Pozz.

3.2 February

Gimp tutorijal 51 - Uklanjanje nezeljenih elemenata sa slike (2013-02-08 22:54) - darthewok

Prikaz filtera Heal selec on i primeri uklanjanja nezeljenih elemenata sa fotografija.

[youtube=h p://www.youtube.com/watch?v=UQsBOJFlRsE]

Gimp tutorijal 52 - Kombinovanje dve fotografije (2013-02-11 00:11) - darthewok

Po zelji jednog od gledalaca u ovoj epizodi govorim o kombinovanju dve fotografije sa finim prelazima izmedju fo-
tografija.

[youtube=h p://www.youtube.com/watch?v=LcT9VYfBN60]
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Ukljucivanje skrivenih stavki u Startup Applica ons... (Ubuntu 12.04) (2013-02-12 01:43) - darthewok

AKO NE ZNATE STA RADITE, BOLJE NE DIRAJTE NISTA!

Lista programa u Startup Applica ons, koji se automatski pokrecu prilikom pokretanja desktopa je po po-
drazumevanim podesavanjima sakrivena. Vidljivi su samo oni programi u lis koji su naknadno ubaceni, bilo
od strane korisnika ili to neki program uradi automatski.

Tu listu je moguce prikaza na sledeci nacin:
Pokrenite terminal i kucajte:

mkdir -p /.config/autostart
cd /.config/autostart
cp /etc/xdg/autostart/*.desktop .
sed -i ”s/NoDisplay=true/NoDisplay=false/g” *.desktop

Ako ste sve dobro uradili, lista programa u Startup Applica ons bi trebalo da bude vidljiva.
Sada mozete da odredite koji ce programi da se pokrecu automatski prilikom pokretanja desktopa.
Iskljucivanjem automatskog pokretanja nepotrebnih programa, mozete op mizova Ubuntu da se malo brze ucita
desktop, da koris manje RAM memorije i da generalno malo brze radi. Poboljsanja su vise primetna na starijim
kompjuterima sa malo RAM memorije.

Ovde ponavljam upozorenje s pocetka teksta!!!

AKO NE ZNATE STA RADITE, BOLJE NE DIRAJTE NISTA!

Jer ako iskljucite nesto sto ne smete da dirate, to moze bi lose...

Stavke koje bezbedno mozete iskljuci su:
Backup-Monitor - Samo ako ne koris te automatski bekap.
Bluetooth-Manager - Samo ako ne korsi te Bluetooth.
Chat - Samo ako ne koris te Telepathy chat klijent.
Desktop Sharing - Vecini korisnika ovo nije potrebno.
Gwibber - Ako ovo ne koris te, iskljucite.
Onboard - Ekranska tastatura, ako ne korsi te, iskljucite.
Orca screen reader - Ako ne koris te, iskljucite.
Personal file Sharing - Ako ne delite fajlove preko mreze, iskljucite.
Ubuntu One - Ako ne koris te, iskljucite.
Zeitgeist-Datahub - Ovo je loger koji belezi razne ak vnos korisnika da bi pojedine aplikacije imale bolju interakciju
sa korisnikom, ako Vam ovo ne treba iskljucite.
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Na kraju se izlogujte i ponovo se logujte da bi izmene bile primenjene.

Samo na kraju da dodam, da kada iskljucujete programe sa liste, NIKAKO ne klikcite na REMOVE, vec ih isklju-
cujte tako sto kliknete na s klirani kvadra c levo od stavke koju iskljucujete. Jer na taj nacin mozete lako ponovo
ukljuci program ponovnim klikom na kvadra c, da ga ponovo s klirate.

Ascii Star Wars animacija (2013-02-12 05:44) - darthewok

Verovatno ste mnogo puta gledali Star Wars. :)
Na ovoj adresi ga mozete ponovo odgleda , ali u Ascii verziji. :)

[1]h p://www.stumbleupon.com/su/2EXq3h/:6c6Ydh2:PcTelC2s/jacob.mason.nam e/starwars.html/

Na gore pomenutoj adresi je web verzija. Telnet verziju mozete vide ako ukucate u terminal:
telnet towel.blinkenlights.nl

Mnogo truda je ulozeno u ovo, prava Ascii umetnost, pogledajte.

1. http://www.stumbleupon.com/su/2EXq3h/:6c6Ydh2:PcTelC2s/jacob.mason.name/starwars.html/

Gimp tutorijal 53 - Oblacici za strip i odgovor na pitanje gledaoca (2013-02-23 00:42) - darthewok

U ovoj epizodi, u prvom delu, odgovaram na pitanje jednog od gledalaca i prikazujem kako se prave oblacici za stripove.

[youtube=h p://www.youtube.com/watch?v=vCO8EiEV9z8]

3.3 March

Gimp tutorijal 54 - Ubacivanje oziljka, tetovaze i pozadine (2013-03-03 20:01) - darthewok

U ovoj epizodi, po zelji jednog od gledalaca pricam o ubacivanju oziljaka, takodje, pricam i o ubacivanju tetovaza i
pozadine.
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[youtube=h p://www.youtube.com/watch?v=STLIuJZ2lVg]

Click&Clean dodatak za Chrome i Firefox (2013-03-23 12:18) - darthewok

Internet pregledaci cuvaju podatke o vasim ak vnos ma na internetu. Web sajtovi uz pomoc kolacica (cookies), kao
i na druge nacine mogu skuplja licne podatke o vama. Takodje, internet pregledaci cuvaju listu internet adresa koje
ste pose li, kao i kesirane fajlove koje je internet pregledac pokupio dok ste posecivali razne web sajtove. Click &Clean
moze pomoci da bezbednije krstarite internetom i da na lak i brz nacin brisete kolacice, kesirane fajlove i ostale stvari
koji mogu da ugroze vasu privatnost.

Click &Clean se razvija za Chrome/Chromium i Firefox.
Detaljnije informacije mozete procita na adresi: h p://www.hotcleaner.com/
Sa gore pomenute adrese mozete preuze aktuelnu verziju dodatka za Chrome/Chromium i Firefox.
Dodatak, takodje mozete preuze i sa Chrome Web Store-a za Chrome/Chromium ili sa Mozilinog ADD-ONS repozi-
torijuma za Firefox.

Ghostery dodatak za Chrome i Firefox (2013-03-23 12:38) - darthewok

Ghostery je dodatak za Chrome/Chromium i Firefox, koji sluzi za zas tu vase privatnos na internetu. Ghostery pra
i blokira tagove, web bube i ostale nevidljive stvari, koje razne kompanije postavljaju na web sajtove da bi pra li vasu
ak vnost na internetu. Takodje prikazuje i listu ”trekera” za svaku web adresu koju pose te. U slucaju da neki web
sajt ne radi dobro zbog blokiranja odredjenog sadrzaja, mozete u podesavanjima za Ghosteri, iskljuci pojedinacne
”trekere” ili po potrebi potpuno zaustavi i kasnije ponovo pokrenu Ghostery.

Detaljnije informacije mozete vide na zvanicnom web sajtu na adresi:
h ps://www.ghostery.com/
Takodje sa gore pomenute adrese ga mozete i preuze i instalira u vas web pregledac.

Ghostery, takodje mozete preuze i sa Chrome Web Store-a za Chrome/Chromium ili sa Mozilinog ADD-ONS repozi-
torijuma za Firefox.
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Sah (2013-03-26 02:27) - darthewok

Odlican sah mozete igra na adresi: h p://lichess.org/
Sah mozete igra pro v kompjutera ili zivog igraca. Mogu se igra pojedinacne par je i turniri.
Moguce je igra i ako niste registrovani, ali u tom slucaju necete bi na rang lis .
Nije potreban nikakav download da bi se igrao sah. Sve radi iz vaseg web pregledaca. Probao sam iz Chromiuma i
Firefoxa i sah radi odlicno.
Podrzano je oko sezdesetak jezika. Jezike mozete bira iz padajuceg menija. Ali mozete i direktno pristupi strani sa
lokalizovanom verzijom.
Na primer engleska verzija je na adresi: h p://en.lichess.org/
Srpska verzija je na adresi: h p://sr.lichess.org/

Gimp tutorijal 55 - Flare efekat (2013-03-30 19:29) - darthewok

Po zelji jednog od gledalaca sam napravio tutorijal o flare efek ma i pravljenju glow efekta.

[youtube=h p://www.youtube.com/watch?v=MEw5rxeXvVw]

3.4 April

Shodan (2013-04-08 23:06) - darthewok

Shodan je vrlo zanimljiv i neobican pretrazivac interneta. Za razliku od Google-a, Yahoo-a, Bing-a i slicnih pretrazivaca
koji pretrazuju web sajtove na osnovu kljucnih reci koje korisnik unese u pretragu. Shodan pretrazuje ono sto se nalazi
”iza scene”, dakle ne pretrazuje direktno web sajtove, vec, na osnovu kljucnih reci, pretrazuje uredjaje koji su prikaceni
na internet. Na primer, kao rezultat pretrage moze da prikaze server, web kameru, stampac, ruter, odredjeni kom-
pjuter koji koris odredjenu vrstu i verziju servera i so vera i sve ostalo sto je prikaceno na internet... Takodje, mozete
filtrira pretragu da je ogranicite na pojedinu drzavu, servis, grad, organizaciju. Neverovatno, sta se sve moze pronaci
na ovom pretrazivacu. Da bi ste imali pun pristup pretrazi i vise rezultata pretrage, potrebno je da se registrujete. Ako
vrsite pretragu ne registrovani, ograniceni ste na rezultate koji se nalaze na prve dve strane.

Adresa pretrazivaca: h p://www.shodanhq.com/
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Detaljniji tekst o pretrazivacu mozete procita na ovoj adresi: h p://www.shodanhq.com/help

UNetboo n (2013-04-09 03:28) - darthewok

UNetboo n je open source program uz pomoc koga mozete napravi butabilni live USB za neku od podrzanih Linux
distribucija, ukljucujuci Ubuntu, Fedora, Mint, Debian. Takodje su podrzani Free Dos, Free BSD i neki usluzni i an-

virus boot diskovi. Sve u svemu, za sada ima oko 40 stavki koje mozete da napravite da se podizu sa USB-a. Da bi
ste instalirali neku od Linux distribucija ili neki od usluznih boot diskova, potrebno je da imate ISO fajl, ako ga nemate,
UNetboo n moze da skine podrzane ISO fajlove sa interneta.

UNetboo n se razvija za Linux, Windows i Mac.

Na zvanicnoj web adresi mozete pronaci dodatne informacije o programu: h p://unetboo n.sourceforge.net/
Takodje sa gore pomenute adrese mozete preuze UNetboo n.
Ako imate Ubuntu, UNetboo n se nalazi u zvanicnom repozitorijumu i mozete ga instalira iz Ubuntu So ware Center
ili komandom u terminalu: sudo apt-get install unetboo n

PayPal u Srbiji (2013-04-10 15:49) - darthewok

PayPal je najzad s gao u Srbiju. Za sada je moguce samo placa robu i usluge. Za drugu fazu je najavljena mogucnost
prijema uplata.

h ps://www.paypal.com/

Gimp tutorijal 56 - Transparentna pozadina (2013-04-13 11:25) - darthewok

Jedan od gledalaca je pitao kako da izdvoji deo slike, a da ostatak slike u pozadini bude transparentan. U ovom tutori-
jalu sam prikazao jedan od nacina da se to uradi. To svakako nije jedini nacin da se to uradi. Za neke druge situacije ce

253



mozda neki drugi nacin bi brzi ili prak cniji, ali mi ova tehnika deluje nekako univerzalno, jer ostale tehnike i nacini
u nekim situacijama dosta pomognu i ubrzaju proces, ali nisu primenljive u bas svim situacijama.

[youtube=h p://www.youtube.com/watch?v=okpdl9mD5Es]

Libre Office 4.0.x i Ubuntu 12.04 LTS (2013-04-13 22:06) - darthewok

Da bi ste instalirali Libre Office 4.0 na Ubuntu 12.04 treba da uradite sledece:

U terminal ukucajte seldece linije:
sudo add-apt-repository ppa:libreoffice/libreoffice-4-0
sudo apt-get update

Za m pokrenite Update Manager i uradite Par al Upgrade.

Gimp tutorijal 57 - Transparentna pozadina 2 (2013-04-14 13:54) - darthewok

Nastavak price iz prethodne epizode. Ovog puta uz pomoc Eraser alata brisem pozadinu koja nije potrebna da bi taj
deo slike bio transparentan.

[youtube=h p://www.youtube.com/watch?v=wnDRrG6xsIg]

Tes ranje ispravnos tastature (2013-04-17 08:44) - darthewok

Na adresi h p://www.keyboardtester.com/ mozete tes ra ispravnost vase tastature. Nije potrebno preuzima bilo
kakve programe, sve funkcionise iz web pregledaca.
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3.5 May

Erepublik (2013-05-08 20:20) - darthewok

Erepublik je online browser drustvena strateska igra. Igraci su u stvari gradjani drzave koju izaberu. U igri gradjani
mogu da ratuju za svoju drzavu, da imaju svoje kompanije, da rade za druge kompanije, da ucestvuju u poli ckom
zivotu drzave...

Link: h p://www.erepublik.com

Slave Hack (2013-05-08 20:30) - darthewok

Slave Hack je besplatna online browser igra koja simulira hakovanje drugih kompjutera. Naravno, sve je pojednos-
tavljeno i nije previse komplikovano. U igri se nalazi desetak virtuelnih sajtova koje mozete da hakujete, da sa njih
preuzmete programe potrebne za hakovanje, an viruse i slicno. Mozete hakova virtuelne kompjutere drugih igraca
itd... Kada sakupite dovoljno novca u igri, mozete kupi poboljsanja za vas virtuelni kompjuter u igri. Brzi procesor,
veci hard disk, veci dodatni hard disk, brzu internet vezu... Sve u svemu prilicno zarazna igra, kada savladate osnove.

Link: h p://www.slavehack.com/

pptx fajlovi (2013-05-15 12:19) - w1ndu

Ukoliko naidjete na fajlove sa ovom extenzijom i ne znate sta sa njima, nemojte panici . Ms Power Point u verziji
2007 koris dodatak ’x’ da bi svima pokazao koliko se nove verzije njihovih paketa dras cno razlikuju od prethodnih
u ’mogucnos ma’. Nesto slicno docx formatu. :)

Da bi ste ove cudesne prezentacije mogli da vidite bez novog Office-a, imate sledece mogucnos :

1) Instalirajte [1]PowerPoint Viewer 2007

2) Office [2]paket kompa bilnos
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3) [3]Foxit PowerPoint Viewer

Iskustva: Opcija 1) & 3) rade pouzdano, dok opcija 2) nije dala ocekivani rezultat.

Preporuceno resenje je medju m pod:

4) [4]Libre & [5]Open Office Portable

.. Sa kojima ne samo da mozete da gledate .pptx prezentacije, vec i da ih modifikujete, izvezete u ppt format
radi upotrebe u starijim verzijama PowerPointa, ili snimite kao pdf ili web.

Konacno, mozete proba i online konvertor na adresi:

5) [6]Pptx2ppt.com (Online Konvertor)

Srecno sa novim Ms umotvorinama & extenzijama..

1. http://www.microsoft.com/en-us/download/details.aspx?id=6
2. http://www.microsoft.com/en-us/download/details.aspx?id=3
3. http://www.foxpdf.com/PowerPoint-Viewer/PowerPoint-Viewer.html
4. http://portableapps.com/apps/office/libreoffice_portable
5. http://portableapps.com/apps/office/openoffice_portable
6. http://www.pptx2ppt.com/

Proxy Tool (2013-05-18 14:39) - darthewok

Proxy Tool je dodatak za Firefox koji potpuno zamenjuje Firefoxove ogranicene proxy mogucnos .

Pored svoje osnovne namene da olaksa i poboljsa rad sa proxy serverima, Proxy Tool poseduje jos neke korisne opcije.
Kao sto su brisanje kolacica (cookies), promena iden fikacije internet pregledaca, skrivanje pravog h p referera itd...

Surfovanje internetom preko proxy-a je moguce iskljuci ili ukljuci samo jednim klikom misa na ikonu u donjem
desnom delu. Takodje, moguce je definisa proxy listu, uves ili izves proxy listu i jos dosta toga...

Detaljnjije informacije mozete procita na zvanicnoj web prezentaciji na adresi: h p://webproxylist.com/ff-proxy-
tool/
Takodje sa gore pomenute adrese je moguce i instalira dodatak za Firefox. Dodatak takodje mozete instalira i sa
Mozilinog ADD-ONS repozitorijuma za Firefox.
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Kreiranje PDF dokumenata (2013-05-18 16:27) - w1ndu

PDF dokumen su standard dugi niz godina. O [1]readerima je vec bilo reci, a sada cemo pomenu dva laka nacina
da se oni naprave.

1) Virtuelni printeri - verovatno najjednostanije resenje.

Standard u ovoj kategoriji je PDFCreator. Mozete ga preuze preko zvanicnog [2]sajta ili direktno na [3]Sourceforge.
Nakon instalacije dobicete dodatni printer u meniju. Na ovaj nacin mozete kreira pdf iz svakog programa koji podrzava
stampanje. Samo izaberite PDFCreator kao printer koji zelite da koris te. Finim podesavanjima mozete pristupi iz
Start menija.

Alterna vno resenje je [4]PrimoPDF. Ovaj virtuelni PDF printer je besplatan, ali ne i open source. Nacin koriscenja
je iden can.

2) [5]Open & [6]Libre Office

Ovi pake imaju ugradjenu funkciju za kreiranje PDFova. Takodje i laku opciju za obradu i izvoz bookmarka unutar
fajla. Iz ovih razloga, kao i cross-pla ormskog modela, pojedini korisnici daju prednost ovakvom pristupu.

Oba resenja imaju prednos u zavisnos od namene buduceg dokumenta. U koliko su potrebni ak vni linkovi onda su
izbor Office pake . U suprotnom preporucuju se virtuelni printeri, jer su dostupni iz svih programa sa print opcijom.

1. http://kompjuteri2011.wordpress.com/2011/05/26/link-o-rama-pt2/
2. http://www.pdfforge.org/pdfcreator
3. http://sourceforge.net/projects/pdfcreator/files/PDFCreator/
4. http://www.primopdf.com/
5. http://portableapps.com/apps/office/openoffice_portable
6. http://portableapps.com/apps/office/libreoffice_portable

Dodavanje menija u PDF dokumen ma | Kompjuteri (2013-05-18 16:48:20)
[…] prethodnom textu pisali o razlici m nacinima kreiranja PDF fajlova. Dodavanje menija u njima sa leve strane […]

Dodavanje menija u PDF dokumen ma (2013-05-18 16:48) - w1ndu

U prethodnom [1]textu pisali o razlici m nacinima kreiranja PDF fajlova. Dodavanje menija u njima sa leve strane
omogucava laksu navigaciju kroz dokument i doprinosi profesionalnijem izgledu.

Postoji vise nacina da se ovo uradi, ovde cemo prikaza jedan lak i proveren.

Priprema:
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1) Skinite [2]mbtPdfAsm, cmd-line alat za rad sa PDFom. Potreban je Windows Binnaries v1.0.28.

2) Skinite [3]BeCyPDFAsm (shell za mbtPdfAsm). Potrebna nam je zip verzija a ne instaler, pa izaberite link
Download: Executable.

3) Napravite novi folder, npr. PDFEdit.

4) Extraktujte sadrzaje oba zip fajla u folder PDFEdit na sledeci nacin. Najpre iz ByCuPDFAsm zipa uzmite Be-
CyPDFAsm.exe i BeCyPDFAsm.ini. Za m iz mbtPdfAsm zipa uzmite mbtPdfAsm.exe koji se nalazi u subfolderu bin
unutar mbtPdfAsm-1.0.28.zip.

Rezultat: Imate folder PDFEdit u kome se nalaze fajlovi: BeCyPDFAsm.exe, BeCyPDFAsm.ini i mbtPdfAsm.exe.

5) Opciono: Zipujte i sacuvajte ovaj folder sa pomenuta tri fajla radi kasnije upotrebe u nekoj drugoj prilici.

Akcija/Primer:

1) Pronadjite neki PDF dokument kome zelite da dodate meni.

2) U folderu PDFEdit pokrenite fajl BeCyPDFAsm.exe. Ucitajte PDF i predjite na tab Output File. Definisite
kako ce se zva fajl koji cete sacuva nakon dodavanja menija, npr. final.pdf.

3) Vra te se na Bookmarks tab. Kliknite na Add i dodajte stavke menija. Mozete podesi ime bookmarka,
stranu u PDFu koja ce se otvori , gde ce bi u rela vnoj poziciji u meniju, kao i Zoom stavke. Preporuka je da za
Zoom birate Windows Size ili Height da vam pojedini programi, poput Foxita, ne bi zoomirali dokumente preko celog
ekrana.

4) Kad sve zavrsite kliknite Finish i dobicete snimljeni pdf sa prethodno definisanim imenom, u nasem primeru
final.pdf.

Mi smo se ovde fokusirali na kreiranje bookmarka u meniju, ali kao sto mozete vide po stavkama sa ovim
programom je moguce menja i druge osobine PDF-a. Mozete dodava footer, menja sigurnosne aspekte pdfa kao
i editova metadata.

Bez ulaska u detalje, pomenucemo jos jedan besplatan i zanimljiv program koji je specijalizovan za pravljenje
menija. U pitanju je [4]JPDFBookmark. Baziran je na javi i omogucava preciznije formiranje menija unutar same
stranice.

Projekat je podrzan od strane [5]Sourceforge.

1. http://kompjuteri2011.wordpress.com/2013/05/18/kreiranje-pdf-dokumenata/
2. http://thierry.schmit.free.fr/spip/spip.php?article14
3. http://www.becyhome.de/download_eng.htm#becypdfasm
4. http://flavianopetrocchi.blogspot.com/
5. http://sourceforge.net/projects/jpdfbookmarks/files/?source=navbar
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JChessBoard (2013-05-18 22:27) - w1ndu

Jednostavan program za igranje saha preko interneta. Ima ugradjen AI ali je pre svega namenjen za igranje sa drugim
igracima. Za tu svrhu je gotovo idealan.

Ima mali footprint, omogucava direktno IP2IP povezivanje, merenje vremena, vracanje poteza, tabelu sa pregledom
par je, pa cak i chat izmedju igraca. Za sve dodatne informacije dovoljno je otkuca /help u chat prozoru.

[1]JChessBoard je napisan u javi i distribuiran u jar fajlu, pa je u vecini slucajeva potrebno rucno pokretanje. Nakon
extraktovanja fajlova u zeljeni folder, potrebno je pokrenu cmd prompt, naci odgovarajuci folder i startova program
sa:

java -jar jchessboard.jar

Pod Windowsom je ponekad dovoljan dvoklik na jar fajl da bi bio pokrenut. Takodje, ako niste vicni radu u DOSu,
potrazite PowerToy Command Prompt, koji vam omogucava da iz Windows Explorera otvorite cmd prompt na zel-
jenom mestu. Verzija za XP nalazi se [2]ovde.

Vise informacija, uputstva i download mozete naci na oficijalnom [3]sajtu.

1. http://jchessboard.sourceforge.net/
2. http://go.microsoft.com/fwlink/?LinkId=211471
3. http://jchessboard.sourceforge.net/

Konverzija nrg u iso u Linuxu (2013-05-26 11:53) - darthewok

Nero nrg disk fajlove mozete konvertova u iso uz pomoc dva kratka programa koji rade iz terminala. To su nrg2iso i
iat.

Ako koris te Ubuntu, te programe morate prvo instalira .

nrg2iso:
Da bi ste instalirali nrg2iso, otvorite terminal i kucajte:
sudo apt-get install nrg2iso

Evo i primera kako treba da izgleda komanda u terminalu:
nrg2iso fajl.nrg fajl.iso

iat:
Da bi ste instalirali iat, otvorite terminal i kucajte:
sudo apt-get install iat

Evo i primera kako treba da izgleda komanda u terminalu:
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iat fajl.nrg fajl.iso

Iz licnog iskustva preporucujem iat. Zato sto se kod nekih nrg fajlova desava da prilikom konverzije, nrg2iso prijavi
da je nrg fajl vec u iso formatu i nece da ga konvertuje. Iat je uspeo i te fajlove da konvertuje u iso.

nGlide (2013-05-27 14:23) - darthewok

nGlide je besplatan program za Windows. nGlide omogucava da igrate stare igre koje koriste 3DFX Glide API, bez
potrebe da posedujete Voodoo graficke kar ce. 3DFX Glide API se vise ne koris kod savremenih video kar ca. Taj
API su koris le Voodoo kar ce.

Podrzane su tri verzije 3DFX API-a i to: Glide 2.1 (glide.dll), Glide 2.4 (glide2x.dll) i Glide 3.0 (glide3x.dll)

nGlide prevodi sve Glide pozive u Direct3D. nGlide, takodje podrzava rezime rada u visokim rezolucijama. Tako da
na primer, ako je originalna igra radila u rezoluciji 640x480, mozete je pokrenu u visoj rezoluciji.

Potrebna konfiguracija za vecinu igara:

Procesor: 1-Core Intel / AMD na 2.0 GHz
Graficka kar ca: DirectX 9 kompa bilna
Opera vni sistem: Windows XP / Windows 7 / Windows 8

Detaljnije informacije mozete procita na zvanicnoj web prezentaciji:
h p://www.zeus-so ware.com/downloads/nglide
Takodje, sa gore pomenute adrese mozete preuze nGlide.

Texturemate (2013-05-29 19:08) - darthewok

[1]Texturemate je sajt gde mozete pronaci mnogo besplatnih tekstura, braseva, paterna i drugih grafickih resursa koje
mozete koris u svojim radovima. Kolekcija tekstura je dosta velika i podeljena je po kategorijama. Autor ovog odlic-
nog sajta je Bill Sco .

h p://www.texturemate.com/
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3.6 June

Gimp tutorijal 58 - Transparentna pozadina 3 (2013-06-02 11:36) - darthewok

Nastavak price o transparentnim pozadinama. Ovog puta pravim transparentnu pozadinu uz pomoc layer mask-a.
Tehnika je pogodna za objekte sa puno detalja, kao sto su na primer zivo nje sa krznom, zivo nje sa perjem, drvece
i slicno. Ovu tehniku nije uvek moguce primeni u svim situacijama. To jest, moguce je primeni samo u situacijama
kada je velika razlika izmedju svetlih i tamnih boja. Takodje, ova tehnika ima svojih mana i mora da se u manjoj ili vecoj
meri rucno dorade neki detalji.

[youtube=h p://www.youtube.com/watch?v=fAv4fmWx6xg]

Seval Malcinovic (2013-06-19 13:04:40)
Poštovani, postoji li mogućnost za tutorial: kako sa slike izdvoji tekst od pozadine

darthewok (2013-06-19 16:49:57)
Postovanje, bice tutorijal, cim budem imao slobodnog vremena. U medjuvremenu pogledajte epizode 56, 57 i 58, jer tehnika
koju cu koris u tom tutorijalu koji ste trazili je potpuno ista kao tehnika primenjena u prikazanim tehnikama u epizodama 56,
57 i 58. Pozdrav

Slobodan so ver (2013-06-02 12:01) - darthewok

Na [1]blogu SLOBODAN SOFTVER mozete pronaci dosta informacija o slobodnom so veru, projek ma koji se cu slo-
bodnog so vera, slobodnim programima i korisnim linkovima ka drugim web adresama.

h ps://slobodanso ver.wordpress.com/

1. https://slobodansoftver.wordpress.com/

Željko Popivoda (2013-06-21 15:22:40)
Hvala za preporuku.
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darthewok (2013-06-21 21:10:07)
Nema na cemu. Pozdrav.

Double Commander (2013-06-08 23:52) - darthewok

Double Commander je mul pla ormski open source fajl menadzer. Napravljen je po uzoru na Total Commander.
Poseduje dva panela. Takodje poseduje mogucnost da koris dodatke (plugins) za Total Commander, ali tu opciju
nisam potpuno tes rao. Oni dodaci koji dolaze uz Double Commander rade, ali nisam tes rao druge dodatke koji se
mogu naci na internetu.

Double Commander se razvija za Linux, Windows i FreeBSD.
Zvanicna web prezentacija je na adresi: h p://doublecmd.sourceforge.net/

[1]

1. http://www.flickr.com/photos/l-i-n-u-x/8990023543/

Instalacija Oracle Java JRE na Ubuntu 12.04 (2013-06-10 19:44) - darthewok

Imao sam nekih problema sa Javom koja dolazi sa Ubuntu repozitorijuma. Konkretno, neki sajtovi koji traze Javu nisu
hteli da rade. Zato sam instalirao Oracle Java JRE i sve je ponovo radilo kako treba.

Prvo sam preuzeo poslednju verziju Jave sa zvanicnog sajta na adresi:
h p://www.java.com
U trenutku pisanja ovog teksta to je bila verzija 7 Update 21.
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Naziv fajla je jre-7u21-linux-i586.tar.gz.
Za instalaciju Jave sam koris o korak po korak uputstvo sa ove adrese:
h p://www.wikihow.com/Install-Oracle-Java-JRE-on-Ubuntu-Linux

Samo za kraj da napomenem, da budete oprezni sa Javom u web pregledacima. Zbog brojnih bezbednosnih propusta,
savetujem da Java dodatak u pregledacima drzite uvek iskljucen. Ukljucite ga samo na sajtovima gde je to neophodno
i gde ste sigurni da su sajtovi pouzdani.

Gimp tutorijal 59 - Odgovor na pitanje gledaoca (2013-06-20 13:51) - darthewok

Jedan od gledalaca je na mom blogu postavio pitanje kako da izdvoji tekst od pozadine u slici. Uslovno pominjem tekst
od pozadine u slici, jer je gledalac tako pitao. Termin tekst u slici, nije sasvim tacan, jer se tekst u rasterskoj (bitmap)
slici ne tre ra kao tekst, vec kao slika. Tako da to pominjem samo da ne bude neke zabune. Tehnika je ista kao i tehnika
koju sam koris o u epizodama 56, 57 i 58, pa sam ovu epizodu takodje iskoris o da ponovim sve ono sto sam pricao
u prethodne tri epizode.

[youtube=h p://www.youtube.com/watch?v=fKfLKolyZ4I]

Seval Malcinovic (2013-06-21 09:59:28)
Hvala za uloženi trud na pojašnjenju za moje pitanje

darthewok (2013-06-21 10:38:31)
Nema na cemu. Pozdrav!

PlayDeb (2013-06-22 12:27) - darthewok

[1]PlayDeb je nezvanicni projekat sa ciljem da obezbedi najnovije open source i freeware igre za Ubuntu. Igre mozete
instalira na jednostavan nacin tako sto prvo dodate PlayDeb repozitorijum, za m igre mozete pronaci i instalira ko-
risteci Ubuntu so ware Center ili klikom na zeljenu igru na samom sajtu, klikom se takodje pokrece Ubuntu So ware
Center iz koga se pokrece instalacija.

[2]PlayDeb pruza najnovije verzije igara kojih nema na zvanicnom Ubuntu repozitorijumu, takodje pruza i igre ko-
jih uopste nema na zvanicnom repozitorijumu.

[3]PlayDeb repozitorijum mozete podesi rucno ili preuze deb paket koji ce to uradi automatski.
Uputstvo za rucno podesavanje, kao i link za preuzimanje deb paketa mozete vide na ovoj adresi:
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h p://www.playdeb.net/updates/ubuntu/12.04/ #how _to _install

Adresa sajta je: h p://www.playdeb.net

1. http://www.playdeb.net/
2. http://www.playdeb.net/
3. http://www.playdeb.net/

3.7 July

Eternal Lands (2013-07-10 22:21) - darthewok

Eternal Lands je MMORPG igra. Zanimljivo je da je napravio jedan covek, Radu Privantu. Radnja igre je smestena
u srednjevekovni fantazijski svet. Igru zapocinjete izborom rase, za m treba da podesite kako ce Vas lik da izgleda i
da upisete ime i sifru za prijavljivanje u igru. Sto se rasa ce, imate izbor od 6 rasa. S m sto su prve tri rase, ljudi,
vilovnjaci i patuljci potpuno besplatni, a za preostale tri rase morate da pla te da bi ste ih vodili.

Igra se razvija za Linux, Windows i Mac.

Zvanicna web prezentacija odakle mozete preuze igru se nalazi na adresi: h p://www.eternal-lands.com/
Korisna adresa gde dosta toga mozete sazna o igri je: h p://el-wiki.net/

[youtube=h p://www.youtube.com/watch?v=pyCcRwAPZyU]

War Thunder (2013-07-10 23:09) - darthewok

War Thunder je online igra u kojoj upravljate borbenim avionima iz perioda s pocetka tridese h godina, pa sve do
kraja cetrdese h godina dvadesetog veka. U igri postoji veliki broj aviona, ali u pocetku, ce Vam na raspolaganju bi
dostupno samo nekoliko modela. Kada zavrsite preuzimanje igre, koje moze da potraje, jer je igra dosta velika, preko 5
Gb, potrebno je da se registrujete, tako sto upisete e-mail adresu, ime i sifru. Kada obavite formalnos oko registracije,
treba da izaberete neku od 5 ponudjenih drzava (Amerika, Nemacka, Sovjetski Savez, Velika Britanija i Japan). Inace,
niste ograniceni samo na drzavu koju u pocetku izaberete, u toku igranja, kako budete skupljali iskustvene poene,
otkljucacete preostale drzave. Pored vazdusnih borbi pro v pro vnickih aviona, mozete napada i ciljeve na zemlji
i moru. Pogled iz aviona mozete menja , tako osim pogleda iz ”treceg lica”, mozete koris pogled iz kokpita i iz
”virtuelnog kokpita” tj, iz ”prvog lica”.

Igra se razvija za Windows.
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Adresa zvanicne prezentacije odakle mozete preuze instaler za igru se nalazi na adresi:
h p://warthunder.com/

Takodje mozete pogleda i sajt na ovoj adresi:
h p://warthunder.wikia.com/wiki/War _Thunder _Wiki
na gore pomenutoj adresi ima dosta korisnih informacija.

[youtube=h p://www.youtube.com/watch?v=y5JK-2Yn5NA]

openBVE (2013-07-10 23:23) - darthewok

openBVE je ”open source” simulator vozova. Pored postojecih scenarija i vozova koji dolaze uz samu igru, moguce je
sa interneta preuze dodatne vozove i scenarije. Igra je jako lepo uradjena i verovatno ce privuci sve ljubitelje vozova
i one koji su voleli da se igraju sa modelima vozova na baterije. :)

Igra se razvija za Linux, Windows i Mac.

Adresa zvanicne internet prezentacije je: h p://www.openbve.org/

[youtube=h p://www.youtube.com/watch?v=eKurAJyU3SM]

Speed Dreams (2013-07-10 23:49) - darthewok

Speed Dreams je ”open source” simulacija auto trka. Razvija se za Linux, Windows, a uskoro i za Mac. Mozete bira
vise vrsta auotmobila, kao i staza gde se mozete trka . Igra ima prilicno realan fizicki model, tako da, treba malo da
se naviknete na kola i fiziku u igri. U pocetku ce te verovatno cesto izleta u krivinama, cak i na ravnom, ako Vas
pro vnicki automobil malo ”cusne” sa strane. :)

Zvanicna web prezentacija se nalazi na adresi:
h p://www.speed-dreams.org/

[youtube=h p://www.youtube.com/watch?v=uLFyaIXY-OY]
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Izbacivanje dodatnog audio streama iz mp4 fajla (2013-07-13 00:27) - w1ndu

Cesto se desava da dodjemo u posed mp4 ili mkv fajla koji ima vise od jednog audio streama. Tipicna situacija je film
sa originalnim zvukom, uz dodatnu sinhronizaciju na jos neki jezik. Ovo najcesce ne predstavlja problem, medju m
ponekad se desava da pojedini playeri odbijaju da puste filmove sa visestrukim zvukom ili jednostavno zelite da
smanjite duzinu fajla izbacujuci nepotrebne streamove.

Ovo mozete pos ci na nekoliko nacina, ovde cemo prikaza dva:

1) GUI verzija:

a) Skinite My.MP4Box.GUI-0.5.2.1 portabilnu verziju [1]odavde, i extraktujte u folder po zelji. Ako vam WinRar
prijavi gresku, slobodno je ignorisite.

b) Pokrenite My MP4Box GUI.exe, predjite na Demux tab i sa Open ucitajte fajl. Kliknite Demux da bi snimili
sve streamove.

c) Proverite audio fajlove nekim playerom (Npr. WinAmp) i zapam te ime fajla sa audio streamom na jeziku
koji zelite da koris te.

d) Predjite na tab Mux. Kliknite Add i dodajte video fajl. Za m opet Add i izaberite zeljeni audio stream. Kliknite Save
As da bi definisali ime izlaznog fajla, za m Mux da bi ga kreirali. Dobicete mp4 fajl sa izabranim elemen ma, bez
nezeljenog streama.

2) Iz konzole:

a) Skinite Trippov FFmpeg build [2]odavde i extraktujte ga u zeljeni folder. Prebacite u is folder film koji ho-
cete da obradjujete i reimenujte ga u nesto krace radi lakseg rade, recimo bla.mp4.

b) Otvorite dos prompt u folderu gde se nalazi ffmpeg.exe i kucajte:

[code]ffmpeg -i bla.mp4[/code]

Dobicete podatke o fajlu koji ce sadrza i sve streamove. U tom delu, output ce izgleda otprilike ovako:

Stream #0.0(und): Video: h264, .....
Stream #0.1(eng): Audio: aac, ....
Stream #0.2(ita): Audio: aac, .....

c) Sad samo ostaje da mapujete streamove koje zelite. Pretpostavimo da vam italijanski ne treba, i da zelite
samo video i eng u izlaznom fajlu. Kucate:

[code]ffmpeg -map 0:0 -map 0:1 -acodec copy -vcodec copy -i bla.mp4 bla1.mp4[/code]

Dobicete fajl bla1.mp4 koji ce ima sadrzaj kakav ste zamislili.
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Prednos & Mane: GUI metod je prilicno lak ali je ogranicen na windows, konzola metod zahteva malo vise
znanja ali je primena crosspla ormska. FFmpeg binarne fajlove po distribucijama, kao i source code koji vam
omogucava da ga samostalno kompajlirate, mozete skinu [3]ovde.

Jos jedan popularan GUI nacin obrade mp4 fajlova je preko programa [4]YAMB. U koliko se opredelite za njega,
obra te paznju na bagovit instaler jer se moze desi da vam prilikom deinstalacije obrise sve linkove iz start menija
koji su registrovani na All Users.

Da ne bismo otvarali zasebnu temu, u koliko zelite da obradjujete mkv fajlove, skinite [5]MKVToolNix. Inter-
fejs je izuzetno intui van - jednostavno prevucite mkv preko programa, selektujte streamove, definisite Output
i kliknite Start muxing. Sva ostala podesavanja su logicna iz naziva dijaloga ili feedbacka koji dobijate iz samog
programa.

Srecno sa obradom video materijala u HD forma ma. :)

1. http://www.videohelp.com/tools?d=My%20MP4Box%20GUI%20v0.5.2.1-no%20installer.rar
2. http://tripp.arrozcru.com/builds/ffmpeg-18639.7z
3. http://ffmpeg.org/download.html
4. http://yamb.unite-video.com/
5. http://www.bunkus.org/videotools/mkvtoolnix/

Mp4 Muxer | Kompjuteri (2013-09-06 02:34:46)
[…] program za muxovanje u mp4 format. Zapravo predstavlja vizuelni shell za mp4creator. Tamo gde prethodno opisani My
Mp4Box napravi propust, velike su sanse da ce Mp4 Muxer bi […]

Gimp tutorijal 60 - Luce plugin (2013-07-15 13:32) - darthewok

U ovoj epizodi predstavljam Luce plugin za pravljenje svetlosnih efekata sa zracima svetla.

[youtube=h p://www.youtube.com/watch?v=VaTwvIk1Hz0 &feature]

Gimp tutorijal 61 - Smanjivanje XCF fajla (2013-07-15 13:44) - darthewok

U ovoj epizodi objasnjavam kako da smanjite velicinu izlaznog XCF fajla uz pomoc kompresije koju podrzava Gimp.

[youtube=h p://www.youtube.com/watch?v=Qo0J3q2Fiwc]
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Brasevi za Gimp (2013-07-17 14:04) - darthewok

Velike kolekcije braseva za Gimp mozete preuze sa sledecih adresa:

h p://grindgod.deviantart.com/art/The-Gimp-TextureBox-385558228
h p://grindgod.deviantart.com/art/The-Gimp-BrushBox-v2-0-382881674
h p://grindgod.deviantart.com/art/Gimp-2-8-Color-Tubeset-for-Digital-Painter s-380814984

Autor braseva je Vasco Basque’
Takodje, mozete pose i njegov blog na adresi: h p://vascobasque.wordpress.com/

Osnove Pitona (2013-07-28 22:49) - w1ndu

Pajton programski jezik uziva sve vecu popularnost kako u obrazovanju tako i u poslu. Dok je u [1]nekim krugovima
ubedljivo na prvom mestu, gotovo [2]uvek je pri vrhu. Razloga za ovo ima mnogo: jednostavnost, preglednost, cena
(besplatan), otvorena licenca, pla ormska nezavisnost, univerzalna primena, jaka podrska itd.

U koliko zelite da naucite Python, ovde cemo da nekoliko proverenih i kvalitetnih predloga:

1) [3]LearnStreet - Zanimljivo uradjen uvod u Python. U pitanju je interak vna skola, koja vas vodi kroz ko-
riscenje interpretera i pisanje jednostavnog koda. Obradjuje segmente programskog jezika kroz niz vezbi i zadataka,
uz hintove i pomoc u koliko je neophodno. Inace, LearnStreet ima slicnu skolu Rubya i JavaScripta.

2) [4]Udacity CS101 - Kurs koji je proslavio Udacity. Iako je zvanicno vezan za Kompjuterske Nauke, u pot-
punos je baziran na Pythonu. Predavanja su interak vna, sadrze brojne vezbe kao i finalni test u dva dela nakon
koga, u zavisnos od rezultata, dobijate pdf ser fikat. Nakon toga slede dodatna predavanja koja konsoliduju znanje
i ukazuju na elegantnija programerska resenja.

3) [5]Google Python - Odlicna dopuna za prethodna dva, a mozda i dobro mesto da se pocne. U pitanju je
kratak kurs Pythona koji podrazumeva da imate makar neku osnovu u programiranju. Sadrzi jednostavne ali vrlo
ilustra vne prak cne primere rasporedjene po oblas ma, video materijale sa originalnih predavanja kao i kodove sa
vezbama.

Napomena: Za prva dva nije potrebno da instalirate bilo sta, jer obe pla orme imaju svoj web interpreter.
Treci je baziran na radu u desktop interpreteru, i daje instrukcije kako da ga instalirate na razlicite sisteme. Moje
misljenje je da ga svakako instalirate, jer je nelogicno i neprak cno uci programski jezik bez istog na sopstvenom
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sistemu.

Napomena+: Sva tri kursa su bazirana na Pythonu v2. Treci kurs medju m daje brojne reference ka Pythonu
v3, na sebi svojstven Google freestyle nacin. To je inace i pristup celog kursa.

FaQ:

1) Sta instalira ? Instalirajte zeljenu verziju Pythona za vas sistem [6]odavde.

2) Web interpreteri? Zgodan nacin da tes rate svoj code preko web interfejsa. Neki od najboljih su [7]repl.it
& [8]codecademy.

3) Koja verzija? Ljudi cesto pitaju da li da instaliraju v2 ili v3. Oba resenja su dobra i ovo je pomalo vestacki
sukob. Pv2 je jednostavniji i popularniji. Pv3 je odavno stabilan i predstavlja buducnost. Razlike su minimalne, i ako
se pokaze neophodnim mozete koris prevodilac [9]2to3 ili backport [10]3to2. Takodje, nista vas ne sprecava da
instalirate obe jer mogu da rade paralelno.

4) Piton vs. Pajton (izgovor imena)? Jos jedan vestacki sukob, oba izgovora su validna. Programski jezik je do-
bio ime po [11]Letecem Cirkusu Mon Pajtona. U koliko shva te na ovaj nacin pravilno je Pajton, u koliko shva te
kao ime vrste zmije onda je Piton.

5) Sta dalje? U koliko vam se dopadne Pajton i zelite da naucite vise, najbolje da sledite svoja prirodna in-
teresovanja. Npr. ako vas zanima desktop potrazite [12]BoaConstructor i slicne [13]alate. Za security aspekt, Python
ima bogate mogucnos [14]enkripcije svake vrste kao i odlicne knjige na temu, poput [15]Violent Python. Ako volite
da pravite igre, tu je [16]InventWithPython.com. I konacno, ako zelite da predjete na Pv3, u najavi su dva odlicna
kursa Univerziteta u Torontu: [17]The Fundamentals & [18]Cra ing Quality Code.

Na kraju, ako vam zatreba pomoc ili savet, gotovo sigurno cete naci resenje na [19]StackOverflow.com - svakako
jednom od najkorisnijih sajtova na temu.

Uzivajte u [20]Pythonu. :)

1. https://news.ycombinator.com/item?id=3746692
2. https://sites.google.com/site/pydatalog/pypl/PyPL-PopularitY-of-Programming-Language
3. http://www.learnstreet.com/lessons/study/python
4. https://www.udacity.com/course/cs101
5. https://developers.google.com/edu/python/
6. http://www.python.org/download/
7. http://repl.it/languages/Python
8. http://labs.codecademy.com/
9. http://docs.python.org/2/library/2to3.html
10. http://wiki.python.org/moin/3to2
11. http://en.wikipedia.org/wiki/Python_%28programming_language%29#Naming
12. http://showmedo.com/videotutorials/series?name=wKQrywla5
13. http://wiki.python.org/moin/IntegratedDevelopmentEnvironments
14. http://docs.python.org/2/library/crypto.html
15. https://www.ethicalhacker.net/features/book-reviews/book-review-violent-python
16. http://inventwithpython.com/
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17. https://www.coursera.org/course/programming1
18. https://www.coursera.org/course/programming2
19. http://stackoverflow.com/
20. http://www.youtube.com/watch?v=PpxQp3Hy5nk

Python – uvod u seriju tekstova sa primerima. | Kompjuteri (2014-01-03 03:25:52)
[…] Windu je vec napisao dobar uvod za Python, mozete ga procita ovde: h ps://kompjuteri2011.wordpress.com/201-
3/07/28/osnove-pitona/ […]

Python туторијали (2014-01-13 19:40:57)
[…] Основе Питона […]

3.8 August

Empire of Sports (2013-08-02 19:29) - darthewok

Empire of Sports je online sportska igra koja se razvija za Windows. Kao sto ime igre sugerise, rec je o sportskoj igri. U
igri postoji vise sportova u kojima se mozete takmici . Prvo sto treba da uradite je da se registrujete i da napravite svoj
avatar. Za m treba da preuzmete instaler za igru i da instalirate igru. Sto se registracije ce, nisam uspeo iz prve da
se registrujem, probao sam vise puta, ali mi je registracija prihvacena, tek kada sam se registrovao preko VPN-a. Pret-
postavljam da je to bio trenutni problem da nisam mogao da se registrujem iz Srbije, vec preko VPN-a sa IP adresom iz
Engleske. :) Ako imate problema prilikom registracije, probajte preko VPN-a ili nekog stranog Proxy-a. Nema veze sto
ce izgleda da se registrujete iz inostranstva, jer uvek u lis drzava mozete izabra Srbiju i takmici se pod srpskom
zastavom. Inace, kada obavite formalnos oko registracije i instalacije igre, igra bez problema radi bez proxy-a i VPN-a.

U igri su zastupljeni sledeci sportovi: fudbal, kosarka, tenis (singl i dubl), zimski sportovi (skijanje, sankanje i bob)
i atle ka, koja se u igri inace naziva track & field i zastupljene su dve trkacke discipline, na 100 metara i 110 metara sa
preponama i dve skakacke discipline, skok u dalj i troskok.

Odradjivanjem raznih misija koje dobijate od NPC likova, treninzima, prijateljskim mecevima i zvanicnim takmicen-
jima dobijate iskustvo i novac. Kada nakupite dovoljno iskustva, dobijate nivo za odredjenu disciplinu, odnosno kada
nakupite dovoljno novca mozete kupi bolju opremu koja ce da poboljsa odredjene atribute vaseg lika.

Zvanicna web prezentacija se nalazi na adresi: h p://www.empireofsports.com

[youtube=h p://www.youtube.com/watch?v=kplE-H-iYl4]
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QB64 Basic (2013-08-03 00:12) - w1ndu

QB64 je krospla ormski Basic kompajler. Ono sto ga cini zanimljivim je visoka kompa bilnost sa QuickBasic-om. Nesto
sto ce verovatno obradova nostaligicne programere.

Trenutno su podrzani Windows, Linux, MacOS & delimicno Android. U koliko nemate iskustva sa ovim popularnim
Basicom, osnovni tutorijal mozete skinu [1]ovde a napredne pogledajte na Pete’s QBasic [2]sajtu.

Vise informacija na [3]Wiki. / Download & test na oficijalnom QB64 [4]sajtu.

1. http://pittajarn.lpru.ac.th/~nukit/basic/tutorial_basic.pdf
2. http://petesqbsite.com/
3. http://en.wikipedia.org/wiki/QB64
4. http://www.qb64.net/

Bezbednost PDF dokumenata (2013-08-06 19:36) - darthewok

Skoro svakodnevno otvaramo neke PDF dokumente, koje preuzmemo sa interneta ili ih dobijemo na drugi nacin.
Ali malo ko je svestan, da i PDF dokumen mogu da budu potencijalno opasni. PDF dokumen mogu da sadrze
Java skripte. Te Java skripte mogu da se automatski izvrse bez znanja korisnika. Upravo ta mogucnost automatskog
izvrsavanja Java skrip bez znanja korisnika predstavlja opasnost od moguce zloupotrebe. Dodatni problem je sto
an virusi najverovatnije ne bi ni upozorili korisnika na potencijalno opasan PDF dokument.

Na srecu, postoji kratka Python skripta koja moze da se iskoris za analizu PDF dokumenata. Skripta je pdfid.py. Posto
je rec o Python skrip , moracete da instalirate Python, ako ga vec nemate instaliranog.

Skriptu mozete preuze sa sledece adrese:
h p://blog.didierstevens.com/programs/pdf-tools/

Kada preuzmete zipovani fajl, raspakujte ga. Pdfid.py radi u komandnom promptu, odnosno terminalu. Na-
jbolje je da pdfid.py i PDF dokument koji tes rate budu u istom folderu. Napomena, za korisnike Linuxa, pre nego sto
budete mogli da koris te skriptu, morate da joj dozvolite da se izvrsava kao program, zato ukucajte komandu:
chmod +x pdfid.py
Kada ste to uradili, mozete da tes rate Vase PDF-ove na sledeci nacin:
./pdfid.py neki _fajl.pdf

Windows korisnici kucaju komandu:
pdfid.py neki _fajl.pdf

Kada skripta zavrsi analizu PDF-a, prikazace sta s ku pojavljivanja izvesnih kljucnih reci u PDF-u i koliko se
puta pojavljuju.
Ako PDF sadrzi kljucne reci /JS i /JavaScript, to znaci da ima neki Java skript u sebi.
Kljucne reci /AA i /OpenAc on znace da se prilikom pregleda PDF-a izvrsavaju neke automatske akcije.
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Ako PDF sadrzi Java skript i kljucne reci /AA i /OpenAc on to znaci da je dokument sumnjiv i da poseduje Java
skript koji moze da se automatski izvrsi.

Naravno, ne mora da znaci da svaki PDF dokument koji automatski izvrsava Java skript ujedno i potencijalno
opasan dokument, ali u tom slucaju treba bi oprezan. Ako ste PDF preuzeli iz izvora koji nisu pouzdani ili ste ga dobili
preko emaila, najbolje je da ga ne otvarate. Ili da ga otvorite u virtuelnom okruzenju, na primer Virtual Boxu.

Samo da dodam, da pdfid moze i da onesposobi automatsko pokretanje Java skrip .
./pdfid.py -d neki _fajl.pdf

Za detaljan spisak komandi kucajte:
./pdfid.py -h

Ako zelite da dalje analizirate PDF dokumente, mozete koris Python skriptu koja se zove: pdf-parser.py
Tu skriptu takodje mozete preuze sa adrese:
h p://blog.didierstevens.com/programs/pdf-tools/

Takodje, na adresi h p://blog.didierstevens.com/programs/pdf-tools/ mozete pronaci vise detalja o tome kako
se koriste skripte.

Jos jedna zanimljiva adresa je:
h ps://brundlelab.wordpress.com/2010/11/23/malware-pdf-analysis-of-a-very-si mple-sample/
Na gore pomenutoj adresi je primer analize jednog malicioznog PDF-a gde se koriste ala pdfid.py i pdf-parser.py.

Brokerov blog (2013-08-07 14:04) - darthewok

Blog sa zanimljivim i korisnim tekstovima mozete pose na adresi:
h p://broker824.blogspot.com/

Izmedju ostalih tekstova, na blogu mozete pronaci srpski [1]prevod GNU GPL2 licence i objsanjenje pojmova [2]haker,
kreker i lamer.

1. http://broker824.blogspot.com/2013/07/gnu-licenca-za-upotrebu-softvera.html
2. http://broker824.blogspot.com/2013/08/pojam-haker-kreker-lamer-haker-cracker.html

Op mizacija SeaMonkey Browsera (2013-08-09 01:30) - w1ndu

[1]SeaMonkey je browser baziran na Mozilla tehnologiji koji u sebi integrise nekoliko funkcija. To su: Navigator
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browser baziran na FireFoxu, mail client baziran na Thunderbirdu, web editor Composer na cijoj je osnovi razvijen
Nvu, integrisani Address Book i IRC klijent ChatZilla. Svi ovi programi su elegantno uklopljeni i podrzavaju jedan drugi.
Medju m ponekad default podesavanja cine ovaj paket pretrpanim, pa cemo se pozabavi brzom op mizacijom.

Svi navedeni predlozi su opcioni i cesto predstavljaju stvar ukusa. Preskocite sve sto vam se cini suvisnim, ili
imate resenje koje vam vise odgovara. Na kraju texta je brzo podesavanje bez dodatnih objasnjenja i napomena.

1) Izgled ->

a) Moderna tema - View > Apply Theme > Modern > Restart Now
b) Sklanjanje BookmarkBar > View > Show/Hide > Bookmark Toolbar
Hint: Brz pristup Bookmark Sidebaru je na F9.

2) Sredjivanje Bookmarka ->
Napomena: Metod predlaze da obrisete sve bookmarke, pa da ucitate svoje. U koliko nemate prethodno pripremljene
books, uradite kako vam odgovara.

a) Brisanje postojecih - U Bookmarks Manageru otvorite Bookmarks Toolbar > Selektujte prvi > Drzite Delete
dok ne obrisete sve. Za m otvorite Bookmarks Menu i ponovite isto.

b) Ucitanje bookmarka - U Bookmarks Manageru: Tools > Import HTML > From File > Next > I selektujte vas
bookmarks fajl.

3) Appearance: Edit > Preferences > Appearance > ..

a) Favicon - Content > Chekirajte Show website icons i Aggressively look for website icons when the page does
not define one.

Napomena: Prva opcija je default, ali ne i druga. Dosta sajtova ne koris standardni html code za obeleza-
banje sajt ikonica, vec jednostavno stavi favicon u root. U koliko ne obelezite drugu opciju ovi sajtovi nece ima
ikonicu u bookmarks lis . Inace, entry istog podesavanja u about:config se zove browser.chrome.favicons.

b) Zoom Level - Content > Dechekirajte Remember zoom levels on per-site bases.

c) Provera spelovanja - Spelling > When typing, check my spelling > Never. Takodje dechekirajte ’Check spelling as
you type’.
Napomena: Ova naporna opcija je u ranijim verzijama bila pod Browser > Languages.

4) Browser: Edit > Preferences > Browser > ..

a) Homepage - Display on browser startup > Blank page.

b) Address Bar pretraga - .. > History: Dechekirajte Enable form and search history.

c) Download lokacija - .. > Downloads: Save files to > Choose Folder > Desktop.
Napomena: Ako zelite da menjate imena fajla ili nacin snimanja htmla, ostavite default.

d) Tabovi - .. > Tabbed Browsing: Dechekirajte Warn me when closing a window with mul ple tabs i Open re-
lated tabs a er current tab.
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5) Privacy & Security: Edit > Preferences > Privacy & Security > ..
Napomena: Predlozeno resenje podrazumeva da sifre za sajtove cuvate u zasebnom programu. U koliko zelite da
SeaMonkey brine o vasim siframa, najbolje da koris te default uz Master Password.

a) Clear private data - Privacy & Security > Dechekirajte Ask me before clearing private data i chekirajte sve
opcije pod When i ask SeaMonkey to clear..

b) Sifre - > Passwords: Dechekirajte Remember Passwords.

c) SSL - > SSL Warnings: Dechekirajte poslednji.

6) Advanced: Edit > Preferences > Advanced > ..

a) Quick Find: .. > Find as you type > Dechekirajte Find automa cally when typing within a web page.
Napomena: Dosadna opcija koja vam ukljucuje Search ako kucate brzo na stranici.

b) Proxy: .. > Proxies > Selektujte Manual proxy configura on da bi podesili svoj proxy. Za m selektujte Di-
rect connec on to internet. Proxy konfiguracija ce osta snimljena. Na ovom mestu kasnije mozete menja nacin
koriscenja interneta.

c) Updej : .. > So ware Installa on > Pod Add-ons dechekirajte Allow websites to install add-ons and updates.
Opciono mozete pod SeaMonkey da prebacite Check for updates na weekly, ili da potpuno iskljucite. Medju m, ovo
se ne preporucuje neiskusnim korisnicima jer nove verzije cesto pokrivaju sigurnosne propuste. Koris te ovu opciju
samo ako tacno znate sta radite.

d) Disable Open File Warning > Upozorenje koje dobijate kada program koji ste downloadovali probate da
pokrenete.

U Address Baru kucajte: about:config > I’ll be careful, i promise! > Search:
browser.download.manager.scanWhenDone i sa dvoklikom promenite u False.

e) Disable Plugins Warning > Upozorenje da neki plugin (poput Flasha) nije updateovan. Koliko moze bi ko-
risno, toliko ume da bude dosadno u nekim situacijama.

about:config > I’ll be careful, i promise! > Search: plugins.hide _infobar _for _outdated _plugin dvoklik za
True, za m: extensions.blocklist.enabled dvoklik za False i na kraju obrisite blocklist.xml iz [2]profil foldera. Ovaj
folder takodje mozete naci i preko: Edit > Preferences > Advanced > Cache, jer se cache i profili nalaze na istom
mestu.

—————<^>

Brzo podesavanje (bez objasnjenja i napomena):

1) Izgled:

a) View > Apply Theme > Modern > Restart Now
b) View > Show/Hide > Bookmark Toolbar

2) Bookmarks:
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a) Bookmarks > Manage Bookmarks > Bookmark Toolbar > obrisite sve; Bookmarks Menu, obrisite sve.
b) Bookmarks Manager > Tools > Import HTML > ucitajte svoje bookmarke.

3) Edit > Preferences >

a) Appearance >

Content > Cekirajte: Aggressively look for website icons..
Content > deCekirajte: Remember zoom levels on per-site bases
Spelling > When typing, check my spelling > Never
Spelling > deCekirajte: Check spelling as you type

b) Browser >

Display on Browser Startup > Blank page
History > deCekirajte: Enable form and search history
Tabbed Browsing > deCekirajte: Warn me when closing mul ple tabs
Tabbed Browsing > deCekirajte: Open related tabs a er current tab

c) Privacy & Security >

deCekirajte: Ask me before clearing private data
Cekirajte: Sve pod When i ask SeaMonkey to clear..
Passwords > deCekirajte: Remember passwords
SLL > pod SSL Protocol Cekirajte sve, pod SSL Warnings deCekirajte sve

d) Advanced >

Find as you type > deCekirajte: Find automa cally when typing..
Proxies > Selektujte Manual proxy, upisite proxy svog ISPa, selektujte Direct connec on..
So ware Installa on > deCekirajte: Allow websites to install add-ons
So ware Installa on > deCekirajte: Automa cally check for updates, ili prebacite na weekly

4) Extras:

U address baru kucate: about:config > I’ll be careful, i promise! (elemente menjate dvoklikom)
browser.download.manager.scanWhenDone > False
plugins.hide _infobar _for _outdated _plugin > True
extensions.blocklist.enabled > False

Na kraju obrisite blocklist.xml iz [3]Profile foldera.

1. http://www.seamonkey-project.org/
2. http://kb.mozillazine.org/Profile_folder
3. http://kb.mozillazine.org/Profile_folder
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Op mizacija Firefox Browsera | Kompjuteri (2013-08-11 01:32:07)
[…] SeaMonkey text, sada cemo se pozabavi brzom op mizacijom Firefox browsera. Slicno kao i ranije, vecina predloga […]

Op mizacija Firefox Browsera (2013-08-11 01:32) - w1ndu

Sledeci SeaMonkey [1]text, sada cemo se pozabavi brzom op mizacijom Firefox browsera. Slicno kao i ranije, vecina
predloga je stvar ukusa i potpuno opciona. Preskocite sve sto vam se ucini suvisnim. Takodje primenite svoja resenja
ako vam vise odgovaraju. Ovo je samo jedan od mnogih nacina kako mozete podesi svoj browser.

Jedina bitna napomena, tutorijal objasnjava kako da promenite pojedine sigurnosne opcije. Ovo zato sto mnogi
napredni korisnici vole da im browser bude browser, a ne bebisiter. Ali svakako da ove opcije imaju svoju ulogu, i
ako zelite da ih koris te jednostavno ostavite default ili primenite svoja setovanja.

Text se bavi FF17esr verzijom. ESR ili [2]Extended Support Release su verzije Firefoxa koje imaju dugu podrsku. U
njima se updejtuju samo sigurnosni aspek , bez promene interfejsa ili dodavanja novih funkcija. Medju m, resenja
iz ovog tutorijala gotovo sigurno mozete da primenite i na osnovnu FF liniju.

Na kraju texta su brza setovanja , bez dodatnih objasnjenja i napomena. Zvezdicom ce bi obelezeni sigurnosni
aspek koji su opcioni.

1) Izgled

a) Tabovi ispod Address Bara - Upisite: about:config u Address Bar > I’ll be careful, i promise! > Upisite u
Search: browser.tabs.onTop > dupli klik na entry da bi prebacili u False.
Napomena: Zbog planova Firefoxa, postoji mogucnost da ova opcija bude ukinuta.

b) New Tab Blank - U Address Bar: about:config > I’ll be careful, i promise! > U Search: browser.newtab.url >
Dupli klik i upisite about:blank umesto about:newtab.
Napomena: Ovo je staro ponasanje FFa, ako zelite da vra te obrnite proces.

c) Opciono: Ako zelite da u Address Baru vidite favicon sajta umesto globusa, skinite addon [3]Favicon Re-
storer.

d) Addon Bar: View > Toolbars > Add-on bar
Napomena: U koliko ste navikli na Status Bar, prelaz u sistemski desktop izgleda neprirodno.
Opciono: Da bi vra li normalni Firefox Status Bar, mozete koris [4]Status4Evar addon.

2) Srednjivanje bookmarka
Napomena: Slicno kao i ranije, predlog je da obrisete postojece i ucitate svoje. U koliko nemate spremnu bazu
bookmarka, uradite kako vam odgovara. Inace, korisno je povremenu ih exportova u html preko managera, na
slican nacin kao sto ce bi objasnjeno importovanje.

a) Brisanje postojecih: Bookmarks > Show all bookmarks > Bookmarks Toolbar > Obrisite sve. Za m Book-
marks Menu > Obrisite sve.

b) Ucitanje bookmarka: U Bookmark Library > Import and Backups > Import Bookmarks from HTML.. > i ucita-
jte svoje bookmarke.
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3) Opcije: Tools > Op ons >

a) General:

- When Firefox starts: Show a blank page
- Pod Downloads Save files to > Browse > Desktop

b) Tabs:

- deCekirajte: Warn me when closing mul ple tabs & Warn me when opening mul ple tabs may slow..

c) Security:

- Opciono deCekirajte: Block reported a ack sites & Block reported malware sites. Ove zas te su bazirane na
blacklistama koje se na pola sata updejtuju iz Google i StopBadware.org baze. U koliko znate sta radite ovo obicno
nije neophodno, ali mozete ostavi kao dodatni nivo zas te.

- deCekirajte: Remember passwords for sites.
Napomena: Ovo se preporucuje u koliko koris te spoljni program za cuvanje passworda. U suprotnom mozete
koris Firefox i setova Master Password.

d) Advanced:

- General tab > deCekirajte: Check my spelling as i type

- Network tab > Connec on deo > Se ngs: Kliknite Manual proxy, upisite proxy svog ISPa, cekirajte Use this
proxy for all protocols. Za m kliknite No proxy i Ok.
Napomena: Na ovom mestu kasnije mozete prebaciva iz direktne u proxy konekciju i obrnuto

- Update tab > Opciono: Firefox updates > Never check for updates. Takodje mozete da deCekirate i Autoup-
date za Search Engines.
Napomena: Ove se provere mogu obavi i rucno, npr. iz Help > About. Ako zelite da Firefox ovo radi za vas, ostavite
default.

4) Opcije+:

a) Brisanje podataka - Tools > Clear recent history > Time range to clear: Everything. U Details cekirajte sve.
Clear now. Ubuduce ce ovi se ngsi za brisanje osta zapamceni.

Napomena: Korisna opcija da obrisete podatke bez suvisnih pitanja je uklonjena jer su developeri, prema sop-
stevnom priznanju, zeleli da ’dumb down’ (zaglupe) upotrebu FFa. Hvala im na tome.

Napomena+: Ako zelite da vam FF brise podatke pri exitu - Tools > Op ons > Privacy > History > Firefox will:
Use custom se ng for history (iz drop down menija) > Clear history when Firefox closes. Nakon cekiranja ove opcije
kliknite Se ngs i tu mozete izabra dodatne podatke koje ce Firefox brisa kada ga zatvorite.

b) Normalno otvaranje tabova (skroz desno, a ne ’pametno’) - U Address Baru upisite: about:config > I’ll be
careful, i promise! > Search: browser.tabs.insertRelatedA erCurrent > dupli klik za False.
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c) Disable Open File Warning - U Address Baru: about:config > I’ll be careful, i promise! > Search:
browser.download.manager.scanWhenDone i sa dvoklikom promenite u False.
Napomena: To je upozorenje koje dobijate kada pokusate da pokrenete fajl koji ste downloadovali.

d) Disable Plugins Warning > Upozorenje da neki plugin (poput Flasha) nije updateovan. U koliko iz bilo kog
razloga ne zelite da koris te poslednju verziju plugina, ovo postaje beskrajno dosadno.

U Address Baru: about:config > I’ll be careful, i promise! > Search: plugins.hide _infobar _for _outdated _plu-
gin dvoklik za True, za m: extensions.blocklist.enabled dvoklik za False i na kraju obrisite blocklist.xml iz [5]profil
foldera.

——————-<^>

Brzo podesavanje (bez objasnjenja i napomena):

1) Izgled:

a) Adressbar: about:config > I’ll be careful > Search: browser.tabs.onTop > 2x Klik za False
b) Adressbar: about:config > I’ll be careful > Search: browser.newtab.url > 2x Klik i promenite u about:blank
c) Addon Bar: View > Toolbars > Cekirajte: Add-on bar

2) Bookmarks:

a) Bookmarks > Show all bookmarks > Bookmarks Toolbar > Obrisite sve. Za m Bookmarks Menu > Obrisite
sve.
b) Bookmarks > Show all bookmarks > Import and Backups > Import Bookmarks from HTML... > ucitajte svoje
bookmarke

3) Tools > Op ons >

a) General:

When Firefox starts: Show a blank page
Pod Downloads: Save files to > Browse > Desktop

b) Tabs:

deCekirajte: Warn me when closing mul ple tabs & Warn me when opening mul ple tabs

c) Security:

deCekirajte: Block reported a ack sites & Block reported malware sites
deCekirajte: Remember passwords for sites

d) Advanced:

General tab > deCekirajte: Check my spelling as i type
Network tab > Se ngs > Manual proxy: upisite svoj ISP proxy > Cekirajte: Use this proxy for all protocols > kliknite
No proxy > Ok
Update tab > Firefox updates > Never check for updates
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Update tab > deCekirate: Automa cally update Search Engines

4) Opcije+:

a) Tools > Clear recent history > Time range to clear: Everything, Details: Cekirajte sve > Clear now
b) Adressbar: about:config > I’ll be careful > Search: browser.tabs.insertRelatedA erCurrent > 2x Klik za False
c) Adressbar: about:config > I’ll be careful > Search: browser.download.manager.scanWhenDone > 2x Klik za False
d) Adressbar: about:config > I’ll be careful > Search: plugins.hide _infobar _for _outdated _plugin > 2x Klik za True.
Search: extensions.blocklist.enabled > 2x Klik za False. Obrisite blocklist.xml iz [6]profil foldera.

Sigurnosni aspek - po potrebi ostavite default.

1. http://kompjuteri2011.wordpress.com/2013/08/09/optimizacija-seamonkey-browsera/
2. http://www.mozilla.org/en-US/firefox/organizations/all.html
3. https://addons.mozilla.org/en-US/firefox/addon/favicon-restorer/
4. https://addons.mozilla.org/en-us/firefox/addon/status-4-evar/
5. http://kb.mozillazine.org/Profile_folder
6. http://kb.mozillazine.org/Profile_folder

Firefox – Novi zum | Kompjuteri (2013-11-03 03:06:57)
[…] U koliko vas zanimaju ostala FF podesavanja, pogledajte prethodni text. […]

ScriptSafe (2013-08-30 00:38) - darthewok

ScriptSafe je dodatak za Chrome / Chromium koji blokira izvrsavanje skrip na web stranama.
Moguce je ukljuci i iskljuci izvrsavanje pojedinih skrip za svaku stranu koju pose te.

Verovatno se pitate zasto blokira izvrsavanje skrip , kada ce to da onemoguci normalno funkcionisanje web strana
koje posecujete?

Iz bezbednosnih razloga je preporucljivo blokira izvrsavanje skrip . Pojedine Java skripte mogu da budu opasne.
Tako da je preporucljivo da dozvolite izvrsavanje skrip samo na sajtovima gde je to zaista neophodno i na sajtovima
kojima verujete da nema potencijalno opasnih Java skrip .

ScriptSafe mozete instalira u Vas Chrome / Chromium sa sledece adrese:
h ps://chrome.google.com/webstore/detail/scriptsafe/oiigbmnaadbk mpbfijlfla hbdbdgdf/details?hl=en

Evo i kratkog video tutorijala za ScriptSafe.
[youtube=h p://www.youtube.com/watch?v=ZCMpnWqdZw4]
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NoScript (2013-08-30 00:49) - darthewok

NoScript je dodatak za Firefox koji blokira izvrsavanje skrip na web stranama.
Moguce je ukljuci i iskljuci izvrsavanje pojedinih skrip za svaku stranu koju pose te.

Verovatno se pitate zasto blokira izvrsavanje skrip , kada ce to da onemoguci normalno funkcionisanje web strana
koje posecujete?

Iz bezbednosnih razloga je preporucljivo blokira izvrsavanje skrip . Pojedine Java skripte mogu da budu opasne.
Tako da je preporucljivo da dozvolite izvrsavanje skrip samo na sajtovima gde je to zaista neophodno i na sajtovima
kojima verujete da nema potencijalno opasnih Java skrip .

Zvanicna web prezentacija je na adresi:
h p://noscript.net/

NoScript mozete instalira iz Mozilinog repozitorijuma na adresi:
h ps://addons.mozilla.org/en-US/firefox/addon/noscript/

Evo i kratkog tutorijala za NoScript.
[youtube=h p://www.youtube.com/watch?v=vSlA _ieay-I]

3.9 September

Pronalazenje facebook naloga preko linka za fotografiju (2013-09-06 01:23) - w1ndu

Cesto se desi da vam neko da direktan link ka facebook fotografiji. Ovim metodom, u velikom broju slucajeva, mozete
naci nalog koji je povezan sa tom fotografijom.

Standardni link je u formatu koji se zavrsava sa tri broja u urlu, razdvojena underscoreom. Nesto pa:

[code]h ps://sphotos-x.ak. cdn.net/hphotos-ak-bla/123 _456 _789 _n.jpg[/code]

Odavde uzmete srednji broj i postavite ga u produzetak facebook.com, u nasem primeru:

[code]facebook.com/456[/code]

Konkretan primer, recimo da ste dobili sledecu fotografiju:

[code]h ps:// cdn-sphotos-h-a.akamaihd.net/hphotos-ak-ash3/6818 _678444215191 _1563081 _n.jpg[/code]

ako je otvorite sa:

h ps://facebook.com/678444215191
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.. videcete kako [1]Zucky sa drugarima pece jarca. :)

Primer dva - pretpostavimo da ste dobili ovu fotografiju:

[code]h ps:// cdn-sphotos-b-a.akamaihd.net/hphotos-ak-ash4/422446 _10100277884733561 _1983628241
_n.jpg[/code]

Otvorite je na is nacin sa:

h ps://facebook.com/10100277884733561

i videcete da je u pitanju Zuckijeva [2]Zverka. :)

Ogranicenja: Metod ne radi u koliko nemate pristup sadrzaju iz bilo kog razloga. Npr. ako je slika dostupna
samo prijateljima ili vas vlasnik naloga blokira. Takodje, ako je grupa setovana tako da sadrzaj bude dostupan samo
clanovima.

Napomena: Ovaj metod radi za korisnike, grupe i pageve. U koliko zelite da ga sprecite, promenite pristup
vasim fotografijama na Friends Only.

1. http://en.wikipedia.org/wiki/Mark_Zuckerberg
2. http://www.facebook.com/beast.the.dog

Mp4 Muxer (2013-09-06 02:34) - w1ndu

Koristan program za muxovanje u mp4 format. Zapravo predstavlja vizuelni shell za [1]mp4creator. Tamo gde
[2]prethodno opisani My Mp4Box napravi propust, velike su sanse da ce Mp4 Muxer bi uspesan.

Napomena: U koliko radite sa raw h264 video streamovima, obavezno podesite frame rate. Inace video nece bi
pravilno muxovan pa moze doci do lose sinhronizacije sa audio fajlom. Frame rate najcesce mozete proveri analizira-
juci izvorni fajl pomocu [3]KMP ili [4]VLC Playera.

Mp4 Muxer mozete skinu sa VideoHelp sajta [5]ovde.

1. http://mp4creator.sourceforge.net/
2. http://kompjuteri2011.wordpress.com/2013/07/13/izbacivanje-dodatnog-audio-streama-iz-mp4-fajla/
3. http://www.videohelp.com/tools?d=KMPlayer2931428.exe
4. http://www.videolan.org/vlc/index.html
5. http://www.videohelp.com/tools/MP4Muxer/old-versions
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Gimp tutorijal 62 - Path alat (2013-09-07 21:00) - darthewok

Po zelji jedne gledateljke prikazujem kako napravi siluetu uz pomoc Path alata.

[youtube=h p://www.youtube.com/watch?v=7-esHtnN5qQ]

Gimp tutorijal 63 - Logo Toolbox (2013-09-24 20:02) - darthewok

U ovoj epizodi predstavljam skriptu Logo Toolbox.

[youtube=h p://www.youtube.com/watch?v=6p6wta9NbSA]

Lovćenac LUG (2013-09-26 23:31) - darthewok

Dana 26.9.2013. je zvanično počeo sa radom sajt Grupe korisnika GNU/Linux opera vnih sistema u Lovćencu.

Cilj zajednice je da promoviše GNU/Linux i Slobodan so ver uopšte sa posebnim osvrtom na edukaciju građana kroz
predavanja, radionice, projekte...

Sajt se nalazi na adresi:
h p://lovcenaclug.blogspot.com/

[1]

1. http://lovcenaclug.blogspot.com/

282

http://lovcenaclug.blogspot.com/


Lovćenac LUG (2013-09-27 07:51:02)
Hvala. :)

darthewok (2013-09-27 11:35:52)
Nema na cemu. :)

Gimp tutorijal 64 - Manipulacije sa slikama (2013-09-30 01:22) - darthewok

U ovom prilicno dugackom tutorijalu prikazujem manipulaciju sa slikama uz pomoc gotovih grafickih resursa, pred-
stavljam program FaceGen i sajt DeviantArt - www.deviantart.com.

[youtube=h p://www.youtube.com/watch?v=bMVrrLSR5q8]

3.10 November

Firefox - Novi zum (2013-11-03 03:06) - w1ndu

Od verzije 22, Firefox nas je obradovao jos jednim genijalnim poboljsanjem. Nakon upgradea, mnogi korisnici su bili
iznenanedjeni slonovski velikim zumom na sajtovima. Evo o cemu se radi.

Opera vni sistemi omogucavaju podesavanje gus ne tacaka slike. U Winu ga mozete naci na:

dClick Desktop > Proper es (otvara Desktop Proper es) > Se ngs tab > Advanced > General tab > i u delu Diplay
videcete DPI Se ngs.

Uobicajeni scenario je da visoka rezolucija novijih monitora navede korisnike da podignu procenat na >100 % da bi
imali razumnu velicinu ikonica i generalno korisnickog interfejsa. Obicno se DPI setuje na 110 % (za 19’ monitor) do
125 % i preko.

Problem je nastao kad se neki genije u FF mu dose o da bi bilo lepo kada bi browser automatski citao sistemski
DPI. Drugim recima, razlog zasto su sajtovi besmisleno veliki je sto sada Firefox koris vas DPI da bi setovao svoj de-
fault zum. Ako ste ga setovali na 120 %, sajtovi ce u startu bi setovani na 120 %.

Obzirom da ovo nije ispravljeno i pored brojnih apela korisnika, evo brzog resenja:

- Ukucajte about:config (u address baru) > I’ll be careful, i promise > search: layout.css.devPixelsPerPx > 2x klik i
promenite u 1.0. Default vrednost -1.0 preuzima DPI iz sistema.

Losa strana ovog metoda je sto menja i velicinu korisnickog interfejsa. Brz nacin da ovo ispravite je pomocu [1]Theme
Font & Size Changer addona. Nakon instalacije: Tools > Theme Changer > i promenite Size u zeljeni.
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U koliko vas zanimaju ostala FF podesavanja, pogledajte [2]prethodni text.

1. https://addons.mozilla.org/en-US/firefox/addon/theme-font-size-changer/
2. http://kompjuteri2011.wordpress.com/2013/08/11/optimizacija-firefox-browsera/

Commodore (2013-11-11 16:24) - darthewok

Na adresi h p://www.zimmers.net/ mozete pronaci dosta zanimljivih stvari vezanih za Commodore kompjutere.
Pored informacija o Commodore kompjuterima, na sajtu mozete pronaci i emulatore za razlicite opera vne sisteme,
programe i igre za Commodore, audio fajlove sa muzikom iz popularnih igara sa Commodore 64 kao i razne usluzne
programe koji sluze za razne konverzije i slicno.

3.11 December

Vremenska prognoza (2013-12-05 00:01) - darthewok

[gigya
src=”h p://swf.yowindow.com/yowidget3.swf” width=”800” height=”500” allowfullscreen=”true” wmode=”opaque”
bgcolor =” #FFFFFF” flashvars=”loca on _id=gn:792680 &loca on _name=Belgrade &landscape=airport & me _for-
mat=24 &unit _system=custom &u _temperature=c &u _wind _speed=mps &u _pressure=mbar &u _distance=km &u
_rain _rate=mm &lang=sr &background= #FFFFFF &copyright _bar=false”]

[1]YoWindow.com

Forecast by [2]yr.no

1. http://WeatherScreenSaver.com/?client=widget&link=copyright
2. http://yr.no/

Micro64 i Hyper64 (2013-12-05 00:29) - darthewok

Micro64 je emulator kompjutera Commodore 64. Razvija se sa ciljem da bude najprecizniji emulator kompjutera
Commodore 64. Razvija se za Linux, Windows i Mac. Sa zvanicne web prezentacije, koja se nalazi na adresi:
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h p://www.micro64.de/ mozete preuze fajl micro64.zip. U fajlu koji ste preuzeli, nalaze se sve tri verzije emula-
tora, za Linux, Windows i Mac. Vi pokrenite verziju koja je namenjena Vasem opera vnom sistemu.

Tes rao sam Linux verziju emulatora i zadovoljan sam kako radi. Zanimljivo je sto mozete ukljuci emulaciju zvuka
flopi disk drajva. To nije nesto funkcionalno vazno, ali ce korisnicima koji su posedovali Commodore 64 sa flopi diskom
to probudi nostalgiju za davno proslim vremenima. :)

Tu i tamo se pojavljuje i po koji bag. Na primer, prime o sam da se s vremena na vreme, posle vise resetovanja i
ucitavanja raznih igara, emulator zamrzne, pa, onda morate da ”ubijete” proces i da ga ponovo pokrenete.

Hyper64 je eksperimentalni emulator kompjutera Commodore 64. Razvija se sa ciljem da bude najbrzi emulator
kompjutera Commodore 64. Za razliku od klasicnih emulatora, kao sto su Vice, Micro64 i ostali, Hyper64 ima dru-
gaciju koncepciju emulacije. Hyper64 u realnom vremenu disasemblira, analizira i ponovo asemblira programski kod
procesora 6510 i takav kod se izvrsava, kao 32 bitni x86 kod. Ovaj emulator nisam probao, ali ga Vi mozete preuze i
proba . Kao i Micro64, Hyper64 mozete preuze sa adrese: h p://www.micro64.de/

Oba emulatora, Micro64 i Hyper64 su besplatna.

Milovanović Siniša (2013-12-05 09:11:08)
Vredi proba

CMYK PSD i Gimp (2013-12-12 20:03) - darthewok

Ako prilikom pokusaja otvaranja PSD fajla u Gimpu dobijete poruku:
loading PSD file: Unsupported color mode: CMYK

To znaci da taj PSD fajl ima CMYK rezim boja, a ne RGB i Gimp ne moze da ga ucita zato sto ne podrzava uvoz PSD
fajlova koji imaju CMYK rezim boja. Da bi ste taj fajl ucitali u Gimp, morate ga prvo konvertova . To mozete uradi na
nekoliko nacina. Meni, najpogodniji nacin je da u programu Krita ucitam PSD fajl i da u Kri konvertujem CMYK rezim
u RGB rezim. I da za m sacuvam taj fajl u PSD formatu da bi se sacuvali lejeri.

Evo kako to konkretno uradi u Kri :

Otvori PSD fajl u programu Krita.
Za m kliknu na Image -> Convert Image Type...
U dijalogu koji se otvorio, treba postavi sledece parametre:
U padajucem meniju Model izabra : Red Green Blue
U padajucem meniju Profile izabra : sRGB
Ostale parametre nije neophodno menja , ali uvek mozete eksperimen sa i sa ostalim parametrima i
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vide koje opcije ce Vam da najbolje rezultate.
Za m sacuva PSD fajl.

Posto ste promenili rezim boja iz CMYK u RGB, takav fajl mozete ucita u Gimp.

Trebalo je da napravim i video tutorijal na ovu temu, ali, kao sto neki od Vas znaju, zbog porodicnih obaveza, ne-
mam vremena za video tutorijale. Ako uspem da ugrabim malo vremena, bice i video tutorijal.

Gopher (2013-12-17 02:39) - darthewok

Gopher (Gofer) protokol je TCP/IP protokol napravljen za pretragu, pregled i preuzimanje dokumenata sa interneta.
Gopher protokol je preteca World Wide Web-a (www).

Gopher protokol je razvijen na Minesota univerzitetu, pocetkom devetdese h godina dvadesetog veka.

World Wide Web je skoro potpuno po snuo Gopher. Gopher protokol je i dalje ziv i koriste ga entuzijas . Takodje,
postoje pokusaji da se upotreba Gophera ozivi na modernim pla ormama i mobilnim uredjajima.

Gopher serverima mozete pristupi na nekoliko nacina:
- Uz pomoc Gopher klijenata. Ako koris te Ubuntu, mozete instalira Gopher klijent koji radi iz terminala. Da bi ste u
Ubuntu instalirali Gopher klijent, kucajte u terminalu:
sudo apt-get install gopher

Da bi ste ga pokrenuli, u terminalu kucajte: gopher
Ako ukucate samo gopher, klijent ce automatski pristupi Gopher serveru na adresi gopherproject.org
Ako kucate gopher neka _adresa, gopher klijent ce pristupi Gopher serveru na toj adresi.

- Gopheru mozete pristupi i uz pomoc dodataka za web pregledace. Na primer OverbiteFF je dodatak za Firefox i
Sea Monkey, koji omogucava pomenu m web pregledacima da pristupe gopher serveru.
Overbite mozete pronaci na adresi:
h ps://addons.mozilla.org/en-US/firefox/addon/overbiteff/

- Gopheru se takodje moze pristupi preko proxy-a, namenjenih pristupu Gopher serverima. Ti proxy serveri kon-
vertuju Gopher menije u HTML, koji je citljiv na web pregledacima.
h p://gopher.floodgap.com/gopher/
h p://gopherproxy.meulie.net/

Postoji nekoliko Gopher pretrazivaca, koji indeksiraju Gopher strane. Najpozna ji je Veronica 2.
Nalazi se na adresi:
[1]gopher://gopher.floodgap.com/1/v2

Evo i nekoliko linkova Gopher servera za laksi ulazak u svet Gophera.
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[2]gopher://gopher.floodgap.com/ odnosno [3]gopher://gopherproject.org/
[4]gopher://gopher.meulie.net/
[5]gopher://gopher.quux.org/

Ako koris te gopher klijent u Linuxu ili nekom drugom opera vnom sistemu, kucajte adrese bez gopher://
gopher:// sluzi web pregledacima (firefox i Sea Monkey), da ”znaju” da pristupaju gopher serveru (potreban je Over-
biterFF dodatak za Firefox).
Takodje, mnogi serveri podrzavaju konverziju Gopher u HTML, pa je moguce pristupi Gopher serverima i bez do-
dataka iz bilo kog web pregledaca.
Na primer, u adresnu liniju je dovoljno da ukucate adresu gopher.quux.org. Ali, kao sto sam napisao, ne podrzavaju
svi serveri konverziju, pa se moze desi da nekim serverima ne mozete pristupi na taj nacin.

1. gopher://gopher.floodgap.com/1/v2
2. gopher://gopher.floodgap.com/
3. gopher://gopherproject.org/
4. gopher://gopher.meulie.net/
5. gopher://gopher.quux.org/

Skype na web portovima (2013-12-18 16:15) - w1ndu

U koliko se bavite web dizajnom i programiranjem, verovatno ste prime li da u nekim situacijama lokalni server jed-
nostavno odbija da se pokrene. Cest razlog za ovo je upravo Skajp, koji zauzima portove 80 i 443 za alterna vno
povezivanje kada je p2p blokiran. Dodatni problem u ovoj situaciji je pracenje, jer se greska po default ne belezi u
apache error logu, ni u Win event vieweru.

Na srecu, sneaky Skajp je lako konfigurisa da ne radi ovo. Iz glavnog menija: Tools > Op ons > Advanced > Con-
nec on > i dechekirajte: Use ports 80 and 443 as alterna ves.. Restartujte Skype i vise vam web portovi nece bi
nepotrebno otvoreni.

SRECNA NOVA GODINA!!! (2013-12-31 07:14) - darthewok

Svim pose ocima bloga Kompjuteri ekipa bloga zeli srecnu novu godinu!
h p://www.flickr.com/photos/l-i-n-u-x/11662009794/
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Malcinovic Seval (2013-12-31 20:48:36)
Hvala i Vama srećna Nova 2014.godina
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4. 2014

4.1 January

2013 in review (2014-01-02 10:01) - darthewok

The WordPress.com stats helper monkeys prepared a 2013 annual report for this blog.
[1]

Here’s an excerpt:

The concert hall at the Sydney Opera House holds 2,700 people. This blog was viewed about 23,000 mes
in 2013. If it were a concert at Sydney Opera House, it would take about 9 sold-out performances for that
many people to see it.

[2]Click here to see the complete report.

1. http://kompjuteri2011.wordpress.com/2013/annual-report/
2. http://kompjuteri2011.wordpress.com/2013/annual-report/

Python - uvod u seriju tekstova sa primerima. (2014-01-03 03:25) - darthewok

Windu je vec napisao dobar uvod za Python, mozete ga procita ovde: h ps://kompjuteri2011.wordpress.com/201-
3/07/28/osnove-pitona/
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Ja cu zapoce seriju tekstova sa primerima u Pythonu.
Odmah da napomenem, da nisam neki ekspert za Python, jos uvek ga ucim, kad imam vremena i volje. :)
Tako da ce primeri bi namenjeni totalnim pocetnicima.

Python programe, odnosno skripte, kako to neki nazivaju, mozete pisa u bilo kom tekst editoru.
Ako koris te Windows, mozete koris Notepad, koji se dobija uz Windows, Notepad++ ili neki drugi slican editor.
Ako koris te Linux, onda mozete koris Gedit, Nano, Vim, Leaf pad ili sta god Vam vec odgovara.
Takodje, mozete koris i neke IDE alate, kao na primer Boa Constructor.

Posto koris m Linux (Ubuntu 12.04 LTS), tekstovi ce bi pisani iz perspek ve Linux korisnika. Ali i korisnici ostalih
opera vnih sistema mogu da citaju tekstove, jer je sam kod skoro is za sve opera vne sisteme, barem za primere
koje cu ja koris . Razlike u kodu su minimalne i odnose se na neke sistemske naredbe i mozda na neke naredbe
vezane za grafiku i graficki korisnicki interfejs (GUI).

Za razliku od Windowsa, u Linuxu se mora dodeli dozvola da se Python fajl izvrsava.
To se radi u terminalu komandom:
chmod +x ime _fajla.py
ili klikom desnog tastera na misu na ikonu tog fajla, za m na Proper es, pa na Permissions i tu s klira opciju Allow
execu ng file as program. Pretpostavljam da sve ovo vec znate, ali za svaki slucaj sam napomenuo. :)

Ne znam za ostale opera vne sisteme, ali u Linuxu mogu da koegzis raju obe verzije, odnosno grane Pythona i 2.x i
3.x.
Tako da je korisno u prvom redu programa, odnosno skripte stavi komentar:
#! /usr/bin/python
ako je program za Python 2.x
ili
#! /usr/bin/python3
za Python 3.x, da bi se skripta pokrenula u odgovarajucoj verziji interaptera.

Jos jedna stvar vezana za koegzis ranje obe verzije Pythona je da, kada pokrecete Python interpreter u takozvanom
interak vnom rezimu, iz terminala, Python 2.x pokrecete komandom python, a Python 3 pokrecete komandom
python3.

Eto, toliko za ovaj uvodni tekst. U narednim tekstovima ce bi konkretnih primera programa za Python.

Python туторијали (2014-01-13 20:04:41)
[…] Python – Увод у серију текстова са примерима […]

Python prvi cas (2014-01-03 22:37) - darthewok

U ovom tekstu cu da obradim print, interak vni rezim interpretera i komentare.
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Primer 1:

Pokrenite tekst editor i upisite programski kod koji se nalazi izmedju linija, sacuvajte fajl pod nekim imenom,
na primer neka se zove: primer1.py

[code]
#! /usr/bin/python3

print (”Zdravo, ja sam Python!”)
[/code]

U prvom redu je komentar:
#! /usr/bin/python3
To znaci da je skripta namenjena Pythonu 3.

U sledecem redu se nalazi:
print (”Zdravo, ja sam Python!”)
Print sluzi da se prikaze neki sadrzaj na ekranu, u ovom primeru: Zdravo, ja sam Python!
Iza print ide otvorena zagrada (, a na kraju ide zatvorena zagrada ).
Izmedju zagrada se nalazi sadrzaj koji treba da se prikaze na ekranu.
Ako su u pitanju karakteri koji se tre raju kao string, a ne kao brojevi, onda se postavljaju navodnici i karakteri idu
izmedju navodnika kao u prvom primeru.
Samo da pojasnim da ne bude zabune, string karakteri mogu bi i brojevi, a ne samo slova i znakovi interpunkcije, ali
se brojevi tre raju kao string, odnosno tekst.

Ovo je samo za Linux korisnike:
Pokrenite terminal, udjite u folder gde ste sacuvali fajl i ukucajte:
chmod +x primer1.py
da bi ste dodelili dozvolu za izvrsavanje fajla.
Za m pokrenite fajl tako sto ukucate: ./primer1.py

U Windowsu ne morate da dodeljujete dozvolu za izvrsenje fajla. Pokrenite komandni prompt, udjite u folder
gde ste sacuvali fajl i kucajte: primer1.py

Ako ste sve dobro uradili, na ekranu bi trebalo da pise:
Zdravo, ja sam Python!

Primer 2:

U ovom primeru cu Vam objasni rad u takozvanom interak vnom rezimu interpretera.
Pokrenite program Idle (graficka verzija za Windows i Linux) ili iz terminala kucajte python3 da bi ste radili u terminalu
(Linux).

Za m kucajte:
print (”Zdravo, ja sam Python!”)
pri snite enter.

Ako ste sve obro uradili, trebalo bi da se pojavi tekst:
Zdravo, ja sam Python!
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Eto, to je interak vni rezim. Kucate liniju po liniju i odmah dobijate rezultat. Naravno, mozete to malo i zakomplikova
varijablama i matema ckim operacijama, ali za pocetak, ovo je sasvim dovoljno. Tu mozete eksperimetnisa sa
komandama i funkcijama. I odmah vide rezultat i proveri da li Vam je dobra sintaksa, odnosno da nemate gresaka.
:)

Primer 3:

U ovom primeru cu pisa o komentarima.

[code]
#! /usr/bin/python3

# Ovo je primer komentara u jednoj liniji.
# Naravno, mozete postavi jos jedan komentar u drugoj liniji.
# I u tecoj itd...

print (”Zdravo, ja sam Python!”)
[/code]

Kao sto vidite u ovom primeru, iza # se postavljaju komentari. Ti komentari se ignorisu prilikom izvrsavanja
programa. Tako da mozete pisa sta god pozelite. Korisno je pisa komentare vezane za sam kod, na primer da
napisete cemu sluzi sledeca komanda ili sledeci blok komandi, odnosno funkcija.

Primer 4:

Takodje, mozete pisa i takozvane blok komentare, odnosno komentare u vise redova. Blok komentari se
nalaze izmedju tri znaka navodnika ”””, kao u primeru:

[code]
#! /usr/bin/python3

”””
Ovo je primer
komentara u vise redova,
odnosno blok komentara.
”””

print (”Zdravo, ja sam Python!”)
[/code]

Primer 5:

Jos jedna izuzetno korisna primena komentara je da, ako niste sigurni da li zelite da zadrzite ili da izbacite
neku programsku liniju, mozete postavi znak # ispred te linije i na taj nacin onemoguci izvrsenje te linije. Jer ce
se tada ta programska linija tre ra kao komentar i nece bi izvrsena. To je mnogo korisnije, nego da je potpuno
izbrisete, jer se kasnije mozda mozete predomisli i da je vra te. Takodje je to korisno i kada probate vise varijan
programskih linija, koje rade slicnu stvar i na taj nacin lako iskljuci ili ukljuci izvrsenje te programske linije.
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Evo i primera:

[code]
#! /usr/bin/python3

#print (”Zdravo, ja sam Python!”)
#print (”Cao, ja sam Python!”)
print (”Ja sam Python!”)
[/code]
—————————

Python туторијали (2014-01-13 20:53:53)
[…] Python први час […]

Python drugi cas (2014-01-04 22:22) - darthewok

U ovom tekstu cu da obradim escape karakter \n.

Primer 1:

\n je takozvani escape karakter, koji u sus ni predstavlja prelazak u novi red. U ovom primeru sam upisao dva puta \n
da bih prvo ubacio dva prazna reda, a za m se ispise tekst.

[code]
#! /usr/bin/python3

print (”\n\nZdravo ja sam Python!”)
[/code]

Primer 2:

\n mozete ubaciva gde god zelite u stringu i koliko god puta hocete.

[code]
#! /usr/bin/python3

print (”Z\nd\nr\na\nve͡xtbackslashno\n \nj\na\n \ns\na\nm\n \nP\ny\nt\nhckslashno\nn\n!”)
[/code]
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Python туторијали (2014-01-14 22:32:22)
[…] Python други час […]

Python treci cas (2014-01-05 11:27) - darthewok

U ovom tekstu cu malo detaljnije da obradim print u nekoliko primera.

Primer 1:

Print u vise redova, odnosno u bloku.

[code]
#! /usr/bin/python3

print (
”””
Ovo je primer
kada se print koris
za prikaz vise redova,
odnosno prikaz u bloku.
”””
)
[/code]

Primer 2:

Primer sa apostrofima umesto navodnika:

[code]
#! /usr/bin/python3

print (’Primer sa apostrofima umesto navodnika.’)
[/code]

Primer 3:

Ako zelite da ubacite navodnike u tekst to mozete uradi ovako:

[code]
#! /usr/bin/python3

print (’Ako zelite da ubacite ”navodnike u tekst” to mozete uradi ovako.’)
[/code]
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Primer 4:

Kada su izmedju navodnika i brojevi se tre raju kao string, odnosno tekst:

[code]
#! /usr/bin/python3

print (”Kada su izmedju navodnika i brojevi se tre raju kao string, odnosno tekst... 1,2,3,4...”)
[/code]

Primer 5:

U dosadasnjim primerima sam print koris o samo za prikaz string podataka. U ovom primeru cu prikaza
kako se print koris sa brojevima:

[code]
#! /usr/bin/python3

print (25)
[/code]

Kao sto vidite, za prikaz brojeva ne koris te navodnike i apostrofe.

Primer 6:

U ovom primeru cu Vam pokaza kako da saberete dva broja:

[code]
#! /usr/bin/python3

print (2+2)
[/code]

Vrlo prosto 2+2=4 :)

Slicno je za ostale osnovne matema cke operacije.
[code]
+ sabiranje
- oduzimanje
mnozenje
/ delenje
[/code]

Za sada toliko o matema ci, detaljnije cu se pozabavi matema kom u narednim tekstovima. :)
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Python туторијали (2014-01-16 14:14:53)
[…] Python трећи час […]

Python cetvr cas (2014-01-14 20:07) - darthewok

U ovom tekstu cu pisa o varijablama, odnosno, u prevodu promenljivim.
Naravno i ovaj tekst ce bi propracen jednostavnim primerima namenjenim pocetnicima.

Sta su varijable (promenljive) i cemu sluze?

Varijable cuvaju odredjenu informaciju u memoriji kompjutera.
To znaci, da kada se definise neka varijabla, tada se rezervise odredjena kolicina memorijskog prostora u memoriji
kompjutera.

Svaka varijabla ima svoje ime, koje moze bi duzine jednog ili vise karaktera. Samo da napomenem, da za
imena varijabli ne koris te reci koje su rezervisane za Python komande i funkcije i da ne stavljate prazna mesta u
nazive varijabli.
Varijable mogu bi brojevi, decimalni brojevi ili karakteri.

U Pythonu, za razliku od nekih drugih programskih jezika, varijable ne moraju bi eksplicitno definisane. To se
radi automatski, kada se definise varijabla.

Definisanje varijable se radi uz pomoc znaka jednakos =
Sa leve strane znaka jednakos se nalazi ime varijable, a sa desne strane znaka jednakos se nalazi vrednost koja se
smesta u varijablu.

Primer 1:

Definisanje i prikaz varijabli.

[code]
#! /usr/bin/python3

# definisanje varijabli

# definisanje brojeva
a = 1337
broj = 33

# definisanje decimalnog broja
z55 = 1337.985

# definisanje stringa
ime = ”Pera”

# prikaz sadrzaja varijabli uz pomoc print

296



print (a)
print (broj)
print (z55)
print (ime)
[/code]

Primer 2:

Sa varijablama mozete radi razne stvari, u ovom primeru sabiram vrednost dve varijable.

[code]
#! /usr/bin/python3

a = 55
b = 33

print (a+b)
[/code]

Primer 3:

Takodje, mozete spoji i dva stringa, kao u ovom primeru.

[code]
#! /usr/bin/python3

rec1 = ”Ja sam ”
rec2 = ”Python!”

print (rec1+rec2)
[/code]

Python туторијали (2014-01-16 18:14:14)
[…] Python четврти час […]

Python: Funkcije kao varijable (2014-01-15 02:49) - w1ndu

Vezano za casove 3 & 4 mali dodatak. U Pythonu se funkcije tre raju kao varijable. Za razliku od ostalih programskih
jezika, one nisu rezervisane. U koliko dodelite vrednost komandi na ovaj nacin ona ce izgubi funkcionalnost. Da bi

297



ste je vra li mozete ili da resetujete Python, ili da je ucitate iz buil ns liba.

Radi ilustracije probajte sledece u IDLE:
[code]
»> print(10)
10
»> print = 10
»> print
10
»> print(print)
TypeError: int object is not callable
»> print(10)
TypeError: int object is not callable
»> import buil ns
»> print = buil ns.print
»> print(10)
10
[/code]

Da bi smo bili sigurni, prijavili smo ovo cudno ponasanje kao bug u trackeru i dobili sledeci odgovor:

h p://bugs.python.org/issue20263

U pitanju je osobenost Pythona, a ne bug. Takodje, korisno je zna kako obnovi funkcionalnost u koliko se nad-
jete u takvoj situaciji.

Python туторијали (2014-01-16 20:44:17)
[…] Python: Функције као варијабле […]

Python pe cas (2014-01-15 12:47) - darthewok

Uz pomoc funkcije input mozete ubaci neke podatke i koris ih u Vasim programima.

Primer 1:

[code]
#! /usr/bin/python3

aa = input (”Upisi neki tekst i pri sni enter... ”)
print (”Upisao si:”, aa)
[/code]
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Python туторијали (2014-01-20 12:41:52)
[…] Python пети час […]

Verzije Pythona (2014-01-15 13:36) - w1ndu

O ovoj temi smo vec pisali u vise navrata. Obzirom da je i dalje aktuelna, posve cemo joj poseban text.

Najpre razlike izmedju v2 i v3 su minorne. Medju m ipak su dovoljne da code iz jedne verzije nece kao takav
radi u drugoj. Ovde cemo naves kljucne razlike:

1) Print je od komande postala funkcija.

Na ovo je bilo najvise prituzbi. U pitanju je s l zapravo. Komanda je vise u basic / pascal s lu, dok funkcija
podseca na c++/java itd. U praksi medju m to jednostavno znaci da cete umesto print x pisa print(x) pa: print 10
-> print(10) ili print ’blah’ -> print(’blah’) i slicno.

Da bi ste imali novu funkcionalnost komande print u v2, mozete koris future modul. Jednostavno dodajte
na pocetku:

[code]from future import print func on[/code]

2) Deljenje je postalo intui vnije.

U v2 u koliko ste integer delili sa drugim integerom, rezulat je takodje bio int tako sto je broj bio zaokruzen. U
v3 dobijate precizan rezultat. Npr. v2: 3/4 daje 0 dok v3: 3/4 daje 0.75. U koliko u Pythonu v3 zelite da sacuvate p
inputa, tj da vam ostane integer (kao u v2), koris te //. U prethodnom primeru v3: 3//4 daje 0.

Kao i u slucaju printa, ovu funkcionalnost je u v2 moguce uves iz buducnost:

[code]from future import division[/code]

Ovo su dve najbitnije razlike izmedju dve verzije. Ima jos nekoliko sa kojima se mozete sres ..

3) Ostale razlike:

a) Funkcija raw _input je postala deo input().
b) Ukinuta je komanda file u koris funkcije open().
c) Funkcija xrange() je postala range().
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I to bi bilo to. Najbitnije su prve dve promene dok su pod tri detalji. Preciznije objasnjenje sa primerima
mozete skinu sa sajta Carleton Koledza, katedra za Kompjuterske Nauke [1]ovde.

E sad, zasto ljudi ostaju pri v2. Postoji vise razloga, od kojih su sledeci najcesci:

a) Podrska - validan razlog. Kao stariji v2 ima siru podrsku u smislu libova i pomocnih projekata. Medju m ve-
lika vecina je vec upgradovana na v3, a oni koji nisu to planiraju da urade u najkracem roku.

b) Navika - jos jedan validan razlog. U koliko vam sve radi stabilno i zadovoljava u potpunos vase potrebe, za-
sto bi prelazili na novu verziju. Pa stvar je cene i profita. Ulozeni napor je rela vno mali, dok ce vam code bi podrzan
u jako dugom periodu.

c) U caj - Pojedine velike kompanije koriste v2. Dobar primer za ovo je Google, koji koris v2 za svoje potrebe.
Medju m treba ima u vidu da oni imaju svoje interne razloge za ovo, te da nikad nisu pokusali da u cu na odluke
drugih u ovom smislu. Uz veliko postovanje za doprinos Googla IT svetu, razvoj programskih jezika ne bi trebalo da
zavisi od prakse jedne kompanije.

d) Prethodni rad - Veliki broj postojecih kurseva i knjiga koris v2. Vecina ipak planira prelazak u najkracem
roku, a svi novi ionako koriste v3. Ovo je obiman posao, te je kasnjenje razumljivo.

Takodje bih se osvrnuo na nesto sto je vec pomenuto. U Winu je kao i u Nixima moguce koris vise verzija
uporedo. Ovo je uobicajena praksa za programere kojima je potreban paralelni rad. Nakon instalacije u Start meniju
ce bi kreirani odvojeni shortcu a u sistemskom folderu odgovarajuci dll fajlovi. Kada zelite da radite, jednostavno
iz Start menija pokrenite odgovarajucu verziju.

Na kraju, preporuka. U koliko sada pocinjete sa Pythonom, najbolje da koris te v3. Ovim cete steci navike
koje ce omoguci da vas code bude podrzan dugi niz godina. U koliko vec programirate u v2, pogledajte odnos cene
i koris . Za rela vno mali korak mozete ima solidan benefit. Ne samo u dugoj podrsci za vase programe vec i u
buducim dodacima, jer su novi prirodno orijen sani ka v3.

Kao i uvek, izbor je na vama.

1. http://www.cs.carleton.edu/faculty/jgoldfea/cs201/spring11/Python2vs3.pdf

Python ses cas (2014-01-17 11:22) - darthewok

Na ovom casu ce bi reci o int i float funkcijama.

Uz pomoc int i float, mozete konvertova broj, napisan u string formi u ”pravi” broj ili konvertova jedan p
brojeva u drugi.
Int pretvara string ili broj sa decimalom u broj bez decimale.
Float pretvara string ili broj bez decimale u broj sa decimalom.
Ovo sada malo deluje konfuzno, ali cu ubrzo pojasni u konkretnim primerima.
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Primer 1:

U ovom primeru se sabiraju dva broja koja korisnik treba da ukuca.
Uz pomoc funkcije input, korisnik ukucava prvi broj, a za m i drugi broj koji se kasnije sabiraju.
Posto funkcija input prima string kao ulaz, tako ce p varijable bi string u datoj varijabi.
Za sabiranje dva broja, nama je potreban nacin da se taj string podatak konvertuje u neki brojcani p podatka.
To se radi uz pomoc funkcija int ili float.

U ovom primeru koris m int za konverziju. Da ponovim, int koris te za brojeve bez decimala. Ako kojim sluca-
jem ukucate decimalni broj, ili neki slovni karakter, bice prijavljena greska.

[code]
#! /usr/bin/python3

a = input (”Upisi prvi broj i pri sni enter... ”)
b = input (”Upisi drugi broj i pri sni enter... ”)

a = int(a)
b = int(b)

print (”Zbir dva broja je:”, a+b)
[/code]

Primer 2:

U ovom primeru koris m float za konverziju. Da ponovim, float koris te za decimalne brojeve. Ako ukucate
broj bez decimale, broj automatski dobija decimalu, na primer ako ukucate 33, broj ce bi u obliku 33.0. Ako ukucate
neki slovni karakter, bice prijavljena greska.

[code]
#! /usr/bin/python3

a = input (”Upisi prvi broj i pri sni enter... ”)
b = input (”Upisi drugi broj i pri sni enter... ”)

a = float(a)
b = float(b)

print (”Zbir dva broja je:”, a+b)
[/code]

Primer 3:

Konverzija int u float. Prilikom konverzije int u float, broj bez decimale, automatski dobija decimalu u ovom
primeru 1337 ce bi 1337.0.

[code]
#! /usr/bin/python3
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a = 1337
b = float(a)

print (”Int =”, a)
print (”Float =”, b)
[/code]

Primer 4:

Konverzija float u int. Prilikom konverzije float u int, decimala se izbacuje i broj ce bi prikazan bez decimale.
U ovom primeru broj 1337.33 ce bi 1337.

[code]
#! /usr/bin/python3

a = 1337.33
b = int(a)

print (”Float =”, a)
print (”Int =”, b)
[/code]

Python sedmi cas (2014-01-17 16:37) - darthewok

Cesto cete bi u situaciji da kontrolisete tok programa u zavisnos od nekih uslova. Jedan od nacina da to uradite je
uz pomoc komande if. Uz if mogu da se koriste elif i else, ali nisu obavezni.

Primer 1:

Program trazi da unesete odgovor. Ako je odgovor da, onda se program prekida. Ako nije da, onda se pro-
gram nastavlja.

[code]
#! /usr/bin/python3

zzz = input (”Da li zelis da prekines izvodjenje programa? ”)

if zzz == ”da”:
exit()
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print(’\nOvo je bio primer kako se koris ”if”’)
[/code]

Primer 2:

Program trazi da se ukuca rezultat zbira 2+2. Ako je odgovor tacan, onda se izvrsava blok komandi ispod if zzz
== 4 i za m program nastavlja dalje izvrsavanje ignorisuci blok komandi ispod elif zzz != 4.
Obra te paznju na uvucene linije. To je u Pythonu jako vazna stvar.
Neke komande, u ovom primeru if i elif imaju blok komandi koje slede ispod i taj blok komandi mora da bude uvucen.
U sus ni, pros m jezikom receno, if i elif proveravaju da li je uslov ispunjen.
Ako je uslov iza if, odnosno elif ispunjen onda se izvrsava taj blok komandi.
Za m program nastavlja izvodjenje programskih linija koje nisu uvucene.

[code]
#! /usr/bin/python3

zzz = input (”Koliko je 2+2? ”)
zzz = int(zzz)

if zzz == 4:
print(”Tvoj odgovor je tacan!”)
elif zzz != 4:
print(”Tvoj odgovor nije tacan!”)
print(”Tacan odgovor je 4.”)

print(’\nOvo je bio primer kako se koris ”if”’)
[/code]

Primer 3:

Ako nijedan od uslova nije ispunjen, onda se izvrsava blok komandi ispod else.

[code]
#! /usr/bin/python3

zzz = input (”Koliko imas godina? ”)
zzz = int(zzz)

if zzz <= 20:
print(”Ti si bas mlad.”)
elif zzz <= 50:
print(”Ti si u najboljim godinama.”)
else:
print(”Bas si mator.”)

print(’\nOvo je bio primer kako se koris ”if”’)
[/code]
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U ovim primerima ste mogli da zapazite i neke simbole koji se koriste za if, elif i else.
U Pythonu postoji 6 simbola za razlicite uslove.

[code]
Manje od ............ <
Vise od ............. >
Manje ili jednako ... <=
Vece ili jednako .... >=
Jednako ............. ==
Razlicito ........... !=
[/code]

Python: Funkcije, uvod (2014-01-18 05:05) - w1ndu

Kao i vecina programskih jezika, Python nam omogucava da pisemo vlas te funkcije. To su zapravo odvojeni delovi
programa, napisani sa ciljem da izvrsavaju neki zadatak. Kada ih jednom definisemo, mozemo ih poziva koliko puta
zelimo. U tom smislu podsecaju na subru ne iz basica.

Drugi razlog koriscenja funkcija je bolja organizacija. Ovaj tzv. modularni pristup programiranju nam omogu-
cava da komplexne zadatke razbijemo na vise delova. Ovi delovi / moduli kasnije mogu da se menjaju i unapredjuju,
pozivaju jedan iz drugog itd. U zavisnos od s la, postoje programeri koji koriste funkcije u >90 % svog koda, upravo
iz ovog drugog razloga.

Struktura funkcije je vrlo jednostavna. Ona ima: ime, argumente, neku akciju i rezultat. Ime sluzi da je po-
zovemo. Argumen su neki podaci koje joj dajemo. Akcija je ono sto uradi. I rezultat su povratni podaci koje nam
funkcija vraca.

U Pythonu ova struktura izgleda ovako:

[code]
def ime(a,b,c..):
neka akcija
sa a,b, i c
return x
[/code]

U ovom primeru ime je ime funkcije; a, b i c su argumen ; u sredini je neka radnja i x je rezultat koji nam
funkcija vraca. No da se manemo teorije, jer se programiranje najbolje uci kroz primere i praksu.

Napisimo jednu jednostavnu funkciju:

1. Otvorite IDLE. Idite na File > New Window (ili Ctrl+N). Otvorice vam se novi editor.
2. U njemu ukucajte sledeci code:
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[code]
def sab(a,b):
x = a+b
return x
[/code]

3. U editoru gde ste napisali code funkcije idite na File > Save as i snimite ga recimo na Desktop pod nazivom
sab.py. U koliko probate da pokrenete fajl pre nego ga snimite dobicete upozorenje da ovo nije moguce. Isto vazi i
ako kasnije modifikujete fajl.

4. U editoru gde ste napisali code funkcije i snimili ga, idite na Run > Run Module (ili F5). Ovim cete izvrsi
funkciju i bicete automatski vraceni u osnovni IDLE shell.

5. U IDLE Shellu kucajte recimo:

[code]
»> sab(10,20)
30
[/code]

Ces tam, upravo ste napisali svoju prvu funkciju u Pythonu. Ova procedura pisanja funkcija u novom prozoru,
za m snimanje i izvrsavanje je inace uobicajena kod pisanja Python programa. U koliko se ranije niste sretali sa ovim,
ponovite proceduru nekoliko puta da bi vam postala bliska.

U koliko kasnije budete zeleli da menjate sab.py, desni klik na njega ce vam da opciju Edit with IDLE. Ako
napravite izmene, moracete najpre da snimite ovakav fajl da bi ste mogli da ga izvrsite. Slobodno experimen site u
Pythonu, to je najbolji nacin da naucite ovaj programski jezik.

Dodacemo jos da su varijable unutar funkcije lokalne za tu funkciju. Drugim recima, u svom glavnom programu
mozete koris ista slova koja ste koris li unutar neke funkcije. Takodje, i u drugim funkcijama mozete radi isto.

Primera radi otvorite sab.py (desni klik > Edit with IDLE) i izvrsite ga (Run > Run Module). Za m u IDLE Shellu
kucajte nesto pa:

[code]
»> a = 10
»> x = 15
»> b = sab(10,x)+a
»> print(b)
35
[/code]

Iz ovoga se vidi da se varijable a,b i x u glavnom programu nezavisno koriste od varijabli unutar funkcije sab.

Toliko za uvod. U [1]narednom textu cemo kroz primere obradi neke osobenos funkcija.

1. http://kompjuteri2011.wordpress.com/2014/01/19/python-funkcije-primeri/
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Python: Funkcije, primeri | Kompjuteri (2014-01-19 02:46:39)
[…] uvodnom textu smo ukratko objasnili sta su funkcije, kako se pisu i koriste. Sada cemo objasni neke osobenos […]

Python: Funkcije, praksa | Kompjuteri (2014-01-20 02:34:02)
[…] da se podse mo sta smo do sada naucili. U prvom textu obradili smo osnovne elemente Python funkcije. U drugom smo
radili na osobinama funkcija kroz […]

Python osmi cas (2014-01-19 00:32) - darthewok

For petlja sluzi da se neka komanda ili funkcija, odnosno blok komandi ili funkcija izvrsi odredjeni broj puta.

Primer 1:

U ovom primeru se koris range, koji ima format range(start,kraj,korak). Korak se ne mora uvek koris . Ako
se izostavi, podrazumevana vrednost je 1, ako se stavi neki broj, na primer 2, bio bi na primer ispisan svaki drugi broj.
O tome kasnije.
Obra te paznju da blok komandi i funkcija koje su obuhvacene for petljom mora bi uvucen. Kada se petlja zavrsi
posle odredjenog broja puta, nastavlja se izvrsavanje programa.

[code]
#! /usr/bin/python3

for n in range(1,11):
print (n)

print (\nOvo je bio primer for petlje.”)
[/code]

Primer 2:

Ovaj primer je slican prethodnom, razlika je, sto je funkciji print dodat end=” ”, na taj nacin, umesto liste bro-
jeva koji su jedni ispod drugog, brojevi ce bi ispisani jedan pored drugog. Ovo je mozda trebalo da pomenem kada
sam pisao o funkciji print, ali dobro, moze i ovde, ovo je dobar primer kada se koris end=” ”.

[code]
#! /usr/bin/python3

for n in range(1,11):
print (n, end=” ”)

print (\nOvo je bio primer for petlje.”)
[/code]

Primer 3:
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For se ne mora koris samo sa brojevima, vec se moze koris i sa karakterima u stringu. U ovom konkret-
nom primeru, mora se na pocetku definisa varijabla a = 0 i za m, varijabla a, sluzi kao brojac karaktera jer se za svaki
karakter u stringu uvecava za 1 u liniji a = a + 1.

[code]
#! /usr/bin/python3

s = ”Python”
a = 0

for n in s:
a = a + 1
print (a,”slovo u stringu je”,n)

print (\nOvo je bio primer for petlje.”)
[/code]

Primer 4:

Slicno kao i prethodnim primerima, samo ovde mnozim svaki broj u opsegu sa 2.

[code]
#! /usr/bin/python3

for n in range(1,5):
print (n*2)

print (\nOvo je bio primer for petlje.”)
[/code]

primer 5:

U ovom primeru koris m i treci argument u funkciji range. Posto je treci argument, odnosno korak 2, to znaci
da ce bi preskocen svaki drugi broj u opsegu.

[code]
#! /usr/bin/python3

for n in range(1,11,2):
print (n)

print (\nOvo je bio primer for petlje.”)
[/code]

Primer 6:

U ovom primeru brojanje ide u nazad.

[code]
#! /usr/bin/python3
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for n in range(10,0,-1):
print(n)
[/code]

Python: Funkcije, primeri (2014-01-19 02:45) - w1ndu

U [1]uvodnom textu smo ukratko objasnili sta su funkcije, kako se pisu i koriste. Sada cemo objasni neke osobenos
funkcija kroz primere. Podse te se kako se tehnicki radi sa .py fajlovima, jer ce vam bi od koris i ovde.

Kao sto smo rekli, funkcije se sastoje od: imena, argumenata, neke akcije i rezultata. Medju m, u praksi cete
se sreta sa programima koji nemaju sve elemente standardne strukture. Evo i nekoliko primera.

1) Funkcije ne moraju da imaju akciju (radni deo). Akcije moze bi upisana u rezultat direktno.

Za ovaj primer iskoris cemo funkciju sab koju smo vec napisali. Ako ste je sacuvali, desni klik na sab.py i iz-
aberite Edit with IDLE. Ako ne, otvorite IDLE i File > New Window za editor, pa upisite ili iskopirajte code.

Da se podse mo sab.py izgleda ovako:

[code]
def sab(a,b):
x = a+b
return x
[/code]

U ovom jednostavnom primeru radni deo je nepotreban. Nije potrebno napravi dodatnu varijablu x za sabi-
ranje, pa onda vraca tu varijablu. Moguce je u startu vra zbir.

Promenite vas sab.py code tako da izgleda ovako:

[code]
def sab(a,b):
return a+b
[/code]

Snimite ga sa File > Save i izvrsite sa Run > Run Module. U IDLE Shellu kucajte:

[code]
»> sab(3,4)
7
[/code]
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Kao sto vidite funkcionalnost je ostala ista, iako je radni deo obrisan. Ili preciznije, prebacen u deo za rezultat.
Sa ovim cete se vrlo cesto sreta .

2) Funkcije ne moraju da imaju rezultat/return. Ponekad je akcija sve sto zelite.

Napisite sledecu funkciju u IDLE Editoru, snimite je i izvrsite:

[code]
def sila(ime):
print(’May the Force be with you,’,ime+’.’)
[/code]

Za m je u Shellu pozovite sa argumentom vaseg imena. Npr. ako se zovete Dejan pisite:

[code]
»> sila(’Dejan’)
May the Force be with you, Dejan.
[/code]

Dobicete pozna pozdrav i StarWars-a. U ovom primeru funkcija nema rezultat koji vraca, vec samo izvrsava
akciju na osnovu prosledjenog argumenta.

3) Funkcije ne moraju ima ni argumente.

Napisite sledecu funkciju u IDLE Editoru, snimite je i izvrsite:

[code]
def cikajova():
print(’Ucio ih, ucio\nOd srede do petka\n’ \
’Al\’ se nisu odmakli\nDalje od pocetka.’)
[/code]

Pozovite je u IDLE Shellu jednostavno sa:

[code]
»> cikajova()
Ucio ih, ucio
Od srede do petka
Al’ se nisu odmakli
Dalje od pocetka.
[/code]

Dobicete poznate s hove Cika Jove Zmaja. :) Ovde funkcija nema ni argumente ni rezultat, vec samo izvrsava
neku akciju. Na ovaj nacin ih mozemo koris kao subru ne, sto donekle vazi i za drugi primer.

Napomena: Sve funkcije mogu staja u istom .py fajlu. Ovo vazi i za glavni code koji ih pokrece.

4) A funkcije mogu bi i korisne.

Do sada smo pisali samo genericke funkcije sa ciljem da ilustrujemo neke osobine i mogucnos . Sada cemo
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napisa jednu korisnu funkciju, temperaturni konverter izmedju celzijusa i farenhajta.

U IDLE Editoru napisite, snimite i izvrsite sledeci code:

[code]
def face(fa):
return (fa-32)*5/9

def cefa(ce):
return ce*9/5+32
[/code]

Koris te cefa za konverziju C u F a face obrnuto. Npr.

[code]
»> cefa(25)
77.0
»> face(47)
8.333333333333334
[/code]

Ovo vam moze bi korisno ako imate drugove u Americi ili na Bahamima. :)

Ovim zavrsavamo drugi deo serije textova u funkcijama. U [2]sledecem textu cemo opisa dva trika koja ce
vase funkcije ucini produk vnijim.

1. http://kompjuteri2011.wordpress.com/2014/01/18/python-funkcije/
2. http://kompjuteri2011.wordpress.com/2014/01/20/python-funkcije-trikovi/

Python: Funkcije, uvod | Kompjuteri (2014-01-19 02:49:08)
[…] za uvod. U narednom textu cemo kroz primere obradi neke osobenos […]

Python: Funkcije, trikovi | Kompjuteri (2014-01-20 00:55:20)
[…] proslom textu obradili smo neke osobenos funkcija kroz nekoliko primera. Danas cemo objasni dva trika kojim […]

Python: Funkcije, praksa | Kompjuteri (2014-01-20 02:34:04)
[…] podse mo sta smo do sada naucili. U prvom textu obradili smo osnovne elemente Python funkcije. U drugom smo radili
na osobinama funkcija kroz primere. U trecem smo naucili dva trika za povecanje […]

Python: Funkcije, trikovi (2014-01-20 00:55) - w1ndu

U [1]proslom textu obradili smo neke osobenos funkcija kroz nekoliko primera. Danas cemo objasni dva trika kojim
vase funkcije mozete ucini korisnijim.
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1) Docstring - Pomocne informacije u funkcijama.

Sve ugradjene funkcije u Pythonu imaju svoj kratak help. Ako zelite da ih vidite, kucajte u Shellu:

[code]
»> dir( _ _buil ns _ _)
[/code]

Dobicete listu svih standardnih funkcija u Pythonu. Sada ako zelite da dobijete vise informacija o njima, mozete
koris komandu help. Pokusajte recimo sledece:

[code]
»> help(print)
Help on built-in func on print in module buil ns:

print(...)
print(value, ..., sep=’ ’, end=’\n’, file=sys.stdout, flush=False)

Prints the values to a stream, or to sys.stdout by default.
Op onal keyword arguments:
file: a file-like object (stream); defaults to the current sys.stdout.
sep: string inserted between values, default a space.
end: string appended a er the last value, default a newline.
flush: whether to forcibly flush the stream.
[/code]

Ili:

[code]
»> help(input)
Help on built-in func on input in module buil ns:

input(...)
input([prompt]) -> string

Read a string from standard input. The trailing newline is stripped.
If the user hits EOF (Unix: Ctl-D, Windows: Ctl-Z+Return), raise EOFError.
On Unix, GNU readline is used if enabled. The prompt string, if given,
is printed without a trailing newline before reading.
[/code]

Docstring metod nam omogucava da isto to uradimo sa nasim funkcijama. Upisuje se unutar tri znaka navoda,
odmah iza imena funkcije a pre akcije. Pogledajmo to na primeru naseg konvertora iz prethodnog texta. Da se
podse mo, on izgleda ovako:

[code]
def face(fa):
return (fa-32)*5/9

def cefa(ce):
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return ce*9/5+32
[/code]

Otvorite ga u IDLE editoru i preradite da izgleda npr. ovako:

[code]
def face(fa):
”””
(num) -> float
Za unetu temperaturu u Farenhaj ma,
vraca vrednost u Celzijusima.
”””
return (fa-32)*5/9

def cefa(ce):
”””
(num) -> float
Za unetu temperaturu u Celzijusima,
vraca vrednost u Farenhaj ma.
”””
return ce*9/5+32
[/code]

Snimite ga, izvrsite (F5) i u IDLE Shellu tes rajte:

[code]
»> cefa(31)
87.8
»> face(90)
32.22222222222222
[/code]

Vec i prilikom kucanja videcete da vam Shell nudi objasnjenje koji p unosa funkcija ocekuje. Sada tes rajte
help na vasim funkcijama:

[code]
»> help(cefa)
Help on func on cefa in module _ _main _ _:

cefa(ce)
(num) -> float
Za unetu temperaturu u Celzijusima,
vraca vrednost u Farenhaj ma.

»> help(face)
Help on func on face in module _ _main _ _:

face(fa)
(num) -> float
Za unetu temperaturu u Farenhaj ma,
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vraca vrednost u Celzijusima.
[/code]

Help vam sada vraca informacije koje ste upisali u docstring funkcije.

Ovo je pican nacin pisanja docstringa. Da li cete i kako koris ovu opciju potpuno je na vama. Ona moze
bi narocito korisna u mskom radu, kao i korisnicima vasih programa radi brzog pregleda informacija.

2) Funkcija iz funkcije

Vec je pomenuto da funkcija moze poziva drugu funkciju. Ovo je korisno radi razbijanja komplexnih zadataka
na jednostavnije. Takodje i radi op mizacije koda, jer ako znate pouzdano da vam neka vec napisana funkcija dobro
radi, nema potrebe da isto ponavljate u drugoj.

Radi ilustracije, napravicemo jednostavan primer. Pretpostavimo da zelite da napisete funkciju koja uzima dva
broja, sabira ih i podize na kvadrat. Pri tome, vec imate funkciju koja dize na kvadrat.

To bi moglo izgleda ovako. U Python editoru kucajte:

[code]
def kvad(a):
return a*a

def skvad(a,b):
return kvad(a+b)
[/code]

Tes rajmo funkciju u shellu:

[code]
»> skvad(1,4)
25
»> skvad(5,7)
144
[/code]

Kao sto vidite, funkcija skvad uzima dva broja, sabira ih, poziva funkciju kvad koja ih podize na kvadrat, i na
kraju nam vraca rezultat. Pri tome je naravno moguce upotrebljava i funkciju kvad direktno:

[code]
»> kvad(4)
16
[/code]

Ovim zavrsavamo treci text serijala o funkcijama. U [2]narednom i poslednjem bavicemo se praksom kroz
jedan zanimljiv primer.
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1. http://kompjuteri2011.wordpress.com/2014/01/19/python-funkcije-primeri/
2. http://kompjuteri2011.wordpress.com/2014/01/20/python-funkcije-praksa/

Python: Funkcije, primeri | Kompjuteri (2014-01-20 01:04:52)
[…] zavrsavamo drugi deo serije textova u funkcijama. U sledecem textu cemo opisa dva trika koja ce vase funkcije ucini […]

Python: Funkcije, praksa | Kompjuteri (2014-01-20 02:34:07)
[…] smo osnovne elemente Python funkcije. U drugom smo radili na osobinama funkcija kroz primere. U trecem smo naucili
dva trika za povecanje produk vnost. I u zavrsnom sumiramo nauceno kroz […]

Python туторијали (2014-01-20 12:42:14)
[…] Python: Функције, трикови […]

Python: Funkcije, praksa (2014-01-20 02:33) - w1ndu

U poslednjem textu mini-serijala o funkcijama pokazacemo njihovu primenu u praksi na primeru Cezar enkripcije.
Ovo ce ujedno bi demonstracija pojedinih naucenih koncepata, kao i op mizavanog i pomalo minimalis ckog s la
u programiranju.

Najpre da se podse mo sta smo do sada naucili. U [1]prvom textu obradili smo osnovne elemente Python
funkcije. U [2]drugom smo radili na osobinama funkcija kroz primere. U [3]trecem smo naucili dva trika za povecanje
produk vnost. I u zavrsnom sumiramo nauceno kroz praksu.

Ovaj kratak program je napisan tokom izvanrednog [4]IHTS kursa, koji svima preporucujem. Cezar cypher je
jednostavan sistem enkripcije koji je dobio naziv po Juliju Cezaru jer ga je primenjivao tokom vojnih operacija za
razmenu poruka. Radi se o jednostavnoj zameni slova za slovo po nekom kljucu koji definise za koliko je mesta
pomeren alfabet u kriptovanom textu. Detaljno objasnjenje mozete naci na wikipediji [5]ovde. Poznat primer ove
enkripcije je cuveni [6]ROT13 u kome je Engleski alfabet podeljen na pola. On je bio jako popularan na starim news
grupama i jednostavnu demonstraciju mozete vide [7]ovde.

Da predjemo na posao. U IDLE Editoru iskopirajte i pokrenite sledeci code:

[code]
def cea(s,x):
a = ”
for n in s:
if n.isalpha():
b = chr((ord(n.lower())+x-97) %26+97)
if n.isupper():
a += b.upper()
else: a += b
else: a += n
print(a)

def uncea(s,x): cea(s,-x)
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def brutc(s):
for n in range(25):
print(’Key’,n+1,’Text:’)
uncea(s,n+1)

#Examples:

#cea(’Simple is be er than complex.’,5)
#brutc(’Mywzvoh sc loddob drkx mywzvsmkdon.’)
#uncea(’Lyuxuvcfcns wiohnm.’,20)
[/code]

Kratko objasnjenje: Funkcija Cea pomera text za faktor x, cime ga enkriptuje. Uncea poziva Cea ali sa obrnu-
m faktorom, cime ga vraca nazad u alfabetu za onoliko mesto koliko je bio pomeren tokom enkripcije. I Brutc

jednostavno izlistava svih 25 mogucnos pomerenog texta za Engleski alfabet. Onda je lako vide koji od njih ima
smisla, a me i koji je kljuc koriscen.

Tes rajmo nas program u shellu:

[code]
»> cea(’Simple is be er than complex.’,5)
Xnruqj nx gjyyjw ymfs htruqjc.
»> uncea(’Lyuxuvcfcns wiohnm.’,20)
Readability counts.
»> brutc(’Mywzvoh sc loddob drkx mywzvsmkdon.’)
[...]
Key 10 Text:
Complex is be er than complicated.
[...]
[/code]

Opciono za kraj mozete proba brutc funkciju za sledeci cypher:

[code]
’Sw lzcowu xili, aiu c riuc swxi.’
[/code]

Dobicete remix verziju jedne nase poslovice. :)

Inace, primeri koje smo koris li predstavljaju neke od osnovnih principa Pythona. Njih je napisao Tim Peters u
svom textu [8]The Zen of Python. U koliko zelite da procitate integralnu verziju texta sa svim principima, mozete
koris pozna Python Easter Egg.

Kucajte u IDLE Shellu:

[code]
»> import this
[/code]
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Na kraju treba doda da Cezar shi vise nije u upotrebi jer se smatra nesigurnim. Dovoljno je pronaci kljuc na
osnovu dela texta i onda je lako dekriptova kompletan sadrzaj. Medju m, gotovo je idealan za ucenje programiranja
i demonstraciju jednostavne enkripcije.

Ovim zavrsavamo mini-serijal o funkcijama. Srecno u novim Python avanturama.

1. http://kompjuteri2011.wordpress.com/2014/01/18/python-funkcije/
2. http://kompjuteri2011.wordpress.com/2014/01/19/python-funkcije-primeri/
3. http://kompjuteri2011.wordpress.com/2014/01/20/python-funkcije-trikovi/
4. https://www.coursera.org/course/insidetheinternet
5. http://en.wikipedia.org/wiki/Caesar_cipher
6. http://en.wikipedia.org/wiki/ROT13
7. http://rot13.com/
8. http://www.python.org/dev/peps/pep-0020/

Python: Funkcije, trikovi | Kompjuteri (2014-01-20 02:39:29)
[…] zavrsavamo treci text serijala o funkcijama. U narednom i poslednjem bavicemo se praksom kroz jedan zanimljiv […]

4.2 February

Skype v4 instalacija (2014-02-24 14:59) - w1ndu

Kompanija [1]MS poznata je po tendenciji sprecavanja korisnika da svoj kompjuter koriste po sopstvenoj zelji.
Poslednji izdanak ove poli ke je primoravanje Skype korisnika da izvrse upgrade i predju sa v4 na neku noviju. Ovde
je narocito zanimljiv nacin kako je to uradjeno.

Naime, dok ne pozelite da reinstalirate Skype ili ne napravite novu instalaciju sve ce bi u redu. Ali cim ovo
uradite, starija verzija jednostavno nece moci da se poveze. Zanimljivo je da tehnicka podrska tvrdi kako pojma nema
o cemu se radi, i preporucuje upgrade jer v5 & v6 rade bez problema. Ono sto zaboravljaju da pomenu su brojni
bagovi, nedoslednos i problemi kojima nove verzije ovog programa obiluju.

Ovde cemo naves dva nacina kako mozete jos uvek koris stariji Skajp u koliko to zelite:

1) Bolje spreci . U koliko zelite da reinstalirate Skype, obavezno sacuvajte fajl shared.xml. Naci cete ga u
Skype folderu u App Data, koji se po defaultu nalazi ovde >

C:\Documents and Se ngs\<username>\Applica on Data\Skype

Nakon reinstalacije jednostavno vra te ovaj fajl na svoje mesto u novoj instalaciji.

2) Druga opcija je, instalirajte bilo koji noviji Skajp, konektujte se na vas nalog, za m ga deinstalirajte ali nemo-
jte nista drugo da menjate. Onda jednostavno instalirajte stariju verziju Skajpa.
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Po zelji mozete nakon ovoga sacuva novi shared.xml, za m detaljno deinstalira Skajp ukljucujuci sve foldere
i registre, reinstalira cis Skype v4 i vra shared.xml u Skype folder u App Data.

Ovo nije neophodno zato sto Skajpov deinstall u principu dobro radi posao.

Navescemo i linkove verzija koje vam mogu bi od pomoci. Novije koje rade sa nesto manje bagova od ostalih
su:

[2]v5.10.0.116 ; [3]v6.1.0.129 & [4]v6.3.0.107

Takodje, ako koris te WinXP SP2, bez zelje da upgradujete na SP3, poslednja verzija koja ce vam radi je [5]v6.6.0.106.

Od starijih verzija, poslednja v4.2 nije vise dostupna na zvanicnom sajtu, ali je mozete skinu sa arhivskih saj-
tova, recimo [6]ovde. MD5 je: 3440548d69923b0fa0c81633576ea91e. Druga provereno dobra starija verzija je
poslednja v4.1 koju mozete skinu [7]ovde. MD5 je: 2ac7e534adb21e8d212608770e0f0b4c. Hashevi se lako
proveravaju sa [8]WinMd5Sum.

Na kraju bitna napomena. Kada uradite downgrade obavezno iskljucite autoupdate. Takodje, svi metodi opisani ovde
rade u trenutku pisanja texta. Dokle ce tako bi , ostaje da se vidi.

1. http://en.wikipedia.org/wiki/Criticism_of_Microsoft
2. http://download.skype.com/msi/SkypeSetup_5.10.0.116.msi
3. http://download.skype.com/msi/SkypeSetup_6.1.0.129.msi
4. http://download.skype.com/msi/SkypeSetup_6.3.0.107.msi
5. http://download.skype.com/msi/SkypeSetup_6.6.0.106.msi
6. http://www.oldversion.com/windows/skype-4-2-0-187
7. http://www.oldversion.com/windows/skype-4-1-0-179
8. http://portableapps.com/apps/utilities/winmd5sum_portable

4.3 March

OpenHardwareMonitor (2014-03-01 14:43) - w1ndu

Besplatni Open Source program za pracenje parametara sa ma cne ploce. Pre svega temperature, fan brzine, na-
pajanja i takta (clock speed). Podrzava veliki broj pova hardware senzora, i po mnogo cemu podseca na CPUID-ov
[1]HwMonitor.

Code je otvoren i dostupan po Mozilla [2]licenci. Vise informacija kao i download mozete naci na sajtu proizvod-
jaca [3]ovde.

1. http://www.cpuid.com/softwares/hwmonitor.html
2. http://www.mozilla.org/MPL/2.0/
3. http://openhardwaremonitor.org/
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windu (2014-03-27 15:48:42)
Mozete pokusa sa programom Audacity koji ima ugradjene Noise i Click Removal funkcije u Effects meniju. Imajte medju m
u vidu da su ove funkcije daleko od savrsenih te da je nerealno ocekiva spektakularne rezultate. Program se moze skinu na
zvanicnom [1]sajtu kao i u [2]portabilnoj verziji. Srecno i pozdrav.

1. http://audacity.sourceforge.net/
2. http://portableapps.com/apps/music_video/audacity_portable

Seval Malcinovic (2014-03-28 09:18:27)
Hvala na savjetu, pozz!

Seval Malcinovic (2014-03-26 12:11:38)
Poštovani, imam snimak sjednice UO i u pozadini mi se glasno čuje muzika koja je dolazila iz obližnjeg lokala, postoji li ikakva
mogućnost da se ta muzika ukloni i da ostane samo snimak sjednice koji je meni potreban. Tražio sam rješenje na netu ali sve
se svodi na izdvajanje matrice od glasa tako da ostaje samo muzička podloga a meni treba obrnuto da ostane glas.

GIMP uputstvo (2014-03-27 22:31) - darthewok

Uputstvo za Gimp na srpskom jeziku.

4.4 April

Yahoo mailto popup (2014-04-17 03:16) - w1ndu

Poslednjih nedelju dana Yahoo je resio da nervira svoje korisnike dosadnim popupom koji nametljivo sugerise da ga
dodate medju aplikacije za slanje mailova. U koliko potvrdite, Yahoo ce bi dodan u Tools > Op ons > Applica ons.
Ali pretpostavimo da ovo ne mozete ili ne zelite da uradite. Jedan od nacina kako da zaustavite ovaj popup je kreiranje
/ editovanje [1]userChrome.css fajla.

1) Pronadjite [2]profile folder za vas browser. Po defaultu se nalazi u:

c:/Documents & Se ngs/<username>/Applica on Data/Mozilla

Najlaksi nacin da dodjete do njega pod Winom je: Start > Run i upisite ” %APPDATA %\Mozilla\”. Za m udjite
u zeljeni Mozilla browser (npr. Firefox) > Profiles > default profil.

2) U profil folderu kreirajte najpre folder ’chrome’, za m u njemu kreirajte fajl userChrome.css i upisite sledeci
code u njega >
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[code]
@namespace url(h p://www.mozilla.org/keymaster/gatekeeper/there.is.only.xul);

no fica on[value=”Protocol Registra on: mailto”] {
display: none !important;
}
[/code]

Napomena: U koliko vec imate folder chrome i fajl userChrome (malo verovatno), jednostavno dodajte no fi-
ca on instrukciju ispod namespace definicije u postojecem fajlu.

3) Snimite userChrome.css, restartujte Firefox i probajte da otvorite Yahoo ili drugi problema cni mail. Vide-
cete da je popup nestao.

Napomena: U koliko koris te portabilni FireFox, profilni folder cete naci u >

FirefoxPortable > Data > profile

Za m odatle pristupite koracima 2) i 3).

Inace, ispla se prouci userChrome, jer omogucava zanimljiva fina podesavanja FireFoxa. Takodje, drugi i
verovatno bolji nacin da radite isto ovo je preko extenzije [3]Stylish.

1. http://kb.mozillazine.org/UserChrome.css
2. http://kb.mozillazine.org/Profile_folder_-_Firefox
3. https://addons.mozilla.org/en-US/firefox/addon/stylish/

SIP klijen (2014-04-29 11:12) - w1ndu

SIP je popularni komunikacioni protokol koji je u masovnoj upotrebi za Voice/Cam komunikaciju preko interneta.
Obzirom na otvorenu strukturu, veliki broj VoIP (voice over internet) klijenata podrzava i koris upravo SIP. Ovde
cemo prikaza nekoliko popularnih klijenata i da brz nacin kako da setujete sve sto je potrebno i pocnete da
razgovarate sa svojim prijateljima.

-[Adresa].

Da bi ste koris li ovaj nacin komunikacije potrebna vam je adresa. Nju jednom otvorite kod bilo kog SIP prova-
jdera i onda je mozete koris u bilo kom klijentu. Za siru listu mogucih lokacija na kojima mozete ovo uradi
konsultujte about stranu [1]ovde. Za nas primer koris cemo Ekigu.

Pose te Ekiga [2]stranu posvecenu kreiranju adrese. Izaberite Get a Free SIP-Address, popunite obrazac i do-
bicete svoju adresu i detaljno objasnjenje za koriscenje. Slican podsetnik, ali bez sifre (zbog sigurnos ), ce vam bi
poslat na vas email.
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Vasa sip adresa izgleda otprilike ovako:

sip:username@ekiga.net

.. i to je ono sto cete dava prijateljima da bi vas dodali u kontakte. Ekiga takodje daje svoj klijent, ali ako se
opredelite da koris te neki drugi, verovatno cete mora da definisete domain ili registrar. U tom slucaju, u odgovara-
jucem polju treba samo da upisete: ekiga.net.

Takodje kada sve budete setovali, genericki testcall Ekiga servisa nalazi se na:

sip:500@ekiga.net

-[Klijen ].

1) Ekiga

U koliko ste otvorili adresu na ovom servisu, njihov klijent je verovatno najjednostavnije resenje. Pose te
[3]ekiga.org i skinite klijent za vas sistem. Trenutno su podrzani Win & Lin.

Nakon instalacije pokrenuce se konfiguracija koja ce vas proves kroz osnovna podesavanja. Sve je unapred
prilagodjeno Ekiga servisu a ako bude nejasnoca imacete objasnjenje kroz primere. U koliko propus te ovo, uvek
mozete pokrenu setup na Edit > Configura on Assistant. U edit meniju mozete podesi i preferences jer je ponekad
potrebno rucno definisa kameru. Ako zelite da dodate novi Account to mozete uradi preko Edit > Accounts a
za novi kontakt u Chat > Add Contact. Kada ste sve obavili pozovite Echo Test radi finalne provere. Naci cete ga u
predefinisanim kontak ma.

Uobicajeni problemi sa ovim klijentom su greska ”Security Check Failed” i povremeni crushing, npr. pri zat-
varanju. U prvom slucaju najcesce je problem kod accounta. U koliko je sifra pogresno uneta ili ni jedan account nije
povezan (registrovan) doci ce do ove greske. Proverite da li je sve u redu pod Edit > Accounts. U drugom slucaju
mozete pokusa sa starijom [4]verzijom.

Ekigu takodje mozete skinu u portabilnoj verziji [5]ovde.

2) QuteCom

Besplatan i open source VoiP klijent dostupan za Win, Lin & OSx. Nakon instalacije i pokretanja, pojavice se
prozor za setovanje profila. Login/username je vas username sa Ekige, za password je Ekiga pass za username, i za
domain stavite ekiga.net. Account i Display name mozete popuni kako zelite. Za m kliknite Connect i ako je sve kako
treba bicete povezani na svoj nalog. Ovo mozete vide na osnovu promene ikonice u SysTray-u kao i na QuteCom
glavnom ekranu. Ako pozelite da se diskonektujete, to mozete uradi na Account > Log Off i videcete da obe ikonice
imaju malo x pored sebe, sto ukazuje na to da ste offline.

Ako ste se disokonektovali, ulogujte se opet sa Account > Log On. Dodajte Test kontakt na Contacts > Add
Contact. Pod Group stavite ’Tes ng’, u First Name upisite ’Ekiga Test’ a u SIP ID upisite 500@ekiga.net. Kliknite Save i
novi kontakt ce se pojavi u Tabu Contacts. Za m desni klik i Call > Free call ili kliknite zelenu ikonicu sa telefonom.
Ako ste sve podesili kako treba, dobicete Ekiga Test pozdravnu poruku koja vam omogucava da isprobate da li je sve
okej. Na is nacin dodavacete vase buduce SIP kontakte. Sva podesavanja, poput audija, videa, izgleda itd, mozete
naci pod Tools > Configura on.
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Dodao bih da je ovaj klijent izuzetno lagan po sistem, jednostavan, stabilan i zgodan za rad. Iz tog razloga
predstavlja omiljeno resenje za veliki broj korisnika. Instalaciju i source mozete skinu sa zvanicnog [6]sajta, a
dostupna je i portabilna [7]verzija.

3) Blink

[8]Blink je besplatan, jednostavan i prilicno popularan open source SIP klijent. Nakon instalacije, automatski
ce bi pokrenut Add Account wizard. U koliko ste vec registrovali SIP prebacite na Add exis ng account i upisite
podatke. U nasem slucaju za SIP address unesite vas username@ekiga.net, i pod password account pass.

Nakon instalacije i osnovnog podesavanja kliknite + dugme dole levo da bi dodali kontakt. Pod name upisite
Ekiga Test. Za m 2x klik na ’Edit to add address’ i upisite sip:500@ekiga.net. Na ovaj nacin cete i kasnije dodava
ostale kontakte. Za m jednostavno obavite test call.

Iako ima brojne zanimljive mogucnos , Blink ne podrzava video call. Ako vam to ne treba, onda je jako dobro
resenje.

4) LinPhone

Jos jedan besplatan i open source SIP klijent. Nakon instalacije bice pokrenut account setup. Ovde mozete
registrova account preko linphone servisa ili koris ranije kreirani. U nasem slucaju izaberite I have already a SIP
account .. Pod username upisite vas username sa ekige, pod password svoju sifru i u domain upisite: ekiga.net.

Nakon podesavanja i povezivanja, kao i u prethodnim slucajevima kliknite + dole levo za contact i upisite
sip:500@ekiga.net za adresu. Obavite razgovor da bi videli da li su podesavanja u redu.

Poput prethodna dva, [9]LinPhone je dostupan za Win, Lin & OSx.

Siri spisak SIP klijenata mozete pogleda [10]ovde, a za vise informacija o samom protokolu pose te odgovara-
juce [11]wiki i [12]about stranice.

1. http://voip.about.com/od/sipandh323/tp/Free-Sip-Providers.htm
2. https://ekiga.im/
3. http://ekiga.org/
4. http://ekiga.org/news/2010-05-31/ekiga-3.2.7-available
5. http://portableapps.com/apps/internet/ekiga-portable
6. http://www.qutecom.org/
7. http://portableapps.com/apps/internet/qutecom_portable
8. http://icanblink.com/
9. http://www.linphone.org/
10. http://en.wikipedia.org/wiki/List_of_SIP_software
11. http://en.wikipedia.org/wiki/Session_Initiation_Protocol
12. http://voip.about.com/od/sipandh323/a/What-Is-Sip-And-What-Is-It-Good-For.htm
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4.5 May

Firefox: Otkrivanje asteriska (2014-05-06 00:37) - w1ndu

Iako ovaj trik moze bi koristan ponekad, post je pre svega zamisljen kao brza demonstracija Web Inspectora u
Firefoxu.

1) Otvorite bilo koju stranu koja od vas trazi da unesete sifru. Npr. [1]Google Accounts.

2) U polju password upisite bilo kakav niz slucajnih karaktera, tj. nalupajte nesto na tastaturi. :)

3) Selektujte polje gde je password > Desni klik > Inspect Element (Q). Otvorice vam se Markup Panel u don-
jem delu ekrana i u njemu ce bi selektovana linija. U toj liniji videcete elemenat:

[code]type=”password”[/code]

4) Promenite ga da bude:

[code]type=”text”[/code]

.. I cim pri snete enter, polje sa sifrom ce bi otkriveno.

Ako kojim slucajem ne vidite Markup Panel, kliknite drugo dugme u donjem redu Inspectora (sa tri linije) ili
jednostavno kliknite Alt + M u koliko je Inspector vec pokrenut.

Is ovaj trik je naravno moguce uradi i pre unosenja bilo kakvog texta. U tom slucaju cete moci da pra te
sta unosite u polje za sifru jer ce u startu bi otkriveno. Samo vodite racuna da neko nepozeljan nije pored vas.

Ovo je bila samo kratka ilustracija Inspectora. On se inace moze koris u razne svrhe, od brzog editovanja
stranice pre stampe (npr. brisanje nezeljenih elemenata) pa do detaljnijeg proucavanja pojedinih elemenata koda.
Sa druge strane postoje korisnici kojima smetaju ovi dodatni elemen jer zele da koriste browser kao browser. Za
njih smo pripremili bonus trik.

Ako zelite da uklonite Inspector iz Firefoxa, to mozete uradi na sledeci nacin:

-> U address baru upisite ’about:config’ > I’ll be careful > pronadjite ’devtools.inspector.enabled’ > 2x klik za
False > restartujte Firefox.

Videcete da je Inspector uklonjen iz svih menija. Medju m imajte u vidu da je on i dalje dostupan te da je
ova promena samo kozme cka. Npr. ako zelite da ga podignete to mozete uradi sa Ctrl+Shi +I bez obzira sto ste ga
sklonili iz menija.

Inspector naravno mozete uvek vra u meni na is nacin kako ste ga sklonili, preko about:config opcije, a
slicno je moguce radi i sa ostalim devtools elemen ma.
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1. https://accounts.google.com/ServiceLogin

ourWorld (2014-05-14 09:07) - darthewok

ourWorld je online browser igra, to jest virtuelni svet. Igru mozete da probate i bez registracije, ali ako zelite da sacu-
vate svoj avatar, odnosno karakter koga ste napravili, nivo koji ste ostvarili i ostalo, morate se registrova . Kao sto sam
napisao, igra je virtuelni svet u kome mozete da se druzite sa ostalim likovima u igri. Mozete da igrate na sto ne igara
i jos dosta toga. Dosta zanimljiv koncept i prilicno zarazno.
Igru igrate iz web pretrazivaca i nije potrebna instalacija nikakvog dodatnog so vera. Naravno, podrazumeva se da
imate Adobe flash.

Adresa na kojoj mozete igra igru je:
[1]www.ourworld.com

1. http://www.ourworld.com/

Xubuntu 14.04 LTS (2014-05-14 09:17) - darthewok

Pre nekoliko dana sam instalirao Xubuntu 14.04, pa, kao i do sada sa ostalim Linux distribucijama koje sam instalirao,
napravio sam novu podkategoriju u kojoj cu pisa o mojim iskustvima sa ovom distribucijom.

Instalacija i podesavanje Xubuntu 14.04 (2014-05-14 10:11) - darthewok

Sama instalacija je protekla brzo i bez problema. Ali, posle zavrsene instalacije sam prime o da, kao prvo swap
par cija nije bila ak vna, kao drugo, ostala je stara swap par cija od prethodne instalacije Ubuntu 12.04, koja takodje
nije bila ak vna.

Sto se ce swap paricije, sama par cija je bila napravljena, ali nije definisana u fstab, tako da sam to morao
rucno da podesim. Prvo sam instalirao Gparted i za svaki slucaj tu par ciju koja je bila napravljena sam forma rao
kao Linux Swap par ciju. Za m sam u /etc/fstab uklonio # sa linije gde se mon ra swap par cija i upisao sam
odgovarajuci UUID. U mom slucaju to izgleda ovako:
UUID=4965c9f5-f8fc-4265-a1c1-bb574592ed38 none swap sw 0 0.
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Onu zaostalu par ciju sa Ubuntu 12.04 sam forma rao kao ext4 i ukljucio sam je u fstab:
U mom primeru to izgleda ovako:
UUID=00c78871-33d9-4466-ad52-17f4d0957f81 /media/user/aaa ext4 noa me,errors=remount-ro 0 2
Posle restarta je iz terminala odradjena komanda:
sudo chown user:user /media/user/aaa
da bi korisnik user imao read/write privilegije na toj par ciji.

Prilikom instalacije Xubuntu na drugom kompjuteru i laptpu, prvo sam pokrenuo Xubuntu live i za m sam iz
terminala pokrenuo Gparted. sudo gparted da bih pre pocetka instalacije izbrisao staru swap par ciju i spojio je sa
glavnom par cijom. Posle zavrsene instalacije je sve bilo kako treba, bez zaostalih par cija od prethodne instalacije.
Naravno, morao sam rucno da sredim swap par ciju (pogledajte pocetak teksta).

Prilikom instalacije sam izabrao opciju da se ukloni stara Ubuntu 12.04 instalacija. Da li su problemi prisutni
i kada se izaberu druge opcije, ne znam, jer nisam probao.

Za m sam poceo da podesavam sistem i da instaliram dodatne programe.

Definisanje root sifre:
sudo passwd root

Dodavanje noa me u fstab:

sudo mousepad /etc/fstab

Liniju:
UUID=96f8ef88-34bb-4b68-86e3-cbb2f8391257 / ext4 errors=remount-ro 0 1

sam izmenio da izgleda ovako:
UUID=96f8ef88-34bb-4b68-86e3-cbb2f8391257 / ext4 noa me,errors=remount-ro 0 1

Ukljucivanje kombinacije tastera Ctrl+Alt+Backspace u XFCE okruzenju:

sudo mousepad /etc/default/keyboard

Liniju:
XKBOPTIONS=””

sam izmenio da izgleda ovako:
XKBOPTIONS=”terminate:ctrl _alt _bksp”

sacuvao sam izmene i restartovao kompjuter.

Podesavanje firewall-a:
Preuzimanje grafickog okruzenja za podesavanje firewall-a:
sudo apt-get install gufw

Ak viranje firewall-a:
sudo ufw enable

Pokrenuo sam firewall konfigurator iz terminala komandom:
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sudo gufw
Podesio sam firewall da odbija sve dolazne upite.

Blokirao sam Ping odgovore na Ping upite na sledeci nacin:
U terminalu sam ukucao:
sudo mousepad /etc/ufw/sysctl.conf

i promenio sam vrednost 0 u 1 u sledecoj liniji:
net/ipv4/icmp _echo _ignore _all=0

Posle izmene linija izgleda ovako:
net/ipv4/icmp _echo _ignore _all=1

Za m sam restartovao firewall da bi se ak virale izmene
sudo ufw disable
sudo ufw enable

Dodavanje H.264 podrske u Firefoxu
sudo add-apt-repository ppa:mc3man/trusty-media
sudo apt-get update
sudo apt-get install gstreamer0.10-ffmpeg

Instalacija dodatnog so vera:
Grub Customizer:
sudo add-apt-repository ppa:danielrichter2007/grub-customizer
sudo apt-get update
sudo apt-get install grub-customizer

Restricted Extras:
sudo apt-get install ubuntu-restricted-extras

Media plejeri:
sudo apt-get install vlc

Browsers:
sudo apt-get install chromium-browser

Da bi u Chromiumu radio flash, instalirao sam Pepper Flash Player
sudo apt-get install pepperflashplugin-nonfree
sudo update-pepperflashplugin-nonfree –install

Preuzet Google Chrome sa www.google.com/ncr i instaliran.

Oracle Java:
sudo add-apt-repository ppa:webupd8team/java
sudo apt-get update
sudo apt-get install oracle-java7-installer

Google Earth:
Sa adrese earth.google.com preuzet i instaliran Google Earth.
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Skype:
Preuzet Skype sa adrese www.skype.com i instaliran.

Midnight Commander:
sudo apt-get install mc

TrueCrypt:
Sa adrese www.truecrypt.org preuzet i instaliran TrueCrypt

Podesavanje TrueCrypt:
Se ngs -> Preferences -> Mount Op ons
U okviru Filesystems u polje Mount op ons ukuca :

rw,nosuid,nodev,noa me,uhelper=devkit,uid=1000,gid=1000,shortname=lower,dmas k=0077,u 8=1,flush

Da bi radilo otvaranje prozora u XFCE okruzenju:
sudo mousepad /usr/bin/nau lus
ukuca
#!/bin/bash
exec thunar $3
exit 0
sacuva fajl kao nau lus, za m iz terminala kuca :
sudo chmod +x /usr/bin/nau lus

Dodaci za Gimp:
sudo apt-get install gimp-data-extras
sudo apt-get install gimp-lensfun
sudo apt-get install gimp-gap
sudo apt-get install gimp-gmic
sudo apt-get install gimp-cbmplugs
sudo apt-get install gimp-texturize
sudo apt-get install gimp-gutenprint
sudo apt-get install gimp-ufraw
sudo apt-get install gimp-plugin-registry

Inkscape:
sudo apt-get install inkscape

Audacious:
sudo apt-get install audacious

Audacity:
sudo apt-get install audacity

Keepassx:
sudo apt-get install keepassx

Synap c:
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sudo apt-get install synap c

Libre Office:
sudo apt-get install libreoffice

Avidemux:
sudo apt-get install avidemux

Instalirano iz Ubuntu So ware Center:
GParted
k3b sa dodacima
Dropbox
Gnome System Monitor
Streamtuner2
WebHTTrackWebHTTrack
Remote Desktop Viewer
Transmageddon
Geany
Acetoneiso
Cheese
SoundConverter
MyPaint
WinFF
Dia
Jhead
Dosbox
Partclone
Par mage
Ghex
Gnome Sub tles
UNetboo n
Arista Transcoder

Deinstalirano:
Ako su Vam ovi programi potrebni, nemorate da ih deinstalirate.

Thunderbird
Abiword
Gnumeric

Zavrsna podesavanja:
Na kraju sam podesio VPN, ubacio listu blokiranih sajtova u hosts fajl /etc/hosts.
Takodje sam prilagodio XFCE okruzenje mojim potrebama.
Samo da dodam, da mi je neki od programa instalirao Zeitgeist, njega sam deak virao, da se ne pokrece sa sistemom.
Udjite u Se ngs i tamo pronadjite Session and startup i u kar ci Applica on Autostart iskljucite Zeitgeist ako ga ne
koris te.
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Vice Commodore emulator i Xubuntu 14.04 LTS (2014-05-30 12:51) - darthewok

Kada sam instalirao paket Vice, emulator mi nije radio. Problem je u tome sto paket nije kompletan, jer fale neki
fajlovi.

Evo resenja:

Instalirajte Vice: sudo apt-get install vice

Sa adrese:
h p://www.zimmers.net/anon p/pub/cbm/crosspla orm/emulators/VICE/
preuze odgovarajuci fajl u zavisnos od verzije Vice emulatora koga imate instaliranog. U trenutku pisanja ovog tek-
sta, verzija za Xubuntu 14.04 je 2.4, pa shodno tome, potrazite verziju 2.4 za Windows. Dakle, u spisku potrazite fajl
WinVICE-2.4-x86.zip, preuzmite ga i raspakujte ga u neki privremeni folder. To je verzija Vice za Windows, ali nas to
trenutno ne zanima, jer nam trebaju neki fajlovi koji se koriste i u Linux i u Windows verziji. U terminalu ukucajte:
sudo -i, za m sifru. Iskopirajte direktorijume iz fajla preuzetog sa interneta, koji ste prethodno raspakovali.
Direktorijumi koje treba da kopirate u /usr/lib/vice su: C128, C64, C64DTV, CBM-II, DRIVERS, PET, PLUS4, PRINTER,
VIC20, fonts.
Kada se kopiranje fajlova koji nedostaju zavrsi, pokrenite Vice emulator. Trebalo bi da Vice radi bez problema.

4.6 June

TrueCrypt (2014-06-30 20:04) - darthewok

Nije mi jasno da li dosadasnji razvojni m odustaje od razvoja programa TrueCrypt ili im je sajt defejsovan ili neka
kompanija ili vlada stoji iza svega toga. Na sajtovima h p://truecrypt.sourceforge.net/ i h p://www.truecrypt.org/
se nalazi neobicna poruka da TrueCrypt ima neke bezbednosne probleme. Ali se nigde ne pominje koje tacno prob-
leme ima. Takodje, na pomenu m adresama se nalazi uputstvo kako da se izvrsi migracija na BitLocker. Sve to mi je
veoma cudno i mislim da je kompanija koja razvija BitLocker odgovorna za sve to. Sve mi to lici na jos jedan pokusaj
gusenja konkurancije.

Na srecu, TrueCrypt je slobodan projekat otvorenog koda. Koji ce, po svemu sudeci nastavi da zivi. Samo ce ga
razvija drugi razvojni m. Zvanicna web prezentacija se sada nalazi na drugoj web adresi: h ps://truecrypt.ch/
Da, preselili su se u Svajcarsku. :)
Na gore pomenutoj adresi se nalaze i linkovi za download.
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4.7 July

Iskljucivanje Zeitgeist u Xubuntu 14.04 (2014-07-03 12:27) - darthewok

Zeitgeist se verovatno instalira uz Nau lus koji je potreban za Dropbox.

U Session and Startup, u kar ci Applica on Autostart iskljuci Zeitgeist Datahub.

Promenjeni nazivi fajlova da se ne bi pokretali.
/usr/bin/zeitgeist-daemon u /usr/bin/zeitgeist-daemon.1
/usr/bin/zeitgeist-datahub u /usr/bin/zeitgeist-datahub.1

Restartovan sistem

Izbrisan folder /.local/share/zeitgeist

MOOC trend (2014-07-08 14:59) - w1ndu

[1]MOOC-ovi su kurservi, obicno organizovani od strane znacajnih obrazovnih ins tucija, besplatni i po pravilu
otvoreni za sve. Obzirom na ovakvu strukturu, njihova popularnost i posecenost je ogromna i meri se dese nama
hiljada studenata. Zapravao sama skracenica MOOC, sa znacenjem - Masivni Online Otvoreni Kursevi, najbolje
definise ovaj koncept.

Obzirom na ideju, struktura korisnika je naravno veoma raznovrsna u svakom smislu. Kako obrazovno i po
lokaciji, tako i po godinama. Npr. uvek je lepo vide ljude sa 60-70 godina koji i dalje imaju zelju da nauce nesto novo,
osobe srednjih godina spremne na usavrsavanje ili cak promenu karijere, kao i mlade ljude pune entuzijazma i zelje
za s canjem novih znanja.

Postoji barem ce ri dobrobi MOOCova, to su: cena, komfor, kvalitet i razvoj. Najpre kursevi su uglavnom be-
splatni. Sto ce reci dostupni svima koji imaju pristup brzom internetu. Gotovo celom svetu. Mogu se zavrsava iz
komfora sopstvenog doma. Obzirom da se radi o vrhunskim predavacima i strucnjacima iz pojedinih oblas , kvalitet
je zaista na zavidnom nivou. I na kraju, uz nezapamcenu popularnost ovog pa prenosa znanja, sam sistem napreduje
na tehnickom i proceduralnom nivou. Npr. ako neko iz rela vno siromasnog malog sela bilo gde u svetu, ima priliku
da zavrsi Stanfordov kurs iz [2]Kompjuterskih Nauka u organizaciji profesora [3]Nicka Parlantea, to zaista izgleda kao
veliki korak napred za covecanstvo. A kako ce se zavrisi , videcemo. :)

Pomenimo jos i akreditaciju. U vecini slucajeva, nakon uspesnog zavrsetka kursa, dobicete i dokaz u obliku
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PDF ser fikata koji mozete skinu sa sajta eduka vnog provajdera i odstampa . U kojoj ce meri ovakav ser fikat
bi cenjen, zavisi od onog ko vrsi procenu, najcesce poslodavca. Svakako je ocigledno da me dokazujete vase
interesovanje, znanje i ulozeni rad u pomenutoj oblas , medju m bitnije je ono sto znate i imate u glavi a ne ono sto
pise na papiru. Upravo iz tog razloga, praxa je da se znanje i vrednost naucenog tes ra.

Sada cemo pomenu nekoliko najvecih i najznacajnijih MOOC pla ormi, u kojima mozete naci takoreci sve sto
vas zanima kad je u pitanju online edukacija.

1) [4]Coursera - verovatno najveca pla orma za online obrazovanje u ovom trenutku. Trenutno imaju oko 8,5
miliona clanova i blizu 700 kurseva iz svih oblas . Spisak svih kurseva mozete vide [5]ovde. Sa leve strane nalaze se
i filteri kojima cete lako pronaci kurseve iz zeljenih oblas

Gotovo svi kursevi nude besplatne ser fikate ako uspesno ispunite kriterijume. Testovi se sastoje od kvizova,
zadataka, eseja i slicnih oblika provere znanja. A u poslednje vreme su dodate i nove opcije, poput specijalizacija i
verifikovanih ser fikata.

2) [6]Udacity - Znacajan igrac u MOOC svetu i do skora jedna od najvecih konkurencija Courseri. Nakon prom-
ena koje su usledile poslednjih meseci, ovoj pla ormi je znacajno opala popularnost. I pored zanimljivih inovacija,
doslo je do primetne komercijalizacije pla orme. Uvedeni su tutori a cene kurseva podignute 99 $/mo. Takodje,
ukinu su bilo kakvi ser fika i potvrde znanja u besplatnoj opciji, iako je materijal za sada i dalje dostupan. Ovde
bi se mogao izdvoji izvanredni [7]CS101, baziran na Pythonu v2 u ogranizaciji odlicnog profesora Dave Evansa sa
Univerziteta u Virdziniji.

3) [8]EdX - Osnovana od strane MITa i Harvarda, ova pla orma je za rela vno kratko vreme dos gla znacajnu
popularnost. Za to su zasluzni pre svega veliki broj univerziteta - saradnika, samim m jako bogat izbor kurseva, kao
i kvalitetan sistem prezentovanja i tes ranja znanja. U pitanju je stabilna pla orma kako u kvalita vnom tako i u
tehnickom smislu. Slicno svojim konkuren ma, nudi opcije placenih ser fikata kao i raznih specijalizacija. Default je,
za sada, besplatni ser fikat baziran na kodeksu cas .

4) [9]Open2Study - Zanimljiv sistem koji drzi Australijsko udruzenje Univerziteta. Ima standardizovan pristup u
tehnickom smislu, 4 nedelje obuke uz tes ranja. U koliko zadovoljite standarde, dobijate ser fikat koji mozete skinu .
Listu kurseva mozete naci [10]ovde.

5) [11]Saylor Fondacija - Iako nije MOOC u pravom smislu te reci, predstavlja znacajan doprinos u pravcu be-
splatnog obrazovanja. U pitanju je sajt koji pokusava da sledi standardne Major i Minor programa univerzitetskog
obrazovanja, ali tako sto ce materijale za predmete dostavi besplatno. Testove za pojedine predmete moguce je
obavi unutar sajta, koji je baziran na [12]Moodle sistemu.

6) [13]Udemy - Ovaj zanimljivi sajt omogucava svakom da napravi svoj placeni ili besplatni kurs. Ovakav pristup daje
mogucnost za ogroman broj tema koje mozete naci, ali je kvalitet nizi nego kod ostalih sajtova. Iako se ne moze
govori o standardnom MOOC pristupu, opcija pravljenja sopstvenih kurseva deluje primamljivo.

7) [14]Stanford Online - I pored toga sto saradjuje sa brojnim drugim MOOC sajtovima, Stanford je i sam kreirao
sopstvenu pla ormu bazirnu na EdX sistemu u tehnickom smislu. I upravo za oko nedelju dana pocinje cuveni
Stanfordov [15]CS101 kurs u novoj verziji koju ce vodi profesor Nick Parlante, poznat izmedju ostalog i po kursu iz
Pythona na [16]Google Developers sajtu.

Toliko o MOOCovima i online obrazovanju u ovom uvodnom textu. Naredni postovi na temu, bice vezani za
preglede i najave predstojecih kurseva iz kompjuterskih nauka.
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3. http://cs.stanford.edu/people/nick/
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7. https://www.udacity.com/course/cs101
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16. https://developers.google.com/edu/python/

4.8 August

Xubuntu 14.04 i Netbook MSI Wind U100 (2014-08-14 14:09) - darthewok

Prime o sam bag u Xubuntu 14.04 koji je instaliran na Netbook MSI Wind U100. Bag se manifestuje treperenjem
ekrana prilikom povratka iz standby, odnosno suspend rezima, prilikom promene osvetljenos ekrana i kada se ekran
ponovo ukljuci posle perioda ne ak vnos .

Probao sam vise nacina da resim problem, ali je jedino delotvorno bilo flesovanje Biosa na noviju verziju.

Sa adrese:
[1]h p://www.msi.com/support/nb/U100.html #down-bios
preuzmite poslednju verziju Biosa za MSI Wind U100.

Za m dobro procitajte uputstvo kako flesova Bios, da nesto ne bi ste zeznuli. Ako koris te Windows, uput-
stva mozete preuze u PDF formatu u zavisnos od verzije Windowsa koji koris te.

Na sajtu nije pomenuto, ali pripremu USB-a za flesovanje mozete radi i iz Linuxa.

Instalirajte UNetboo n iz Ubuntu So ware Center.
Za m sa adrese:
[2]h p://www.freedos.org/download/
preuzmite FreeDOS 1.0 Floppy.

Ukljucite USB fles i pokrenite UNetboo n. U UNetboo n-u kliknite na opciju Disk Image i u padajucem meniju,
umesto ISO izaberite Floppy. Kliknite na dugme sa tri tacke i potrazite fajl fdboot.img, koji ste skinuli sa Free Dos sajta.
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U padajucem meniju Type postavite USB Drive a u padajucem meniju Drive postavite USB flash koji ste ukljucili u MSI
Wind i kliknitee na ok. Kada se pravljenje Boot diska zavrsi zatvorite UNetboo n.

Za m raspakujte zipovani fajl n011 _10g.zip u kome se nalazi Bios na USB fles.
Restartujte kompjuter i podignite sistem sa USB-a.

Kada se pojavi tekst na ekranu default, pri snite enter na tastaturi i za m u meniju, strelicama, izaberite op-
ciju FreeDOS Safe Mode (don’t load any drivers) i pri snite enter.

Kada se pojavi DOS prompt udjite u folder gde je raspakovan fajl n011 _10g.zip, komandom u DOS-u:
cd EN011IMS.10G i pri snite enter.
kada ste usli u taj folder, pokrenite flash.bat tako sto ukucate flash i pri snete enter.

Sacekajte da program flesuje Bios.

NAPOMINJEM DA ZA VREME OVE OPERACIJE NIKAKO NE ISKLJUCUJETE MSI WIND!!!

A preporucujem vam da baterija bude napunjena i kabal za napajanje bude ukljucen u struju. Kada se op-
eracija zavrsi iskljucite MSI Wind, iskljucite kabal za napajanje i izvadite bateriju na jedno 15 sekundi (tako pise u
uputstvu za flesovanje). Zato sam napomenuo na pocetku da ga procitate. Ima korisnih informacija koje su veoma
bitne za flesovanje. Jer je to potencijalno rizicna operacija. Ako ne uradite dobro, onda ce te mora MSI Wind da
nosite u servis.

Za m vra te bateriju, ukljucite kabal za napajanje i odmah po ukljucenju udjite u Bios. Sacuvajte podesavanja
Biosa i restartujte kompjuter. Posle restarta, kada se podigne Xubuntu, problem sa treperenjem ekrana bi trebalo da
nestane.

1. http://www.msi.com/support/nb/U100.html#down-bios
2. http://www.freedos.org/download/

4.9 November

Xubuntu 14.04 LTS Zoom desktopa (2014-11-05 16:21) - darthewok

Zoom desktopa mozete pos ci tako sto drzite pri snut Alt taster na tastaturi i okrecete tockic misa. Jako korisna oop-
cija za uvecanje sitnog teksta i sitnih detalja u XFCE radnom okruzenju.

Do juce za ovo nisam znao, sve dok moj sin nije to slucajno otkrio, dok se igrao s misem i lupao po potastaturi. :)

Da malo ci ram Gidru: ”Ljubi ga majka. :)”
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4.10 December

FireFox Hello (2014-12-12 00:40) - w1ndu

Od verzije 34, FireFox je resio da ponudi svoje resenje za Audio/Video chat. Za razliku od drugih servisa, nije potrebno
otvaranje naloga. Jednostavno kliknete Hello dugme, dobijete link, pastujete ga vasem prijatelju i imate A/V komu-
nikaciju. A sve ovo preko [1]WebRTC protokola, koji promovise upravo [2]WWW Konzorcijum kao novi standard A/V
komunikacije izmedju browsera, bez upotrebe addonova.

Jos od beta verzije, postavljano je pitanje gde naci ovu opciju. U beta verziji to se radilo sa klikom gore desno na
Menu bu on (tri vodoravne linije) > Customize > i tu je moglo da se nadje dugme za ak viranje Hello opcije. Nakon
premestanja u polje menija ili toolbara, sve je radilo kako treba.

Sa finalnom verzijom medju m, za veliku vecinu korisnika (90 %), ova opcija je skrivena. Razlog su kapacite Mozilla
servera. Iz tog razloga developeri FF-a su odlucili da ovu opciju pustaju korak po korak, da bi bili sigurni u kvalitet
ponude. U koliko spadate u h 90 % koji nemaju ovu opciju, evo kako da je enablujete.

U address baru upisite ‘about:config’ > I’ll be careful > pronadjite ’loop.thro led’ > 2x klik za False > restartujte Fire-
fox. Za m dugme Menu (gore desno) > Customize > i prebacite Hello dugme na upotrebljivo mesto. Klik na Hello,
paste link prijatelju i imate ak vni A/V chat. Ovo su tek prvi koraci, pa se mogu ocekiva problemi. Ali obzirom na
orijentaciju FF-a i W3C, mozemo ocekiva ne samo poboljsanja vec i nove opcije, a mozda i nezavisne specijalizovane
klijente.

Treba doda da Mozilla ima i svoj server za naloge, te se mozete i registrova u koliko prime te da ovaj nacin povezi-
vanja cesto koris te. Ovo omogucava kontakt liste i slicne opcije na koje smo navikli na ostalim messengerima.

Srecno sa novim standardnima online komunikacije. :)

1. http://en.wikipedia.org/wiki/WebRTC
2. http://en.wikipedia.org/wiki/World_Wide_Web_Consortium
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	Save Images (2011-07-03 19:40) - darthewok
	TP-Link TL-WN722NC Wireless USB Adapter (2011-07-08 16:35) - darthewok
	Prebacivanje .mdx u .iso (2011-07-15 00:13) - w1ndu
	Gimp tutorijal 01 (2011-07-17 19:40) - darthewok
	Gimp tutorijal 02 (2011-07-18 12:11) - darthewok
	Gimp tutorijal 03 (2011-07-19 12:49) - darthewok
	Gimp tutorijal 04 (2011-07-20 12:44) - darthewok
	Gimp tutorijal 05 (2011-07-21 01:45) - darthewok
	Gimp tutorijal 06 (2011-07-21 13:19) - darthewok
	Gimp tutorijal 07 (2011-07-21 15:51) - darthewok
	Gimp tutorijal 08 (2011-07-22 11:52) - darthewok
	Gimp tutorijal 09 (2011-07-23 17:21) - darthewok
	Gimp tutorijal 10 (2011-07-24 09:37) - darthewok
	Gimp tutorijal 11 (2011-07-25 10:42) - darthewok
	Gimp tutorijal 12 (2011-07-26 09:59) - darthewok
	Screengrab (2011-07-26 13:08) - darthewok
	Video DownloadHelper (2011-07-26 13:16) - darthewok
	Gimp tutorijal 13 (2011-07-26 17:57) - darthewok
	Gimp tutorijal 14 (2011-07-26 21:17) - darthewok
	Gimp tutorijal 15 (2011-07-27 07:51) - darthewok
	Gimp tutorijal 16 (2011-07-27 22:49) - darthewok
	Gimp tutorijal 17 (2011-07-28 15:50) - darthewok
	Gimp tutorijal 18 (2011-07-28 23:08) - darthewok
	UFO Alien Invasion (2011-07-30 21:22) - darthewok

	August
	20 godina Linuxa (2011-08-01 15:26) - darthewok
	Slobodni softver (2011-08-02 09:36) - darthewok
	Brisanje Flash Cache-a (2011-08-07 14:29) - w1ndu
	zsnes (2011-08-14 22:04) - darthewok
	MAME (2011-08-15 00:17) - darthewok
	BetterPrivacy (2011-08-19 15:48) - darthewok
	Cookie Monster (2011-08-19 16:44) - darthewok
	PrivacySuite (2011-08-19 16:59) - darthewok
	shouldichangemypassword.com (2011-08-21 07:13) - darthewok
	User Agent Switcher (2011-08-24 03:29) - darthewok
	Advanced Cookie Manager / Editor (2011-08-24 03:32) - darthewok
	RefControl (2011-08-24 03:40) - darthewok
	KBasic (2011-08-25 11:37) - darthewok
	Highpass sharpening (2011-08-26 19:57) - darthewok

	September
	Kako povecati WIFI domet? (2011-09-09 22:07) - darthewok
	Sta je to Easter Egg? (2011-09-09 22:19) - darthewok
	Sta je NetBIOS over TCP/IP (NetBT ili NBT)? (2011-09-16 12:28) - darthewok
	Recuva (2011-09-16 12:52) - darthewok
	Double Driver (2011-09-18 21:46) - darthewok
	Firefox i Facebook (2011-09-19 00:48) - darthewok
	Wolfenstein: Enemy Territory (2011-09-25 23:14) - darthewok

	October
	Zastita fajla grub.conf od nedozvoljenih izmena prilikom podizanja sistema (2011-10-01 22:33) - darthewok
	Otvaranje Google pretrazivaca na engleskom (2011-10-10 14:05) - w1ndu
	Ripovanje mp3 is avi fajla (2011-10-10 14:14) - w1ndu
	˜ nrg2iso ˜ (2011-10-10 14:39) - w1ndu
	Kako instalirati dll fajl? (2011-10-29 15:56) - darthewok

	November
	˜ MiPony ˜ (2011-11-09 18:15) - w1ndu
	Otvaranje Google pretrazivaca na engleskom u Operi. (2011-11-10 21:55) - darthewok
	Gimp tutorijal 19 (2011-11-11 16:51) - darthewok
	Gimp tutorijal 20 (2011-11-13 12:37) - darthewok
	Gimp tutorijal 21 (2011-11-14 13:26) - darthewok
	Dodaci za Firefox da Facebook radi normalno... (2011-11-19 15:07) - darthewok
	Eraser [FF] (2011-11-20 07:26) - w1ndu
	Gimp tutorijal 22 (2011-11-20 12:51) - darthewok
	Linux Free Software Catalog and Packages Search (2011-11-21 12:16) - darthewok
	GIMP Matrix Plugin (2011-11-22 03:28) - darthewok
	Pixlr Grabber (2011-11-25 15:57) - darthewok
	Fedora 16 i Grub2 (2011-11-25 16:46) - darthewok
	Grub2 - Izmena podrazumevane boot opcije i izmena vremena (2011-11-25 17:06) - darthewok
	Optimizacija Fedore 16, zatvaranje nepotrebnih otvorenih portova i instaliranje nekih programa. (2011-11-26 09:20) - darthewok
	Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Internet za poneti (Fedora 15 i 16). (2011-11-26 13:58) - darthewok
	Photo editor online (2011-11-26 17:38) - darthewok
	MyPaint (2011-11-28 02:40) - darthewok

	December
	Global Conflict Blue 2 (2011-12-01 00:38) - darthewok
	Sta je TCP/IP? (2011-12-02 06:28) - darthewok
	Gimp tutorijal 23 - Layer Mask (2011-12-04 15:56) - darthewok
	Fedora 16 boot problem posle poslednjeg apdejta (2011-12-14 20:28) - darthewok
	Second Life u Linuxu (2011-12-19 11:33) - darthewok
	Fedora 16 & Virtual Box (2011-12-25 16:23) - darthewok
	Fedora 16 & vlasnicki NVidia i ATI drajveri (2011-12-26 19:03) - darthewok
	Srecna Nova Godina!!! (2011-12-30 01:48) - darthewok
	Jhead (2011-12-31 15:15) - darthewok


	2012
	January
	2011 in review (2012-01-01 12:25) - darthewok
	Instaliranje custom firmware-a na PSP 3000 (2012-01-02 21:41) - darthewok
	Srecan Bozic! (2012-01-07 12:33) - darthewok
	Gimp tutorijal 24 – Ray Studio (2012-01-11 03:22) - darthewok
	Fedora 16 i VLC problem posle poslednjeg update-a (2012-01-15 22:49) - darthewok
	Gimp tutorijal 25 - 3D TV foto montaza (2012-01-17 21:09) - darthewok
	Protest na internetu... (2012-01-18 04:49) - darthewok
	"PROTECT IP / SOPA" akt rusi Internet (2012-01-18 05:24) - darthewok
	Linux Mint 12 - kako sam podesio i koje sam programe dodatno instalirao (2012-01-22 11:04) - darthewok
	Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Internet za poneti (Mint 12). (2012-01-22 11:13) - darthewok
	Gimp tutorijal 26 - ubacivanje Photoshop braseva u Gimp (2012-01-23 00:13) - darthewok
	Gimp tutorijal 27 - munje, varnice i neonske reklame (2012-01-24 19:14) - darthewok
	Mint 12 i Kdenlive (2012-01-27 15:55) - darthewok
	Mint 12, Skype i izvrnuta slika na integrisanoj web kameri na Asus laptopu (2012-01-27 19:46) - darthewok
	Besplatni web hosting - 000webhost.com (2012-01-30 11:45) - darthewok
	YoWindow - vremenska prognoza (2012-01-30 12:17) - darthewok

	February
	Gimp tutorijal 28 - sneg (2012-02-05 16:08) - darthewok
	Gimp tutorijal 29 - dopuna prethodne epizode (2012-02-05 17:48) - darthewok
	Gimp tutorijal 30 - Animirani GIF-ovi (2012-02-07 20:17) - darthewok
	Gimp tutorijal 31 - Hockney fotografija (2012-02-09 00:43) - darthewok
	Dogfight Battle In The Skies (2012-02-10 02:31) - darthewok
	Gimp tutorijal 32 - Valentine's Vampir (2012-02-12 15:06) - darthewok
	Aviary Tools (2012-02-15 02:31) - darthewok
	Start Page - pretrazivac (2012-02-15 03:00) - darthewok
	Gimp tutorijal 33 - Svemir (2012-02-17 19:42) - darthewok

	March
	Gimp tutorijal 34 - Nazubljene ivice na fotografijama (2012-03-05 15:30) - darthewok
	Hidden and Dangerous Deluxe (2012-03-08 09:55) - darthewok
	Gimp tutorijal 35 - Foto montaza (2012-03-08 16:24) - darthewok
	NBUExplorer (2012-03-19 11:29) - darthewok
	˜ Razdvajanje integrisanog Flac-a pomocu Cue fajla ˜ (2012-03-23 13:33) - w1ndu
	˜ WinLame ˜ (2012-03-23 13:38) - w1ndu
	˜ CDDB Mp3 Tool ˜ (2012-03-23 13:42) - w1ndu

	April
	Linux IDX - pretrazivac (2012-04-22 23:30) - darthewok
	FreeCol (2012-04-23 04:20) - darthewok
	Adblock Plus (2012-04-26 12:34) - darthewok
	Blur (nekada se zvao DoNotTrackMe) (2012-04-28 01:24) - darthewok
	Sumo Paint (2012-04-28 03:09) - darthewok
	Adobe flash player i poremecene boje u flash videu na Linuxu (2012-04-29 12:58) - darthewok

	May
	DOSBox (2012-05-04 17:26) - darthewok
	Gimp 2.8.0 i Fedora 16 (instaliranje) (2012-05-07 04:40) - darthewok
	Gimp tutorijal 36 - Gimp 2.8.0 prvi utisci (2012-05-07 20:48) - darthewok
	Dodaci za Gimp koji ne rade u verziji 2.8.0 (2012-05-09 13:06) - darthewok
	Ubuntu 12.04 LTS (2012-05-18 02:17) - darthewok
	Ubuntu 12.04 LTS – kako sam podesio i koje sam programe dodatno instalirao (2012-05-18 17:50) - darthewok
	Adobe flash player i poremecene boje u flash videu na Linuxu (Ubuntu 12.04 LTS) (2012-05-18 18:20) - darthewok
	Vice Commodore emulator i Ubuntu 12.04 LTS (2012-05-18 18:38) - darthewok
	Postupak povezivanja CDMA modema AnyDATA ADU-520E, koji firma Orion Telekom nudi u paketu Internet za poneti (Ubuntu 12.04 LTS). (2012-05-18 22:31) - darthewok
	LiBRE! - Časopis o slobodnom softveru (2012-05-19 16:45) - darthewok
	Citanje .ePub formata (2012-05-20 16:53) - w1ndu
	True Crypt - Ubuntu 12.04 LTS (2012-05-21 15:08) - darthewok
	Grub Customizer - Izmena grub menija na lak nacin - Ubuntu 12.04 LTS (2012-05-23 12:32) - darthewok
	Root pristup bez sifre - Ubuntu 12.04 LTS (2012-05-23 12:55) - darthewok
	Korisnici i grupe za Virtual Box - Ubuntu 12.04 LTS (2012-05-23 14:15) - darthewok
	Nautilus Image Converter - Ubuntu 12.04 LTS (2012-05-23 14:53) - darthewok
	Skype i izvrnuta slika na integrisanoj web kameri na Asus laptopu - Ubuntu 12.04 LTS (2012-05-31 05:36) - darthewok

	June
	Gimp tutorijal 37 - Crop (2012-06-18 16:22) - darthewok
	Gimp tutorijal 38 - Popravka fotografije (2012-06-20 04:13) - darthewok
	Universal USB Installer (2012-06-26 03:08) - darthewok
	Sardu (2012-06-26 03:29) - darthewok

	July
	Brisanje deaktiviranih facebook kontakata (2012-07-01 19:54) - w1ndu
	Gimp tutorijal 39 (2012-07-05 23:12) - darthewok
	Gimp tutorijal 40 - Kratka animacija (2012-07-06 14:16) - darthewok
	Video tutorijali za Blender na srpskom jeziku (2012-07-08 14:06) - darthewok
	Pravopis srpskog jezika (2012-07-08 14:26) - darthewok
	Google Beatbox (2012-07-14 15:48) - w1ndu
	Inkscape tutorijal 01 - Uvod u Inkscape (2012-07-17 22:57) - darthewok
	Inkscape tutorijal 02 - Efekti sa slovima i tekstom (2012-07-22 14:15) - darthewok
	Gimp tutorijal 41 - "Iskljucivanje" providnosti piksela (2012-07-31 16:10) - darthewok

	August
	Gimp tutorijal 42 - Pravljenje i stampanje plakata (2012-08-07 15:54) - darthewok
	Inkscape tutorijal 03 - Uvoz i izvoz bitmapiranih slika u Inkscape (2012-08-10 15:44) - darthewok
	Inkscape i Gimp Specijal (2012-08-19 10:26) - darthewok
	Gimp tutorijal 43 - Xsane i odgovori na pitanja gledalaca (2012-08-19 23:18) - darthewok

	September
	Free Falcon (2012-09-04 11:50) - darthewok
	Gimp Magazin (2012-09-15 20:31) - darthewok
	Opsiran odgovor na pitanje zasto pravim tutorijale za Gimp, a ne za Photoshop (2012-09-18 04:15) - darthewok
	XnView (2012-09-18 13:18) - darthewok
	Make Human (2012-09-21 02:06) - darthewok
	C-evo (2012-09-30 13:31) - darthewok

	November
	Windows XP i Fujitsu Siemens Amilo Li 2735 laptop (2012-11-01 15:13) - darthewok
	Obrada PDF-a u Open/Libre Office-u (2012-11-19 00:29) - w1ndu
	Gimp tutorijal 44 - Dim u boji (2012-11-24 14:45) - darthewok
	AutoIt (2012-11-25 01:09) - darthewok
	hawksmont Universe :) (2012-11-28 05:05) - darthewok

	December
	Korisnicka uputstva za upotrebu (2012-12-05 08:09) - darthewok
	Krita (2012-12-08 16:38) - darthewok
	Gimp tutorijal 45 - Refleksija na vodi (2012-12-15 14:12) - darthewok
	Srpski jezik za Gimp - Ubuntu 12.04 (2012-12-23 10:23) - darthewok
	CODE:FREE (2012-12-25 13:06) - darthewok
	Skype - nema audio obavestenja o dolazecim pozivima, chat porukama... - Ubuntu 12.04 (2012-12-30 12:32) - darthewok
	Srecna Nova Godina!!! (2012-12-31 10:09) - darthewok
	2012 in review (2012-12-31 10:33) - darthewok
	Animate It! (2012-12-31 16:40) - darthewok
	LibreCAD (2012-12-31 17:08) - darthewok
	Izbacivanje Suspend - Ubuntu 12.04 (2012-12-31 17:46) - darthewok


	2013
	January
	Dconf Editor - Configuration Editor (2013-01-05 13:01) - darthewok
	Strut (2013-01-06 10:51) - darthewok
	Ubuntu telefon (2013-01-06 15:20) - darthewok
	FreetuxTV (2013-01-06 16:21) - darthewok
	Ne, ne i ne, Photoshop CS2 NIJE besplatan!!! (2013-01-08 12:22) - darthewok
	Cinnamon desktop na Ubuntu 12.04 (2013-01-11 11:18) - darthewok
	Iskljucivanje Jave u Firefox-u i Chromium-u - Ubuntu 12.04 (2013-01-15 01:29) - darthewok
	Midnight Commander (2013-01-15 04:34) - darthewok
	Zašto koristiš linux? (2013-01-16 07:12) - darthewok
	Calligra Flow (2013-01-18 01:07) - darthewok
	Brython (2013-01-19 20:19) - darthewok
	Gimp tutorijal 46 - Gif animacija (2013-01-21 14:06) - darthewok
	Gimp tutorijal 47 - Lightsaber Effect (2013-01-24 13:06) - darthewok
	Gimp tutorijal 48 – Instaliranje Gimp 2.8.2 u Windowsu (2013-01-26 22:02) - darthewok
	Gimp tutorijal 49 - Prikaz filtera Highpass sharpening i Kalendar (2013-01-27 17:40) - darthewok
	Virtual Box - Prikaz (2013-01-29 22:54) - darthewok
	Gimp tutorijal 50 - efekat sa tekstom (2013-01-30 16:18) - darthewok

	February
	Gimp tutorijal 51 - Uklanjanje nezeljenih elemenata sa slike (2013-02-08 22:54) - darthewok
	Gimp tutorijal 52 - Kombinovanje dve fotografije (2013-02-11 00:11) - darthewok
	Ukljucivanje skrivenih stavki u Startup Applications... (Ubuntu 12.04) (2013-02-12 01:43) - darthewok
	Ascii Star Wars animacija (2013-02-12 05:44) - darthewok
	Gimp tutorijal 53 - Oblacici za strip i odgovor na pitanje gledaoca (2013-02-23 00:42) - darthewok

	March
	Gimp tutorijal 54 - Ubacivanje oziljka, tetovaze i pozadine (2013-03-03 20:01) - darthewok
	Click&Clean dodatak za Chrome i Firefox (2013-03-23 12:18) - darthewok
	Ghostery dodatak za Chrome i Firefox (2013-03-23 12:38) - darthewok
	Sah (2013-03-26 02:27) - darthewok
	Gimp tutorijal 55 - Flare efekat (2013-03-30 19:29) - darthewok

	April
	Shodan (2013-04-08 23:06) - darthewok
	UNetbootin (2013-04-09 03:28) - darthewok
	PayPal u Srbiji (2013-04-10 15:49) - darthewok
	Gimp tutorijal 56 - Transparentna pozadina (2013-04-13 11:25) - darthewok
	Libre Office 4.0.x i Ubuntu 12.04 LTS (2013-04-13 22:06) - darthewok
	Gimp tutorijal 57 - Transparentna pozadina 2 (2013-04-14 13:54) - darthewok
	Testiranje ispravnosti tastature (2013-04-17 08:44) - darthewok

	May
	Erepublik (2013-05-08 20:20) - darthewok
	Slave Hack (2013-05-08 20:30) - darthewok
	pptx fajlovi (2013-05-15 12:19) - w1ndu
	Proxy Tool (2013-05-18 14:39) - darthewok
	Kreiranje PDF dokumenata (2013-05-18 16:27) - w1ndu
	Dodavanje menija u PDF dokumentima (2013-05-18 16:48) - w1ndu
	JChessBoard (2013-05-18 22:27) - w1ndu
	Konverzija nrg u iso u Linuxu (2013-05-26 11:53) - darthewok
	nGlide (2013-05-27 14:23) - darthewok
	Texturemate (2013-05-29 19:08) - darthewok

	June
	Gimp tutorijal 58 - Transparentna pozadina 3 (2013-06-02 11:36) - darthewok
	Slobodan softver (2013-06-02 12:01) - darthewok
	Double Commander (2013-06-08 23:52) - darthewok
	Instalacija Oracle Java JRE na Ubuntu 12.04 (2013-06-10 19:44) - darthewok
	Gimp tutorijal 59 - Odgovor na pitanje gledaoca (2013-06-20 13:51) - darthewok
	PlayDeb (2013-06-22 12:27) - darthewok

	July
	Eternal Lands (2013-07-10 22:21) - darthewok
	War Thunder (2013-07-10 23:09) - darthewok
	openBVE (2013-07-10 23:23) - darthewok
	Speed Dreams (2013-07-10 23:49) - darthewok
	Izbacivanje dodatnog audio streama iz mp4 fajla (2013-07-13 00:27) - w1ndu
	Gimp tutorijal 60 - Luce plugin (2013-07-15 13:32) - darthewok
	Gimp tutorijal 61 - Smanjivanje XCF fajla (2013-07-15 13:44) - darthewok
	Brasevi za Gimp (2013-07-17 14:04) - darthewok
	Osnove Pitona (2013-07-28 22:49) - w1ndu

	August
	Empire of Sports (2013-08-02 19:29) - darthewok
	QB64 Basic (2013-08-03 00:12) - w1ndu
	Bezbednost PDF dokumenata (2013-08-06 19:36) - darthewok
	Brokerov blog (2013-08-07 14:04) - darthewok
	Optimizacija SeaMonkey Browsera (2013-08-09 01:30) - w1ndu
	Optimizacija Firefox Browsera (2013-08-11 01:32) - w1ndu
	ScriptSafe (2013-08-30 00:38) - darthewok
	NoScript (2013-08-30 00:49) - darthewok

	September
	Pronalazenje facebook naloga preko linka za fotografiju (2013-09-06 01:23) - w1ndu
	Mp4 Muxer (2013-09-06 02:34) - w1ndu
	Gimp tutorijal 62 - Path alat (2013-09-07 21:00) - darthewok
	Gimp tutorijal 63 - Logo Toolbox (2013-09-24 20:02) - darthewok
	Lovćenac LUG (2013-09-26 23:31) - darthewok
	Gimp tutorijal 64 - Manipulacije sa slikama (2013-09-30 01:22) - darthewok

	November
	Firefox - Novi zum (2013-11-03 03:06) - w1ndu
	Commodore (2013-11-11 16:24) - darthewok

	December
	Vremenska prognoza (2013-12-05 00:01) - darthewok
	Micro64 i Hyper64 (2013-12-05 00:29) - darthewok
	CMYK PSD i Gimp (2013-12-12 20:03) - darthewok
	Gopher (2013-12-17 02:39) - darthewok
	Skype na web portovima (2013-12-18 16:15) - w1ndu
	SRECNA NOVA GODINA!!! (2013-12-31 07:14) - darthewok


	2014
	January
	2013 in review (2014-01-02 10:01) - darthewok
	Python - uvod u seriju tekstova sa primerima. (2014-01-03 03:25) - darthewok
	Python prvi cas (2014-01-03 22:37) - darthewok
	Python drugi cas (2014-01-04 22:22) - darthewok
	Python treci cas (2014-01-05 11:27) - darthewok
	Python cetvrti cas (2014-01-14 20:07) - darthewok
	Python: Funkcije kao varijable (2014-01-15 02:49) - w1ndu
	Python peti cas (2014-01-15 12:47) - darthewok
	Verzije Pythona (2014-01-15 13:36) - w1ndu
	Python sesti cas (2014-01-17 11:22) - darthewok
	Python sedmi cas (2014-01-17 16:37) - darthewok
	Python: Funkcije, uvod (2014-01-18 05:05) - w1ndu
	Python osmi cas (2014-01-19 00:32) - darthewok
	Python: Funkcije, primeri (2014-01-19 02:45) - w1ndu
	Python: Funkcije, trikovi (2014-01-20 00:55) - w1ndu
	Python: Funkcije, praksa (2014-01-20 02:33) - w1ndu

	February
	Skype v4 instalacija (2014-02-24 14:59) - w1ndu

	March
	OpenHardwareMonitor (2014-03-01 14:43) - w1ndu
	GIMP uputstvo (2014-03-27 22:31) - darthewok

	April
	Yahoo mailto popup (2014-04-17 03:16) - w1ndu
	SIP klijenti (2014-04-29 11:12) - w1ndu

	May
	Firefox: Otkrivanje asteriska (2014-05-06 00:37) - w1ndu
	ourWorld (2014-05-14 09:07) - darthewok
	Xubuntu 14.04 LTS (2014-05-14 09:17) - darthewok
	Instalacija i podesavanje Xubuntu 14.04 (2014-05-14 10:11) - darthewok
	Vice Commodore emulator i Xubuntu 14.04 LTS (2014-05-30 12:51) - darthewok

	June
	TrueCrypt (2014-06-30 20:04) - darthewok

	July
	Iskljucivanje Zeitgeist u Xubuntu 14.04 (2014-07-03 12:27) - darthewok
	MOOC trend (2014-07-08 14:59) - w1ndu

	August
	Xubuntu 14.04 i Netbook MSI Wind U100 (2014-08-14 14:09) - darthewok

	November
	Xubuntu 14.04 LTS Zoom desktopa (2014-11-05 16:21) - darthewok

	December
	FireFox Hello (2014-12-12 00:40) - w1ndu



